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License Agreements

PORTLAND CEMENT ASSOCIATION
EVALUATION SOFTWARE LICENSE AGREEMENT

BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR
OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE
BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE
WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION
PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO
NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS
APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO
PCA.

PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED,
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION
SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE
TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER
DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA DIRECTLY OR
THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER).

WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN
CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH
WHICH THIS SOFTWARE IS USED.

PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR
THE SOFTWARE OR USER DOCUMENTATION.

THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FIT NESS
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT
AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE
PROVIDED ON AN "AS-IS" BASIS.

IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS,
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL
OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS BEEN ADVISED OF THE
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POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY THIRD
PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE
OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON
PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR
USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS,
INAC CURACIES, FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO
THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION;
(4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILI TIES; (5) PCA NOT
PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE
SOFTWARE OR USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS
NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION
CAUSED BY (a) ACCIDENT, (b) NEGLI GENCE OR ABUSE BY CUSTOMER, (c) ACTS OF
THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR,
MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING
USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND
FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO
EVENT SHALL PCA BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS
OR ANY OTHER UNDERSTAN DINGS BETWEEN CUSTOMER AND DEALER (IF ANY)
RELATING TO THE SOFTWARE OR USER DOCUMENTATION.

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF
THAT AGREEMENT AND UNDERSTANDING. IT SUPER SEDES ALL PRIOR
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMEN
TATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL NOT BE
RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT.

1. LICENSE RESTRICTIONS

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA,
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer,
translate or decompile the Software or User Documentation in whole or in part; (2) disclose,
publish, release, sublicense or transfer to another person any Software or User Documentation;
(3) reproduce the Software or User Documentation for the use or benefit of anyone other than
Customer; or (4) modify any Software or User Documentation. All rights to the Software and
User Documentation not expressly granted to Customer hereunder are retained by PCA. All
copyrights and other proprietary rights except as expressed elsewhere in the Software or User
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at
only one designated workstation at Customer's site at any given time. Customer may not transmit
the Software electronically to any other workstation, computer, node or terminal device whether
via a local area network, a wide area network, telecommunications transmission, the Internet or
other means now known or hereafter created without prior written permission by PCA.

(b) Customer acknowledges that this is a limited license for trial and evaluation purposes only. This
limited license shall automatically terminate upon the earlier of: (1) ten executions of the
Software on the computer on which it is installed; or (2) fifteen days after the installation of the
Software. Thereafter, Customer may only use the Software and Documentation if it acquires a
production license for the same.

xii
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2. TERM AND TERMINATION

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or
installs, copies or otherwise uses the Software or User Documentation until: (1) it is terminated by
Customer, by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein; or
(2) the limited trial and evaluation license terminates.

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply
with any of its terms or conditions. This Agreement may be terminated by Customer without
cause at any time upon written notice to PCA.

3. BACKUP AND REPLACEMENT COPIES
Customer may make one copy of the Software for back-up and archival purposes only, provided
PCA's copyright and other proprietary rights notices are included on such copy.

4. PROTECTION AND SECURITY

(a) Customer shall not provide or otherwise make available any of the Software or User
Documentation in any form to any person other than employees of Customer with the need to
know, without PCA's written permission.

(b) All Software and User Documentation in Customer's possession including, without limitation,
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination
of this Agreement for any reason, Customer shall immediately destroy all Software and User
Documentation, including all media, and destroy any Software that has been copied onto other
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing
with the foregoing to PCA.

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons
permitted access to the Software or User Documentation, to enable Customer to satisfy its
obligations under this Agreement with respect to use, copying, protection, and security of the
same.

(d) If PCA prevails in an action against Customer for breach of the provisions of this Section 4,
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in
connection with such action in addition to any award of damages.

5. CUSTOMER'S RESPONSIBILITIES

The essential purpose of this Agreement is to provide Customer with limited use rights to the
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the
Software and User Documentation to satisfy Customer's business needs and achieve Customer's
intended results; (b) the use, set-up and installation of the Software and User Documentation;
(c) all results obtained from use of the Software and User Documentation; and (d) the selection,
use of, and results obtained from any other software, programming equipment or services used
with the Software or User Documentation.

6. LIMITED WARRANTIES
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PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the
Software and User Documentation and/or the right to grant Customer the rights granted
hereunder; (b) the Software and User Documentation provided hereunder is PCA's most current
production version thereof; and (c) the copy of the Software provided hereunder is an accurate
reproduction of the original from which it was made.

7. LIMITATION OF REMEDY

(@

(b)

PCA AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT.
CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR
NONPERFORMANCE OF ANY SOFTWARE OR USER DOCUMENTATION, PCA,
DEALER (IF ANY), OR ANY OTHER CAUSE WHATSO EVER, AND REGARDLESS
OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING
NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE
SOFTWARE AND USER DOCUMENTATION AND RETURNING THE SAME TO PCA.

NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS
OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY),
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES
DISCLAIMED BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND
(2) ALL ACTUAL OR ALLEGED DAMAGES IN CONNECTION WITH THE USE OF
THE SOFTWARE AND USER DOCUMENTATION. THE ESSENTIAL PURPOSE OF
THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE
THE RISKS AS PROVIDED ABOVE.

8. U.S. GOVERNMENT RESTRICTED RIGHTS

This commercial computer software and commercial computer software documentation were
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard
Road, Skokie, Illinois, 60077. U.S. Government rights to use, modify, release, reproduce,
perform, display or disclose this computer software and computer software documentation are
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) (June
1995), or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 52.227-19
(June 1987), as applicable.

9. GENERAL

(a) No action arising out of any claimed breach of this Agreement or transactions under this

Agreement may be brought by Customer more than two years after the cause of such action has
arisen.

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted

herein or the Software or User Documentation by operation of law or otherwise without the prior
written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent is void.

(c) Customer acknowledges that the Software, User Documentation and other proprietary information

and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not

Xiv
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have an adequate remedy at law and PCA may enforce its rights hereunder by an action for
damages and/or injunctive or other equitable relief without the necessity of proving actual damage
or posting a bond therefor.

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS
AGREEMENT.

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RE LATING TO THIS
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO
EXTRATERRITORIAL SERVICE OF PROCESS.

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure
to the benefit of the personal and legal representatives, permitted successors, and permitted
assigns of the parties hereto.

(g) All notices, demands, consents or requests that may be or are required to be given by any party to
another party shall be in writing. All notices, demands, consents or requests given by the parties
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international
delivery service, addressed to the respective parties. Notices, demands, consents or requests
served as set forth herein shall be deemed sufficiently served or given at the time of receipt
thereof.

(h) The various rights, options, elections, powers, and remedies of a party or parties to this Agreement
shall be construed as cumulative and no one of them exclusive of any others or of any other legal
or equitable remedy that said party or parties might otherwise have in the event of breach or
default in the terms hereof. The exercise of one right or remedy by a party or parties shall not in
any way impair its rights to any other right or remedy until all obligations imposed on a party or
parties have been fully performed.

(i) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other
shall be deemed a waiver of any other breach, provision or default.

() The parties hereto, and each of them, agree that the terms of this Agreement shall be given
aneutral interpretation and any ambiguity or uncertainty herein should not be construed against
any party hereto.

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding
the remainder of this Agreement, it being the intent and agreement of the parties that this
Agreement shall be deemed amended by modifying such provision to the extent necessary to
render it enforceable and valid while preserving its intent or, if such modification is not possible,
by substituting therefor another provision that is enforceable and valid so as to materially
effectuate the parties’ intent.
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(1) Except as set forth herein, this Agreement may be modified or amended only by a written
instrument signed by a duly authorized representative of PCA and Customer.
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PORTLAND CEMENT ASSOCIATION
SOFTWARE LICENSE AGREEMENT

BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE
USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY
DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE
THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND
RETURN THE SOFTWARE AND USER DOCUMENTATION TO PCA FOR A FULL REFUND
WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND USER
DOCUMENTATION.

PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED,
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION
IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT.
SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA
DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER).
WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN
CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH
WHICH THIS SOFTWARE IS USED.

PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR
THE SOFTWARE OR USER DOCUMENTATION.

THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT
AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE
PROVIDED ON AN "AS-IS" BASIS.

IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF
PROFITS, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE,
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST
CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED
"INFRINGEMENT"; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF
THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE
PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM
USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT

License Agreements xvii



slabloc/Beam

LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S
INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE
SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM
CUSTOMER'S RESPONSIBILITIES; (5) PCA NOT PROVIDING UPDATES, BUG FIXES OR
CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6)
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE
SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE
OR ABUSE BY CUSTOMER, (¢) ACTS OF THIRD PERSONS INCLUDING, BUT NOT
LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE
WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE
SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e¢) FLOODS,
WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL PCA BE
LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER
UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE
SOFTWARE OR USER DOCUMENTATION.

THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF
THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER
DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL
NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT.

1. LICENSE RESTRICTIONS

(a)Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA,
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer,
translate or decompile the Software or User Documentation in whole or in part; (2) disclose,
publish, release, sublicense or transfer to another person any Software or User Documentation; (3)
reproduce the Software or User Documentation for the use or benefit of anyone other than
Customer; or (4) modify any Software or User Documentation. All rights to the Software and
User Documentation not expressly granted to Customer hereunder are retained by PCA. All
copyrights and other proprietary rights except as expressed elsewhere in the Software or User
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at
only one designated workstation at Customer's site at any given time. Customer may not transmit
the Software electronically to any other workstation, computer, node or terminal device whether
via a local area network, a wide area network, telecommunications transmission, the Internet or
other means now known or hereafter created without prior written permission by PCA.

(B) CUSTOMER ACKNOWLEDGES THAT THE REGISTRATION PROCESS FOR THE
SOFTWARE RESULTS IN THE GENERATION OF A UNIQUE LICENSE KEY AND
ACTIVATION CODE PAIR. ONCE THE LICENSE KEY AND ACTIVATION CODE
ARE ENTERED DURING THE INSTALLATION PROCESS, THE SOFTWARE WILL
ONLY WORK ON THE COMPUTER ON WHICH THE SOFTWARE IS INITIALLY
INSTALLED. IF YOU NEED TO DEINSTALL THE SOFTWARE AND REINSTALL
THE SOFTWARE ON A DIFFERENT COMPUTER, YOU MUST CONTACT PCA TO
OBTAIN THE NECESSARY REINSTALLATION PROCEDURES.

xviii
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2. CHARGES AND PAYMENTS
All payments for the Software and User Documentation shall be made to either PCA or Dealer (if
any), as appropriate.

3. TERM AND TERMINATION

(a)This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs,
copies or otherwise uses the Software or User Documentation until it is terminated by Customer,
by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein.

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply
with any of its terms or conditions. This Agreement may be terminated by Customer without
cause at any time upon written notice to PCA.

4. BACKUP AND REPLACEMENT COPIES
Customer may make one copy of the Software for back-up and archival purposes only, provided
PCA's copyright and other proprietary rights notices are included on such copy.

5. PROTECTION AND SECURITY

(a)Customer shall not provide or otherwise make available any of the Software or User Documentation
in any form to any person other than employees of Customer with the need to know, without
PCA's written permission.

(b) All Software and User Documentation in Customer's possession including, without limitation,
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination
of this Agreement for any reason, Customer shall immediately destroy all Software and User
Documentation, including all media, and destroy any Software that has been copied onto other
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing
with the foregoing to PCA.

(c)Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons
permitted access to the Software or User Documentation, to enable Customer to satisfy its
obligations under this Agreement with respect to use, copying, protection, and security of the
same.

(d) IfPCA prevails in an action against Customer for breach of the provisions of this Section 5,
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in
connection with such action in addition to any award of damages.

6. CUSTOMER'S RESPONSIBILITIES
The essential purpose of this Agreement is to provide Customer with limited use rights to the
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the
Software and User Documentation to satisfy Customer's business needs and achieve Customer's
intended results; (b) the use, set-up and installation of the Software and User Documentation; (c)
all results obtained from use of the Software and User Documentation; and (d) the selection, use
of, and results obtained from any other software, programming equipment or services used with
the Software or User Documentation.
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7. LIMITED WARRANTIES
PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the
Software and User Documentation and/or the right to grant Customer the rights granted
hereunder; (b) the Software and User Documentation provided hereunder is PCA's most current
production version thereof; and (c) the copy of the Software provided hereunder is an accurate
reproduction of the original from which it was made.

8. INFRINGEMENT
(a) PCA shall defend Customer against a claim that the Software or User Documentation furnished and
used within the scope of the license granted hereunder infringes a U.S. patent or U.S. registered
copyright of any third party that was issued or registered, as applicable, as of the date Customer clicked
the “I AGREE” below or installed, copied or otherwise began using the Software or User
Documentation, and PCA shall pay resulting costs, damages, and attorneys' fees finally awarded,
subject to the limitation of liability set forth in Section 9 entitled "Limitation of Remedy," provided
that:
1. Customer promptly notifies PCA in writing of the claim.
2. PCA has sole control of the defense and all related settlement negotiations.
3. If such claim has occurred or in PCA's opinion is likely to occur, Customer shall permit PCA at its
sole option and expense either to procure for Customer the right to continue using the Software or
User Documentation or to replace or modify the same so that it becomes noninfringing. If neither of
the foregoing alternatives is reasonably available in PCA's sole judgment, Customer shall, on one
month's written notice from PCA, return to PCA the Software and User Documentation and all
copies thereof.
(b) PCA shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any
claim based upon (1) use of other than a current unaltered release of the Software or User
Documentation, or (2) the combination, operation or use of any Software or User Documentation
furnished hereunder with any other software, documentation or data if such infringement would have
been avoided but for the combination, operation or use of the Software or User Documentation with
other software, documentation or data.
(c) The foregoing states the entire obligation of PCA and Customer’s sole remedy with respect to
infringement matters relating to the Software and User Documentation.

9. LIMITATION OF REMEDY

(a) PCA'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND CUSTOMER'S EXCLUSIVE
REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF
ANY SOFTWARE OR USER DOCUMENTATION, PCA, DEALER (IF ANY), OR ANY
OTHER CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION,
WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE
LIMITED TO THE AMOUNT PAID TO PCA OR DEALER (IF ANY) FOR THE
SOFTWARE AND USER DOCUMENTATION.

(b) NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF
THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY),
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED
BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR

XX
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ALLEGED DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY
PROVIDED HEREUNDER. THE ESSENTIAL PURPOSE OF THE LIMITED REMEDY
PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED
ABOVE.

10. U.S. GOVERNMENT RESTRICTED RIGHTS

This commercial computer software and commercial computer software documentation were
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard
Road, Skokie, Illinois 60077. U.S. Government rights to use, modify, release, reproduce,
perform, display or disclose this computer software and computer software documentation are
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a)
(June 1995), or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR
52.227-19 (June 1987), as applicable.

11. GENERAL

(a)No action arising out of any claimed breach of this Agreement or transactions under this Agreement
may be brought by Customer more than two years after the cause of such action has arisen.

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license
granted herein or the Software or User Documentation by operation of law or otherwise without
the prior written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent
is void.

(c)Customer acknowledges that the Software, User Documentation and other proprietary information
and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not
have an adequate remedy at law and PCA may enforce its rights hereunder by an action for
damages and/or injunctive or other equitable relief without the necessity of proving actual damage
or posting a bond therefor.

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS
AGREEMENT.

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO
EXTRATERRITORIAL SERVICE OF PROCESS.

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to
the benefit of the personal and legal representatives, permitted successors, and permitted assigns
of the parties hereto.

License Agreements XXi
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()

()

All notices, demands, consents or requests that may be or are required to be given by any party to
another party shall be in writing. All notices, demands, consents or requests given by the parties
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international
delivery service, addressed to the respective parties. Notices, demands, consents or requests
served as set forth herein shall be deemed sufficiently served or given at the time of receipt
thereof.

The various rights, options, elections, powers, and remedies of a party or parties to this
Agreement shall be construed as cumulative and no one of them exclusive of any others or of any
other legal or equitable remedy that said party or parties might otherwise have in the event of
breach or default in the terms hereof. The exercise of one right or remedy by a party or parties
shall not in any way impair its rights to any other right or remedy until all obligations imposed on
a party or parties have been fully performed.

(1) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other

shall be deemed a waiver of any other breach, provision or default.

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral

(k)

interpretation and any ambiguity or uncertainty herein should not be construed against any party
hereto.

If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding
the remainder of this Agreement, it being the intent and agreement of the parties that this
Agreement shall be deemed amended by modifying such provision to the extent necessary to
render it enforceable and valid while preserving its intent or, if such modification is not possible,
by substituting therefor another provision that is enforceable and valid so as to materially
effectuate the parties’ intent.

Except as set forth herein, this Agreement may be modified or amended only by a written instrument
signed by a duly authorized representative of PCA and Customer.

XXii
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Chapter 1

Introduction

pcaSlab is a computer program for the analysis and design of reinforced concrete
beams and slab systems. Two-way slab systems are analyzed using the Equivalent
Frame Method. Beams and frames of up to 22 spans can be analyzed and designed.
In addition to the design option pcaSlab has the capability of investigating existing
beams and slab systems. pcaSlab includes such features as punching shear check
and cracked-section or gross-section deflections. For beams, moment
redistribution as well as combined shear and torsion design are available. Material
quantity take-offs are computed. In addition to the required area of reinforcing
steel at the critical sections, pcaSlab provides a complete bar schedule that
includes number of bars and bar sizes and lengths. pcaSlab checks all applicable
provisions of the relevant code.

pcaBeam is a limited version of pcaSlab. It includes all elements that apply to
beams and one-way slab systems. Topics describing these elements are denoted
with - lablpeEeam icon because they are included in both pcaSlab and pcaBeam.
Two-way slab systems are available in pcaSlab only and topics related to two-way
slab systems are denoted with - fab icon.

Program Features SfablocGeam

e ACI318-05, ACI 318-02, ACI 318-99 and CSA A23.3-94

e English and SI units

e Beams/one-way slab and two-way slab systems design and investigation
e Flexure and shear design and investigation

e Torsion design and investigation for beams/one-way slab systems

e  Moment redistribution for beams/one-way slab systems

e (Calculation of instantaneous and long-term deflections

e Mixed slab system types (pcaSlab only)
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Auto-input feature that walks you through the input process
Checking of data as they are input

Graphical display of geometry and loads as they are input

Print preview of graphical screen

User-controlled screen color settings

Ability to save defaults and settings for future input sessions
Customizable results report

Import input data from ADOSS v6.0x/7.0x and PCA-Beam v1.0x

Context sensitive online help

Program Capacity sfablocA6eam

21 supports (22 spans including left and right cantilevers)
6 load cases

20 load combinations

999 partial dead loads per case

999 partial live loads per case

2 top bar layers (Design mode)

2 bottom bar layers (Design mode)

15 bar sets per span

System Requirements STablpcG8am
Operating systems <TablocABeam

Windows 98 SE
Windows ME
Windows NT4
Windows 2000

1-2
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e Windows XP

Minimum Requirements slablocABeam
e 100 MHz processor
e 32 MB of RAM memory
e 50 MB of free hard disk space for program installation

Recommended Options slablocfBeam

e  Most recent OS service pack installed

Terms <Tablo- Beam

The following terms are used throughout this manual. A brief explanation is given
to help familiarize you with them.

Windows refers to the Microsoft Windows environment as listed in
Operating System section of System Requirements.

[1] indicates equivalent value expressed in metric unit or CSA
code requirement corresponding ACI code requirement
Click on means to position the cursor on top of a designated item or

location and press and release the left-mouse button (unless
instructed to use the right-mouse button).

Double-click on  means to position the cursor on top of a designated item or
location and press and release the left-mouse button twice in
quick succession.

Marquee select means to depress the mouse button and continue to hold it
down while moving the mouse. As you drag the mouse, a
rectangle (known as a marquee) follows the cursor. Release
the mouse button and the area inside the marquee is
selected.

Introduction 1-3



slab|pcfBeam

Conventions

slab|pc/Beam

Various styles of text and layout have been used in this manual to help
differentiate between different kinds of information. The styles and layout are

explained below...

slab|pc/Beam

slab

Italic

Bold

Mono-space

KEY + KEY

SMALL CAPS

placed in a topic header means that the topic applies to both
pcaSlab and pcaBeam

placed in a topic header means that the topic applies to
pcaSlab only

indicates a glossary item, or emphasizes a given word or
phrase.

All bold typeface makes reference to either a menu or
a menu item command such as File or Save, or a tab such as
General Information or Columns

indicates something you should enter with the keyboard. For
example type “c:\*.txt”.

indicates a key combination. The plus sign indicates that you
should press and hold the first key while pressing the second
key, then release both keys. For example, “ALT + F”
indicates that you should press the “ALT” key and hold it
while you press the “F” key. Then release both keys.
Indicates the name of an object such as a dialog box or
a dialog box component. For example, the OPEN dialog box
or the CANCEL or MODIFY buttons.

Installing, Purchasing and Licensing pcaSlab/pcaBeam SablscG8am

For instructions on how to install, purachase and license pcaStructurePoint
software please refer to our Software Quick Start Guide.

Introduction
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Method of Solution

The user should be aware of the assumptions made by the program during the
design stage. These include details regarding loading, strip widths, reinforcement
selection, deflection computations, material quantities, etc.

Geometric checks SfablocAGaam

The pcaSlab and pcaBeam programs provide geometric checks to avoid an
analysis with an inconsistent system. The dimensions of the slabs, beams, drops
and column capitals are checked and modified to produce a legitimate system.

If the slab cantilever length is less than one-half the column dimension in the
direction of analysis, c;, or less than the lateral extension of the transverse beam
into the cantilever, the cantilever length will be increased to the larger of these two
lengths. If the slab width is less than one-half the column dimension transverse to
the direction of analysis, c,, or less than one-half the longitudinal beam width, the
slab width will be increased to the larger of these two widths.

If the drop panel lengths extend beyond the end of the slab cantilevers, the drop
panel lengths will be reduced so that they extend only to the cantilever tip. The
drop panel edges will be shifted forward or backward in the transverse direction
when the slab strip width on either side of the column is less than one-half the
drop panel width.

If a column capital contains a depth/extension ratio less than 1, the extension will
be limited to the capital depth. The upper limit for the depth/extension ratio is 50.
If, by drawing lines extending the column capital through the drop or beam to the
underside of the slab, the column capital extension falls outside the edge of the
drop or beam at the slab soffit, the extension will be modified such that these lines
extend only up to the edge of the drop or beam at the slab soffit (Figure 2-1). The
modified column capital dimensions will be used when computing column
stiffness.



slab|pcfBeam

\ Maximum /
N Capital Width //
\f———— 7

Figure 2-1 Maximum capital width

Code Checks SfablocAGaam

Prior to an analysis, pcaSlab checks that the input values for the drop panel
dimensions, column capital dimensions, T-beam flange widths, waffle slab rib
dimensions and slab and beam depths meet the applicable code values.

Drop Panel Dimensions slab

A valid drop must extend in each direction at least one-sixth the center-to-center
span length in that direction (Figure 2-2) and have a drop depth below the slab of
at least one-quarter the input slab depth. Per ACI', slabs that contain valid drops
are allowed a 10% decrease in minimum slab depth. The drop depth of an invalid
drop will not be used in the calculation of the depth used to reduce the amount of
reinforcement required at a column?, and will not be used in the calculation of
moment of inertia for deflection computations.

If the valid drop depth is greater than one-quarter the distance from the edge of the
drop panel to the face of the column (x) the excess depth exceeding “4x will not be
considered in the calculation of the effective depth used to reduce the amount of
reinforcement required at a column (Figure 2-3)°.

' ACI 318-05 (Ref. [1]), 9.5.3.2; ACI 318-02 (Ref. [2]) , 9.5.3.2, ACI 318-99 (Ref. [3]), 9.5.3.2
2 ACI 318-05, 13.3.7; ACI 318-02, 13.3.7; ACI 318-99, 13.3.7
3 ACI 318-05, 13.3.7; ACI 318-02, 13.3.7.3; ACI 318-99, 13.3.7.3; CSA A23.3-94 (Ref. [4]), 13.11.6

Method of Solution
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11607

11627

1/6 04 1/6 44

Figure 2-2 Valid drop dimensions

[ i

I 1
—r >1/4x

Figure 2-3 Excess drop depth

The input drop dimensions will be used for self-weight computations, when
computing slab stiffness and to determine moments and shears when computing
punching shear around a column.

Method of Solution 2-3
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Minimum Slab Thickness slab

For ACI 318 codes, the minimum thickness of slabs with or without interior beams
spanning between supports and having a ratio of long to short span not exceeding
2 is*:

f
1,/ 0.8+ Y
200,000
= R 02<a,<2.0 Eq. 2-1
36+ 5B (a,, —0.2)
f
1,/ 0.8+
200,000 20 Ea. 2.2
= , o, >2.0. . 2-
36+9p m d
For CSA A23.3-94°
f
1,0.64+——
h 1000 ki 2.0 Eq. 2-3
>— 7 o, taken<2.0, q. 2-
T 30+4Bay, m
where
1, = clear span in the direction of analysis,
§ = ratio of the clear spans in long to short direction,
fy = yield stress of reinforcing steel,
O = average value of o, the ratio of flexural stiffness of a beam

section to theequ flexural stiffness of a width of slab bounded
laterally by centerlines of adjacent panels on either side of the
beam, for all beams supporting the edges of a slab panel.

For the design of ACI slabs without beams (o, < 0.2) spanning between supports
the minimum thickness shall conform to ACI 318 Table 9.5(c). For flat slabs that
contain valid drops, Table 9.5(c) reduces the minimum thickness by approximately
10%. (See Figure 2-2).

The minimum thickness in a span that contains a discontinuous edge will be
increased by 10%, if the edge beam provided has a stiffness ratio, a, of less than

* ACI 318-05, 9.5.3.3; ACI 318-02, 9.5.3.3; ACI 318-99, 9.5.3.3
S CSA A23.3-94,13.3.5

2-4
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0.80.° The first and last spans are considered to contain a discontinuous edge as
well as a span that contains an exterior edge.

For the CSA Standard the minimum thickness is:

o for flat plates and slabs with column capitals

f
1, 0.6+——
1000

hy>——"-——=, Eq. 2-4
s 30 q

o for slabs with drop panels

f}’
1,/ 0.6+
1000
h, > ,
2x h,-h
30|14 224 || 24 s
1n hS

where 2x4/1, is the smaller of the values determined in the two directions, x4

Eq.2-5

shall not be taken greater than 1, /4, and (h d— hs) shall not be greater thanh, .

For flat plate systems, the minimum allowable thickness can in no case be less
than 5.0 in. For two-way flat slab systems with drops, described above, the
minimum allowable thickness can in no case be less than 4.0 in.” For supported
slab systems supported by beams with an a,, greater than or equal to 2.0, the
minimum allowable thickness can in no case be less than 3.5 in.®

A message will be printed with the output showing the required slab depth for any
span where the depth does not meet or exceed code requirements.

Minimum Thickness for Waffle Slab Systems slab
The minimum slab thickness allowed for waffle slabs is one-twelfth the clear rib
spacing, or 2 in.’

A message will be printed with the output showing the required slab depth for the
system if the depth does not meet or exceed code requirements.

5 ACI 318-05, 9.5.3.3 (d); ACI 318-02, 9.5.3.3 (d); ACI 318-99, 9.5.3.3 (d)
7 ACI 318-05,9.5.3.2; ACI 318-02, 9.5.3.2; ACI 318-99,9.5.3.2

8 ACI 318-05, 9.5.3.3; ACI 318-02, 9.5.3.3; ACI 318-99, 9.5.3.3

9 ACI 318-05, 8.11.6.1; ACI 318-02, 8.11.6.1; ACI 318-99, 8.11.6.1

Method of Solution 2-5
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Waffle Rib Dimensions <fab

Walffle slab rib dimensions will be considered valid if the rib width is at least 4 in.
[100 mm], the depth is no more than 3-1/2 times the rib width, and the clear
spacing between ribs does not exceed 30 in. [750 mm] (Figure 2-4). When valid
ribs exist, the ACI code permits the nominal concrete shear strength, Ve, to be
increased by 10%. "

- | <30in. |
b=z4in.

Figure 2-4 Valid rib dimensions

Special Considerations for Waffle Slabs <fab

For the purposes of analysis and design, pcaSlab replaces the waffle with solid
slabs of equivalent moment of inertia, weight, and punching shear resistance.

The equivalent thickness based on system weight is used to compute the system
self-weight. This thickness, hy, is given by:

v

h, =-—mod Eq. 2-6
v Amod
where:
Vimod= the volume of one waffle module,
Ao the plan area of one waffle module.

The equivalent thickness based on moment of inertia is used to compute slab
stiffness. The ribs spanning in the transverse direction are not considered in the
stiffness computations. This thickness, hy, is given by:

' ACI 318-05, 8.11.8; ACI 318-02, 8.11.8; ACI 318-99, 8.11.8

Method of Solution
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1
121, )3
hyy :( nbj > Eq. 2-7
brib
where:
Ly = moment of inertia of one waffle section between centerlines of
ribs.
briv = the center-to-center distance of two ribs (clear rib spacing plus
rib width).

The drop depth for waffle slab systems is set equal to the rib depth. The equivalent
drop depth based on moment of inertia, dyy, is given by:

dmr =y +hyip Eq. 2-8
where:
h.ip = rib depth below slab,
hyr = equivalent slab thickness based on moment of inertia.

A drop depth entered for a waffle slab system other than 0 will be added to dy,
thus extending below the ribs.

The equivalent thickness based on shear area is used to compute the area of
concrete section resisting shear transfer, A, around the drop. The equivalent slab
thickness, hy, used to compute A, is given by:

h, = Arib +d i Eq. 2-9
byip

where:

Agq = the entire rib area below the slab plus the slab thickness minus
the distance to the reinforcement centroid, d,,;, within the rib
width, i.e., the slab depth between the ribs is not considered as
contributing to shear resistance,

biiv = the center-to-center distance of two ribs (clear rib spacing plus
rib width),

dreint = the distance to reinforcement centriod from the slab top at the
support.

Method of Solution 2-7
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Material Properties STablpcG8am

By entering the concrete density and compressive strength of the members, default
values for the other concrete properties are determined. The slab, column, and
beam members may have different concrete properties.

The density of concrete is used to determine the type of concrete, modulus of
elasticity, and self-weight.

For the ACI 318 code, the concrete type is used to determine the default value of
f.., the average split tensile strength of concrete. The concrete type is determined in
accordance with Table 2-1.

Note: The CSA Standard does not use f.

Density (w)
Type
pef kg/m3
w>130 w > 2000 Normal
105 <w <130 1700 <w <2000 Sand-Lightweight
w <105 w <1700 All-Lightweight

Table 2-1 Default Concrete Types

Once the compressive strength of concrete f; is input, various parameters are set
to their default values.

The modulus of elasticity is computed as:''

E. = 33w1-5£, Eq. 2-10
where:
A = is the density of the concrete.

For CSA A23.3 standard

1.5
E, =(3300\/E +69ooj (ﬁj Eq.2-11

where:

" ACI 318-05, 8.5.1; ACI 318-02, 8.5.1; ACT 318-99, 8.5.1; CSA A23.3-94, 8.6.2.2

Method of Solution
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Y = the unit weight of concrete.

The square root of f; is limited to 100 psi for the computation of shear strength
provided by concrete, V., and development lengths. "

f, <100 psi . Eq. 2-12
Equations 2-10 through 2-12 are used internally and cannot be modified.

The average split tensile strength is used to compute the modulus of rupture and
reinforcement development lengths. For normal weight concrete, the default value
of f,; used by pcaSlab is set equal to:"

£, =674t Eq.2-13

In no case will f/6.7 exceed 100 psi. The value f; will be modified according to
the concrete type. Table 2-3 shows the default values for f,, for different concrete
types. No interpolation is performed for partial sand replacement.

Type f

(130 pljfo and labove) 6.7\1c
(105 petrot30pen | (089671
tbelor0say | (075)67R

Table 2-2 Default Average Splitting Tensile Strength

The modulus of rupture is used to determine the cracking moment when
computing the effective moment of inertia for deflection computations. The default
value of modulus of rupture, f,, is for ACI 318 code set equal to:

£ =1.121,. Eq. 2-14

If f,; is that given in Eq. 2-13, Eq. 2-14 becomes: "

2 ACI1318-05, 11.1.2; ACI 318-05, 11.1.2; ACI 318-99, 11.1.2
'3 ACI 318-05, 9.5.2.3(a); ACI 318-02, 9.5.2.3(a); ACI 318-99, 9.5.2.3(a)
'* ACI 318-05, Eq. 9-10; ACI 318-02, Eq. 9-10; ACI 318-99, Eq. 9-9

Method of Solution 2-9
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£, =754t . Eq. 2-15
For CSA A23.3 standard, the default value of modulus of rupture, f,, is 15
£, =062t . Eq. 2-16
for beams and columns and
0.6 1 /f.
f = T\F Eq.2-17

for slabs'® with A equal to'”: 1.00 for normal density concrete (2000 kg/m® and
above), 0.85 for structural semi-low-density concrete (1700 kg/m® to 2000 kg/m’),
and 0.75 for structural low-density concrete (below 1700 kg/m®).

There is no limit imposed on f.. Entering a large value of f, will produce
deflections based on gross properties, (i.e., uncracked sections).

The default values for the longitudinal reinforcement yield strength, f,, and shear
reinforcement yield strength, f,,, if applicable, are set equal to 60 ksi (413 MPa)
for ACI and 400 MPa for CSA.

Equivalent Frame Method sfab

The equivalent frame method, as described in the code'®, is used by pcaSlab for
both analysis and design. The code specifies procedures for the analysis and design
of slab systems reinforced for flexure in more than one direction, with or without
beams between the supports. A two-way slab' system, including the slab and its
supporting beams, columns, and walls may be designed by either of the following
procedures:

e The Direct Design Method
e The Equivalent Frame Method

pcaSlab uses the Equivalent Frame Method of analysis. It should be noted that this
method is based on extensive analytical and experimental studies conducted at the

" CSA A23.3-94,8.6.4

'S CSA A23.3-94,13.3.6

'"CSA A23.3-94,8.6.5

'8 Chapter 13 in ACI 318-05, ACI 318-02, and ACI 318-99, Clause 13 in CSA A23.3-94

' Implies a slab supported by isolated supports which permits the slab to bend in two orthogonal
directions.

2-10
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University of Illinois. Note also that there are no restrictions on the number of slab
spans or on dead-to-live load ratios in this method of analysis.

The first step in the frame analysis is to divide the three-dimensional building into
a series of two-dimensional frames extending to the full height of the building.
Horizontal members for each frame are formed by slab strips as shown in Fig. 2-5.
For vertical loads, each story (floor and/or roof) may be analyzed separately with
the supporting columns being considered fixed at their remote ends. (Figure 2-6).

Column Strip #2/2 or
£4/2, Whichever is Smaller

One-Half
Middle Strip

Exterior Equivalent Frame

Edge

i
?h

//fl_
s

T
i
1

Length of Spans in
Direction Moments
are Being Determined

_ﬁ__ _a_

1/2 Col. Size ¢ 2

Width L input:
. ) Left = /9/2; Right = c2/2
Width L input:
Left = 4 /2; Right = (/2

—— Interior Equivalent Frame

. | n ¢
T

I - -

912

)___

8

Slab Beam Strip £5/2 —F—|

/
€ of Panel {2 ————F—

~
[N)

Figure 2-5 Design strips
1774 1774 V774

1777 177 1777
Figure 2-6 Analytical model for vertical loads for a typical story
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Stiffness Characteristics <fab

The stiffness factors for the horizontal members (the slab beams) and the vertical
members (the equivalent columns) are determined using segmental approach.

Slab Beams slab

The moment of inertia of the slab beam elements between the faces of the columns
(or column capitals) is based on the uncracked section of the concrete including
beams or drop panels. The moment of inertia from the face of the column (or
capital) to the centerline of the column (or capital) is considered finite and is
dependent on the transverse dimensions of the panel and support. This reduced
stiffness (as compared to the infinite stiffness assumed in previous codes) is
intended to soften the slab at the joint to account for the flexibility of the slab away
from the support. This is consistent with provisions of the code.*’

Figure 2-7 shows the changes in stiffness between a slab, and a drop panel, and a
column (or capital).

Columns slab

The computation of the column stiffness is more complicated as it utilizes the
concept of an equivalent column. Theoretical slab studies have shown that the
positive moment in a slab may increase under pattern loads, even if rigid columns
are used, because of the flexibility of the slab away from the column. However, if
a two-dimensional frame analysis is applied to a structure with rigid columns,
pattern loads will have little effect. To account for this difference in behavior
between slab structures and frames, the equivalent column torsional member, as
shown in Figure 2-8, runs transverse to the direction in which the moments are
being determined. The transverse slab beam can rotate even though the column
may be infinitely stiff, thus permitting moment distribution between adjacent
panels. It is seen that the stiffness of the equivalent column is affected by both the
flexural stiffness of the columns and the torsional stiffness of the slabs or beams
framing into the columns. Note that the method of computation of column stiffness
is in accordance with the requirements of the code®'. Figure 2-9 shows a schematic
representation of the stiffness of typical columns.

2 ACT 318-05, 13.7.3; ACI 318-02, 13.7.3; ACT 318-99, 13.7.3; CSA A23.3-94, 13.9.2.3
2 ACI 318-05, 13.7.4; ACI 318-02, 13.7.4; ACI 318-99, 13.7.4; CSA A23.3-94, 13.9
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Figure 2-7 Sections for calculating slab-beam stiffness, K,
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Figure 2-7 continued

The column stiffness is based on the column height, €., measured from mid-depth
of the slab above, to the mid-depth of the slab below. pcaSlab calculates the
stiffness of the column below the design slab, taking into account the design slab
system at its top end. pcaSlab calculates the stiffness of the column above the
design slab taking only the slab depth into account at its bottom end; column

capitals, beams, or drops are ignored.

The computation of the torsional stiffness of the member requires several
simplifying assumptions. The first step is to assume dimensions of the transverse
torsional slab-beam members. Assumptions for dimensions of typical torsional

members are shown in Figure 2-10.
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Figure 2-8 The equivalent column
The stiffness, K,, of the torsional member is given by the following expression®*:

9Eqg C

(i)

K =2 , Eq. 2-18

where:

E. = modulus of elasticity for slab concrete,

C = cross-sectional constant defining torsional properties; see Eq.
2-19 (it is a conservatively low approximation of the torsional
rigidity of rectangular sections when assuming elastic behavior),
for the CSA Standard ¢, is taken as the smaller of ¢, or €;,

) = size of rectangular column or capital measured transverse to the
direction in which moments are being determined,

¢ = for ACI 318, length of span transverse to ¢;, measured on each
side of the column, for CSA A23.3-94 ¢, is taken as the smaller
of ¢, or ¢;.

22 ACI 318-05, 13.7.5; ACI 318-02, 13.7.5; ACI 318-99, 13.7.5; CSA A23.3-94, Eq. 13.13
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The constant C is evaluated for the cross section by dividing it into separate
rectangular parts and by carrying out the following summation®:

3
0:2[1—0.633jﬂ Eq. 2-19
y) 3
where:
X = short overall dimension of the rectangular part of a cross section,
y = long overall dimension of the rectangular part of a cross section.

9Es C

Asaresultof K, =) 3

, Eq. 2-18, walls* running the full width of a
S

b

slab (c, = ¢,) cannot be modeled by the Equivalent Frame Method.

Ir

Slab System With  Column Stiffness

J=c0

Slab System  Column Stiffness

Without Beams Diagram Column Capitals Diagram
I IR —TL— I—oo
Bottom / -
Le Lor Eccle , |of Slab-Beam
“¢| of Joint Lex Ecclc
Top of
[ . m— J-{— I= SIab—Bea\m
‘T' | ——— ] -} —— I =0
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Drop Panels Diagram Slab System  Column Stiffness
With Beams Diagram

Figure 2-9 Sections for calculating the stiffness (K;) of the column below
the design floor ( ¢-input, £*-computed)

» ACI 318-05, 13.6.4.2; ACI 318-02, 13.0; ACI 318-99, 13.0; CSA A23.3-94, Eq. 13-14

* Instead walls can be modeled as long supports less than the full design width of the slab. To obtain
a uniform distribution of the end moment along the column and middle strips, the width of the wall
must be greater than 75% of the design strip.
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When beams frame into the column in the direction of analysis, the value of K; as
computed in Eq. 2-18 is multiplied by the ratio of the moment of inertia of the slab
with the beam (Iy,) to the moment of inertia of the slab without the beam (1), as
shown:

1

K, =K, ILb Eq. 2-20
S

With reference to Figure 2-8, I is computed from part A (slab without beam),
whereas I, is computed from both parts A and B (slab with beam).

Cq C1q

IT y: 1 F 1 T :X1:

Condition (a) Condition (b)
c A 4
1 [ —

ol o]

A

by + 2hyy S by + 8hy | c1 |
I
Condition (c) Condition (d)

Y1

) y1 |
I = B '
P Xy
Pe | ] T
! Y2 ! (Note: x <y)

X1 X13Y1- X2 | x23y2
=3|(1-0.63 5 |——|+|[|1-0.63 7 | —=—=
¢ 2[( y1) 3 ] K VZJ 3 }

Figure 2-10 Section of the attached torsional members
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Knowing the column stiffness, K., and the stiffness of the attached torsional
member, K, the stiffness of the equivalent column, K, is computed from the
equation:

K, +K
K=—o2—%, Eq. 2-21
1+ Kct + ch
1 r
Kta + Kla
where:
K = top column stiffness,
Kb = bottom column stiffness,
K = torsional stiffness of the left (Kltal ) and the right (K|, ) member.
Loading SfablocGeam

All applied loads are input as unfactored loads. There are no limitations imposed
on the ratio of dead to live loads in the Equivalent Frame Method. Results of
gravity load and lateral load analyses may be combined, however, the effects of
cracking and reinforcement on stiffness must be accounted for in the lateral load
analysis.

Self-Weight <TablocABeam

The self-weight of the floor system is computed internally by pcaSlab. The
weights of the slabs, drops, and longitudinal and transverse beams are considered
in the self weight computations. Only the concrete weight is considered, the
reinforcement weight is ignored. The weight of longitudinal beams is ignored
starting at the column centerline, for a length equal to one-half ¢, the column
dimension in the direction of analysis. This will produce slightly less self-weight
than actually present for beams wider than c,, the column’s transverse dimension.

Superimposed Loading €fablocfGeam

All superimposed vertical loading is considered to act over the entire transverse
width of the slab. For slab systems with beams, loads supported directly by the
beam (such as the weight of the beam stem or a wall supported directly by the
beams) are also assumed to be distributed over the entire transverse width of the
strip. An additional analysis may be required, with the beam section designed to
carry these loads in addition to the portion of the slab moments assigned to the
beam.
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Lateral Loading slablocfBeam

For lateral loads, each frame should be analyzed as a unit for the entire height of
the building (Figure 2-11). Computer programs, such as pcaFrame, are available
for performing such analyses. It should be realized that, for lateral load analysis,
slab-beam elements may have a reduced stiffness due to cracking as well as other
assumptions made for the effective slab width used for the lateral analysis. The
moments obtained from such an analysis may then be input into the equivalent
frame model using pcaSlab to determine the appropriate design moments under
combined vertical and lateral loads.

22222 RAAARA

m m m m
Figure 2-11 Analytical model for lateral loads
pcaSlab distributes the effect of lateral load moment to the column strip and

middle strip according to the code distribution factors computed for vertical loads
(see Table 2-3 through Table 2-5 later in this chapter).

Loading Patterns sTablocfBeam

The analysis of floor systems requires the consideration of several loading
configurations. For example, the two adjacent spans loaded may produce the
maximum shear stress around a column, while the alternate spans loaded may
produce the maximum flexural moments. To cover different loading scenarios
pcaSlab generates live load case based on the following load patterns (Figure
2-12):

e Pattern No. | (All): All spans loaded with live load,
e Pattern No. 2 (Odd): Stating at span 1, alternate spans loaded with live load,
e Pattern No. 3 (Even): Stating at span 2, alternate spans loaded with live load,

e Pattern No. 4 (Sn): Two spans adjacent to support n loaded with live load.
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Figure 2-12 Live load patterns

pcaSlab reduces the magnitude of live load patterns No.2 through No.4 by
a predefined ratio. For two-way systems, the default live load pattern ratio selected
by the program equals 75% as permitted by the code®. The user has the ability to
select different value for the pattern ratio within the range 0-100%. If 0% is

» ACI 318-05, 13.7.6.3; ACI 318-02, 13.7.6.3; ACI 318-99, 13.7.6.3; CSA A23.3-94, 13.9.4
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selected than no load patterning is considered. However, the pattern No.1 with all
spans loaded (as specified by the user) is always considered with full unreduced
magnitude.

Load Combinations sfablpcf6eam

pcaSlab allows defining up to 20 load combinations. The user has full control over
the combinations. The program contains predefined (build into the program)
default primary load combinations for the supported codes. These default
combinations are created when starting a new project.

For the ACI 318-99 code, the default combinations of the Dead (D), Live (L),
Wind (W) and Earthquake (E) loads considered by the program are:

U, - 14D+17L,
U, = 0.75(14D+ L.7L + 1.7W),

U, = 0.75(1.4D+ 1.7L — 1.7W),

U, = 0.75(14D + 1.7W),

Us = 0.75(1.4D - 1.7W),

Us = 0.9D + 1.3W,

U = 0.9D - 1.3W,

Us = 0.75(1.4D + 1.7L + 1.7*1.1E),
Uy = 0.75(1.4D + 1.7L — 1.7*1.1E),
Ui = 0.75(1.4D + 1.7*1.1E),

Uy = 0.75(1.4D - 1.7*1.1E),

U]z = 09D + 143E,

U13 = 09D - 1.43E.

For the ACI 318-05 and ACI 318-02 codes, the default combinations of the Dead
(D), Live (L), Wind (W) and Earthquake (E) loads considered by the program are:

U1 = 14D,
U, = 1.2D + 1.6L,
Us = 1.2D + 1.6L + 0.8W,

U, = 1.2D + 1.6L — 0.8W,
Us = 1.2D+1.0L +1.6W,
Us = 12D+ 1.0L - 1.6W,
U, = 0.9D + 1.6W,
Us = 0.9D - 1.6W,
U = 12D + 1.0L + 1.0W,
Uy = 1.2D + 1.0L — 1.0W,
U11 = 0.9D + IOW,
U, = 0.9D — 1.0W.
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For the CSA A23.3 code, the default combinations of the Dead (D), Live (L),
Wind (W) and Earthquake (E) loads considered by the program are:

U, = 1.25D + 1.5L,
U, = 1.25D +0.7(1.5L + 1.5W),
U, = 1.25D +0.7(1.5L — 1.5W),
U, = 0.85D+1.5W,
Us = 0.85D-1.5W,
Us = 1.0D + 0.5L + 1.0E,
U, = 1.0D + 0.5L — 1.0E,
Us = 1.0D + 1.0E,
U = 1.0D — 1.0E.
Column and Middle Strip Widths sfab

The code®® defines the width of the column strip on each side of the column
centerline as being one-fourth of the smaller of either the transverse or the
longitudinal span. These widths are printed as part of the echo of input data.

The strip widths at a support are computed by (see Figure 2-13)

e column strip

min @,ﬁ + min @z,r ,ﬁ
2 4] 2 4]
Weg = min , Eq. 2-22
U 6, g
min{——,— + min —
2 4 i+1 24 i+1
e middle strip
Wus = min{ b ’5,1+1}‘Wcs- Eq.2-23

% ACI 318-05, 13.2.1; ACI 318-02, 13.2.1; ACI 318-99, 13.2.1; CSA A23.3-94, 13.1
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Figure 2-13 Strips widths at support
The strip widths in the span are defined as (see Figure 2-14):

e column strip

Weg = min @,ﬁ +min b ,ﬁ , Eq. 2-24
2 4 2 4
e middle strip
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where:
¢ = span length in the direction of analysis,
[ = the total input transverse strip width,
2% = the input transverse strip widths on the left of column centerline,
b, = the input transverse strip widths on the right of column centerline,
i = span left and right of column centerline,
i+1 = span left and right of column centerline.
—
| — |
| |
| |
| |
| T |
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| |
| |
: T
Wms I I Wimns
P |
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€ €
Figure 2-14 Strip widths in span
If a beam exists
WCS = WCS — Wb . Eq 2-26
where:
W, = beam width.

If the beam width, Wy, is greater than the column strip width, W, then an error
message is displayed and the solution is aborted. This usually happens when
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modeling a banded-beam system as a two-way slab with a wide beam. In this case,
it is suggested that wide beams are modeled separately in one direction, and in the
other direction one-way slab supported by beams is modeled.

For exterior frames, the edge width should be specified to the edge of the slab
from the column centerline.

Strip Design Moments sfab

pcaSlab considers negative moments for design purposes as those producing
tension at the top of the slab. The negative design moment is taken at a section
located at the face of the column, or column capital, but in no case is it considered
at a location greater than 0.175 of the longitudinal span length, ¢;, away from the
center of the column.?”” This imposes a limit on long narrow supports, in order to
prevent undue reduction in the design moment. For slab systems with transverse
beams, the face of a beam is not considered as the face of support. For end
columns with capitals, the moments are taken at the midpoint of the capital
extension.” The column and middle strip moments correspond to the moments
assigned to the slab element only.

The column strips are proportioned to resist the portions in percent of interior
negative factored moments according to Table 2-3.%

b,/e, 0.5 1.0 2.0
(a1 &/6) = 0 75 75 75
(Q,f] ez/ﬁ]) >1.0 90 75 45

Table 2-3 Column Strip Percent of Interior Negative Factored Moments at
Supports

The column strips are proportioned to resist the portions in percent of exterior
negative factored moments according to Table 2-4.%

7 ACI 318-05, 13.7.7.1; ACI 318-02, 13.7.7.1; ACI 318-99, 13.7.7.1; CSA3-A23.3-94, 13.9.5.1
* ACT 318-05, 13.7.7.2; ACI 318-02, 13.7.7.2; ACI 318-99, 13.7.7.2; CSA3-A23.3-94, 13.9.5.2
¥ ACI 318-05, 13.6.4.1; ACI 318-02, 13.6.4.1; ACI 318-99, 13.6.4.1; CSA3-A23.3-94, 13.9.5.1
3 ACI 318-05, 13.6.4.2; ACI 318-02, 13.6.4.2; ACI 318-99, 13.6.4.2;
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6/t 0.5 1.0 2.0

PN B.=0 100 100 100
(@n &/6) =0 B.>25 75 75 75
B.=0 100 100 100

(0n &)= 1.0 7555 90 75 45

Table 2-4 Column Strip Percent of Exterior Negative Factored Moments at
Supports

The values o, in Table 2-3 and Table 2-4 and B, in Table 2-4 are defined as:

of = ratio of flexural stiffness of the beam section to flexural stiffness
of a width of slab bounded by centerlines of adjacent panels (if
any) on each side of the beam in the direction of analysis. For
flat plates, flat slabs, and waffle o ¢,/¢; =0

By = ratio of torsional stiffness of an edge beam section to flexural
stiffness of a width of slab equal to the span length of the beam,
center-to-center of supports.”’ When no transverse beams are
present, B, = 0, otherwise

B, :%, Eq.2-27
CS™S
where:
Eu = modulus of elasticity of beam concrete,
E = modulus of elasticity of slab concrete,
C = cross-sectional constant, see Eq. 2-19,
I = moment of inertia of the gross section of the slab about its

centroidal axis.

For intermediate values of (6,/¢,), (a.n€/€;) and B, the values in Table 2-3 and Table
2-4 are interpolated using equations Eq. 2-28 and Eq. 2-29.

Percentage of negative factored moment at interior support to be resisted by

column strip:
75430 (O‘le‘}?j [1 —%J . Eq.2-28

Percentage of negative factored moment at exterior support to be resisted by
column strip:

' ACI 318-05, 13.6.4.2; ACI 318-02, 13.0; ACI 318-99, 13.0; CSA3-A23.3-94, 13.0

2-26

Method of Solution



slab|pcfBeam

100-10 B, +123(°‘2+QJ (1-%}. Eq. 2-29

When a column width, c,, is equal to or greater than 75 percent of the strip width,
¢, the negative moment is uniformly distributed across 0,32

When designing by the CSA A23.3-94 code, a portion of the total positive or
interior negative moment equivalent to:

Oy

2 b
1+ [é]
b
is resisted by the beam. For exterior supports the beam is proportioned to resist
100% of the negative moment.

Eq. 2-30

That portion of the moment not resisted by the beam is resisted by the slab. The
reinforcement required to resist this moment is distributed evenly across the slab.

For ACI designs the longitudinal beams are proportioned to resist 85 percent of the
column strip moments if apéy/¢; is equal to or greater than 1.0. For values of
agby/l; between 0 and 1.0, the beam is designed to resist a proportionate
percentage of the column strip moment between 0 and 85.%

When lateral loads are present, pcaSlab, by default, distributes the effects of lateral
loads according to Table 2-1 and Table 2-4.

The middle strips are proportioned to resist the portion of the total factored
moments that is not resisted by the column strips.

For design purposes, pcaSlab computes the amount of reinforcement for the
moments on the left and the right side of the support. The negative design moment
is the moment which requires the most area of reinforcement to be resisted. The
location, left or right of the support, of the maximum moment may vary when
systems differ on each side of the support (for example, a system with beams on
one side only). pcaSlab considers positive moments for design purposes as those
producing tension at the bottom of the slab. The column strips are proportioned to

32 ACI 318-05, 13.6.4.3; ACI 318-02, 13.6.4.3; ACI 318-99, 13.6.4.3
3 ACI 318-05, 13.6.5; ACI 318-02, 13.6.5; ACI 318-99, 13.6.5
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resist the portions in percent of positive factored moments according to Table
2.5

(24 0.5 1.0 2.0
(anb/l) = 0 60 60 60
(Q,fleQ/e[) >1.0 90 75 45

Table 2-5 Column Strip Percent of Positive Factored Moments

For intermediate values of (£/€;) and (agéy/€)) the values in Table 2-5 are
interpolated using Eq. 2-31 as follows:

60+30 (O‘fT&J (1.5—%} . Eq.2-31

The middle strips are proportioned to resist the remainder of the total factored
moments.

Note: For flat plates, flat slabs, and waffle slabs, o €,/¢; = 0.

Moment Redistribution SfablocAGaam

Redistribution of negative moments applies to one-way and beam systems only. It
can be engaged using the Input Redistribution radio button on the Solve Options
tab in the General Information dialog box.

pcaSlab allows for redistribution of negative moments at supports. Only reduction
in negative moments is considered. Increase of negative moments at the support is
not taken into account even though it is allowed by the code®. Static equilibrium
is maintained meaning that bending moments and shear forces along the span are
adjusted in accordance with the reduction of moments applied at the supports. The
following procedure is followed to obtain moment redistribution factors at the
supports.

From elastic static analysis, the largest moments from all load combinations and
load patterns are determined at support faces on both ends of each span except
cantilevers. These moments are used to calculate the maximum percentage
adjustment of moments, &, allowed by the codes.

* ACT 318-05, 13.6.4.4; ACI 318-02, 13.6.4.4; ACI 318-99, 13.6.4.4
3 ACI 318-05, 8.4.1; ACI 318-02, 8.4.1; ACI 318-99, 8.4.1; CSA A23.3-94,9.2.4
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For ACI 318-05 and ACI 318-023¢;

0,if g, <0.0075,

5= , Eq. 2-32
1000-¢,, if &, >0.0075,

where ¢, is net tensile strain in extreme tension steel at nominal strength.

For ACI 318-99%":

0,if (p—p')>0.5p,,

5= 20[1—p_p}if(p—p‘)SO.Spb, Eq. 2-33
Py
where:
p = tension reinforcement ratio,
p' = compression reinforcement ratio,
Py, = balanced reinforcement ratio.
For CSA A23.3-94°:
c
8:30—505, Eq. 2-34
where:
c = distance from extreme compression fiber to neutral axis,
d = distance from extreme compression fiber to centroid of tension

reinforcement.

In the investigation mode, program uses the area of provided reinforcement to
obtain redistribution factors. In the design mode the required reinforcement area is
used. Additionally, & is checked not to exceed 20% and not to exceed the
maximum values specified by the user. Negative moments at span ends are
reduced by the amount of redistribution factors and new moment values are
iteratively used to obtain new redistribution factors. This iterative procedure is
repeated until the change in distribution factor does not exceed 0.01% but no more
than 10 times.

36 ACI318-05, 8.4.1 and 8.4.3 ; ACI 318-02, 8.4.1 and 8.4.3
T ACI 318-99, 8.4.1 and 8.4.3
3% CSA A23.3-94,9.2.4
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Shear Analysis of Slabs sfab

Three types of shear can occur on slab systems: wide beam shear, punching shear,
and moment transfer shear. pcaSlab checks wide beam shear at a critical section
located at a distance equal to the effective depth away from the face of the
supports. The tributary area for wide beam shear calculations extends from the
critical section to the center of the span. For punching shear including moment
transfer shear it is assumed that both types of shear act on the same critical section.
The critical section for shear is defined in the code.”

Figure 2-15 shows the general punching shear area used by pcaSlab. Note that the
shaded area represents the general case and is modified for special considerations
as explained below.

Shallow beams are considered in the unbalanced moment transfer as indicated in
Figure 2-15 by areas B;, B,, Bs;, B,, Bs, and B4. Ordinarily, transverse beams
transfer unbalanced moment to the column through torsion along the beam and not
through shear between the slab and column. However, the code leaves the transfer
method to the engineer’s judgment concerning the point at which punching shear
is no longer applicable and beam shear becomes the dominate element in shear
transfer to the column. pcaSlab makes no such distinction and computes
unbalanced moment transfer stress without regard to any beams framing into the
column. Although the depth of the beam is considered in the critical section
surfaces, the distances to the critical section are not increased at the intersection
with any beams. This approach is conservative. pcaSlab does not compute
torsional stresses in the slab. If in the engineer’s judgment this may control, it must
be computed manually.

For a circular column or column capital, a square shape with an equivalent area is
assumed as shown in Figure 2-16. Critical section area for punching, A, is then
multiplied by n(D+d) /(2D\/E +4d) to account for the difference between

circular and square critical sections, where D is the diameter of a column or
a column capital and d is the effective depth of the slab.

¥ ACI 318-05, 11.12.1.2; ACT 318-02, 11.12.1.2; ACI 318-99, 11.12.1.2; CSA A23.3-94, 13.4.3
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Direction of
Analysis

*Not considered by program

Figure 2-15 Critical section for shear at column

The critical section is considered closed if the concrete slab around a column
extends to a distance greater than or equal to the specified threshold value. In
pcaSlab the user may define the distance extended beyond the column face in
order to consider the section closed. The default value for this distance is ten times
the slab thickness (10h) as required by ACI code. If the critical section does not

meet the distance requirement it is considered open.
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Critical Shear Area
Acsq = (2D /m + 4d)d

Critical Shear Area
Acgr=n (D +d)d

An = (D +d)
Ceir = (2D Jm + 4d) *Csa

Figure 2-16 Critical section area for circular column
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Critical Section for Interior Supports of Interior Frames slab

The critical section (Figure 2-17) consists of four vertical surfaces through the
slab, located at distances of d/2 beyond the support faces.

Critical Section

Figure 2-17 Interior supports of interior frames

The critical section for interior supports of interior frames is always closed.
A closed section will have all its faces defined in Figure 2-15 resisting shear as
indicated by Eq. 2-35:

8
Ac=YA;. Eq. 2-35
i=1

If beams frame*” into the column, then the critical section includes the dimensions
of the beams (B, through By in Figure 2-15).

Critical Section for Exterior Supports of Interior Frames slab

The critical section for exterior supports of interior frames (Figure 2-18) will be
either closed (full A; and Ag for the first column or A; and A, for the last column
in Figure 2-15) or open, depending upon the length of the cantilever in relation to
slab thickness. The critical section will be considered closed when the clear
cantilever span, €., is greater than or equal to the distance defined by the user
beyond the column face (the default value is 4 h when an ACI code is selected*!
and 5 d for the CSA standard*?). If beams frame into the column, then the critical

0 A beam is considered as framing into the column if the beam is within a face of the column.
#! Critical Sections near Holes and at Edges in [5], pp.649, paragraph (c)
2 CSA A23.3 Figure N13.4.3.4 (b)
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section includes the contributions from the beam dimensions (B; through B¢ in
Figure 2-16).

—\/\_

l——|
le

45°

Critical Section

Vu
M
+d Vb é u
1VAB
Open Critical
~ Section

Figure 2-18 Exterior supports of interior frames

Critical Section for Interior Supports of Exterior Frames

slab

Figure 2-19 shows the critical section for shear for an interior support of an
exterior frame. Note that the section is considered as U-shaped (As = 0, Ag = 0,
B;=0, B, = 0 in Figure 2-15) and it extends up to the edge of the exterior face of
the support. If beams frame into the column, then the critical section includes the
contribution from the beam dimensions (B; through B in Figure 2-15). If the
exterior cantilever span, €, is greater than or equal to the distance defined by the
user beyond the column face (the default value is 4 h when an ACI code is
selected*! and 5 d for the CSA standard“), the section is treated as closed, that is,
the support is treated as an interior support of an interior frame.

Method of Solution
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Figure 2-19 Interior supports of exterior frames
Critical Section for Exterior Supports of Exterior Frames slab

The critical section for an exterior support of an exterior frame will typically be L-
shaped (A5 =0, A6 =0, A7 =0, A8 =0, B1 =0, B3 =0, and B4 = 0 in Figure 2-15).

If the cantilever span , €, (in the direction of analysis) is greater than or equal to
the distance defined by the user beyond the column face (the default value is 4 h
when an ACI code is selected*' and 5 d for the CSA standard*), then the section is
treated as a U-shaped interior support. If, in addition, the cantilever span in
transverse direction is greater than or equal to the distance defined by the user
beyond the column face, the section is treated as closed. If beams frame into the
column, then the critical section includes the contributions from the beam
dimensions.

Computation of Allowable Shear Stress at Critical Section slab

One-way shear strength of slabs is limited* to 2 fcv . Two-way shear strength of

slabs is affected by concrete strength, relationship between size of loaded area and
slab thickness, loaded area aspect ratio, and shear-to-moment ratio at slab-column
connections.

For the ACI 318-99, ACI 318-02 and CSA A23.3-94 codes, these variables are
taken into account in the allowable shear stress Eqs. 2-36 through 2-39. The
allowable shear stress used by pcaSlab is computed at distances of d/2 around the
columns and drops (if applicable) and taken as the smallest of the 3 quantities:**

# ACI 318-05, 11.3.1.1; ACI 318-02, 11.3.1.1; ACI 318-99, 11.3.1.1
* ACI 318-05, 11.12.2.1; ACI 318-02, 11.12.2.1; ACI 318-99, 11.12.2.1; CSA A23.3-94, 13.4.4
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Ve :[2+1J f., Eq. 2-36

d) =
v, :(2+ % j\/f_ Eq.2-37
b,
ve=af. . Eq. 2-38

where

Be = the ratio of the long to the short side of the column.

O = a constant dependent of the column location, (40 for an interior
4-sided effective critical area, 30 for an exterior 3-sided critical
area, 20 for a corner 2-sided effective critical area.)

d = distance from the slab bottom to centroid of the slab tension
reinforcement at support.

bo = the perimeter of the critical section.

The allowable shear stress around drops when waffle slabs are used is computed

as:
2Jf,  for ACI
v = \/_ oratd Eq. 2-39
02,4, for CSA,
where:
O = resistance factor for concrete.

For waffle slab systems with valid ribs defined earlier in this chapter, the
allowable shear stress is increased by 10% for ACI designs.*

Computation of Factored Shear Force at Critical Section slab

The factored shear force V, on the critical section, is by default computed as the
reaction at the centroid of the critical section (e.g., column centerline for interior
columns) minus the self-weight and any superimposed surface dead and live load
acting within the critical section. If the section is considered open, two 45 degree
lines are drawn from the column corners to the nearest slab edge (lines AF and DE

* ACI 318-05, 8.11.8; ACI 318-02, 8.11.8; ACI 318-99, 8.11.8
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in Figure 2-19) and the self-weight and superimposed surface dead and live loads
acting on the area ADEF are omitted from V,.

Computation of Unbalanced Moment at Critical Section slab

The factored unbalanced moment used for shear transfer, Myy,, by default is
computed as the sum of the joint moments to the left and right, taken to the
centroidal axis of the critical section.

Computation of Shear Stresses at Critical Section <fab

The punching shear stress printed by the program is based on the following:*

vy, =—%, Eq. 2-40
u AC
where:
V. = factored shear force on the critical section described above,
A, = area of concrete, including beam if any, resisting shear transfer.

Under conditions of combined shear, V,, and an unbalanced moment, M a1,
YvMunbal 18 assumed to be transferred by eccentricity of shear about the centroidal
axis of the critical section. The shear stresses printed by the program for this
condition correspond to:*’

Vu + YvMunbalCAB

Vap =—% , Eq. 2-41
AB A, I, q
\Y M C
vep =—~u ¥y Punbal®CD Eq. 2-42
AC JC
where:
Munbal = factored unbalanced moment transferred directly from slab to
column, as described above,
Yy = (=v¢), Eq. 2-43

is a fraction of unbalanced moment considered transferred by the
eccentricity of shear about the centroid of the assumed critical
section,*

* ACT 318-05, 11.12.6.2; ACT 318-02, 11.12.6.2; ACT 318-99, 11.12.6.2; CSA A23.3-94, 13.4.5
7 ACT 318-05, R11.12.6.2; ACT 318-02, R11.12.6.2; ACT 318-99, R11.12.6.2; CSA A23.3-94, 13.4.5.5
* ACI 318-05, 11.12.6.1; ACI 318-02, 11.12.6.1; ACI 318-99, 11.12.6.1; CSA A23.3-94, Eq, 13-8
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c = distance from centroid of critical section to the face of section
where stress is being computed,
T = property of the assumed critical section analogous to polar

moment of inertia.

Factor y¢ in Eq. 2-43 is calculated as™®

1
V=, Eq. 2-44
1+(2/3)ﬂb1 /b2
where
b, = width of critical section in the direction of analysis,
b, = width of the critical section in the transverse direction.

pcaSlab calculates v, as the absolute maximum of v, and vcp. Local effects of
concentrated loads are not computed by pcaSlab and must be calculated manually.

Shear Resistance at Corner Columns slab

For CSA A23.3-94 code the program performs one-way shear resistance check in
the vicinity of corner columns. A critical shear section is located d/2 from the
column corner. The minimum length section is selected using an optimization
algorithm which analyzes sections at different angles. The extension to the
cantilevered portion is considered by a length not to exceed effective slab
thickness d. For slabs with edge beams or drop panels the check including the
contribution of these components should be preformed manually.

Shear Analysis of Longitudinal Beams SfabloGeam

When longitudinal beams are present in a span, pcaSlab will compute the shear
reinforcement requirements for the beams. Table “Longitudinal Beam Shear
Reinforcement Required” in the program output provides values of V,, V., and
Av/s for selected segment locations of each span. Segment lengths are chosen not
to exceed the beam section depth. The beginning of first segment and the end of
last segment correspond to the locations of critical sections on the left and right
support respectively. The critical sections are located at a distance d, the effective
beam depth, away from the column face at both the left and the right ends of the
beam. However, if concentrated loads are present within distance d from the
column face, critical section is selected at the column face.

* ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-94, Eq, 13-7
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V, is computed from the load acting over the entire width of the design strip. The
program makes no distinction between shallow beams (o /€, less than 1) and
deeper beams (o fy/¢; greater than 1).

For the ACI 318 codes the shear strength provided by concrete, V., is computed

by:50
V. = Zﬁbwd . Eq. 2-45

In CSA design, for beams without minimum stirrup reinforcement and greater than
300 mm deep, V. is calculated from the following equation’":

Ve (10(2)(6)0 djw Jbod = 0102.6fEb,d. o246

WhenV, > ¢V, /2, the beam must be provided with at least a minimum shear
reinforcement of: >

A 50b
Y= L Eq. 2-47
s £y
where
A, = area of two legs of stirrups,
s = stirrups spacing,
by = longitudinal beam width,
i = yield strength of the shear reinforcement.
When V, > ¢V,, shear reinforcement must be provided so that:
A e\
v = Vu_d)c , Eq. 2-48
s ofyd
where:
A = factored shear force at the section being considered
d = effective depth of the beam at the same location

S0 ACI318-05, 11.3.1.1; ACI 318-02, 11.3.1.1; ACI 318-99, 11.3.1.1
Sl CSA A23.3-94,11.3.5.1
2 ACI 318-05, 11.5.5.2; ACI 318-02, 11.5.5.2; ACI 318-99, 11.5.5.2; CSA A23.3-94,11.2.8.4
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For the ACI 318-99 code the strength reduction factor for shear calculations is
specified as ¢ = 0.85. For the ACI 318-05 and ACI 318-02 codes the strength

reduction factor for shear calculations is equal ¢ =0.75 .

When Vu exceeds5¢V,, the beam section dimensions must be increased or

ahigher concrete strength must be provided.”> When V, S(I)IO\/E b, d, the

spacing is computed as:

s=—Ag,, Eq. 2-49

where

Ay = total bar area of the two legged stirrup.

The maximum stirrup spacing must not exceed d/2 nor 24in when
V, < ¢6\/g b,d. WhenV, > ¢6\/E b, d, the maximum stirrup spacing must be
reduced by half, to d/4 or 12 in.>* When v, > ¢10\/E b,d, the beam section
dimensions must be increased or a higher concrete strength must be provided.

When no ribs are present the program proportions the slab and beam share of one-
way shear according to the following ratios:

anb /G, 1-anb /6, Eq. 2-50

When ribs are present (waffle) the program proportions the slab and beam share of
one-way shear according to the following ratios of cross-section areas:

Avribs Apeam ) Egq. 2-51
Aribs + Abeam Aribs + Abeam

Torsion and Shear SfablocAGaam

Torsion analysis can be engaged for beam and one way systems using the Torsion
Analysis and Design check box located on the Solve Options tab in the Input |
General Information dialog box.

3 ACI 318-05, 11.5.7.9; ACI 318-02, 11.5.6.9; ACT 318-99, 11.5.6.9; CSA A23.3-94, 11.3.4
* ACI 318-05, 11.5.5; ACI 318-02, 11.5.4; ACI 318-99, 11.5.4; CSA A23.3-94, 11.2.11
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As far as torsional analysis is concerned, it is assumed that columns provide
perfectly rigid supports so there is no transfer of torsional moments between spans.
Within a span, torsional moments are considered only if a longitudinal beam is
present. Torsion can be induced by concentrated and redistributed torsional loads
and also, in the case of a beam with unsymmetrical cross sections, by self weight
and area loads. A T-section with different flange widths is an example of a cross
section which is not symmetrical. It can be obtained if a beam and a slab with
different left and right widths are combined in the same span. However, in order
for a flange to be considered in the torsional analysis its thickness has to be greater
than twice the cover. If a flange is wider than the effective width then only the
effective width is taken into account.

The design for torsion is based on a thin-walled tube, space truss analogy. For the
Canadian code the simplified method is used. Program allows both equilibrium
and compatibility torsion conditions. In the equilibrium mode, which is assumed
by default, unreduced total value of the torsional design moment is used in the
design. In the compatibility mode®, factored torsional moments that exceed
cracking moment T (0.67 T, for CSA) are reduced to the value of T (0.67 T,

for CSA). However, it is user’s responsibility to determine which mode is
appropriate and pcaSlab does not perform any redistribution of internal forces if
compatibility torsion is selected.

If torsion analysis is engaged then both torsion and shear actions contribute to the
amount of required transverse (stirrup) reinforcement. However, additional
longitudinal bars distributed along the perimeter of a cross-section are also
required to provide torsional resistance.

For torsion design a span is divided into segments in the same way as for shear
design. Governing values within a segment are used to design the whole segment.
For stirrups, the governing values of torsional moment and shear force (acting
simultaneously) will be these that produce the highest intensity of required stirrup
area. On the other hand, the required area of longitudinal bars depends only on the
torsional moment so the highest absolute value of torsional moment will govern.
Please note that since stirrup area depends both on shear and torsion whereas
longitudinal bar area depends only on torsion so the governing values for stirrups
and longitudinal bars can occur at different locations within a segment and for
different load combinations. These governing values along with their location and
associated load combination are output in the design results report.

> ACI 318-05, 11.6.2.2; ACI 318-02, 11.6.2.2; ACI 318-99, 11.6.2.2; CSA A23.3-94,11.2.9.2
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Effect of torsion within a segment will be neglected if the factored torsional
moment, T,, at every segment location is less than one fourth of the torsion

u°’

cracking moment, T, which equals*®

cr

— A
Tcr =4 (I) \/E L > Eq 2-52
Pep
for ACI code and”’
— A
T, =04 ¢, &yf, —2 Eq. 2-53
Pep

for CSA standard. A, denotes the area enclosed by outside perimeter of concrete
section and p., is equal to the outside perimeter of concrete section. To be

adequate for torsion design, a section has to be proportioned in such a way that
combined shear stress due to shear and torsion does not exceed the limit value
specified by the code. In ACI code this condition reads as™*:

2 2
V T,py V )
| — < <+ 84/f, |, Eq. 2-54
(bwd} [1-7A<2)hJ q{bwd CJ 1

The simplified method of CSA standard defines this relation as>’:

v, T ,
—u oy ouPh 2059 £ Eq. 2-55
b,d AZ

In both relations, A ;, is the area enclosed by centerline of the outermost closed
transverse reinforcement and p,, is the perimeter of that area. By default, flanges
do not contribute to A, and py, . For sections with flanges, flanges will only be
taken into account for A, and p, if the option to include stirrups in flanges is

engaged in the torsion design. In the program output, the combined stress (left
hand side of the above inequalities) is denoted as v and the limit value as ¢s,, .

% ACI318-05, R11.6.1; ACI 318-02, R11.6.1; ACI 318-99, R11.6.1;
7 CSA A23.3-94,11.2.9.1
¥ ACI 318-05, 11.6.3.1; ACI 318-02, 11.6.3.1; ACI 318-99, 11.6.3.1;
% CSA A23.3-94,11.3.9.8
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The required intensity of stirrup area to provide required torsional resistance is
calculated from the following formula®:

A T
e Eq. 2-56
s 20A.f,
where the gross area enclosed by the shear path®, A, is taken as 0.85A .
A, /s is the quantity per stirrup leg so the total requirement for stirrup intensity
combining shear and torsion equals®
AV+21 — A At

R, i Eq. 2-57
S S S

This value cannot be taken less than minimum stirrup area required by the codes.
The minimum code requirements can be written in the following form®:

; b

max(0.75 fC,SO)-f—W, for ACI 31805 and ACI 31802,

yt
A
w2t > 150 b—W, for ACI 318-99, Eq. 2-58
S fyV
- b
0.064f, f—W for CSA A23.3-94.
yv

In addition to stirrup spacing requirement defined for shear, program imposes one
more torsion specific requirement for all codes which limits the spacing to the
smallest of p, /8, d/2, and 12 in [300 mm]. Based on the total required stirrup
area intensity and spacing requirements, program attempts to select stirrups taking
also into account that if stirrups with more than two legs have to be used than the
area of an outer leg must not be less than A, .

The area of additional longitudinal reinforcement, A, is calculated from®

Tu ph

=—urh Eq. 2-59
204, 1,

(4

% ACI 318-05, 11.6.3.6; ACI 318-02, 11.6.3.6; ACI 318-99, 11.6.3.6; CSA A23.3-94, 11.3.9.4
¢ CSA A23.3-94,11.3.9.7

2 ACI 318-05, R11.6.3.8; ACI 318-02, R11.6.3.8; ACI 318-99, R11.6.3.8

% ACI 318-05, 11.6.5.2; ACI 318-02, 11.6.5.2; ACI 318-99, 11.6.5.2; CSA A23.3-94, 11.2.8.4
¢ ACI318-05, 11.6.3.7; ACI 318-02, 11.6.3.7; ACI 318-99, 11.6.3.7; CSA A23.3-94, 11.3.9.5
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For ACI code it is also checked against the following minimum value®:

ﬂm £ b 260

Af,min = — |Pn f >

y y

where A /s is calculated from Eq. 2-56 but is not taken less than 25b /f,; .

Longitudinal bars are selected in such a way that their area is not less than
Ay 2 Ay in and that number of longitudinal bars in a section is enough to provide

a bar in every corner of a stirrup and preserve spacing between bars not higher
than 12 in [300 mm]. Also, bar sizes are selected not to have diameter less than
No. 3 bar and not less than 1/24 of stirrup spacing for ACI codes and 1/16 for CSA
standard.

In the investigation mode when transverse and longitudinal reinforcement is input
by the user, program checks the combined shear and torsional capacity of the
system in terms of required and provided reinforcement area i.e. the provided area
of reinforcement is compared with to the area of reinforcement required to resist
applied loads. This is different approach than for flexure and shear actions with no
coupling where internal design forces are compared to capacity. In case where
torsion and shear stirrup requirements are combined, the approach of comparing
total reinforcement area is more convenient since it does not require dividing
stirrup area into a part that resists torsion only and a part resisting shear only. For
consistency, longitudinal reinforcement is also checked in terms of provided and
required area. Other requirements like bar or stirrup spacing, number of
longitudinal bars, area of stirrup outer leg, and combined stresses in concrete due
to shear and torsion are checked also. Exceeded capacity and other conditions are
flagged in the Design Results section of the report.

Area of Reinforcement <Tablo- Beam

The program calculates the required area of reinforcement (top and bottom) based
on the values of bending moment envelope within the clear span. For rectangular
sections with no compression reinforcement, the design flexural strength of the
column strip, middle strip and beam must equal the factored design moment:

A,
M, = f,A|d——Y—|. Eq. 2-61
2(0.85f,)b

% ACI 318-05, 11.6.5.3; ACI 318-02, 11.6.5.3; ACI 318-99, 11.6.5.3
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The reinforcement can therefore be computed from:

AszM I FEp P Eq. 2-62
fy ¢ 0.85f,b
For CSA A23.3-94
A f
M, = . f A, d—d)s—5¥ . Eq. 2-63
20,0.f.b

The effective depth of the section is taken as the overall section depth minus the
distance from the extreme tension fiber to the tension reinforcement centroid. The
column strip depth may include all or part of the drop panel depth. The drop depth
will not be included in the effective depth of the column strip when the drop does
not extend at least one-sixth the center-to-center span length in all directions, or
when the drop depth below the slab is less than one-quarter the slab depth. If the
drop does extend at least one-sixth the center-to-center span length and the drop
depth is greater than one-quarter the distance from the edge of the drop panel to
the face of the column or column capital, the excess depth will not be included in
the column strip effective depth. If the drop width is less than the column strip
width, the drop width will be used in the computation of the required
reinforcement.

For the ACI 318-99 code the strength reduction factor for flexure calculations is
specified as ¢$=0.90.® For the ACI 318-05 and ACI 318-02 codes the strength
reduction factor for tension-controlled sections (&; = 0.005) is equal $=0.90. For

transition sections (f,/E, <& <0.005) the strength reduction factor can be

linearly interpolated by the formula®’:

0.90-0.65
=0.65+—— (¢, -1, /E)). Eq. 2-64
¢ 0.005—fy/Es( Iy /E) a
ACI 318-05 and ACI 318-02 codes specifie the strength reduction factor for
compression controlled sections (&, <f,/E) as equal ¢=0.65. The reduction

factors for transition or compression controlled sections have application primarily
in investigation mode of the program. In design mode the program performs the

¢ ACI318-99,9.3.2
7 ACI318-059.3.2; ACI 318-02 9.3.2
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calculations assuming tension controlled section (&, =0.005) or section with
compressive reinforcement (if enabled).

The ACI 318-99 code requires keeping the steel ratio below 75 percent of py ,

where: %
f. 87
=0.858, - , Eq. 2-65
Po =085 £, 87+, a
where
0.85 for £, < 4ksi,
B = 0.65 for f, > 4ksi,
1.05-0.05f, for 4ksi < f, < 8ksi.
For CSA code the value of py is calculated as follows:
£, 700
= —_— E . 2'66
Py =P £, 700+, q
where
o = 085-00015f, >067,
Bi = 097-00025f,>0.67.

The ACI 318-05 and ACI 318-02 codes control the amount of reinforcement by
limiting the value of net tensile strain (g, =0.004 ). pcaSlab satisfies this
condition by assuming a tensioned controlled section with g, =0.005 . From this

assumption the equivalent maximum reinforcement ratio for rectangular section
can be written as:

0.003  0.85f,
= Eq. 2-67
Pmax =5 003 +0.005 fy a

If the calculated reinforcement exceeds the maximum allowed, a message will
appear in the output. In such cases, it is recommended that the engineer review the

8 ACI 318-99, 8.4.3; CSA A23.3-94,10.5.2
% ACI 318-05, 10.3.5; ACI 318-02, 10.3.5
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slab thickness to ensure a more satisfactory design. If compression reinforcement
calculations are enabled, pcaSlab will attempt to add compression reinforcement to
the section. The program is capable to design compressive reinforcement for any
design strip (column, middle, and beam) including also unbalanced moment strip.

The amount of reinforcement provided will not be less than the code prescribed
minimum. For the ACI 318 code, the minimum ratio of reinforcement area to the
gross sectional area of the slab strip using Grade 60 reinforcement is taken as
0.0018. When reinforcement yield strength exceeds 60 ksi, the minimum ratio is
set to 0.0015-60/f . For reinforcement with yield strength less than 60 ksi, the

minimum ratio is set to 0.0020. In no case will this ratio be less than 0.0014 (See
Table 2-6)°. The CSA Standard requires a minimum ratio of slab reinforcement
area to gross sectional area of the slab strip equal to 0.002 for all grades of
reinforcement”".

£, (ksi) AJA,
<60 0.0020
o 0.00;8%020‘0014
y

Table 2-6. Minimum Ratios of Reinforcement to Gross Concrete Area

According to ACI code for beams and positive moment regions of waffle slabs,
minimum reinforcement provided will not be less than: "

"
Asamin ==~ byd Eq.2-68
y

s,min —

and not less than 200b,d/f, .

Similar equation prescribed by CSA code has the form”*:

02T
Ag min = byh Eq. 2-69
y

s,min — £

" AC1318-05,7.12.2.1; ACI 318-02, 7.12.2.1; ACI 318-99, 7.12.2.1
"' CSA A23.3-94,7.8.1

2 ACI 318-05, 10.5.1; ACI 318-02, 10.5.1; ACI 318-99, 10.5.1

3 CSA A23.3-94, 10.5.1.2(b)

2-46

Method of Solution



slabloc/Beam

In calculating required amounts of negative support steel for the CSA A23.3-94
code, the program performs the adjustment for banded and distributed
reinforcement. The code requires concentrating one-third of the negative
reinforcement at interior supports in the band region extending 1.5 hy from the
sides of the columns. At exterior supports the total negative reinforcement is
placed in the band region. The remaining portion of the negative reinforcement
needs to be placed in the distributed strip. The reinforcement in banded and
distributed strip is also checked for compliance with the minimum reinforcement
requirement.

Reinforcement Selection SfablocAGaam

The default minimum clear spacing of reinforcement for both slabs and beams is
taken as the larger of the two code prescribed minima of one bar diameter, d,, or
1 in.”* The user may select clear spacing greater than the default value.

For two-way systems, the maximum spacing of reinforcement is kept at two times
the slab thickness for the ACI code” and three times the slab thickness for the
CSA code’® but no more than 18 in. or 500 mm respectively. For waffle slabs the
limit is increased to 5 times the slab thickness’’. When calculating negative
support reinforcement for the CSA code’, the program assumes that banded
reinforcement over supports is spaced at a maximum of 1.5 hy and no more than
250 mm.

In case of beams and one-way systems the maximum spacing of reinforcement is
selected so that the crack control requirements of the ACI and the CSA codes” are
met.

An iterative process is performed to determine the number of bars and bar size.
The initial number of bars is determined by dividing the total reinforcement area
required, A, by the area of one bar, Ay, of the input minimum bar size. Next, the
spacing is determined. If the minimum spacing limitations are violated, the bar
size is increased and the iterative process continues until all bars sizes have been
checked. If the maximum spacing limitations are not met, the number of bars
required to satisfy these limitations is computed and the iteration process
terminates.

™ ACI 318-05, 7.6.1; ACI 318-02, 7.6.1; ACI 318-99, 7.6.1

> ACI 318-05, 13.3.2; ACI 318-02, 13.3.2; ACI 318-99, 13.3.2

6 CSA A23.3-94,13.11.3(b)

77 ACI 318-05,7.12.2.2; ACI 318-02, 7.12.2.2; ACI 318-99, 7.12.2.2; CSA A23.3-94,7.8.3
8 CSA A23.3-94, 13.11.3(a)

™ ACI 318-05, 10.6.4; ACI 318-02, 10.6.4; ACI 318-99, 10.6.4; CSA A23.3-94, 10.6.1
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For beams, layered reinforcement is provided if sufficient beam width is not
available. By default pcaSlab assumes a 1.5 in [40 mm] cover to stirrup for width
calculations but this value can be changed by the user. pcaSlab also assumes that
the longitudinal bar makes contact at the middle of the stirrup bend where the
minimum inside diameter of the bend is 4d,. Therefore, an additional width is
added to the cover for longitudinal bars less than #14 (an SI N-45) in size (Figure
2-20 — Figure 2-21). This additional width due to the bend, w4, is equal to:

Wieng = 0.293 (1.0—%’), Eq. 2-70

where
d, = bar diameter of the longitudinal bar.

By default, the clear distance between layers is assumed 1.0 in [30 mm] but the
user can change this value. Hooks and bends are not included in bar length figures.

|

— -4— Side Cover

—p Whend b

R
\\.4— Longitudinal Bar

#4 Stirrups
Figure 2-20 Width due to strip bend
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Top Slab
Thickness

e v o \ -

Beam Depth

—| |=— Stirrup +
Side Cover

; q Y. Layer
Y Spacing

Bar Spacing

— |<— Face Dist.

Width
Figure 2-21 Detail reinforcement in longitudinal beams

Bar-length computations are performed for two-way slabs and longitudinal beams.
For top reinforcement at the supports, the length for long bars is given by:

maX(lso%) + ld’long s
liong = maxy max(l,;) + max{d, 12dy, 1, /16}, Eq. 2-71
1fos +1

cr,long’

and the length for short bars is given by:

max(l 00) + max{d, 12d;, },
1short = max{ 0%

Eq. 2-72
lfos + max{ld,short > 1cr,short }v
where:
max(lsg,) = maximum distance to the points of 50% demand,
max(l) = maximum distance to the points of inflection (P.I.),
14 = bar development lengthgo,
d = effective depth,
dy = bar diameter,

8 Chapter 12 in ACI 318-05, ACI 318-02, and ACI 318-99; CSA A23.3-94, Clause 12.2
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1, = clear span length,
los = distance to the face of support (column),
Ler = minimum code prescribed extension.

These bar lengths are then compared and adjusted if necessary to the minimum
requirements specified by the code.® Additionally the program may select
continuous top bars in those spans where steel is required by calculation in mid-
span at top.

If the computed bar lengths overlap, it is recommended that such reinforcement be
run continuously. The printed bar lengths do not include hooks or portions of bars
bent down into spandrel beams or other bar-bend configurations.

The selection of bar lengths for positive reinforcement for flat plates, flat slabs,
and beam-supported slabs, is based strictly on the minimum values of the code.
For waffle slabs, however, the positive reinforcement selection is based on an
additional assumption of two bars per joist. For purposes of output, one bar is
treated as a long bar and the other as a short bar.

The development length depends on the following factors: concrete cover,
minimum transverse reinforcement, special transverse reinforcement, layer
location bar size and bar clear spacing. The computation of tension development
lengths in terms of dy, is given by the general expression®*:

g 3 f  opyr

dy, 40@(“1(&]
dy

Eq. 2-73

where:

= reinforcement location factor (1 or 1.3),

coating factor (1.2 or 1.5),

reinforcement size factor (1 or 0.8),

light weight aggregate concrete factor (1 or 1.3),
i transverse reinforcement index,

= spacing or cover dimension.

AR>®>R™e
Il

¥ Figure 13.3.8 in ACI 318-05, ACI 318-02, and ACI 318-99; CSA A23.3-94, Figure 13.1
82 ACI 318-05, 12.2.3; ACI 318-02, 12.2.3; ACI 318-99, 12.2.3; CSA A23.3-94, 12.2.2
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Additional Reinforcement at Support sfab

pcaSlab computes the fraction of the unbalanced moment, y;M,, that must be
transferred by flexure within an effective slab width (a band) equal to the column
width plus one and one-half the slab or drop panel depth (1.5h) on either side of
the column where:*

I
1+§1/b1/b2

The amount of reinforcement required to resist this moment is computed. The
amount of reinforcement already provided for flexure is then computed from the
bar schedule (i.e. the number of bars that fall within the effective slab width
multiplied by the area of each bar). Depending on load conditions, additional
negative or positive reinforcement may be required. If the reinforcement area
provided for flexure is greater than or equal to the reinforcement requirements to
resist moment transfer by flexure, no additional reinforcement is provided, and the
number of additional bars will be set to 0. If the amount of reinforcement provided
for flexure is less than that required for moment transfer by flexure, additional
reinforcement is required. The additional reinforcement is the difference between
that required for unbalanced moment transfer by flexure and that provided for
design bending moment in the slab, and it is selected based on the bar size already
provided at the support.

Yf = Eq. 2-74

It should be noted that the ACI code™ requires either concentration of
reinforcement over column beam joint by closer spacing, or additional
reinforcement, to resist the transfer moment within the effective slab width. Thus
for the ACI code, pcaSlab only provides additional reinforcement and does not
concentrate existing reinforcement. The CSA code, however, requires
concentration of column strip reinforcement within the bands over supports®’,
which is done in pcaSlab first and then additional reinforcement is provided, if
necessary.

8 ACI 318-05, 13.5.3.2; ACI 318-02, 13.5.3.2; ACI 318-99, 13.5.3.2; CSA A23.3-94, 13.11.2 and
13.4.5.3

# ACI 318-05, 13.5.3.4; ACI 318-02, 13.5.3.4; ACT1 318-99, 13.5.3.4

85 CSA A23.3-94,13.12.2.1 and 13.12.2.2
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Integrity Reinforcement SfablocGeam

For the ACI code, all bottom bars in the column strip should extend continuously
(or with splices) in the entire span and at least two of these bars should pass within
the column core and should be anchored at exterior supports*®. In continuous
beams, including longitudinal beams in two-way slab systems, the program
designs reinforcement that satisfies ACI requirements for structural integrity. In
perimeter (exterior) beams, at least one sixth of the negative tension reinforcement
and not less that two bars are continuous®’. Also, at least one fourth of the positive
tension reinforcement and not less than two bars are continuous in all beams™.

For the CSA code, the program performs calculation of the amount of integrity
reinforcement at slab column connections. The integrity reinforcement is required
for slabs without beams. Integrity reinforcement is not required if there are beams
containing shear reinforcement in all spans framing into the column. Otherwise,
the sum of all bottom reinforcement connecting the slab to the column on all faces
of the periphery should meet the condition:

2;756 Eq. 2-75

y

DAL

and should consist of at least two bars®.

Corner Reinforcement <fab

The program performs calculation of the amount of reinforcement in exterior
corners of slabs with stiff edge beams (o. greater than 1.0). This reinforcement is
required within a region equal to 1/5 of the shorter span. The amount of corner
reinforcement is calculated from the moment per unit width intensity
corresponding to the maximum positive moment in span. The code requires the
corner reinforcement to be placed at top and bottom of the slab in bands parallel to
the sides of the slab edges.

8 ACI 318-05, 13.3.8.5; ACI 318-02, 13.3.8.5; ACI 318-99, 13.3.8.5

7 ACI 318-05, 7.13.2.2(a); ACI 318-02, 7.13.2.2(a); ACI 318-99, 7.13.2.2

88 ACI 318-05, 7.13.2.2(b) and 7.13.2.4; ACI 318-02, 7.13.2.2(b) and 7.13.2.4; ACI 318-99, 7.13.2.2
and 7.13.2.3

% CSA A23.3-94,13.11.5.1 and 13.11.5.2

% ACI 318-05, 13.3.6; ACI 318-02, 13.3.6; ACI 318-99, 13.3.6; CSA A23.3-94, 13.13.5
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Deflections slab|pcABeam
Instantaneous Deflections slablocfBeam

Instantaneous deflections are obtained directly by the program from elastic
analysis of the defined system for two load levels. The first corresponds to dead
load only, while the second corresponds to dead load plus live load on all spans.
The live load deflection is computed afterwards as the total load deflection minus
the dead load defection. Depending on the option selected by the user, the program
will calculate flexural stiffness of the members based on either gross moment of
inertia or the effective moment of inertia which allows taking cracking into
account.

Cracking sTablocfBeam

When calculating the deflections for effective (cracked) section properties, the
frame solution is obtained for two load levels: dead load only and dead load plus
live load combined. Flexural stiffness is assumed corresponding to the load level.

A reduction in the flexural stiffness caused by cracking leads to an increase in
deflections. Several methods of deflection analyses taking cracking into account
are reviewed in Ref. [11]. The program uses the approach based on the effective
moment of inertia as permitted by the code.”"

The effective moment of inertia, I, developed by Branson (Ref. [6]) and
incorporated into the code equals:

3 3
M M
Ie:[ o J I, + 1—(¢j I, Eq. 2-76
Mmax Mmax

where:
I = moment of inertia of the gross uncracked concrete section,
I = moment of inertia of the cracked transformed concrete section®,
M., = cracking moment,
Mnax = maximum bending moment at the load level for which the

deflection is computed.

o' ACI 318-05, 9.5.2.3; ACI 318-02, 9.5.2.3; ACI 318-99, 9.5.2.3; CSA A23.3-94,9.8.2.3
%2 See formulas for various cross sections in Table 10-2 in [7]
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To calculate I, for two-way slabs, the values of all terms for the full width of the
equivalent frame are used in Eq. 2-76. This approach averages the effects of
cracking in the column and middle strips.

The value of I. at midspan for a simple span and at support for a cantilever is
taken” to calculate flexural stiffness of a member. For other conditions, an
averaged effective moment of inertia, I,y is used. For spans with both ends
continuous, I,y is given by‘)4

Lame = 0.7017 +O.15( L +1c, ) , Eq. 2-77
where:
17 = effective moment of inertia for the positive moment region,
o1 = effective moment of inertia for the negative moment region at
the left support,
| P = effective moment of inertia for the negative moment region at
the right support,

For spans with one end continuous the value of Iy 1S given by95 :

Liame =0.85 10 +0.151, Eq.2-78
where:
I = effective moment of inertia for the positive moment region,
I, = effective moment of inertia for the negative moment region at
the continuous end.
Long-Term Deflections slablocABeam

The program estimates additional long-term deflection resulting from creep and
shrinkage, A, by multiplying the immediate deflection due to sustained load, Ay,
by the factor, A,, equal to”®

% ACI 318-05, 9.5.2.4; ACI 318-02, 9.5.2.4; ACI 318-99,9.5.2.4

% ACI 435R-95 [8], 2.5.1, Eq. (2.152), CSA A23.3-94,9.8.2.4, Eq. 9.3

% ACI 435R-95 [8], 2.5.1, Eq. (2.15b), CSA A23.3-94, 9.8.2.4, Eq. 9.4

% ACI 318-05, 9.5.2.5; ACI 318-02, 9.5.2.5; ACI 318-99, 9.5.2.5; CSA A.23.3-94,9.8.2.5
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g

Ay = , Eq. 2-79
A 1+50p d
where:

& = time dependant factor with the maximum value of 2.0 (the actual
value is interpolated from the values and the chart given in the
code” based on the load duration specified by the user in the
input)

p’ = ratio of compressive reinforcement at midspan for simple and

continuous spans and at support for cantilevers.

Deflection due to the sustained load, A, consists of the deflection induced by the
dead load (including self weight), Age.q, and the deflection A which is induced by
that portion of the live load which is declared as sustained in the input by the user.
Thus

A = Ageag + A » Eq. 2-80

sust
and

Ay = Ay . Eq.2-81

sust

The program calculates incremental deflection which occurs after partitions are
installed in two ways. In the first approach, it is assumed that the live load has
been applied before installing the partitions and the incremental deflection equals”™

A = ACS + (Alive _Als) 5 Eq 2-82

cs+lu

In the second approach, the assumption is that the full live load, including the
sustained portion of the live load, has been applied after the partitions are installed
which results in the incremental deflection equal to*

Agor1 =D + A » Eq. 2-83

cs+l
The total long-term deflection Ay, is also calculated as'®

Aggal = At A+ A0) +(A = A), Eq. 2-84

" Fig. R9.5.2.5 in ACI 318-05; ACI 318-02, and ACI 318-99; Fig. N9.8.2.6 in CSA A.23.3-94
% CSA A23.3-94N9.8.2.5

 See Example 10.1 in [7]

10 CSA A23.3-94N9.8.2.5
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Deflections of two-ways systems slab

Calculation of deflections of reinforced concrete two-way slabs is complicated by
a large number of significant parameters such as: the aspect ratio of the panels, the
vertical and torsional deflection of supporting beams, the stiffening effect of drop
panels and column capitals, cracking, and the time-dependent nature of the
material response. Based on studies (Ref. [9-11]), an approximate method
consistent with the equivalent frame method was developed (Ref. [12]) to estimate
the column and middle strip deflections.

Calculation of the midspan deflection of the column strip or the middle strip is
based on the M/EI ratio of the strip to that of the full-width panel:

Mstrip EJame Eq. 2-85

strip — Sframe P
Mframe EcIstrip

A

where Ay, is taken from the equivalent frame analysis assuming gross section
(un-cracked) or effective (cracked) section properties.

The ratio (Mguip/Mirame) can be considered as a lateral distribution factor, LDF. The
lateral distribution factor, LDF, at an exterior negative moment region is:

LDF, g ex¢ =100-10 B, +12 B, [aﬂ ﬁj [ —ﬁj . Eq. 2-86
b b
The LDF at an interior negative moment region is:
LDF, ¢ ine =75-30 (aﬂ QJ ( —QJ . Eq. 2-87
6 6
The LDF at a positive moment region is:
LDFE, = 60+30£0Lf1 ﬁ](l.S—éJ, Eq. 2-88
b b
where:
olgy = the ratio of flexure stiffness of a beam section to the flexural

stiffness of a width of slab bounded laterally by centerlines of
adjacent panels on either side of the beam,
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Bt = ratio of torsional stiffness of an edge beam section to the flexural
stiffness of a width of slab equal to the span length of the beam,
center-to-center of the supports (see Eq. 2-27).

Direction

of Analysis
\ Acx
K

Assumed
Support Line

Assumed
Support Line

.- Assumed
-/~ Support Line

A

Y U > X
Assumed 7. /
Support Line y Direction

(b) Y Direction Bending of Analysis

(c) Combined Bending
Figure 2-22 Deflection computation for a square panel

When ay€y/¢, is greater than 1.0, opy/¢; will be set equal to 1.0.
The column and middle strip LDF’s can be computed by:

DR, LDE, oy | +LDE,
LDF, = 5 2 : Eq. 2-89
LDF,, =100 - LDF,, Eq. 2-90
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where:
LDFyee = LDF for the negative moment region at the left end of the span
LDFer = LDF for the negative moment region at the right end of the span

The deflections should be used in conjunction with the deflections obtained from
an analysis in the transverse direction. For square panels (¢, =¢,), the midpanel
deflection is obtained by Eq. 2-91 as shown in Figure 2-22:

A=Ay +Ap =An + A, . Eq. 2-91

For rectangular panels, (¢; # ¢;), the mid panel deflection is obtained by Eq. 2-92:

Ay, AL JFH AL, F A
A=( 2 ) ( Y °). Eq. 2-92
2
Material Quantities SfablocAGaam

The program computes concrete and reinforcing steel quantities. The quantity of
concrete is based on an average of the slab, drop, and beam sizes. The total
quantity of reinforcing steel computed by the program corresponds to the actual
bar sizes and lengths required by design. No allowance is made for bar hooks,
anchorage embedment, and so forth. It should be noted that the quantity of
reinforcement printed by the program pertains to bending in one direction only. In
practice, the total amount of reinforcement for the structure should also include the
quantities obtained for the appropriate transverse equivalent frames.
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Chapter 3

pcaSlab/pcaBeam Interface

Main Window lablpcfBEam

Slab - Example 5 - PCA Notes on ACI 318-05 Example 20-2.slb
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The main screen will appear after the pcaSlab is started as shown above. The main
screen consists of a title bar, menu line, tool bar, five view windows and status bar.
The pcaSlab name and current data file name is shown in the title bar. All the
menu commands can be accessed from the menu line and some frequently used
commands also can be accessed from the buttons in the tool bar. The four view
windows show the geometry of a floor system and the loads on it. Plan view, side
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view, elevated view and isometric view are available. The status bar shows the
current states of pcaSlab.

Title Bar sfablpcf6eam

" pcaslab - Example 1 - PCA Notes on ACI 318-05 Example 8-2.s1b FEX

The title bar displays the pcaSlab name, and following the hyphen, displays the
name of the current data file you are using. If the data you are currently working
on has not been saved into a file, the word pcaSlabl is displayed in the title bar. If
you start an other new data file by clicking the NEW button on the most left of the
tool bar, the next data file is named as pcaSlab2, and so on.

Menu Bar slablpcAGeam

File Input Solve Wiew Options Window Help

Located directly below the title bar is the menu line. pcaSlab commands are listed
in the pop-up menus located in the menu line. These menu commands allow you to
perform functions that create, view, and ultimately design the floor system.

In the pcaSlab program there are seven main pull-down menus: File, Input, Solve,
View, Options, Windows, and Help. To access a menu item using the mouse,
place the arrow cursor on the menu item you want and click the left mouse button.
Each menu item can also be selected with the keyboard keys by simultaneously
pressing the ALT key and the underlined letter of the menu you want to open. For
example, to open the File menu, press ALT + F. To close a menu without selecting
a command, move the cursor to any blank area on the screen and click the left
mouse button. Press ESC key to close a menu using the keyboard keys.

To select a command from a menu with the mouse, place the arrow on the item
you want, and click the left mouse button. In some cases, you will be told to
double click on a selection, that is, press the mouse button twice, quickly. Anytime
you have to wait, for example, when loading the program or designing the system,
the mouse cursor becomes an hourglass cursor. It will return to its original state
when the task is completed.

To select a command from a menu using the keyboard, use the down arrow key to
highlight your choice and press ENTER key or press the keyboard key of the
command’s underlined letter. The space bar is also equivalent to pressing the left
mouse button.

Special instructions for inputting with the keyboard keys are given wherever
necessary.

pcaSlab/pcaBeam Interface
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Tool Bar sfablpcf6eam
DEE RS LS —SAET U Aa e DRDA S BRRFbREEE & 8 8¢t d

Located directly below the menu line is the tool bar. Some frequently used buttons
can be found in the tool bar. A description of the corresponding button is shown in
the status bar (on the bottom of the window) when the mouse cursor is moving
over this button. In addition to the description in the status bar, a brief tip is shown
in a light yellow colored pop-up window close to the corresponding button when a
mouse cursor is hanging over the button for a short period of time. Exactly the
same functions or features can be accessed from either the menu items or tool bar
buttons.

The tool bar can be changed from docking status to floating status by single
clicking the left mouse button on the tool bar and dragging it away from the
docking position to any other positions on the screen. A floating tool bar can be
resized by clicking and dragging its borders.

To restore the tool bar to the docking status, single click the left mouse button on
the tool bar and drag it to the location that is directly below the menu line and
release the mouse button.

View Windows sfablpcf6eam

A total of 10 view windows can be used to show Plan, Elevated, Side and
Isometric views of the geometry, as well as Loads, Shear and Moment, Moment
Capacity, Shear Capacity, Deflection, and Reinforcement.
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- pcaSlab - Example 5 - PCA Notes on ACI 318-05 Example 20-2.slb
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Status Bar lablpcABeam

Status bar is always on the bottom of the main window. The status bar shows the
current status of the data file and the coordinate values of the mouse cursor
position. For example, the figure above shows that pcaSlab is ready to take user
input and the current view window is Reinforcement View. Depending on the
active view window, different information of the mouse cursor will appear in the

status bar.

File Menu fabloceam
The File menu is used for saving or | o i
retrieving data, printing, and exiting. The | o e

Save As..

File menu contains the following commands: ™"
New, Open, Close, Save, Save As, Print | rncrosis..

Print Setu...
PreVleW, Prlnt Results, Prlnt Setup, 1 Example 1 - PCA Nates on ACT 318-05 Example 8-2.sb

. . 2 Example 2 - PCA Notes on ACL 318-05 Example 13-L.slb
Recent FlleS and EXlt 3 Examz\e 3- Structural Concrets by Hassnuanxamp\a 16,15l

4 Example 4 - Design of Concrete Structures by Milsan Example 13.3.5b

Exit
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New

Open

Close

Save

slab|pc/Beam

The New command clears any data input
and returns to the default values. Thus,
you are able to create a new data file. | (1) =echommsiosnsh i -pchtoiosonacainos e 527
However, before you can begin a new
data file, pcaSlab will ask whether you
want to save the current data. Answering YES will save the old data and begin a
new data file. Answering NO will discard any changes to the data and begin a new
data file. Answering CANCEL will return you to pcaSlab so that you can continue
to work with the current data.

pcaSlab

s Mo | Cancel ‘

slab|pc/Beam

The Open command allows you to load an existing pcaSlab data file. The dialog
box that appears shows you a listing of all the files with the extension contained in
the default data directory or in the current directory (if a default data directory was
not specified). This box also enables you to change the current drive and directory.
If you are currently working on a data file and select the Open command, pcaSlab
will ask whether you want to save the current data. Answering YES will save the
old data and display the Open dialog box. Answering NO will discard any changes
to the data and display the Open dialog box. Answering CANCEL will return you to
pcaSlab so that you can continue to work with the current data.

slab|pc/Beam

The Close command allows you to close the current pcaSlab data file. If you are
currently working on a data file and select the Open command, pcaSlab will ask
whether you want to save the current data. Answering YES will save the old data
and display the Open dialog box. Answering NO will discard any changes to the
data and display the Open dialog box. Answering CANCEL will return you to
pcaSlab so that you can continue to work with the current data.

slab|pc/Beam

The Save command saves the changes you’ve made to the current data under that
same filename. The new data overwrites the old data, and you cannot retrieve the
old data. It is a good practice to periodically save while inputting data. If a data file
is untitled, the Save As dialog box will appear.
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Save As slablocABeam

The Save As command allows you to [E3E BT

name or rename a data file. Use Save As | seen |5 Hand = cf B
when you want to save bOth the original 2] Excample 1 - PCA Miotes on ACT 318-D5 Example 8-2 sl

[7]Excample 2 - PCA Motes on ACT 316-05 Example 13-1.5b
data and any Changes you’Ve Currently [ Excample 3 - Structural Concrete by Hassoun Example 16,15l

.. E‘Example 4 - Design of Concrete Structures by Milson Example 13.3.slb

made to the data. The Orlglnal data [#] Example 5 - PCA otes on ACT 318-05 Example 20-2.sh
remains under the old filename. If a file
of the same name exists, the program

will ask if you would like to overwrite

File name: iz 1 - PCA Notes on ALl 318.05 Example 8246

Save as type: | poaSlab Files o] ~| Cancel
the file. =
Print Preview slablpcBeam
The Print Preview command [Eiaie s it e et en v e o (=] |

P | Zoam I | oo |

allows you to preview and print
the current view window (floor
system geometry in the plan,
elevated, and isometric views,
prints the shear and moment
diagrams, and prints the deflected
shapes). To obtain a view window
you must first perform the design,
then select what you want to view
from the View menu. You may
have more than one view windows
opened. The current view window
is the one activated and on top of
the others on your screen.
Selecting this command closes the
pcaSlab main window and opens
the print preview window as
shown below. On the print preview
window, press the ZooM IN or
Z0ooM OUT buttons or simply click
the left mouse button on the
preview window to magnify or
reduce the size of the preview paper. Press the NEXT PAGE button if more than one
page needs to be printed. Press the PRINT button to print the view. The printer
could be a local printer, which is connected to your computer directly, or a
network printer. Press the CLOSE button to close the preview window and go back
to pcaSlab.

= s ceneare
Sl

Ergreer:peasnar rini

Page | Moment Capacity x = 49,958 ft Mu=-136.3 k-Ft ACI 318-05
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Print Results slablocABeam

The Print Results command allows you to send the analysis and/or design results
to the printer. Selecting this command will show the Results Report Setup dialog
box. By selecting items in the Selection group prior to performing the print, you
can print selected sections of the data instead of the entire analysis. Option
Include Non-redistributed Internal Forces is available only for beams/one-way
slab systems if moment redistribution is engaged. It allows including in the report
non-redistributed internal forces in addition to redistributed values which are
printed by default.

Print |E| E‘

Results Report Setup g| Printer
Selection Name: |HP Laserlet 4100 Seriss PCL j Properties...
I [1]Input Echa Check &l Status:  Ready
¥ [2] Design Results Clearal Type: HF Laser)et 4100 Series PCL
4 Where:  LPTI:
R [3] Colurn Asial Farces and Maments e
Cammert I~ Pint to fle
I~ [4]Inteinal Forces - Load Cases
I~ [5] Intemal Forces - Load Cambinatians Prirk range Copies
¥ [8] Interrial Forcss - Ermvelopes =l Number of copies: [T =]
I [7)Seamental Deflections " Pages  from; |1 to: 333
" ekl el ™
Options
oK
I Inchude Non-edistibuted Intemal Forces [ |
Cancel Cancel
. o
Printer Setup Sfab|pcABeam

The Printer Setup command brings up the Windows printer setup box which
allows the user to select the printer to send the output to and to change the settings
of the printer.

Recent Files slablocABeam

Exit

This list contains the data files that are used recently and can be accessed quickly
from the menu by a single click. The most recently used one is on the top of the
list. Up to four files can be listed.

slablpcfbeam

The Exit command ends the pcaSlab session and returns you to Windows. If you
have made any changes to your data and have not saved them, pcaSlab will first
ask whether you want to save or abandon any changes you’ve made before you
exit.
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Input Menu

slab|pc/Beam

The Input menu allows you to enter and modify data for the
floor system. The Input menu contains the following
commands: Data Input Wizard, General Information,
Material Properties, Spans, Supports, Reinforcement
Criteria, Reinforcing Bars, Load Cases, Load

Data Input Wizard

General Information...
Material Properties. ..

Spans...
SUppOFES...

Reinforcement Criteria. ..
Reinforcing Bars...

Load Cases,..

Combinations, Span Loads, Support Loads and
Displacements, and Lateral Effects.

Load Combinations. ..

Span Loads. .

Suppott Loads and Displacements. ..
Lateral Effects. ..

slab|pc/Beam

Data Input Wizard

The Data Input Wizard command is designed to make the inputting process
easier. By selecting Data Input Wizard, a logical sequence of dialog boxes will
automatically be displayed allowing you to enter data for your floor system.

General Information <TablocABeam
The General Information consists of three General Information E\
tabs: General Information, Solve Options, | el fomsion | soive opions | span conel]
and Span Control. Labels

Praject  [poaSlab/peaBeam Manual, Exampls 1
The General Information tab will allow you Fiams: PG Notes on AC1 31505, Evenple 82
to enter the project name, frame name, Engnesr. [peastnuctaePant
engineer name, design code, rebar database, Opions Ey—
Designeode: 40171805 =| | & Design

run mode, and number of supports. You must
always use the General Information tab Rerfocsrert [#5Th A5t5 7]
before doing any further inputting since it Fiane

affects the availability of other commands in o o
this menu.

™ Investigation

Floor System

 Two'Way

[«

[ Leftcantilever [~ Right cartilever | & One‘wap/Beam
I Distance location as ratio of span

The Solve Options command allows you to
specify design options and deflection
calculations options. Please note that design
options for two-way systems are different
from beams/one-way slab systems. To take effect, this command must be used

prior to Execute.

o]

Carcel ‘ Help ‘

3-8 pcaSlab/pcaBeam Interface



slab|pcfBeam

General Information rz| General Information E\
General Information Solve Options } Span Control | General Information $olve Options I Span Control |
Design Options Design Options
Live load pattern ratio: 75 % Live load pattern ratio: {100 %
I Compiession Reinforcement I Compression Reinforcement [ Effective flange width
Critical section for punching shear ¥ homent Redistibution I™ Rigid beam-column joint
Ignore side on a fies edge i within ~ [4 times the sleb ] Ve e DesE
thickness fiam the face of the support VGIEER B
= (o
Deflection calculation options C 0

Sections ta use in deflection caleulations are
" Gioss [uncracked) (+ Effective [cracked)

In negative mament regions, to calculate |g and Mer use:

Deflection calculation options

Sections to uze in deflection calculations are

& Rectangular Section " T-Section " Gross [uncracked] ' Effective [cracked)
W Caloulate long-term deflections In negative mament regions, to caloulats g and Mer use
Duration of load Sustained part of live load O PGt £ T Section
=) months 0 4
[+ Calculate long-term deflections
Duration of load Sustained part of live load
60 months 0 %

oK Cancel | Help ‘ 0K Cancel ‘ Help ‘

The Span Control tab provides commands for span manipulation such as inserting
new spans, copying spans, moving spans, and deleting spans.

Material Properties Sfab|pcABeam

The Material Properties command enables you to input material property
requirements for concrete and reinforcement. Concrete density, compressive
strength, Young’s modulus, rapture modulus, as well as the longitudinal and shear
reinforcement yield levels, are required.

Material Properties g‘ Material Properties g‘
Concrete } Reinforcing Stesl ] Concrete  Reinforcing Steel ]
Slabs and
Beams Colurns
Unit density: 150 150 Ib/it3 “ield stress of flexwral stesl B0 ksi
Camp. strength: 4 4 ksi “Yield stress of stimups: 60 ksi
Young's modulus; | 3834.3 38342 ksi Young's modulus: 29000 ksi
Rupture modulus: |0.47434 047434 ksi I™ Reinforcing bars are spoxy-coated
Copy >

1] Cancel Help oK Cancel Help
| |

Spans slablpcBeam

The Spans menu allows you to input geometric dimensions for slabs, longitudinal
beams, and ribs.
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Span Data E|
SlabsFlanges | Longiudinal Beams | Fibe |
Span: 1 > Length: 25 it idth Left, [0 ft
Location: | Interior - Thickness: |0 in width Right: [0 ft
Madify Copy

Span No | Location | Length | Thickness [ widthL | widthR

1 Interior 25 [ 0 [

2 Interior 15 o 0 o

3 Interior 20 0 i 0

Ok Cancel Help

slablpcfbeam

Supports
The Supports menu allows you to input geometric dimensions for columns, drop

panels, column capitals, and transverse beams. The percentage of the actual
column joint stiffness to be used in the analysis to determine the joint moments
and shears can be modified on the Columns tab. The Drop Panels tab is available
if two-way system is selected and the Moment Redistribution tab is available
only for beams/one-way slab systems if moment redistribution is engaged in the

General Information window.

Support Data g
Columns | Drop Panels | Column Capitals | Transverse Beams | Boundsry Condiions |
Height [ft] ¢l [in) 2 [in)
Support: 1 > | Above 0 16 16
Stiffness share %: 100 Below; 10 18 16
I™ Check punching shear araund column
Modiy Copy..

Sup Mo [ Stfs [ Hi [ ela [ 24 HiB B 28 Shear

1 100 10 16 16 10 16 16 No

2 100 10 16 18 10 16 16 No

3 100 10 16 18 10 16 16 No

4 100 10 16 16 10 16 16 No

oK Cancel Help
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Support Data E\
Columns | Column Capitals | Transverse Beams | Mament Redistibution | Boundary Conditons |
Height ) ol (i) o2 fin)
Suppott: T =] | bove n 16 16
Stfinss share % [100 | Below 0 18 16
Modiy Copy.

Sup Mo | stz [ H [ [ caa [ HE [cB [cee |

1 100 10 16 16 10 16 15

H 100 10 18 18 10 16 I

3 100 10 16 16 10 16 15

4 100 10 18 18 10 18 i

i3 Cancel Help
. .. _
Reinforcement Criteria SlablpcABeam

The Reinforcement Criteria menu allows you to specify the distance to
reinforcement, reinforcement bar sizes, bar spacing, and reinforcing ratio for both
slabs and beams. For beams it also allows you to specify criteria for stirrups, side
cover and distance between layers of reinforcement if more than one layer is
needed.

Reinforcement Criteria Reinforcement Criteria

Slabs and Ribs } Bieams | Slabs and Ribs Beams I
Top bars Bottom biars Top bars Boltom bars Stinups
Cover in] Cover [in) Side Cover ]
Oear 15 [i5 Clear. [T5 [T5 Clear [15
Bar size Bar size Bar size
Min w5 =] [#s | L ] I PR i [43 <]
Msx [we =] [wg | L ] R TR Msx [#5 <]
Spacing (in) Spacing (in) Spacing (in)
Min ’17 ’17 Min: |1 [1 Min: |6
Max 18 [1a Max 18 [ Max  [18
Rleint. ratio (%) Riinf. rafio (%) Nurber of legs
M 014 fors Hire 014 [0.1e W 2 +|
Ma: ’57 ’57 Hax |5 [5 Max ‘E ﬂ
Eoeree b o i Rt TR i el it i
i Cancel Help K. Cancel Help
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Reinforcement Bars Sfab|pcABeam

For two-way floor systems, the Reinforcement Bars menu allows you to specify
the longitudinal reinforcement arrangement information for column strip, middle
strip, and beam, as well as shear reinforcing information for beams.

Reinforcing Bars g‘
Column Strp Bars | Middle Stip Bars | Beam Bars | Beam Stirups |
Barsize: |H5  v| Moofbas |3 Length () [5.1317
pan
Spana [Toptet =] Coveri [i5
Span=291
Span Copy. | Add ‘ Modity | Delete |
Size | Type | Count [ Cover | Lenath [ Start
8 Topl 3 15 B13167
45 Topl 2 15 294328
15 Toph 3 15 589255
H5 TopR 2 15 2 F4306
45 Boi 2 15
18 Botlr B 15 14019 EEB1T
of | caedl | Hee |

For beams/one-way slab systems, flexural bars, stirrups, and torsional longitudinal
reinforcement can be specified. The Reinforcement Bars menu is disabled if Run
Mode of Design is selected from the General Information dialog box. Select the
Run Mode of Investigation from the General Information dialog box to enable

1t.
Reinforcing Bars g\
Flesne Bars | Beam Stinups | Torsion Bars |
Barsize: |5 A Mo, of bars: |3 Length (. |61317
pan
Span3 [Toptet =] Coverlink [15
Span=251t
Span Capy... | Add ‘ tadify | Delete |
Size [ Type [ count [ Cover | Length [ start
HE TopL 3 15 E131E7
H5 ToplL 2 15 294328
HE TopR 3 15 523255
H5 TopR 2 15 2 B4906
HE BotC 2 15
HS BotD 2 15 1409 56617
ok Cancel Help
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Load Cases slablocABeam

The Load Cases menu allows you to specify load cases. Up to six load cases can
be added and only one live load case is allowed.

Load Cases g\
Label: [SELF Type: [DEAD =
aid | \
Label | Type
SELF DEAD
Dead DEAD
Live LWE

1] Cancel Help

Load Combinations slablocABeam

The Load Combinations menu allows you to specify load combinations as shown
in Figure 3-34. Up to twenty load combinations can be added.

Load Combinations E|

SELF Dead Live Wind EQ

T4 14 [ [ [

sdd | Modiy | Delets |

Comb [ sELF [ Dead [ Live [ wind [E0

Ul 1.4 1.4 0 ] i

u2 12 12 15 i i

U3 1.2 1.2 15 it i

U4 12 1.2 15 08 i

s 12 12 1 16 i

g 12 1.2 1 15 i

u? 09 09 i 16 i

It 03 03 0 16 i

s 12 12 1 0 1

o 12 12 1 i 1

U 03 03 i i 1

Uiz 09 039 i i a

[ oK ] comel Help
Span Loads slablpcBeam

The Span Loads menu allows you to enter superimposed area loads, line loads,
point loads, and moments.
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]

Span Loads
Start E

Current Case: nd
Span: |1 | Copy. Magnitude: |1167 1167 It
Live J
Type: [Lineload =] Lecaton [0 E 1t

Span=251t

Case Copy._ | sdd | Modty | Dekts |
SpanMo_ | Type | wa | La | wh [ 16
1 LineLosd 1167 i 1167 %
2 Lineload 1167 0 1167 15
3 Lnelosd 1167 0 1167 20

oK Cancel Help

slablpcfbeam

Support Loads and Displacements
The Support Loads and Displacements menu allows you to enter prescribed

displacements and rotations of supports as well as concentrated loads applied

directly at support locations.

Support Loads and Displacements

X

Displacement/ atation Force/Moment:

Curent Case: Support:
T - ] in F= [0 kip
Ive

Ry |0 rad My |0 kAt
Modify Copy...

=

! [

Supp No. |

cooo|mn
cooolz

R
1}
o
1}
o

g —
cooolo

oK. Cancel Help

slablpcfbeam

Lateral Effects
The Lateral Effects menu allows you to enter the lateral loads as moments acting

on the two ends of each span.

pcaSlab/pcaBeam Interface
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Lateral Load Effects

Current Case:

Q Span: |1 w|  Momentatlef |0 k-t
Moment at ight: [0 keft
Madity Copy.
Span Mo | Mleit | Mright
1 [ i
H o i
3 0 0

oK Cancel Help

Solve Menu

slablpcfbeam

The Solve menu contains commands that enable you to perform the

Execute... F5
Results Report... Fé

analysis and/or design of the floor system and view the results. The

Solve menu contains the following commands: Execute and Report.

Execute

The Execute command executes the solver
portion of pcaSlab. If some data is still
required when this command is executed,
respond with an

pcaSlab  will

Model!" error message. The missing data
must be completed before execution. A status

window pops up and shows
the status during the
execution. If the execution
is not successful, an error
message will be shown and

slablpcfbeam

Analysis E‘
Status: Finished.
Purching shear check oK -
n . Erwelaping internal forcss oK 3
Invahd Combining internal forces oK
Punching shear check 1]
Enveloping intemal forces 1]
Extracting support reactions 1]
Input validation oK
Flexural design oK
Shear design oK
Flexural investigation oK
Shear and torsion investigation oK
pcaSlab Frame analysis [DEAD., cracked) oK
et Estracting deflections oK
Frame analysis (TOTAL, cracked] [ule
|§ Irvvalid input 11 Estracting deflections 0.
2 - ¢ 1 complated! - 3

the execution is terminated.

Results Report

slablpcfbeam

The Results Report command brings up a window with text results of the analysis
and/or design as shown below. From this window, results can be copied to
clipboard or printed using Copy and Print command buttons.

pcaSlab/pcaBeam Interface
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M Results Report
Close Select Al Copy Fiint ‘ [12] Desin Fiesults | 3Tlnes
[[1] Input Echa
[2] DESIGN RESULTS 3] Column Axial Forces and Moments
4] Intemal Forces - Load Cases
5] Intemal Forces - Load Combinations
Moment Redistribution Factors: B Intemal Forces - Envelopes
7] Deflections
Units: Org.Mu {(k-ft) Cuslomize
Caleulated _User_  _Applied_
supp  Side  Org.Mu Iter.# EpsilonT Factor(#] Limit(3] Factor(s]
1 Right 83.52 7 0.01736 17.96 0.00 0.00
s Left Fi. s & 0.015Z8 1526 z0.oo 15.28
z Right 41.57 2 0.04l88 z0.00 z0.00 z0.00
3 Left 3z2.97 £ 0.0&ZeB Z0.00 z0.oo Zo.0o0
3 Righe 57.21 2 0.0z308 z0.00 z0.00 20.00
4 Left 43.30 2 0.034d8 z0.00 0.00 0.00
Top Beinforcement:
Univs: Wideh (fr), Mmax (k-ft), Xmax (fe), As (in®2), Sp (in)
Span Zone Width Muax Mmax  AsMin  AsMax  SpRey  AsRey  Bars v
< >

To change the content of report, select items [1] through [7] from the combo box.
Item Customize brings up the Results Report Setup window described earlier
(Print Results, page 3-7). It will allow you to generate a report with multiple item

selected.

View Menu

slablpcfbeam

The View menu commands enable you to modify
the floor system’s appearance on the screen to suit
your viewing needs and enable you to view the
result diagrams. The View menu contains the
following commands: Zoom, Pan, Restore, Plan
View, Elevated View, Side View, Isometric
View, Change View Angles, View Options,
Loads, Internal Forces, Moment Capacity,
Shear Capacity, Reinforcement, Deflection and
Duplicate Active View.

Zoom

Zoom In (2x) Chrl+Palp
Pan Zaom Out {0.5x) Ctr+PgDn
Restore Zoom Window
Plan Yiew

Elevated Vigw

Side Wiew

Isametric Yiew
Change Wiew Angles. ..
View Options...

Loads

Internal Forces
Moment Capacity
Shear Capacity
Deflection
Reinforcement

Duplicate Active View

slablpcfbeam

The Zoom menu contains a cascade sub-menu, which enables you to zoom in and
out on any portion of your floor system. Select Window from the sub-menu and
use the mouse to specify a zooming region; the program will enlarge the portion
you select. Select the In(2x) or Out(0.5x) to enlarge or reduce the model by two
times, respectively.

3-16
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Pan €fablocfGeam
The Pan command allows you to move your model on the plane of the screen.
You may move the model in any direction. The mouse cursor is changed to a palm
shape once the Pan command is selected. Press and hold the left mouse button on
the view window and drag to the new location. After the mouse button is released,
the model is moved in the same distance and direction as the mouse cursor from
the original position.

Restore €fablocfGeam
The Restore command will redraw the floor system in full size. If you have altered
your screen view using the Zoom command, select Restore to restore the figure’s
original proportions.

Plan View <TablocABeam
Select Plan View command to show the plan view window.

Elevated View <TablocABeam
Select Elevated View command to show the elevated view window.

Side View <TablocABeam
Select Side View command to show the side view window.

Isometric View <TablocABeam
Select Isometric View command to show the isometric view window.

Change View Angles <TablocABeam
The Change View Angle command allows you to modify the angle at which the
floor system is displayed in the Isometric View. The default angles are set at -45
about the X axis and 45 about the Z axis. A more convenient way to change the
view angle is to use the keyboard short cut CTRL + ARROW KEYS. To rotate
around Z axis, press CTRL + « or CTRL + . To rotate around X axis, press
CTRL + 1 or CTRL + ‘ Geometry. E|

Show

View Options slabloEam || ©

¥ Colurnns and capitals

The View Options command allows you to view selected || ® o
members of the floor system in the view windows. Clicking the ¥ Lorgitudinalbeans
left mouse button on the check boxes next to the items in the || * Tamvesetean
dialog box, or tabbing to the member type and pressing the space o
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bar will toggle the selection. pcaSlab will draw any members that contain a v* in
the box.

Loads sfablpcf6eam

Select Loads command to show the load view window.

Internal Forces sfablpcf6eam

Select Internal Forces command to show the [EREITIrNEEa e e Evat =] |
shear, moment, and torsion (for beams/one-way
slab systems only) diagram view window. The
analysis and/or design must be performed before
selecting this command. Otherwise “Problem Not
Solved” message will be shown instead.

Problem Not Solved

Moment Capacity slablocfBeam

Select Moment Capacity command to show the moment capacity diagram view
window. The analysis and/or design must be performed before selecting this
command. Otherwise “Problem Not Solved” will be shown instead.

Shear Capacity <TablocABeam

Select Shear Capacity command to show the shear capacity diagram view
window. The analysis and/or design must be performed before selecting this
command. Otherwise ‘“Problem Not Solved” will be shown instead.

Reinforcement sTablocfBeam

Select Reinforcement command to show the reinforcement view window. The
analysis and/or design must be performed before selecting this command.
Otherwise “Problem Not Solved” will be shown instead.

Deflection sfablocABeam

Select Deflection command to show the deflection diagram view window. The
analysis and/or design must be performed before selecting this command.
Otherwise “Problem Not Solved” will be shown instead.

Duplicate Active View €fablocfGeam
Select Duplicate Active View to make a copy of the current active view window.
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Options Menu

slablpcfbeam

Startup Defaults. ..
Reinforcement Database. ..

v Toolbar

w Stakus Bar

Graphical Qutput...
Text Qutput...

The Options menu allows you to change the startup
options of the pcaSlab program to suit your needs. The
Options menu contains the following commands: Colors,

Startup Defaults, Rebar Database, Toolbar, and Status

Bar.

Colors

Fonts

The Colors command allows you to

slablpcfbeam

Colors g‘
change the background color,
General Results
member color, load color, text — e | | [ =
color, diagram color, etc. You may Background whie Deflection [Dead)  Dark Blue
Text Black Deflection [Live] PFink
save the new colors as default | |5 i
setting, which will be used when | | ., [emresee g
. . L | Dark Yel.. — I | F 11 Wil
pcaSlab is executed in the future. Tz tosn Brean Inemairaces 2 e,
Area Load Red Internal Forces (3] Turquoise
o o o il et T S
Change color to: Change color to:
|Wh\te j |Dalk Blue j
The Fonts command allows you to
select properties of the font that will [¥ Prirt in Black and Ywhite Frinted line thickness: 1
be used in the graphical Output [ Save settings for future use Buorder line thickhess: 1
window and printout, Graphical [ ok | cowe | Hep |

Output, as well as in the text result

window and output, Text Output. Please note that for the Text Output only
nonproportional (fixed width) fonts can be used.

Font \1\E| Font |1|E\
Font: Fort style: Size: Fort Font style: Size:
] [Frequiar E 0K [ Courier New [Fiequiar E JiT3
~ -
g Al Black Italic —( |G —| | e
Arial Naaw — |Bold
g il Founded MT 8ol |Bold lialic y % GungsuhChe Biold lialic 11
Aridl Sub Lucida Consols E 12
B ial Super 0 Lucida Sans Typewite 14
Batang v v H MingLil ~ 15 ™
Effects Sample Sample
I™ Stikeout
2By
I~ Underline EEmpas AeBbYyZz
Color
I C=ck =] | Serpt Seiipt:
Westom - Westem -

pcaSlab/pcaBeam Interface

3-19



slab|pcfBeam

Startup Defaults Sfab|pcABeam

The Startup Defaults command allows you [Eaams

to enter engineer name, change the default | e [posSuctuncFaint
design code, reinforcement database, and the | ccigicte  [rmzems =]
data directory which is where the program | c.juues [fEmms =
looks for data when it is executed.

Data folder: |E “Program Files\PCANpCaSlabhE xamplas
Note: Default values of various design [k | cocd | Heo |

parameters (e.g. minimum and maximum bar
spacing and reinforcement ratio, Young modulus, rupture modulus, etc.) assumed
by the program depend on the design code selected in this dialog box. Subsequent
change of the design code in the General Information dialog box does not reset
values of these parameters to the default values corresponding to the newly
selected code. It may, however, convert these values to different units if the code
change is accompanied by a change of units.

Reinforcement Database sfablpcfBeam
The Rebar Database command allows you to [EREEATEIE X
view the pre-defined rebar information and define | [ =rn®==

p ASTH ABIE =
your own database. The user-defined database
can be selected from the General Information |s.. [ B |2 i
dialog bOX. Ares in“2 ‘feight: It

Toolbar slablpcfBeam Size [ob [4b [wh |

. . #3 0.375 oo 0.376
Check the Toolbar command with a v sign to ||# e e b
show the tool bar. Select the command again to || bEn oam Zods
. . #8 1.000 0.790 2670
clear the v" sign to hide the tool bar. The tool bar 5 1z oo s
is shown by default. @ m am e
#18 2257 4.000 13.600
Status Bar SlablocGEam oK Ll | Heb |

Check the Status Bar command with a v sign to show the status bar. Select the
command again to clear the v sign to hide the status bar. The status bar is shown
by default.

Window Menu Sabloc6am

This menu enables you to arrange view windows shown on screen. The Window
menu contains the following commands: Cascade, Tile Horizontal and Tile
Vertical.
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Cascade sfablpcf6eam

The Cascade command displays all the open windows in the same size, arranging
them on top of each other so that the title bar of each is visible. The current active
view widow will be on the top after the execution of the Cascade command.

Cascade
Tile Horizankal
Tile ‘ertical

1 C:\Program FilesiPCalpaslabiExamplesiManualiExample 1 - PCA Motes on ACL 318-05 Example 8-2.5lb -- Deflection Wiew

2 C:\Pragram Files\PCAIpeaslabiExamplesiManualiExample 1 - PCA Motes on ACT 318-05 Example 8-2.slb -- Moment Capacity View

3 Ci\Program Files\PCAYpraslablExamplesiManualiExample 1 - PCA Motes on ACT 316-05 Example 8-2,slb -- Isometric View

4 C:\Pragram Files\PCAYpeaslablExamplesiiManualiExample 1 - PCA Motes on ACT 318-05 Example 8-2.5lb -- Shear and Tarsion Capadity Wiew
5 Ct\Pragram Files\PCAIpeasSlabiExamplesiManualiExample 1 - PCA Motes on ACT 315-05 Example 8-2.slb -- Plan View

& Ci\Program Files\PCAYpoaslablExamplesiManualiExample 1 - PCA Mobes on ACT 318-05 Example 8-2,5lb -- Elevated Yiew

7 C:\Pragram Files\PCApeaslablExamplesiManualiExample 1 - PCA Motes on ACT 316-05 Example 8-2.5lb -- Side View

& Ct\Pragram Files\PCAIpeaslabiExamplesiManualiExample 1 - PCA Motes on ACT 318-05 Example 8-2.slb -- Load View

9 C:\Program Files\PCAYpraslablExamplesiManualiExample 1 - PCA Motes on ACT 316-05 Example 8-2.slb -- Reinforcement Yiew

More Windows. ..

<

Tile Horizontal sfablpcf6eam

The Tile Horizontal command arranges all open windows horizontally so that no
window overlaps another. The current active view widow will be on the most left
or on the upper-left corner of the screen after the execution of the Tile Horizontal
command.

Tile Vertical sfablpcf6eam

The Tile Vertical command arranges all open windows vertically so that no
window overlaps another. The current active view widow will be on the most left
or on the upper-left corner of the screen after the execution of the Tile Vertical
command.

Window List slablocfBeam
The remaining menu items are in a list of the windows that are available for
viewing. Selecting any window from this menu will bring up or restore the
window to its previous size and position if it was minimized.

Help Menu SfablocGeam
A The Help menu includes commands that enable you to obtain
ok for e online help for the program and show the copyright and registration

eck for Updates. ..

RU— information about your software. The Help menu contains three
commands: Help Topics, Context Help and About pcaSlab.
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Help Topics

slablpcfbeam

The Help Topics command shows the Windows Help window with a table of
contents. Select a topic of your interest to display information about that item.
More information on the help system can be obtained from the Microsoft
Windows manual.

Context Help

The Context Help command enters the program into the context-sensitive help
mode which is indicated by a question mark %? attached to the mouse cursor. In
this mode, the user can click the element for which information is needed and the
program will display the help topic associated with this element. More information
on the help system can be obtained from the Microsoft Windows manual.

About pcaSlab/pcaBeam

slablpcfbeam

slablpcfbeam

The About pcaSlab command shows the version number of the program, the
licensing information, and the copyright information. In the case of a trial license,
the expiration date is given as well as the locking code which is needed to obtain
a standalone license.

About pcaSlab

F=t

peaSlab w2.00

Analysis, Desian, and Investigation of Reinforced Concrete
Beams, One-way and Two-way Slab Systems

License Type: 15 day trial license

License Expr - Dec 19, 2006 at 16:48:132
License Sever ZrAN [192.168.100.183) «7.2.23
Locking Code: [422108

Licensed to,

praStuctursPoint, Partland Cament Association

Copyright € 2003-2008
peaStiucturePoint, Portland Cement Association

Skokie, IL - U524

A& Rights Reserved

X

~

About pcaSlab &\

peaSlab v2.00

Analysis, Design, and |nvestigation of Reinforced Concrete
Beams. Ore-way and Two-way Slab Spstems

License Type: 2 seat network. license
License Exp: Mever
License Sever: PCASTRUCTURE [132 168.100.200] v.7.2.23

Liense ID:  [123451234567-4-2D 2DE 22104
Licensed to:

peaShuctursPoint

Copyright © 2003-2006
praStucturePoint, Portland Cement Association

Skokie, IL - US4

&l Rights Reserved
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Control Menu SlablpBeam

All the view windows have one pull-
down menu located in the upper left

hand corner of the open window. This g
is the Control menu. To access the el
Control menu, press CTRL + F6 to

cycle through the windows and press
ALT + — (hyphen), to open the Control _
menu of the desired window. The \Vx
following is a list and a brief
description of the commands in this
menu.

X Close Chrl+F4

Mext CtrHFe

Restore slab|pcABeam

The Restore command will restore a window or an icon to its previous size and
position. This menu item is available when the window is iconized or maximized.

Move slab|pcABeam

The Move command moves the window to a new location. Select Move and use
the ARROW KEYS to move the window in the desired direction and select
ENTER to accept the new location.

Size slablpcfbeam

The Size command resizes a window. Select Size and use the ARROW KEYS to
move the border of the window in the desired direction and select ENTER to
accept the new size.

Minimize slab|pcABeam

The Minimize command reduces a window to an icon and positions it at the
bottom of the screen.

Maximize slablocABeam

The Maximize command enlarges a window to fit your entire screen.

Close slablocABeam

The Close command is used to close a window and return it to an icon and the
bottom of the screen.
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Next

Program Toolbar

slab|pc/Beam

The Next command switches among open windows and icons.

slab|pc/Beam

Dl Bs BB

O

=

SAalgT MMt Dol EEREBEREE @ actd

Close the current data file if there is one and start a new data
file. The equivalent menu command is File/New.

Open an existing data file on hard disk. The equivalent menu
command is File/Open.

Save the current data file to hard disk. The equivalent menu
command is File/Save. If you have not changed the default file
name (pcaSlabl, pcaSlab2, etc.), the equivalent menu command
is File/Save As.

Print view window. The equivalent menu command is File/Print
View.

Print results. The equivalent menu command is File/Print
Results.

Copy Bitmap to clipboard. The bitmap then can be pasted to a
word processing or presentation software such as Microsoft
Word or Microsoft PowerPoint.

Copy Metafile to clipboard. The metafile then can be pasted to a
word processing or presentation software such as Microsoft
Word or Microsoft PowerPoint.

Open the Data Input Wizard. The Data Input Wizard will guide
you to enter the necessary input to your project. The equivalent
menu command is Input/Data Input Wizard.

Enter general information. The equivalent menu command is
Input/General Information.

Enter material properties. The equivalent menu command is
Input/Material Properties.

Enter span geometry information for slabs, longitudinal beams,
and ribs. The equivalent menu command is Input/Spans.

Enter support information for columns, drop panels, column
capitals, and transverse beams. The equivalent menu command
is Input/Support.

Enter reinforcement criteria for slab and ribs, and beams. The
equivalent menu command is Input/Reinforcement Criteria.
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= Enter reinforcing bar information for column strips, middle
strips, beams, and beam stirrups. This button is disabled if
Design run mode is selected from the General Information
dialog box. The equivalent menu command is Input/
Reinforcing Bars.

i Enter load cases. The equivalent menu command is Input/Load
Cases.

5 Enter load combinations. The equivalent menu command is
Input/Load Combinations.

=l Enter span loads. The equivalent menu command is Input/Span
Loads.

Enter support loads and displacements. The equivalent menu
command is Input/Support Loads and Displacements.

b Enter lateral effects. The equivalent menu command is
Input/Lateral Effects.

= View plan geometry. The equivalent menu command is
View/Plan View.

@ View elevated geometry. The equivalent menu command is
View/Elevated View.

= View side geometry. The equivalent menu command is
View/Side View.

@ View isometric geometry. The equivalent menu command is

View/Isometric View.
Execute the analysis and/or design. The equivalent menu
command is Solve/Execute.

View results. The equivalent menu command is Solve/Report.

= View loads. The equivalent menu command is View/Loads.

be View internal forces within the whole system or a single span.
The equivalent menu command is View/Internal Forces.

= View moment capacity of the whole geometry or a single span.
The equivalent menu command is View/Moment Capacity.

= View shear capacity of the whole geometry or a single span. The
equivalent menu command is View/Shear Capacity.

= View deflection of the whole geometry or a single span. The
equivalent menu command is View/Deflection.

= View flexure reinforcement for beam strip, middle strips, and

column strips. View shear reinforcement for beam strips. The
equivalent menu command is View/Reinforcement.

@ Zoom in view window to magnify the system. The equivalent
menu command is View/Zoom/In(2x).
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%

Zoom out view window to reduce the system. The equivalent
menu command is View/Zoom/Out(0.5x).

Zoom any part of a view window. The equivalent menu
command is View/Zoom/Window.

Move the model in the screen plane. The equivalent menu
command is View/Pan.

Restore a view window. The equivalent menu command is
View/Redraw.
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Chapter 4

Operating pcaSlab/pcaBeam

Working with Data Files (menu File) sfablocA6eam
Creating a New Data File sfablo-A6eam

When you first load pcaSlab you will have a new file ready for input. The data will
not have a filename associated with it, therefore, "pcaSlab1" will appear in the title
bar. If a new data file is created after the "pcaSlabl", the new data file will be
named as "pcaSlab2", and so on.

To start a new data file:

1.

If you are already in the program and in an existing file, select NEw button U
or New menu command to clear your screen and return you to the default
settings. If existing data has been changed prior to executing the New
command, pcaSlab will ask if you would like to save the data.

After New is selected, Auto Input command in the Input menu may be used.
This command guides you through the inputting process by automatically
displaying all the dialog boxes necessary to design your floor system. You
may cancel the auto input mode by selecting CANCEL button from any dialog
box.

After you enter data through the Input menu, use the Save As command to
give the file a name.

Opening Existing Data File ¢lablocABeam

pcaSlab allows you to open data files that were saved at an earlier time.

To open an existing data file:

1.

Select Open command from the File menu or click the OPEN button % to
bring in an existing pcaSlab data file. The dialog box of Figure 4-1 will be
displayed. All the files with an .slb extension contained in the current drive
and directory will be displayed in the list box. This dialog box also enables
you to change the current drive and directory.



slab|pcfBeam

Look in: | £ Marual = e B

2] Excample 1 -
(2] Excample 2 -
ﬂExamp\e 3-
|#]Example 4 -
2] Example 5 -

PCA Notes on ACT 318-05 Example 8-2.slh
PCA Motes on ACT 318-05 Exampls 13-1.5lb
Struckural Concrete by Hassoun Example 16.1.5lb

Design of Concrete Struckures by Milson Example 133,510

PCA Motes on ACT $18-05 Example 20-2.slb

File name:

[*slb

Open

Files of type: ‘pcaS\ab/DCaEEam Files [*slb]

j Cancel

Figure 4-1 Open dialog box

2. Type in the name of the file you want to open. You may also select a file from
the provided list with the mouse or using the keyboard by tabbing to the list
and using the up and down arrow keys.

3. Press OPEN to exit the dialog box and allow pcaSlab to read the data. You
may combine steps 2 and 3 of this procedure by double clicking the left
mouse button over the desired file from the provided list.

slablpcfbeam

Importing ADOSS and PCA-Beam Data File

pcaSlab and pcaBeam allow you to open ADOSS v6.0x/7.0x and PCA-Beam
v1.0x data files that were saved at an earlier time.

To open an existing ADOSS or PCA-Beam data file:

1. Select Open command from the File menu or click the OPEN button =. The
dialog box of Figure 4-2 will be displayed. Select the type of the file you want
to open and all files of the selected type contained in the current drive and
directory will be displayed in the list box. This dialog box also enables you to
change the current drive and directory.

7))

x|« B ¥ E-

Open

Look i | 3 Adoss

[#A] ltple ads
(7] Fltslb, ads
ﬂp\tbms‘ads
[A] waffle.ads

Fieneme: |

Open

Cancel |

Files of type: ‘ADDSS 6. 04/7 O Files 7 ads] j

peatlab/peatican Fies [ sl
i ack]

Figure 4-2 Importing ADOSS or PCA-Beam data file dialog box
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Type in the name of the file you want to open. You may also select a file from
the provided list with the mouse or using the keyboard by tabbing to the list
and using the up and down arrow keys.

Press OPEN to exit the dialog box and allow pcaSlab to read the data. You

may combine steps 2 and 3 of this procedure by double clicking the left
mouse button over the desired file from the provided list.

Note: The extension name of an ADOSS v6.0x/7.0x file is .ADS and the extension
name of a PCA-Beam v1.01 file is .BMS. Both pcaSlab and pcaBeam v1.5x use
files with the .SLB extension.

Saving Data File sTablocfBeam

To save your data with the same filename:

1.

Select the Save command from the File menu or simply click the SAVE button
B If the data has not been modified since the last save or Save As command
was executed, this option will not be available. The file will be updated and
the Save command and button will be shaded gray.

To give your data a new filename:

1.

2.
3.

If you have not saved your data yet, select the Save or Save As command
from the File menu. Either command will have the same effect. If you would
like to save a data file that currently has a filename with a new filename,
select the Save As command. The dialog box of Figure 4-3 will appear. When
no filename has been given to the current data, the default filename is
"pcaSlabl.slb", and it is highlighted in the edit box.

Save As @
Save in: [ 5 Manual | ek E-

|| Example 1 - PCA Motes on ACT 318-05 Example 8-2.5b

HExamD\E 2 - PCA Motes on ACT 318-05 Example 13-1.slb

2] Excample 3 - Structural Cancrete by Hassoun Example 16.1.5h

|3]Examp\a 4 - Design of Concrete Struckures by Nilson Example 13,3.51b
@Examp\e S - PCA Motes on ACT 318-05 Example 20-2.slb

File name:  [Example 1 - PCA Notes on ACI 318-05 Example Save
Save a5 typs: | peaS|ab Files (slb] | Cancel

Figure 4-3 Save As dialog box

Type a new name to overwrite the current name.

Press SAVE to exit the dialog box and save the data into the filename
specified.
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Most Recently Used Files (MRU) €fablocfGeam
New Chrl+N
Qpen... Chrl+O
Close 4G

Save Chrl+5
Save As. ..

Print Preview. ..
Print Results. ..
Fint Setup...

1 Exarnple 1 - PCA Nokes on ACT 318-05 Example 6-2.slh
MRU 2 Example 2 - PCA Notes on ACT 318-05 Example 13-1.5lb
3 Example 3 - Struckural Concrete by Hassoun Example 16.1.51b
4 Example 4 - Design of Concrete Structures by Nilson Example 13.3.slb

Exit

Figure 4-4 Most Recently Used File List (MRU)

The Most Recently Used Files (MRU) list shows the four data files that were
opened most recently. Selecting a data file from this list makes it easier and faster
to open the file. The list is empty when the program is executed for the first time.

Specifying Model Data (menu Input) sfablocA6eam
Data Input Wizard <TablocABeam

The Data Input Wizard is designed to make the inputting process easier. By
selecting the Data Input Wizard from Input menu or selecting * from the tool
bar, a logical sequence of dialog boxes will automatically be displayed allowing
you to enter data for your floor system.

Defining General Information ¢lablocABeam

The General Information command allows you to enter labels, design code, rebar
database, run mode, and the frame information needed by pcaSlab to proceed with
the input process. You must choose this command before doing any further
inputting since this command affects the availability of the commands in the Input
menu.

To enter general information:
1. Select the General Information command from the Input menu or click the
i button from the tool bar. The dialog box of Figure 4-5 will appear.

2. Enter the project name, frame name, and engineer name in the Label frame
box.

3. Select the building standard you want your floor system to be designed to
(ACI 318-02, ACI318M-02, ACI318-99, ACI318M-99, CSA A23.3-94,
CSA A23.3-94E) from the Option frame box.
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General Information K
General Information I Solve Options | Span Control |

Labels

Project; |poaSiab/peaBesm Marnual, Exsmple 1

Frame: |FEA MNotes on ACH 318-08, Evample 8-2

Enginesr: |peaShucturePoint

Options Run mads

Designeode:  [ACI31805  w| | © Design
Reinforcement:  [ASTMAB15  w| | € Investigation

Frame Floor System
Moo of Supports: |4 O Twowiay

I Left cantilever [~ Right cantilewer | % One‘wWay/Beam

I Distance location as ratio of span

oK I Cancel ‘ Help ‘

Figure 4-5 General Information dialog box

Select the Design or Investigation from the Run mode frame box.

5. In the Frame frame box, enter the Number of supports of the frame. The
default number of supports is 2. The minimum and maximum number of
spans is 1 and 20 spans, respectively. Therefore the minimum number of
supports is 2 and the maximum number of supports is 21.

6. Check the Left cantilever and/or Right cantilever check boxes if left cantilever
and/or right cantilever exist in the frame respectively.

7. In the Floor System frame box, select Two-Way or Beams/one-way slab
option.

8. Check the Distance location as ratio of span if the locations of loads need to
be entered as a ratio of the length of a span.

9. Press OK button to exit the dialog box and allow pcaSlab to use the new data.
If using the Auto Input, click the NEXT button to the next dialog box.

Defining Solve Option ¢lablocABeam

The Solve Options command allows you to select options and specify parameters
that affect the analysis and design results. Please be advised that changing these
settings involves engineering judgment and it has to be done cautiously. To take
effect, this command must be used prior to the Execute command. The set of
parameters is different for two-way and one-way systems.
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Two-way systems slab
To specify solve options for two-way systems:

Enter the live load pattern ratio.

Check COMPRESSION REINFORCEMENT checkbox if it is to be considered
when needed.

Enter the multiplier that defines the distance between a column face and a free
edge of a slab, within which a segment of punching shear critical section is to
be ignored.

Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be
considered in the deflection calculations.

Choose if in the case of a section with flanges in the negative moment region,
only the web (RECTANGULAR SECTION) or the whole section (T-SECTION) is
to be used to calculate the gross moment of inertia (Ig) and the cracking
moment.

Check CALCULATE LONG-TERM DEFLECTIONS checkbox if you want the
program to calculate long-term deflections. Provide the duration of load in
months and the percentage of the live load which is considered as sustained
load.

a) General Information E\ b) General Information g\
General Information  Solve Dptions ] Span Conirol | General Information Solve Options I Span Control |
Design Options Design Options
Live load pattern ratio; |75 % Live load pattern ratio: {100 %
I Compression Reinforcement I Compression Reinforcement I Effective flange width
Critical section far punching shear ™ Moment Redistibution [ Rigid beam-column joint
Ignore side on a fies edge f within [ times the slab ] Ve e DesE
Torsion type
thickness from the face of the support. & =
Deflection calculation aptions C 0

Sections to use in deflection calculations are:

£ Gross funcracked) @ Effective (cracked) et m et i s
s o b el
I negative moment regions, ta caleulate Ig and Mer use

* Rectangular Section " T-Seclion " Gross [uncracked] ' Effective [cracked)
v Calculate longterm deflections In negative mament regions, to calculate |g and Mer use
Duration of load Sustained part of live load O PGt £ T Section
60 manths 0 %
[+ Calculate long-term deflections
Duration of load Sustained part of live load
60 months 0 %
1] Cancel | Help | 0K Cancel ‘ Help ‘

Figure 4-6 Solve Options (a)two-way systems (b) beam and one-way
system
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One way/beam systems slablocfBeam
To specify solve options for beams/one-way slab systems:

1. Enter the live load pattern ratio. The default value for beams/one-way slab
systems is 100%.

2. Check COMPRESSION REINFORCEMENT checkbox if it is to be considered
when needed.

3. Check MOMENT REDISTRIBUTION checkbox if it is to be considered in the
analysis. This option has to be checked for the MOMENT REDISTRIBUTION tab
to be available in the SUPPORT DATA dialog box.

4. Check EFFECTIVE FLANGE WIDTH if instead of the full flange width only the
effective flange width is to be considered in the flexural design.

Check RIGID BEAM-COLUMN JOINT to consider beam-column joint as rigid.

Check TORSION ANALYSIS AND DESIGN if they are to be included in the
solution. This option has to be checked for the TORSION TYPE and STIRRUPS IN
FLANGES options to be enabled. Also torsional loads will only be available in
the TYPE combo box of the SPAN LOADS dialog box if this option is checked.

7. If TORSION ANALYSIS AND DESIGN is checked then select if EQUILIBRIUM or
COMPATIBILITY torsion is to be considered and if for sections with flanges
STIRRUPS IN FLANGES can be considered.

8. Choose if GROSS (UNCRACKED) or EFFECTIVE (CRACKED) sections are to be
considered in the deflection calculations.

9. Choose if in the case of a section with flanges in the negative moment region,
only the web (RECTANGULAR SECTION) or the whole section (T-SECTION) is
to be used to calculate the gross moment of inertia (Ig) and the cracking
moment.

10. Check CALCULATE LONG-TERM DEFLECTIONS checkbox if you want the
program to calculate long-term deflections. Provide the duration of load in

months and the percentage of the live load which is considered as sustained
load.

Using Span Control sTablocfBeam

The Span Control tab allows you to perform different operations on the spans that
your system consists of. These operations include inserting new spans with default
parameters, creating new spans by copying existing spans, moving spans to change
span sequence, and deleting spans. The result of an operation depends on the span
selected as well an on the selected support. Spans can be selected using the Span
Control List and columns using the Support Selection radio buttons.
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General Information &

General Infarmalion | Salve Optians Span Contiol |

Suppoit Selection State

% Left Support " Right Support
Span Contral List -
Mewth [0t | SuplR | Copy |
> HLL -4
1 1 1/2

2 2 2/3 Insert
3 3 34

HCR 4/ Before
-

Copy

Before | After
< >

Move

o]

1] Cancel | Help |

Figure 4-7 Span control tab

Additionally before the Span Control window is closed all changes made to the
spans can be revoked using the RESET ALL button. The RESTORE button can be
used to bring back a span removed using the DELETE button.

To insert a new span with default dimensions:

1.

In the SPAN CONTROL LIST select the span next to which you want to insert
a new span.

Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the newly created
span will be inserted.

Press INSERT BEFORE button to insert the new span left to the selected span or
INSERT AFTER button to insert the new span on the right side of the currently
selected span.

Examples of the insert operations are presented in Figure 4-8. Assuming that
Span 2 is always selected the resulting systems will depend on whether
INSERT AFTER or INSERT BEFORE was used and whether LEFT COLUMN or
RIGHT COLUMN was selected. Newly inserted span and column are denoted
with an “x”.
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FT T

Insert After
Span: 2
Column: Left

g O R

Insert After
Span: 2
Column: Right

g I A |

o b o o

Insert Before
Span: 2
Column: Left

T T 11

FT T

Insert Before
Span: 2
Column: Right

G |

Figure 4-8 Inserting a new span using Span Control

To copy a span:

In the SPAN CONTROL LIST select the span you want to copy.

2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the copied span
will be copied with the span.

3. Press INSERT BEFORE button to place the copied span left to the selected span
or INSERT AFTER button to place the copied span on the right side of the
currently selected span.

Examples of the insert operations are presented in Figure 4-9. Assuming that
Span 2 is always selected the resulting systems will depend on whether COPY
AFTER or CorYy BEFORE was used and whether LEFT COLUMN or RIGHT
COLUMN was selected. Newly created span and column are denoted with the

prime sign.
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[1] [2] [3] > [1] [2] [2] [3]
Span: 2
Column: Left

[1] [2] [3] > [1] [2] [2] [3]
Span: 2
Column: Right

[1] [2] [3]

b o o o

Copy Before
Span: 2
Column: Left

T T 11

FT T

Copy Before
Span: 2
Column: Right

T T

Figure 4-9 Copying a span using Span Control

To move a span:

In the SPAN CONTROL LIST select the span you want to move.

2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the moved span
will be moved with the span.

3. Press MOVE BEFORE button to move the span to the left or MOVE AFTER
button to move the span to the right side.

Examples of the move operations are presented in Figure 4-10. Assuming that
Span 2 is always selected the resulting systems will depend on whether MOVE
AFTER or MOVE BEFORE was used and whether LEFT COLUMN or RIGHT
COLUMN was selected.

4-10
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[1] [2] [3] > [1] [3] [2]
CT Tl 0T T
Span: 2
Column: Left
[1] [2] [3] > [1] [3] [2]
FT T e T T
Span: 2
Column: Right
[1] [2] [3] > [2] [1] (3]
A) é J;) &Move Before é} J} (g é
Span: 2
Column: Left
[1] [2] [3] > [2] [1] [3]
4} é Jg) gMove Before 4} J}) é} é
Span: 2
Column: Right

Figure 4-10 Moving a span using Span Control
To delete a span:

In the SPAN CONTROL LIST select the span you want to delete.

2. Select whether the LEFT SUPPORT or the RIGHT SUPPORT of the deleted span
will be removed with the span.

3. Press the DELETE button to delete the selected span.

Examples of the delete operations are presented in Figure 4-11. Assuming that

Span 2 is always selected the resulting systems will depend on whether LEFT
COLUMN or RIGHT COLUMN was selected.
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Figure 4-11 Deleting a span using Span Control

Defining Material Properties Sfablpc6eam

The Material Properties command from the Input menu allows you to input
material properties of the concrete and the reinforcement. There are two tabs in
this dialog box. One is for concrete and the other is for reinforcing steel. This
command must be executed in order to perform a design of the floor system. Use
the tab key to get to each edit box then type in your values, or use your mouse and
click directly on the desired tab and box, then type in your values. Refer to
"Material Properties" for a detailed explanation of the default values.

To define material properties:

1. Select the Material Properties command from the Input menu or click the
button on the tool bar. The dialog box of Figure 4-12 will appear.
Material Properties X
Cancrete | Reinforcing Steel |

Slabs and
Beams Calumns

Urit dersity: ,T W (=1iE)
Comp. stenathe [4 [& ks
Young'smodulus: [38343  [38343 ki
Ruptue modulus: (047434 [0.47438 ks

Copy >

i3 Concel | Heb |

Figure 4-12 Concrete Properties dialog box
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2. Click the Concrete tab and enter the concrete density for the following
members: Slabs, Beams, and Columns.

3. Enter the concrete compressive strength. By entering a value for the
compressive strength, values for Young’s modulus and rupture modulus will
automatically be computed for the slabs, beams, and columns. Young’s
modulus and rupture modulus will automatically be shown in the
corresponding text boxes.

4. If you have values for the rupture modulus, enter the values in the text boxes
for the slabs, beams, and columns. Default values are computed based on
average split tensile strength of concrete, which is calculated internally by the
program. These values will be used for deflection analysis. A large value for
the rupture modulus will produce a deflection analysis based on gross, non-
cracked, sections. The CSA A23.3-94 Standard requires'®' that for the
calculation of slab (either one-way or two-way) deflections a rupture modulus

value equal to 0.6\/5 /2 be used. pcaSlab defaults to this value of the rupture

modulus for the slab concrete in CSA design runs. However, for beams

rapture modulus of 0.64/f, has to be used and this value needs to entered
directly by the user overwriting the default value.
5. Click the Reinforcing Steel tab as shown in Figure 4-13.

Material Properties El

Conciste  Reinforcing Stes! |

ield stress of fexural steal L:t1] ksi
‘field stress of stimups: E0 kesi

‘foung's modulus: 29000 kesi

™ Reinforcing bars are epoxp-coated

oK Cancel | Heb |

Figure 4-13 Reinforcing Steel Properties dialog box

6. Enter the yield stress of flexure steel.
7. Enter the yield stress of stirrups.
8. Enter the Young’s modulus for flexural steel and stirrups.

11 CSA A23.3-94, 13.3.6
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9. Select whether the main reinforcement is epoxy-coated by clicking the left
mouse button on the box or tabbing to the box and pressing the SPACE BAR.
This selection affects development lengths.

10. Press OK button to exit the dialog box so that pcaSlab will use these material
properties. If using the Auto Input, click the NEXT button to the next dialog
box.

Defining Slabs/Flanges SlablpcABeam
The Spans command from the Input menu is available for all floor systems. Span
numbers, which are determined from the number of supports entered in the
General Information box, are automatically filled into the Span drop-down list in
the Span Data dialog box.

To input slab geometry:

1. Select the Spans command from the Input menu or click the — button on the
tool bar. Click the left mouse button on the Slabs tab. The dialog box of
Figure 4-14 will appear.

2. Select the number of the span, for which dimensions will be entered, from the
Span drop-down list.

Span Data E\

Slabs/Flanges 1 Longtudingl Beams | Riss |

Span: 1 - Length: 25 ft ‘width Left: |0 ft
Location: | Interior A Thickness: |0 in “width Right: |0 ft

Modify Copy.

Span Mo. | Location | Length [ Thickness | widthrl | wicthR |
1 Interior 25 0 1} 1}
2 Interior 15 1} 1} 1}
3 Interior 20 0 1} o

1] ‘ Cancel | Help |

Figure 4-14 Defining the Slabs dialog box

3. Select the span location from the Location drop-down list. Three types of
locations are available: Interior, Exterior Left, and Exterior Right. The "left"
and "right" are defined as you look along the direction of analysis. If a span

4-14 Operating pcaSlab/pcaBeam



slab|pcfBeam

has design strips on both sides it should be an "Interior" span. If a span has
only a left design strip, it should be an "Exterior Right" span. If a span has
only a right design strip, it should be an "Exterior Left" span.

Enter the slab thickness of the span.

5. Enter the span length from column centerline to column centerline or edge to
column centerline for the two cantilever spans in the Length edit box. If the
program detects a cantilever span length less than one-half the column
dimension in the direction of analysis, an error message will pop up when the
frame is analyzed. If a partial load is affected by the span length, a message
warns the user of this condition.

6. Enter the span design width in the transverse direction of analysis on the left
and right side of the column (see Figure 4-15). These distances are usually
one-half the distance to the next transverse column or edge of the slab for
exterior spans. The left and right designations are arbitrary. Both interior and
exterior spans may be used in a design strip. An exterior width will
automatically be designated by pcaSlab by entering a width value less than or
equal to the transverse column dimension. Exterior sides do not contribute to
the attached torsional stiffness, although they do contribute to loading.
pcaSlab will use the total width entered for weight and superimposed loading
but will use code allowed dimensions for flange width and stiffness

computations.
g
=| 7 e
o
= Direction of Analysis
S\ [
2
s | <~ e
B
=y
| 2 |
| | — Depth

Transverse to the
Direction of Analysis
—-—————————

Figure 4-15 Required Slab Dimensions

7. Press the MODIFY button to update the slab geometry.
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8. Repeat steps 2 through 7 until all the spans have been updated. You can use
the COPY button as a shortcut.
9. Press OK button to exit the dialog box and allow pcaSlab to use the updated
slab geometry.
Defining Longitudinal Beams sfablpcfBeam

Longitudinal beam dimensions are required for the beam-supported slab. Span
numbers, which are determined from the number of supports entered in the
General Information box, are automatically filled into the Span drop-down list.

To input geometry for beam-supported slab system:

1.

wokh v

6.

Select the Spans command from the Input menu or click the — button on the
tool bar. Click the left mouse button on the Longitudinal Beams tab. The
dialog box of Figure 4-16 will appear.

Select the span number from the Span drop-down list.

Enter the width of the beam (Figure 4-17).

Enter the depth of the beam from the top of the slab (Figure 4-17)).

Press the MODIFY button to update the longitudinal beam geometry.

Span Data g‘

Slabs/Flanges Lnng\tudina\ﬁeamﬂﬂihs |

Span: 1 - wiidth

Depth:

Maodify Copy...

Span Ho [ width Depth
1 12 16
2 12 16
3 12 16

of | caedl | Hee |

Figure 4-16 Longitudinal Beam Geometry dialog box

Repeat steps 2 through 6 until all the beams have been updated. You can use
the COPY button as a shortcut.

4-16
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7. Press OK button to exit the dialog box so that pcaSlab will use the new beam
geometry.

= e

Beam Depth

Width

Figure 4-17 Required Longitudinal Beam Dimensions

Defining Ribs slablpcBeam
For the waffle slab system, you must define the rib geometry. The ribs are
assumed to be the same throughout the strip.

To enter rib geometry:

1. Select the Spans command from the Input menu or click the — button on the
tool bar. Click the left mouse button on the Ribs tab. The dialog box of Figure
4-18 will appear.

Span Data &

SIabsfF\anges]Long\tudlna\Beams Ribs 1

in Spacing: a in

in

Span: 1 - wiidth:

Depth:

Modify Copy.

Span No. ‘ “width | Depth ‘ Spacing
1 1} 0

—
—

o
2 a i} 1}
3 1} i} 1}

1] ‘ Cancel | Help |

Figure 4-18 Ribs Geometry dialog box
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2. Select the span number from the Span drop-down list.
3. Enter the spacing between ribs at the bottom for clear rib spacing (see Figure

4-19).
Top Slab
| Thickness |
% -
L
5y
Q 12
2 1
14
- Clear Rib
| Spacing |

T T T T
L Rib Width at BottomA

Figure 4-19 Required Rib Dimensions

. Enter the width at the bottom for rib width (see Figure 4-19).
5. Enter the depth of the rib below the slab for Rib depth (see Figure 4-19).

6. Press OK button to exit the dialog box so that pcaSlab can use the rib
geometry.

Defining Columns sTablocfBeam

Column data is optional. If no column is specified at the joints the joint is assumed
hinged. You will be allowed to enter column dimensions above and below.

To input column/capital geometry:

1. Select the Supports command from the Input menu or click the £ button on
the tool bar. The dialog box of Figure 4-20 will appear. Click on the Columns
tab.

2. Enter the column height above, which is the distance from the top of the
design floor to the top of the floor above (see Figure 4-20). pcaSlab obtains
the clear column height above by subtracting the average slab depth from the
height given. Only the slab is considered for the floor system above. A zero
dimension for the column heights above and below will create a pin condition.
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Support Data E\
Columns | Column Capitals | Transverse Beams | Mament Redistibution | Boundary Conditons |
Height ) ol (i) o2 fin)
Suppart T v |bover 0 f5 I8
Stfness share % [100 | Below [l e s

Madify Copy.

Sup Mo | stz [ H [ [ caa [ HE [cB [cee |
1 100 10 18 18 10 18 16
2 100 10 16 16 10 16 16
3 100 10 16 16 10 16 16
4 100 10 18 18 10 18 18
ot | cacd | Hee |

Figure 4-20 Column Geometry dialog box

3. Enter the column height below, which is the distance from the design floor to
the top of the floor below (see Figure 4-21). To obtain a clear column height
below, the slab/drop/beam depth is subtracted from the height given. A zero
dimension for the column heights above and below will create a pin condition.

]
Column
Height
Above
C, y Design
l Floor
e—Ci—1 Column
Height
Direction of Analysis Below

Figure 4-21 Required Column Dimensions
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4. Enter a value for cl, the column dimension in the direction of analysis (see
Figure 4-21).

5. Enter a value for c2, the column dimension perpendicular to the direction of
analysis (see Figure 4-21). Round columns are specified with a zero input for
c2; cl is then taken as the diameter. Zero value for Stiffness Share will create
a pin condition.

6. Press the MODIFY button to update the slab geometry.

7. Check the Check punching shear around column if the punching shear needs
to be checked.

8. Repeat steps 2 through 7 until all the columns and capitals have been updated.
You can use the COPY button as a shortcut.

9. Press OK button to exit the dialog box so that pcaSlab will use the new data.

Defining Drop Panels slab

Drops are only available for the flat slab or waffle slab systems and can be defined
at all the support locations. The drop length and width dimensions are computed
by pcaSlab, based on slab span dimensions, when the "Standard" is selected in the
Type drop-down list.

To input drop geometry

1. Select the Supports command from the Input menu or click the £ button
then click on the Drop Panels tab. The dialog box of Figure 4-22 will appear.

Support Data &\

Columne  Drop Panels | Column Capitals | Transverse Beams | Boundary Candiions |

Left Fiight Thickness fin)
Suppott: T =] | Lenghify
Type [None - | width ity

I¥ Check punching shear around drop

Madify Copy.

Sup Mo [ Type |
1 None:

2 More
3 None
4 MNone

cooolr

[ [ [ Shear

R

0 ‘Yes
0

0

0

Yes
Yes
Yes

cooo|-
cooole
cooolg

ot | cacd | Hee |

Figure 4-22 Drop Geometry dialog box
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2. Select whether pcaSlab should compute the drop dimensions or the
dimensions will be user specified. If pcaSlab is to compute the dimensions,
the "Standard" option should be selected from the Type drop-down list and
then only the drop depth will be available. When the "Standard drop" option is
selected pcaSlab will calculate drop panel dimensions in accordance with ACI
318 Clause 13.3.7. Similar requirements contained in previous editions of the
CSA A23.3 Standard have been removed from the 1994 edition. As a result,
the ACI minimum specifications for drop panels are also used in CSA A23.3
runs when the "Standard Drops" option is selected. If you would like to
specify drop dimensions other than those computed by pcaSlab, you must
select "User-defined" from the Type drop-down list.

3. Enter the dimension in the direction of analysis from the column centerline to
the edge of the drop left of the column (see Figure 4-23). If this is a standard
drop, this dimension will not be available and the length left is set equal to the
slab span length left/6 for interior columns or the left cantilever length for the
first column.

| Direction
Column | of Analysis
I —_—
e
B —t———- \ _____
= % _@
\~, Drop
|
A i Plan
Length | Length
Left Right
| |
?J_l—’j Elev.
Thickness*

*measured from thinner slab

Figure 4-23 Required Drop Dimensions
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4. Enter the width dimension in the transverse direction (see Figure 4-23). If this
is a standard drop, this dimension will not be available and the width is set
equal to slab width/3.

5. In order for pcaSlab to recognize drops, drop depths are required for the flat
slab systems even if Standard Drop is selected. Enter the depth of the drop
from the span with the smaller slab depth (see Figure 4-23). For waffle slab
systems, the depth is automatically assumed to be equal to the rib depth below
the slab and is not displayed. A value entered will be considered to exist
below the rib depth during calculations.

6. Press the MODIFY button to update the drop geometry.

7. Repeat steps 2 through 6 until all the drop dimensions have been updated.
You can use the COPY button as a shortcut.

8. Press OK button to exit the dialog box so that pcaSlab will use the new drop
geometry.

Defining Column Capitals slablpcABeam

To input column capital geometry:

1. Select the Supports command from the Input menu or click the £ button on
the tool bar. Click left mouse button on the Column Capitals tab to activate
it. The dialog box of Figure 4-24 will appear.

Support Data g‘
Columns  Column Capitals: | Transverse Bears | Moment Redistibution | Boundary Conditons |
Support: 1 w| | Depthgn) 0

Side slope: ,U_
Sup Mo | Depth Side Slope
1 1} 1}
2 1} 1}
3 o [t}
4 1} 1}
ok | cacel | Heb |
Figure 4-24 Capital Dimensions
2. Select the support number from the Support drop-down list.
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3. Enter the capital depth which is the distance from the bottom of the soffit
(slab, drop, or beam), to the bottom of the capital.

4. The Side slope is the rate of depth to extension of the capital and it must be
greater than 1 and smaller than 50 (see Figure 4-25).

5. Enter the capital extension which is the distance from the edge of the column
to the end of the capital (see Figure 4-25).
Top of Slab
| /

| 1 |

%
KExtension

Depth

Figure 4-25 Required Capital Dimensions

Defining Transverse Beams €fablocfGeam
The Transverse Beam command allows you to input the width, depth, and offset
(eccentricity) of transverse beams at each column. This command is optional.

To input transverse beam geometry:

1. Select the Support command from the Input menu. Select Transverse
Beams tab from the Support Data dialog box. The dialog box of Figure 4-26
will appear.

Enter the width of the transverse beam (see Figure 4-27)

3. Enter the depth of the transverse beam which is taken from the top of the slab
to the bottom of the beam (see Figure 4-27)

4. Enter the eccentricity, which is measured from the joint centerline, positive to
the right, and negative to the left of the joint (See Figure 4-27).

5. Press the MODIFY button to update the transverse beam dimensions.
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6.

Repeat steps 2 through 5 until all the beams have been updated. You can use
the CoPY button as a shortcut (see "Entering the Structure Geometry" earlier
in this chapter for help on the COPY button).

Support Data g‘
Columns | Column Capitals  Transverse Beams | boment Riedistibution | Boundary Conditions |
Suppart: 1 - Width [in] 0 Offset [in] o

Depth [in) 0
Maodify Copy...
Sup No [ widih Depth Difset
1 a 0 a
2 a 0 o
3 i i i
4 a 0 1]
of | caedl | Hee |

Figure 4-26 Transverse Beam Geometry dialog box

Press OK button to exit the dialog box so that pcaSlab will use the new beam
geometry.

|
Top of Slab |
| \ ] |
{2 I I
|
I [ 1
> f <«<—Width
Depth ||
I 1
vy |
—>J|<— Ecc.
I I + right
— left
||
€1
Beam |
%
Column

Figure 4-27 Required Transverse Beam Dimensions
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Defining Boundary Conditions slablpcABeam

By default pcaSlab assumes that column-slab/beam joints can only rotate and that
they do not undergo any translational displacements. Rotation of a joint is affected
by the stiffness of elements it connects i.e. slabs/beams, transverse beams, and
columns. Columns are assumed by default to be fixed at their far ends as shown in
Figure 2-6. These default assumptions can be altered using the Boundary
Conditions command.

Support Data F‘S_<

Columne | Column Capitals | Transverse Beams | Mament Redistibution  Boundary Conditions |

Support Springs Far End

Support: 1 - Wertical Kz: |0 kip/in Column sbove: | Fixed -
Ruotation Ky |0 kip-infrad | Column Below: | Fixed hd

Madify Copy.

Sup. No [
1

[y [ FarEnd-Above | FarEnd Below |
0 Fired Fined
1) Fixed Fixed
0 Fired Fived
0 Fired Fined

cooolx

2
3
4

ot | cacd | Hee |

Figure 4-28 Boundary Conditions dialog box

By specifying vertical spring support constant with K, value other than 0, you can
allow the joint to displace vertically. This movement is then controlled by the
stiffness of the spring K, in addition to the stiffness of the column below. The
column above is assumed not to constrain the vertical movement of the joint.
Additional rotational spring support can be applied to the joint by specifying the
value of K,,. Also the far end column conditions can be selected as either fixed or
pinned as shown in Figure 4-29 (b). All elements controlling the displacements of
a joint are shown in Figure 4-29 (a).
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EI

Ky K
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777 /77 Fixed Pinned _A_

Figure 4-29 (a) Elements controlling joint displacement (b) Far End Column
Boundary Conditions

To input boundary conditions:

1. Select the Support command from the Input menu. Select Boundary
Conditions tab from the Support Data dialog box. The dialog box of Figure
4-28 will appear.

2. Select support number

3. Enter value of K, to allow vertical displacement of the support and to add
translational spring support (see Figure 4-29 (a))

Enter value of K., to add rotational spring support (see Figure 4-29 (a))

5. Select far end support conditions for the column above and below the joint
(see Figure 4-29 (b))

6. Press the MODIFY button to update the boundary conditions.

Repeat steps 2 through 5 until all the joints have been updated. You can use

the COPY button as a shortcut (see "Entering the Structure Geometry" earlier
in this chapter for help on the COPY button).

8. Press OK button to exit the dialog box so that pcaSlab will use the new
boundary condtions.

Defining Moment Redistribution Factors €fablocfGeam

This command is only available for beams/one-way slab systems when MOMENT
REDISTRIBUTION option is checked in the General Information dialog box.
To input boundary conditions:

1. Select the Support command from the Input menu. Select Moment
Redistribution tab from the Support Data dialog box. The dialog box of
Figure 4-30 will appear.
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Select support number

Enter the maximum value of the redistribution factors you want to allow on
the left and the right side of the support. Please note that actual value used is
determined by the program when the problem is being solved and that the
check against the code specified limit is also performed.

Press the MODIFY button to update the redistribution factor limits.

Repeat steps 2 through 5 until all the supports have been updated. Please note
that supports connecting to cantilevers will not be available since moment
redistribution is not allowed there. You can use the COPY button as a shortcut
(see "Entering the Structure Geometry" earlier in this chapter for help on the
COPY button).

Press OK button to exit the dialog box so that pcaSlab will use the new
moment redistribution limits.

3

Support Data
Colurnns | Column Capitals | Transverse Bearns  Moment Redistibution | Boundary Conditions |

Redistribution Limits [%]

Left E
e

o

Support:

Right:

tadify Copy...

Sup Mo | Let Fiight
1 0 0

2 Fi]
3 20
4 i i

ok | cacel | Heb |

Figure 4-30 Moment Redistribution dialog box

Defining Reinforcement Criteria for Slabs and Ribs

In order for pcaSlab to select the reinforcement, you must define the slab and rib
reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of

Reinforcement"

and "Reinforcement Selection"

a discussion of the reinforcement computations.

To define reinforcement Criteria for Slabs and Ribs:

slablpcfbeam

in Method of Solution for

Operating pcaSlab/pcaBeam

4-27



slab|pcfBeam

Select the Reinforcement Criteria command from the Input menu or click
the # button on the tool bar. Select Slabs and Ribs tab by clicking the left
mouse button on the tab title. The dialog boxes of Figure 4-31 will appear.

Reinforcement Criteria E\
Slabs and Ribs I Eeamg]
Top bars Bottom bars
Covver [in)
Clear. [1.5 1.5
Bar size
Minc |#5 - H5 -
Max:  |Ha - Ha -
Spacing [in)
Min: |1 1
Max |18 18
FRieint. ratio %]
Mirc {014 014
Max |5 5
There is more than 12 in of
concrete below top bars,
i3 Carcdl | Heb |

Figure 4-31 Slab and Rib Reinforcement dialog boxes

For slabs and ribs, enter the clear covers for top and bottom reinforcing bars.
For the top reinforcement, this distance is from the top of the slab to the top of
the top bars. For the bottom reinforcement, this distance is from the bottom of
the slab to the bottom of the bottom bars (see Figure 4-32). The default value
is 1.5 in. [40mm] for both input items.

Enter the minimum bar size to start the iteration for determining flexural
reinforcement.

Enter the maximum bar size. This number will be used as a stop in the
iteration for determining flexural bars in beams.

Enter minimum bar spacing for slab and rib flexural reinforcement. This
number should be based on aggregate size or detailing considerations. Default
spacing is 6 in. [150mm)] for slabs and ribs.

Enter maximum bar spacing for slab and rib flexural reinforcement. Default
spacing is 18 in. [S00 mm] for slabs and ribs.

Enter minimum Reinforcement Ratio for slab and rib flexural reinforcement.
Default ratio is 0.14% [0.20%]for slabs and ribs. If the user specified value is
smaller than 0.14%, 0.14% is used by pcaSlab. If the user specified value is
greater than 0.14%, the specified value is used by pcaSlab.
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Figure 4-32 Distance to Reinforcement Edges

8. Enter maximum Reinforcement Ratio for slab and rib flexural reinforcement.
Default ratio is 5% for slabs and ribs.
9. If the top bars have more than 12 in. [300 mm] of concrete below them, check
the corresponding check box.
10. Press OK button to exit the dialog box and allow pcaSlab to use the new data.
Defining Reinforcement Criteria for Beams €fablocfGeam

In order for pcaSlab to select the reinforcement, you must define the beam
reinforcement, bar sizes, location, and minimum spacing dimensions. See "Area of
Reinforcement” and "Reinforcement Selection" in the Method of Solution for a
discussion of the reinforcement computations.

To define reinforcement criteria for beams:

1.

Select the Reinforcement Criteria command from the Input menu or click
the * button on the tool bar. Select Beams tab by clicking the left mouse
button on the tab title. The dialog boxes of Figure 4-33 will appear.

Enter the covers for top and bottom reinforcing bars for beams. For the top
reinforcement, this distance is from the top of the slab to the centroid of the
top bars; and for the bottom reinforcement, this distance is from the bottom of
the slab to the bottom of the bottom bars (see Figure 4-34). The default value
is 1.5 in. [40mm] for both input items.

Enter the side cover which is measured from the side face of a beam to the
face of the stirrup (see Figure 2-20). The default value is 1.5 in [40 mm].

Enter the minimum bar size for top and bottom bars and stirrups to start the
iteration for determining flexural reinforcement.

Enter the maximum bar size for top and bottom bars and stirrups. This number
will be used as a stop in the iteration for determining flexural bars in beams.
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Enter the minimum bar spacing for beam flexural reinforcement and stirrups.
This number should be based on aggregate size or detailing considerations.
The default minimum reinforcement bar spacing is 1 in. [25 mm] and the

default stirrup spacing is 6 in. [150 mm]

Reinforcement Criteria

Slabs and Aibs  Beams |

Top bars Battam bars Stirmups

Cover [in] Side Cover (in]

Clear. ,157 ,157 Clear: ’157
Bar size: Bar size

M [#s ] Jus ] M |83 =

Mar [ws ] [we ] Max |45 =
Spacing [in) Spacing (in]

we T | M 5

wa B fE | M B
Fieint. ratio (%] Number of legs

N ST i R |

wee - F | W f =

St R

o]

Cancel ‘ Help ‘

Figure 4-33 Reinforcement dialog boxes

Enter the maximum bar spacing for beam flexural reinforcement and stirrups.
The default maximum reinforcement spacing is 18 in. [S00 mm] and the
default maximum stirrup spacing is 18 in. [450 mm]

Enter the minimum Reinforcement Ratio for beam flexural reinforcement.
Default ratio is 0.14% [0.20%] for beams. If the user specified value is
smaller than 0.14%, 0.14% is used by pcaSlab. If the user specified value is
greater than 0.14%, the specified value is used by pcaSlab.

_Jl/__ _Jl/__

distance to
_j'

{top reinforcement

I{ ?
distance to
bottom reinforcement JI/‘

_Jl/__ i

Figure 4-34. Distance to Reinforcement

Enter the maximum Reinforcement Ratio for beam flexural reinforcement.
Default ratio is 5% for beams.
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10. Enter the clear distance between bar layers to use if the program needs to
distribute flexural bars in multiple layers. Default distance is 1 in. [30 mm] for
beams.

11. If the top bars have more than 12 in. [300 mm] of concrete below them, check
the corresponding check box.

12. Press OK button to exit the dialog box and allow pcaSlab to use the new data.

Defining Column Strip Bars for Two-Way Slab Systems slab

The reinforcing bar size, number of bars, bar length, etc. can be defined by users if
the Run Mode of Investigation and two-way floor system are selected in the
General Information dialog box. This menu item is not available if Run Mode of
Design is selected in the General Information dialog box.

To define column strip bars:

1. Select Reinforcing Bars from the Input menu or click the ¥ button on the
tool bar. Select the Column Strip Bars tab by clicking the tab title or use the
tab key on the keyboard to toggle to the tab title then select the Column Strip
Bars tab using the arrow keys. The dialog boxes of Figure 4-35 will appear.

Reinforcing Bars &‘

Calurnin Strip Bars 1 Middie Stiip Bars | Beam Bars | Beam Stirups |

Barsize |85 | Mo.ofbas |4 Length iy [3.7439
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Span3 ’m Cove [in) 1.5
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Size | Type | Count | Caver | Length ‘ Start
HE Topl 4 15 374987

Ha TopL
H5 TopR
i) TopR
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=R,

15
15
15
15
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Figure 4-35 Defining Column Strip Bars

2. Select the span for which reinforcing bars will be defined from the Span list
box on the upper left corner. The length of the selected span will be shown
right above the ADD button.

3. Select bar size from the Bar Size drop-down list.
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10.

11.

12.

Define the number of reinforcing bars in the selected span by entering the
number in the Number of Bars input box.

Define the length of the reinforcing bars by entering the length in the Length
input box. The unit of the length is foot [m].

Define the types of the reinforcing bars in the selected span by selecting from
the Type drop-down list, which is right below the Bar Size drop-down list.
Five types are available: Top Left, Top Right, Top Continuous, Bottom
Continuous and Bottom Discontinuous.

Define the cover by entering the number in the Cover input box. The unit of
cover is inch [mm)].

Press ADD button to add the new data into the list box below the buttons.

Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use
the SPAN COPY button below the Span list to simply copy the data of one span
to other spans.

If the reinforcing data of a span needs to be modified, select the data from the
data list box on the lower part of the dialog box then modify the data as
mentioned above. Press MODIFY button when finished to update the
corresponding data in the data list box.

To delete the reinforcing data for a span, select the data of the span from the
data list box then press the DELETE button.

Press OK button to exit the dialog box so that pcaSlab will use these
reinforcing bar properties.

Defining Middle Strip Bars for Two-Way Slab Systems slab

The reinforcing bar size, number of bars, bar length, etc., can be defined by users
if the Run Mode of Investigation and two-way floor system are selected in the
General Information dialog box. This menu item is not available if Run Mode of
Design is selected in the General Information dialog box.

To define middle strip bars:

1.

Select Reinforcing Bars from the Input menu or click the ¥ button on the
tool bar. Select the Middle Strip Bars tab by clicking the tab title or use the
tab key on the keyboard to toggle to the tab title then select the Middle Strip
Bars tab using the arrow keys. The dialog boxes of Figure 4-36 will appear.
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Figure 4-36 Defining Middle Strip Bars

2. Select the span for which reinforcing bars will be defined from the Span list
box on the upper left corner. The length of the selected span will be shown
right above the ADD button.

3. Select bar size from the Bar Size drop-down list.

Define the number of reinforcing bars in the selected span by entering the
number in the Number of Bars input box.

5. Define the length of the reinforcing bars by entering the length in the Length
input box. The unit of the length is foot [m].

6. Define the Types of the reinforcing bars in the selected span by selecting from
the drop-down list, which is right below the Bar Size drop-down list. Five
types are available: Top Left, Top Right, Top Continuous, Bottom Continuous
and Bottom Discontinuous.

7. Define the cover by entering the number in the Cover input box. The unit of
cover is inch [mm].

8. Press ADD button to add the new data into the list box below the buttons.

9. Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use
the SPAN COPY button below the Span list to simply copy the data of one span
to other spans.

10. If the reinforcing data of a span needs to be modified, select the data from the
data list box on the lower part of the dialog box then modify the data as
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mentioned above. Press MODIFY button when finished to update the
corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the
data list box then press the DELETE button.

12. Press OK button to exit the dialog box so that pcaSlab will use these
reinforcing bar properties.

Defining Beam Bars for Two-Way Slab Systems slab

The reinforcing bar size, number of bars, bar length, etc. can be defined by users if
the Run Mode of Investigation and two-way floor system are selected in the
General Information dialog box. This menu item is not available if Run Mode of
Design is selected in the General Information dialog box.

To define beam bars:

1. Select Reinforcing Bars from the Input menu or click the ¥ button from the
tool bar. Select the Beam Bars tab by clicking the tab title or use the tab key
on the keyboard to toggle to the tab title then select the Beam Bars tab using
the arrow keys. The dialog boxes of Figure 4-37 will appear.

Reinforcing Bars &‘
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Figure 4-37 Defining Beam Bars

2. Select the span for which reinforcing bars will be defined from the Span list
box on the upper left corner. The length of the selected span will be shown
right above the ADD button.

3. Select bar size from the Bar Size drop-down list.

4-34

Operating pcaSlab/pcaBeam



slabloc/Beam

4. Define the number of reinforcing bars in the selected span by entering the
number in the Number of Bars input box.

5. Define the length of the reinforcing bars by entering the length in the Length
input box. The unit of the length is foot [m].

6. Define the types of the reinforcing bars in the selected span by selecting from
the Type drop-down list, which is right below the Bar Size drop-down list.
Five types are available: Top Left, Top Right, Top Continuous, Bottom
Continuous and Bottom Discontinuous.

7. Define the cover by entering the number in the Cover input box. The unit of
cover is inch [mm)].

8. Press ADD button to add the new data into the list box below the buttons.

Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use
the SPAN COPY button below the Span list to simply copy the data of one span
to other spans.

10. If the reinforcing data of a span needs to be modified, select the data from the
data list box on the lower part of the dialog box then modify the data as
mentioned above. Press MODIFY button when finished to update the
corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the
data list box then press the DELETE button.

12. Press OK button to exit the dialog box so that pcaSlab will use these
reinforcing bar properties.

Defining Beam Stirrups for Two-Way Slab Systems slab

The stirrup size, number of stirrups, etc. can be defined by users if the Run Mode
of Investigation and two-way floor system are selected in the General
Information dialog box. This menu item is not available if Run Mode of Design
is selected in the General Information dialog box.

To define beam stirrups:

1. Select Reinforcing Bars from the Input menu or click the ¥ button from the
tool bar. Select the Beam Stirrups tab by clicking the tab title or use the tab
key on the keyboard to toggle to the tab title then select the Beam Stirrups
tab using the arrow keys. The dialog boxes of Figure 4-38 will appear.
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10.

11.
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Figure 4-38 Defining Beam Stirrups

Select the span for which stirrups will be defined from the Span list box on
the upper left corner. The length of the selected span will be shown right
above the ADD button.

Enter the amount of stirrups of the selected span in the Count input box. (see
Note)

Select stirrup size from the Size drop-down list.

Enter the spacing of the stirrups of the selected span in the Spacing input box.
The unit of spacing is inch [mm].

Enter the number of legs in the Leg input box.

Press ADD button to add the new data into the list box below the buttons.

Repeat steps 2 to 8 to define stirrups for all the spans. You may use the Span
CoPY button below the Span list to simply copy the data of one span to other
spans.

If the stirrup data of a span needs to be modified, select the data from the data
list box on the lower part of the dialog box then modify the data as mentioned
above. Press MODIFY button when finished to update the corresponding data
in the data list.

To delete the stirrup data for a span, select the data of the span from the data
list box then press the DELETE button.

Press OK button to exit the dialog box so that pcaSlab will use these
reinforcing bar properties.
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Note: If stirrups do not apply in a part of a span, the Count should be set to 0
(zero) and the Spacing should be the length of the part of the span where no
stirrups are defined. For example, the following configuration shows stirrups in the
left and right ends of a span with an empty space (46.0 in. long, no stirrups) in the

middle part of the span.

Count Bar Size Spacing Legs
32 #5 4.50 2
0 #5 46.0 2
32 #5 4.50 2

Defining Flexure Bars for Beams and One-WaySlab Systems

slablpcfbeam

The reinforcing bar size, number of bars, bar length, etc. for one-way beam
systems can be defined by users if the Run Mode of Investigation and beams/one-
way slab floor system are selected in the General Information dialog box. This
menu item is not available if Run Mode of Design is selected in the General

Information dialog box.
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Figure 4-39 Defining Flexure Bars for Beams/One-Way slab Systems

To define flexure bars for beam in beams/one-way slab systems follow the steps

described in section Defining Beam Bars.
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Defining Stirrups for Beams and One-Way Slab Systems slablpcABeam

The stirrup size, number of stirrups, etc. for beams/one-way slab systems can be
defined by users if the Run Mode of Investigation and beams/one-way slab floor
system are selected in the General Information dialog box. This menu item is not
available if Run Mode of Design is selected in the General Information dialog
box.
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Figure 4-40 Defining Beams Stirrups in Beams/One-Way Slab Systems

To define beam stirrups in beams/one-way slab systems follow the steps described
in section Defining Beam Stirrups.

Defining Torsional Longitudinal Bars for Beams SlablpcABeam

The torsional longitudinal reinforcement bars are distributed along the perimeter of
the section in addition to the flexure bars. They can be defined by users if the Run
Mode of Investigation, beams/one-way slab floor system, and torsional analysis
and design are selected in the General Information dialog box. This menu item is
not available if Run Mode of Design is selected in the General Information
dialog box.

To define torsional longitudinal bars for beams in beams/one-way slab systems:

1. Select Reinforcing Bars from the Input menu or click the T button from the
tool bar. Select the Torsion Bars tab by clicking the tab title or use the tab
key on the keyboard to toggle to the tab title then select the Torsion Bars tab
using the arrow keys. The dialog boxes of Figure 4-41 will appear.

4-38

Operating pcaSlab/pcaBeam



slab|pcfBeam

10.

Reinforcing Bars
Flexwue Bars | Beam Stirups  Torsion Bars |

Span 2
Spana

—
—

H3

Bar size: > Mo, of hars:

Continuous hd

Span=291

Cower [in)

Span Copy. | Add ‘ Modity | Delete |

Size | Type | Count [ Cover | Lenath [ Start

of | caedl | Hee |

Figure 4-41 Defining Torsion Bars for Beams in Beams/One-Way Slab
Systems

Select the span for which reinforcing bars will be defined from the Span list
box on the upper left corner. The length of the selected span will be shown
right above the ADD button.

Select bar size from the Bar Size drop-down list.

Define the type of the reinforcing bars in the selected span by selecting from
the Type drop-down list, which is right below the Bar Size drop-down list.
Two types are available: Continuous and Discontinuous.

Define the number of reinforcing bars in the selected span by entering the
number in the Number of Bars input box.

Define the cover by entering the number in the Cover input box. The unit of
cover is inch [mm)].

For discontinued bars, define the length and the starting point of the
reinforcing bars by entering the values in the Start and Length input boxes.
The unit of both is foot [m].

Press ADD button to add the new data into the list box below the buttons.

Repeat steps 2 to 8 to define reinforcing bars for all the spans. You may use
the SPAN COPY button below the Span list to simply copy the data of one span
to other spans.

If the reinforcing data of a span needs to be modified, select the data from the
data list box on the lower part of the dialog box then modify the data as
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mentioned above. Press MODIFY button when finished to update the
corresponding data in the data list.

11. To delete the reinforcing data for a span, select the data of the span from the
data list box then press the DELETE button.

12. Press OK button to exit the dialog box so that pcaSlab will use these
reinforcing bar properties.

Defining Load Cases slablpcBeam
Up to 6 load cases of dead load, live load or lateral load can be defined in the
Load Cases dialog box. The default five load case labels (types) are SELF (dead
load), Dead (dead load), Live (live load), Wind (wind load), and EQ (seismic
load).

To define load cases:

1. Select Load Cases command from the Input menu or click the = button on
the tool bar. Dialog box as in Figure 4-42 will appear.

Load Cases &‘

Label: [SELF Type: |DEAD =l

agd | ‘

Label [ Type
SELF DEAD
Dead DEAD
Live LIVE
Wind LATERAL
EQ LATERAL

K Cancel | Heb |

Figure 4-42 Defining Load Cases
2. Enter a name for the new load case in the Label edit box. The name could be
any character string defined by the user.

3. Select the type of the new load case from the Type drop-down list. The
available types are Dead Load, Live Load and Lateral Load.

4. Press ADD button to add the new load case into the load case list box on the
lower part of the dialog box.

4-40 Operating pcaSlab/pcaBeam



slab|pcfBeam

Repeat steps 2 to 4 to define all the load cases. The maximum number of load
cases is 6. Once the maximum number is reached, the ADD button will be
disabled.

To modify an existing load case, select the load case from the load case list
box then change the label or type the selected load case as mentioned above
and press the MODIFY button.

To delete an existing load case, select the load case from the load case list box
then press the DELETE button.

Press OK button to exit the dialog box so that pcaSlab will use these load
cases.

Note: Only one case of live load can be defined. Load case label must be unique
for each of the load cases.

Defining Load Combinations slablpcABeam

pcaSlab allows you to change the magnification factors applied to the load cases.
The default values depend on the code selected with the General Information
command.

To define load factors:

1.

Select Load Combinations from the Input menu or click the * button from
the tool bar. The dialog box of Figure 4-43 will appear if the ACI code was
selected in the GENERAL INFORMATION dialog box.
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Figure 4-43 Define Load Combinations
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2. The load cases and the corresponding factors that are defined in the Load
Cases dialog box are shown on the top of the Load Combinations dialog box.

3. Enter the load factors for each of the load cases in the input box below the
corresponding load case label.

4. Press the ADD button to add the combination defined above into the big list
box in the lower part of the dialog box.

5. Repeat steps 2 to 4 to define all the load combinations. Up to twenty load
combinations may be defined. All the combinations are indexed automatically
from Ul to U20.

6. To change the factors of an existing combination, select the load combination
from the load combination list box on the lower part of the dialog box then
change the factors as mentioned above. Press the MODIFY button when
finished to update the data in the load combination list box.

7. To delete an existing combination, select the load combination from the load
combination list box then press the DELETE button.

8. Select OK button when all the desired load factors have been modified to exit
so that pcaSlab will use the new data.

Span Loads sTablocfBeam

pcaSlab computes the self weight of the floor system. Other loads applied to the
structure have to be specified by the user. There are several types of applied loads
that may be entered. They are found in the Input menu. Surface loads are placed
over the entire strip. Partial loads consist of uniform or trapezoidal loads,
concentrated loads, and concentrated moments that may exist anywhere within the
span length. For beams/one-way slab systems torsional loads can be defined either
as concentrated or distributed torques.
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Figure 4-44 Span Load Types
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Note: The loads shown in the Figure 4-44 are all positive and may not match the
typical sign conventions.

The following table describes input for the span load types shown in Figure 4-44.

W, For uniformly distributed loads, W, is the intensity of the load
in units of 1bs/ft [kN/m], positive W, is downward. For
trapezoidal loads, W, is the intensity at the left end in units of
Ibs/ft [kN/m], positive W, is downward. For concentrated
force, W, is the force P in units of kips [kN], positive W, is
downward. For concentrated moments, W, is the moment M
in units of ft-kips [kN-m], positive W, is clockwise. For
concentrated torque, W, is the external torque T in units of ft-
kips [kN-m], positive W, is such that applying the right hand
screw rule the torque vector points to the right. For distributed
torque, W, is the external torque intensity T, in units of ft-
kips/ft [kKN-m/m], positive W, is such that applying the right
hand screw rule the torque vector points to the right.

W For trapezoidal loads, W,, is the intensity at the right end in
units of lbs/ft [kN/m], positive W}, is downward. For
distributed torque, Wj, is the external torque intensity T, in
units of ft-kips/ft [kN-m/m], positive W, is such that applying
the right hand screw rule the torque vector points to the right.
For all the other partial load types, Wy, is not available.

L, For distributed loads, L, is the distance where the load begins
from the centerline of the column at the left of the span, in
units of ft [m]. For concentrated loads and moments, La is the
distance where the load exists from the centerline of the
column at the left of the span in units of ft [m].

Ly For distributed loads, Ly, is the distance where the load ends
from the centerline of the column at the left of the span, in
units of ft [m]. For concentrated loads and moments, L, is
unavailable.

Note: Although the particular loading may not actually act
over the entire transverse width, all line loading is converted
internally by pcaSlab to act over the full width of the slab. In
the design direction, partial loads given as acting over less
than 1/20 of the span length will be averaged over 1/20 by the
program.
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Defining Area Load on Span slablpcABeam

Area loads are uniform loads acting over the entire strip. These loads have units of
1b/ft* [kN/m?].

To input area loads:

Select the Span Loads command from the Input menu or click the = button
on the tool bar. Select the AREA LOAD from the TYPE drop-down list on the
SPAN LOADS dialog box. The dialog box of Figure 4-45 will appear.
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Figure 4-45 Defining Area Load on Span

Select the load case from the CURRENT CASE list box on the upper left corner
as shown in the dialog above.

Select the span on which the area loads will be applied from the SPAN drop-
down list.

Enter the un-factored superimposed area load magnitude acting over the entire
area of the strip in the Magnitude edit box. Positive surface loads act
downward.

Press the ADD button to update the area loads in the area load list box on the
lower part of the dialog box.

Repeat steps 2 through 5 until the loads have been updated. You can use the
CoPY button as a shortcut.

To change the data of an existing area load, select the area load from the area
load list box then change the magnitude as mentioned above. Press the
MODIFY button when finished to update the data in the area load list box.
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8. To delete an existing area load, select the load from the area load list box then
press the DELETE button.

9. Press OK button to exit the dialog box so that pcaSlab will use the new data.

Defining Line Load on Span slablpcBeam
You may enter uniform or trapezoidal loads that do not span from column
centerline to column centerline in the direction of analysis. These loads are called
line loads and are input through the SPAN LOADS dialog of the Input menu. Partial
loads are assumed to act over the entire strip width.

To input line loads:

1. Select the Span Loads command from the Input menu or click the = button
on the tool bar. Select the LINE LOAD from the TYPE drop-down list. The
dialog box of Figure 4-46 will appear.
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Figure 4-46 Defining Line Load on Span
2. Select the load case of the line load that will be defined from the Current
Case list box.

3. From the Span drop-down list, select the span number of the span whose line
loads you would like to input.

4. Define un-factored load values and their locations in the corresponding text
boxes.

5. Select Add to add the line load defined into the line load list box.

6. Repeat steps 2 through 5 until all the line loads have been entered then press
OK button to exit the dialog box so that pcaSlab will use the new loads.
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To change line loads data:

1. Select the line load you want to change from the line load list box on the
lower part of the dialog box by clicking the left mouse button on the load or
tabbing to the list box and using the arrow up and down keys.

2. Make your changes to the load by modifying the load type, the load
magnitude, and/or location.

3. Select Modify to replace the old data with the new data.
To delete line load data:
1. Select the line load you want to delete from the line load list box by clicking

the left mouse button on the load or tabbing to the list box and using the arrow
up and down keys.

2. Press the DELETE button.

Defining Point Force on Span slablpcABeam

You may enter concentrated vertical loads. These loads are input through the Span
Load command of the Input menu. Point loads are assumed to act over the entire
strip width.

To input point loads:

1. Select the Span Loads command from the Input menu or click the = button
on the tool bar. Select the Point Force from the Type drop-down list. The
dialog box of Figure 4-47 will appear.

Span Loads rg|

Current Case,

Span: [1 | Copy Magritude: [1167 kip
Live J
ATl Foint Farce Locatior: [0 it
Span=251

Case Cope.. | add | Mody | el |

Span Mo. [ Tupe [ wa [La [ wh [Le
1 Line Load 1167 a 1167 25
2 Line Load 1167 o 1167 15
3 Line Load 1167 o 1167 20

oK Cancel | Hep |

Figure 4-47 Defining Point Forces on Span
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2. Select the load case of the point force that will be defined from the Current
Case list box.

3. From the Span drop-down list, select the span number of the span whose
point loads you would like to input.

4. Define un-factored load values and their locations in the corresponding text
boxes.

5. Select Add to add the point load defined into the point load list box on the
lower part of the dialog box.

6. Repeat steps 2 through 5 until all the point loads have been entered then press
OK button to exit the dialog box so that pcaSlab will use the new loads.

To change point load data:
1. Select the point force you want to change from the point load list box by

clicking the left mouse button on the load or tabbing to the list box and using
the arrow up and down keys.

2. Make your changes to the load by modifying the load type, the load
magnitude, and/or location.

3. Select Modify to replace the old data with the new data.
To delete point load data:
1. Select the point force you want to delete from the point load list box to the

right by clicking the left mouse button on the load or tabbing to the list box
and using the arrow up and down keys.

2. Press the DELETE button.

Defining Point Moment on Span €fablocfGeam
You may enter concentrated moment. This load is input through the Span Load
command of the Input menu. Point moments are assumed to act over the entire
strip width.

To input point moments:

1. Select the Span Loads command from the Input menu or click the # button
on the tool bar. Select the Point Moment from the Type drop-down list. The
dialog box of Figure 4-48 will appear.
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Figure 4-48 Defining Point Moments on Span
2. Select the load case of the point moment that will be defined from the
Current Case list box.

3. From the Span drop-down list, select the span number of the span whose
point moments you would like to input.

4. Define un-factored moment values and their locations in the corresponding
text boxes.

5. Select Add to add the point moment defined into the point moment list box on
the lower part of the dialog box.

6. Repeat steps 2 through 5 until all the point moments have been entered then
press OK button to exit the dialog box so that pcaSlab will use the new
moments.

To change point load data:
1. Select the point moment you want to change from the point moment list box

by clicking the left mouse button on the load or tabbing to the list box and
using the arrow up and down keys.

2. Make your changes to the moment by modifying the moment type, the
moment magnitude, and/or location.

3. Select Modify to replace the old data with the new data.
To delete point load data:
1. Select the point moment you want to delete from the point moment list box to

the right by clicking the left mouse button on the load or tabbing to the list
box and using the arrow up and down keys.
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2. Press the DELETE button.

Defining Line Torque on Span

slablpcfbeam

You may enter line torque for beams/one-way slab systems if Torsion Analysis
and Design is selected in the GENERAL INFORMATION dialog box. This load is
input through the Span Load command of the Input menu.

To input line loads:

1. Select the Span Loads command from the Input menu or click the = button
on the tool bar. Select the LINE TORQUE from the TYPE drop-down list. The
dialog box of Figure 4-49 will appear.

Span Loads

Current Case,

Live

Case Copy. |

Start End

Span: |1 +| Copy Magritude: [1167 167

RECE i Torque
Span=25 1t

add | Mody | Dele |

X

ke-ft

Location: |0 28 it

SpanMo. | Tupe [ wa [La [ wh [Ls

1 Line Load 167 1} 1167 25
2 Lire Load 167 o 1167 185
3 Line Load &7 1} 1167 20

——

Cancel |

Help

Figure 4-49 Defining Line Torque on Span

2. Select the load case of the line load that will be defined from the CURRENT

CASE list box.

3. From the SPAN drop-down list, select the span number of the span whose line
loads you would like to input.

4. Define un-factored torque values and their locations in the corresponding text

boxes.

5. Select Add to add the line torque defined into the list box.

6. Repeat steps 2 through 5 until all the line torques have been entered. Then
press OK button to exit the dialog box so that pcaSlab will use the new loads.

To change line torque data:
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3.

Select the line torque you want to change from the load list box on the lower
part of the dialog box by clicking the left mouse button on the load or tabbing
to the list box and using the arrow up and down keys.

Make your changes to the load by modifying the load type, the load
magnitude, and/or location.

Select Modify to replace the old data with the new data.

To delete line torque data:

1.

2.

Select the line torque you want to delete from the load list box by clicking the
left mouse button on the load or tabbing to the list box and using the arrow up
and down keys.

Press the DELETE button.

Defining Point Torque on Span slablocfBeam

You may enter point torque for beams/one-way slab systems if Torsion Analysis
and Design is selected in the GENERAL INFORMATION dialog box. This load is
input through the Span Load command of the Input menu.

To input point torque:

1.

Select the Span Loads command from the Input menu or click the = button
on the tool bar. Select the POINT TORQUE from the TYPE drop-down list. The
dialog box of Figure 4-50 will appear.

Select the load case of the point torque that will be defined from the CURRENT
CASE list box.

From the SPAN drop-down list, select the span number of the span whose
point moments you would like to input.

Define un-factored torque values and their locations in the corresponding text
boxes.

Select ADD to add the point torque defined into the list box on the lower part
of the dialog box.

Repeat steps 2 through 5 until all the point torques have been entered. Then
press OK button to exit the dialog box so that pcaSlab will use the new
torques.
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Figure 4-50 Defining Point Torque on Span
To change point torque data:

1. Select the point torque you want to change from the list box by clicking the
left mouse button on the load or tabbing to the list box and using the arrow up
and down keys.

2. Make your changes to the moment by modifying the torque magnitude, and/or
location.

3. Select MODIFY to replace the old data with the new data.
To delete point load data:
1. Select the point moment you want to delete from the point moment list box by

clicking the left mouse button on the load or tabbing to the list box and using
the arrow up and down keys.

2. Press the DELETE button.

Defining Support Loads and Displacements Sfablpc6eam

You may enter prescribed support displacements and rotations as well as apply
concentrated forces and moments to the system at support locations. These loads
are input through the Support Loads and Displacements command of the Input
menu.

To input support loads and displacements:
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1.

Select the Support Loads and Displacements command from the Input
menu or click the ¥ button on the tool bar. The dialog box of Figure 4-51 will
appear.

Support Loads and Displacements

Cunent Case,

Live

Support:

T [ -

Displacement/Hotation

Dz |0 in
Ry |0 rad

)
Force/Moment:

Fz |0 kip
My |0 keft

Hodify Copy.

Supp No. [Dz [ Ry [

K=

-t —
scocoo|o
cocoo|n
socoo|m

.

cooolz

Cancel |

Help

Figure 4-51 Defining Support Loads and Displacements
Select the load case of the support loads and displacements that will be
defined from the CURRENT CASE list box.

From the SUPPORT drop-down list, select the support number of the support
whose loads you would like to input.

Define un-factored values of the displacement, rotation, forces, and moment.
Select Add to add the support loads and displacements defined into the load
list box on the lower part of the dialog box.

Repeat steps 2 through 5 until all the support loads and displacements have
been entered then press OK button to exit the dialog box so that pcaSlab will
use the new moments.

To change support and displacement loads data:

1.

2.
3.

Select the entry you want to change from the load list box by clicking the left
mouse button on the load or tabbing to the list box and using the arrow up and
down keys.

Make your changes to the values.
Select Modify to replace the old data with the new data.

To delete support and displacement load data:
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2.

Select the entry you want to delete from the load list box by clicking the left
mouse button on the load or tabbing to the list box and using the arrow up and
down keys.

Press the DELETE button.

Defining Lateral Effects sfablpcfBeam

pcaSlab can combine the gravity load analysis with a lateral load analysis. Lateral
loads are entered as joint moments obtained elsewhere by a frame analysis. The
joint moments are combined with the gravity load moments to produce load
patterns 5 through 8.

To input lateral load moments:

1.
2.

Define at least one lateral load case from the Load Cases dialog box.

Select Lateral Effects from the Input menu. If no lateral case is defined this
command is disabled. Once selected, Figure 4-52 will appear.

Lateral Load Effects El

Current Case:

Span: 1 ~| Homentatleft: |0 keft
Homent at right: |0 keft

Modify Copy.

Span Mo. [ Mieit | Mright
1 i i
2 0 i
3 i i

oK Carcel | Hep |

Figure 4-52 Lateral Moment dialog box

Select load cases from the CURRENT CASE list box. At least one lateral load
case must be defined in the LOAD CASES dialog box before you can see the
load case in the CURRENT CASE list box.

Select span number on which lateral loads will be defined from the SPAN
drop-down list.

Enter the moments at the left end and right end of the span in the Moment at
Left and Moment at Right input boxes, respectively.
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6. Press the ADD button to add the lateral load defined above into the lateral load
list box in the lower part of the dialog box.

7. Repeat steps 2 through 5 to define all the lateral loads.

8. To change an existing lateral load, select the load from the lateral load list box

then change the moments as mentioned above. Press the MODIFY button when
finished to update the data in the lateral load list box.

9. To delete an existing lateral load, select the load from the lateral load list box
then press the DELETE button.

10. Select OK button when all the desired lateral loads have been modified to exit
so that pcaSlab will use the new data.

Executing Calculations (menu Solve) SlablocBam
Execute €fablocfGeam

The Execute command starts the design portion of pcaSlab after you have finished
inputting all the data.

To design the system:

Select the Execute command from the Solve menu or click the % button on the
tool bar. If any data required to analyze and design the system has not been input
prior to executing this command, pcaSlab will display an "Invalid model!"
message. You must complete the data before execution.

An analysis status window shows the current state of the execution as shown in
Figure 4-53. If the state of each of the computations is OK, the analysis is
successful. If any error is encountered ERROR will be shown and the computation
is terminated.

Analysis ﬁ‘

Status: Finished.

Puriching shear check oK ~
Envelaping internal forces oK
Combiriing inemal forces oK
Punching shear check 0K
Enveloping internal forces oK
Extracting support reactions i[3
Input validation oK
Flexual design oK.
Shear design oK
Flexural investigation oK
Sheat investigation oK
Frame analysis (DEAD, cracked) 0K
Extiacting deflections oK
Fiame analysis (TOTAL, cracked) oK

v

Close

Figure 4-53 Analysis Status Window
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Viewing Results Report slablocBeam

Once the analysis and/or design is performed, you can view the results, shear and
moment diagrams, and deflected shapes. This section provides procedures
performing these functions.

To view the analysis and design results:

1. Select Report command from the Solve menu or click the ® button from the
tool bar. A dialog box similar to Figure 4-54 will appear.

Il Results Report |;‘@
Close sekctal | Cop | it | [i21Design Rests =] 23tines

[[1]Input Echa

[2] DESIGH REZULTS 2] Colurnn Aial Forces and Moments
4] Intemal Forces - Load Cases =====z====zz===a:
5] Intemal Forces - Load Combinations

Moment Redistribution Factors: £] Internal Forees - Envelopes
7] Deflections

Customize...

Units: Org.Mu (k-ft)

Caloulated _ User_ _hpplied

Supp  Side Org.Mu Iter.f EpsilonT Factor(#] Limit[%] Factor[s]
1 might 83.53 7 0.01796 17.36 0.00 0.00

z Lefn 91,92 £ 0.01526 15,26 zo. o0 1526

z Bight 41.57 z 0.04163 z0.00 zo.00 zo.00

3 Lefn 32.97 z 0.05368 z0.00 zo. 00 z0.00

3 Bight £7.z1 z  0.0z803 z0.00 zo.00 zo.00

4 Left 49.30 Z 0.03446 z0.00 0.00 0.00

Univs: Wideh (fv), Mmax (s-ft), Xmax (ft), As (in"2), Sp (in)
Span Zone Width Mmax Mmax  AsMin  AsMax SpRey  AsReg  Bars v
< >

Figure 4-54 View and Print Results dialog box

2. Select the results you want to view from the drop-down list. The contents of
the results box will be changed based on your selection. The Customize
option allows for more than one result selection to be viewed in the results
report.

3. Press the COPY button to copy the current results into the Windows clipboard.
Then you may use CTRL + V to paste the contents of the clipboard to any
other editors such as Word or Notepad.

4. Press the CLOSE button to close the result dialog box.

Saving Results Report slablpcABeam

Analysis and design results are automatically saved to a text file named
"projectname.out" in the same folder as the project data file (.slb file). The
contents of the .out file depends on which option is selected from the drop-down
list on the Results Report dialog box.
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For example, if the project name is "Example 1 - FlatPlate (ACI Note)" and Input
Echo is selected from the Results Report dialog box as shown in Figure 4-55,
atext file named "Example 1 - FlatPlate (ACI Note).out" is generated
automatically in the same directory as "Example | - FlatPlate (ACI Note).slb".

Il Results Report
Cose | Sekcial | com | i | 195 lines
~
[1] INPUT ECHO 3
: C:yProgram Files\PCA\peoaSlabiErauplesiManualiExample 1 - PCA Notes on ACTI 318-C
Project: peaSlab/pcaPesw Mawual, Example 1 -
Frame: PCA Motes on ACI 218-0&, Example 8-Z
EIngineer: poastructurePoint
Code: ACI 218-0F&
Reinforcement Database: ASTM AGLS
Mode: Desigm
Humber of supports = 4
Floor System: One-Way/Beau
Liwve load pattern ratio = 100%
Deflections are based on cracked section properties.
In negative moment regions, Tg ond Mer DO NOT inelude flange/slsbh comtribucion (if awailak
Long-tern deflections are calculated for load duratien of 60 months.
0% of liwe load is sustained. ~
< | >

Figure 4-55 Input Echo is selected from Results Report dialog box
The file "Example 1 - FlatPlate (ACI Note).out" is a pure text file and can be

Fle Edt View Insert Format Help
Ded Sk # [
[1] INPUT ECHO
Project: Example 1 (PCA Notes 22.1)
Frame: Interior
Engineer: peaStructurePaint
Code: ACI 318-05
Reinforcement Database: ASTH 4615
Hode: Design
Nurber of supports = 4 + Left cantilever + Right cantilever
Floor System: Two-Uay
Live load pattern racio = 75%
Hinimum free edge for punching shear = 4 times slab thickness
Deflections are based on cracked section properties.
In negative moment regions, Ig and Mer DO NOT include flange/slab contribution (if available)
Long-term deflections are caleulated for load duration of 60 months.
0% of live load is sustained.
Compression reinforcement caleulations NOT selected.
Material Properties:
Columns
we o= 150 1b/1e3
e = 1
e = 3834.3 4696 kai
&= = 0.474342 0.58095 ksi
1y = 60 ksi, Bars are not epoxy-coated
fye = 60 ksi v
< 2
For Help, press F1 [

Figure 4-56 Output file is opened using Wordpad
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Note: Once another option is selected from the Results Report dialog box, the
contents of the .out file is changed based on the selection.

Output files (.out file) may not be in proper format if opened using Microsoft
Notepad. Please use Word or Wordpad.

View Program Output (menu View) sfablocA6eam

Zooming in on Floor System <TablocABeam

In order to view the floor system in greater detail, pcaSlab allows you to magnify
a portion of the floor system for closer analysis.

Using zoom with a magnifier:

1. Select Zoom from the View menu then a sub menu appears beside the View
menu.

2. Select Window from the sub menu. Notice that the Window command is
checked and the cursor is changed to a magnifier. The other way to magnify
window is to click the & button on the tool bar.

3. Move the cross cursor to the upper left corner of the portion of the system you
want to enlarge.

4. Press and hold down the left mouse button while dragging the cursor to the
lower right portion of the system enclosing the desired area within the dashed
box.

5. Release the mouse to enlarge that portion.
Using Zoom In and Zoom Out command:

1. Select Zoom from the View menu and a sub menu appears.

2. Select the In(2x) menu command from the sub menu. The current active
window will be magnified by two times. The other way to do this is to click
the ® button on the tool bar.

3. Select the Out(0.5x) menu command from the sub menu. The current active
window will be reduced by two times. The other way to do this is to click the
€ button on the tool bar.

Note: To return to original (default) zoom, select Restore from the View menu, or
select % from tool bar. To move model in a view window, use Pan from the View
menu, or select < from tool bar.
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Change Isometric View Angle slablocfBeam

You can modify the X and Z angles at which the floor system is displayed in the
isometric view window. By default, the floor system is viewed at -45° about the X
axis and 45° about the Z axis. The right hand rule is used to determine the angle of
rotation about the X and Z axes and the X axis is always rotated first.

To change angles:

1. Select Change View Angle from the View menu. The dialog box of Figure
4-57 appears displaying the currently set angles.

Specify otation angles about Z and % axis.
FRotation about Z axis is always done first,

Fotate about 72 |0 Degess
Rotate about 2 180 Degiees

Cancel

Figure 4-57 Isometric View dialog box

2. Change the angles of rotation about the X and Z axes. The X axis is rotated
first then the Z axis is rotated. The floor system is rotated about the axis using
the right hand rule.

3. Select OK button to accept the new angles and to modify the isometric view.
Note: A more convenient way to change the view angles instantly without entering
angles in the dialog box is to use the keyboard shortcut CTRL + ARROW Keys.

For example, press CTRL + + and CTRL + = to rotate the floor system around Z
axis and press CTRL + * or CTRL + ¥ to rotate around X axis.

Viewing Specific Member Type <TablocABeam

In order to see the floor system members in greater detail, you can select specific
member types to view by enabling and disabling them.

To select member type:

1. Select the View Options command from the View menu. The dialog box of
Figure 4-58 will appear showing the currently displayed member types.
Depending on the floor system, some of the member types will be shaded gray
and unavailable.
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Geometry &‘

Show

W Slabs

¥ Columns and capitals

v Drops

[ Longitudinal beams

¥ Transverse beams
Cancel

Figure 4-58 View Options dialog box

2. To hide a member type from a view of the floor system you must remove the
v sign from the check box. Click the left mouse button on the check box of
the member type you would like to hide. To view a previously hidden member
type, click the left mouse button on the check box to add the v sign to the
check box.

3. Select OK button to view only the selected member types.
Plan View SlablocfBeam
To switch to plan view:

1. Select the Plan View command from the View menu or click © button on the
tool bar. The dialog box of Figure 4-59 will appear.

= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 5 - PCA Notes on ACI 318-05 Example 20-2.s1b -- Plan View: |ZH§|FX\

—

Figure 4-59 Plan View Window
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2. Right click on the view window to show the pop-up menu. You may save the
current view window as bitmap (BMP) file or metafile (EMF) on the
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively.
You may also select the commands from the pop-up menu to zoom in or zoom
out the view window and preview it before printing it out.

Copy Bitmap
Copy Metsfils

Zonm Window
Pan
Restore

Display Diagram Grids

Prink Preview. .
Options...

Figure 4-60 Pop-up Menu of View Window

3. Select the Options command from the pop-up menu, and then you may
decide what geometry members need to be shown on the view window as
shown in Figure 4-61. To hide a member type from a view of the floor system
you must remove the v* sign from the check box. Click the left mouse button
on the check box of the member type you would like to hide. To view a
previously hidden member type, click the left mouse button on the check box
to add the v sign to the check box.

Geometry E\

Show
[V Slabs

¥ Calumns and capitals
¥ Drops
W Longitudinal bearms

¥ Transverse beams

Cancel

Figure 4-61 Geometry Options of Plan View

4. Select OK button to view only the selected member types.

Elevated View sfablpcf6eam

To switch to elevated view:

1. Select the Elevated View command from the View menu or click @ button
from the tool bar. The dialog box of Figure 4-62 will appear.
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= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 1 - PCA Notes on ACI 318-05 Example 8-2.slb -- Elevate... |Z”E‘E|

Figure 4-62 Elevated View Window

2. Right click on the view window to show the pop-up menu. You may save the
current view window as bitmap (BMP) file or metafile (EMF) onto the
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively.
You may also select the commands from the pop-up menu to zoom in or zoom
out the view window and preview it before printing it out.

Copy Bitmap
Copy Metafile

Zoom indow
Pan
Restare

Display Diagram Grids

Print Preview. ..
Options...

Figure 4-63. Pop-up Menu of View Window

3. Select the Options command from the pop-up menu, and then you may
decide what geometry members need to be shown on the view window as
shown in Figure 4-64. To hide a member type from a view of the floor system
you must remove the v sign from the check box. Click the left mouse button
on the check box of the member type you would like to hide. To view a
previously hidden member type, click the left mouse button on the check box
to add the v sign to the check box.
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Geometry g‘

Show
W Slabs

¥ Columns and capitals
v Drops
[ Longitudinal beams

¥ Transverse beams

Cancel

Figure 4-64 Geometry Options of Elevated View
4. Select OK button to view only the selected member types.
Side View slablpcfbeam
To switch to side view:

1. Select the Elevated View command from the View menu or click © button
from the tool bar. The dialog box of Figure 4-65 will appear.

= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 5 - PCA Notes on ACI 318-05 Example 20-2.5lb -- Side View \ZHE|E|

—

Figure 4-65 Side View Window

2. Right click on the view window to show the pop-up menu. You may save the
current view window as bitmap (BMP) file or metafile (EMF) onto the
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively.
You may also select the commands from the pop-up menu to zoom in or zoom
out the view window and preview it before printing it out.
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Copy Bitmap
Copy Metsfils

Zonm Window
Pan
Restore

Display Diagram Grids

Prink Preview. .
Options...

Figure 4-66 Pop-up Menu of View Window

3. Select the Options command from the pop-up menu, and then you may
decide what geometry members need to be shown on the view window as
shown in Figure 4-67. To hide a member type from a view of the floor system
you must remove the v sign from the check box. Click the left mouse button
on the check box of the member type you would like to hide. To view a
previously hidden member type, click the left mouse button on the check box
to add the v sign to the check box.

Geometry E\

Show
v Slabs

¥ Columns and capitals
I Drops
¥ Longitudinal beams

W Transverse beams

Cancel

Figure 4-67 Geometry Options of Side View

4. Select OK button to view only the selected member types.

Isometric View sfablpcf6eam
To switch to isometric view:

1. Select the Isometric View command from the View menu or click & button
on the tool bar. The dialog box of Figure 4-68 will appear.
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= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 5 - PCA Notes on ACI 318-05 Example 20-2.51b -- Isometric View |;”E\E|

Figure 4-68 Isometric View Window

Right click on the view window to show the pop-up menu. You may save the
current view window as bitmap (BMP) file or metafile (EMF) onto the
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively.
You may also select the commands from the pop-up menu to zoom in or zoom
out the view window and preview it before printing it out.

Copy Bitmap
Copy Metafile

Zoom Window
Pan
Restore

Display Diagram Grids

Print Preview. ..
Options...

Figure 4-69 Pop-up Menu of View Window

Select the Options command from the pop-up menu, and then you may
decide what geometry members need to be shown on the view window as
shown in Figure 4-70. To hide a member type from a view of the floor system
you must remove the v* sign from the check box. Click the left mouse button
on the check box of the member type you would like to hide. To view a
previously hidden member type, click the left mouse button on the check box
to add the v sign to the check box.
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Geometry g‘

Show
W Slabs

¥ Columns and capitals
v Drops
[ Longitudinal beams

¥ Transverse beams

Cancel

Figure 4-70 Geometry Options of Isometric View

4. Select OK button to view only the selected member types.
Loads slab|pcABeam
To show the loads:

1. Select the Loads command from the View menu or click ¥ button from the
tool bar. The dialog box of Figure 4-71 will appear.

= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 1 - PCA Notes on ACI 318-05 Example 8-2.slb -- Load View |Z”E\E|
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Figure 4-71 Loads View Window

2. Right click on the view window to show the pop-up menu. You may save the
current view window as bitmap (BMP) file or metafile (EMF) onto the
Windows clipboard by selecting Copy Bitmap or Copy Metafile, respectively.
You may also select the commands from the pop-up menu to zoom in or zoom
out the view window and preview it before printing it out.
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Copy Bitmap
Copy Metsfils

Zonm Window
Pan
Restore

Display Diagram Grids

Prink Preview. .
Options...

Figure 4-72 Pop-up menu of View Window

3. Select the Options command from the pop-up menu, and then you may
decide what kind of loads need to be shown on the view window as shown in
Figure 4-73. To hide a load case or type you must remove the v* sign from the
check box. Click the left mouse button on the check box of the member type
you would like to hide. To view a previously hidden load type, click the left
mouse button on the check box to add the v sign to the check box.

Loads g|
Select load cases: Shows
[EELF T [@AweaForce
[¥Dead [#ILine Force
[ Live: w|Pairt Force:
[wldind [w]Paint Mament
[¥IE.Q.
W Show values

Figure 4-73 Loads Options

4. If you want to hide the load values, remove the v~ sign before Show values
check box.

5. Select OK button to view only the selected member types.

View Graphical Results sTablocfBeam
Viewing Internal Forces Diagrams slab|ecfBeam

Once the design has been performed, you may view the shear, moment, and
internal torque (beams/one-way slab systems with torsion) diagrams for any span
at any available load combination.

To view shears and moments diagram:

1. Select the Internal Forces command from the View menu or click the &
button on the tool bar. A view window similar to Figure 4-74 will appear. The
upper half view window shows the shear diagram and the lower half the view
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window shows the moment diagram. If torsion is enabled for beams/one-way
slab systems than internal torque diagram will also be shown in this window.

= C:\Program Files\PCA\pcaSlab\Bxamples\Manual\Example 1 - PCA Notes on ACI 318-05 Bxample 8-2.slb - Internal... |Z”E|E\
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Figure 4-74 View Internal Forces Diagram

2. The current coordinate values can be captured based on the position of the
mouse cursor. The status bar in Figure 4-75 shows the name of the diagram,
two coordinate values of the current mouse cursor position, and the current
design code used in the project.

Internal Forces X =49.777 ft Mu = 48,480 k-f: ACI318-05

Figure 4-75. Coordinate Value Shown in Status Bar

3. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting
commands from this pop-up menu.

4. Click the Options command from the pop-up menu to change the span for
which the internal forces diagrams will be shown and to choose if legend will
be displayed or not. Figure 4-76 shows the OPTIONS dialog box. Select a span
number from the SHOW DIAGRAM FOR drop-down list and select a load
Envelope or combination from the SELECT LOAD COMBINATIONS check list
box. Use DRAW LEGEND checkbox to control whether legend is drawn or not.
Press the OK button to close the dialog box and redraw the view windows.
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Internal Forces &
Show diagram for:

Curve selection
All spans -

& Redistibuted

Select load combinations:

" Mon-Redistributed
" Bath

v Draw Legend

Cancel

Figure 4-76 View Internal Forces Diagram Options

Note: The pop-up menu can be accessed from each of the view windows of
pcaSlab.

The Restore command cannot be executed in the pop-up menu until the Zoom or
Pan command is stopped by pressing the ESC key. Without stopping the
Zoom/Pan command, one can only restore a view using the Restore command in
View menu or ¥ button in the tool bar. This occurs in all pcaSlab view windows.

Viewing Moment Capacity SlablocfBeam

Once the design has been performed, you may view the moment capacity diagrams
for any span at any available loading pattern. The moment capacity window will
be split in half horizontally. The middle strip moment capacity will occupy the
upper half and the column strip moment capacity will occupy the lower half where
each diagram will be scaled to fill the entire half of the window.

To view moment capacity:
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Select the Moment Capacity command from the View menu or click the &
button on the tool bar. A view window similar to

= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 5 - PCA Notes on ACI 318-05 Example 20-2.slb -- Moment ... |L|\E\E|
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Figure 4-77 will appear.

2. Right click on the Moment Capacity view window and select Options
command from the pop-up menu. A dialog box similar to Figure 4-78 will
appear.

3. The current coordinate values can be captured based on the position of the
mouse cursor. The status bar shows the name of the diagram, two coordinate
values of the current mouse cursor position, and the current design code used
in the project.

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting
commands from this pop-up menu.
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Figure 4-77 View Moment Capacity Diagram

5. Click the Options command from the pop-up menu to change the span for
which the moment capacity will be shown. Select which span will be shown
in the SHOW DIAGRAM FOR drop-down list. Use DRAW LEGEND checkbox to
control whether legend is drawn or not. Select which part of the selected span
will be shown in the Show frame box.

6. Press the OK button to close the dialog box and redraw the view windows.

Show diagram for:

[¥ Draw Legend

Show
¥ Column Stip

v Middle Strip

¥ Beam Stip

Cancel

Figure 4-78 View Moment Capacity Option dialog box
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Viewing Shear Capacity slablocBeam

Once the design has been performed, you may view the slab shear capacity
diagrams for any span at any available loading pattern.

To view shear capacity:

1. Select the Shear Capacity command from the View menu or click the &
button on the tool bar. A view window similar to Figure 4-79 will appear.
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Figure 4-79 View Shear Capacity

2. Right click on the Shear Capacity view window and select Options command
from the pop-up menu. A dialog box similar to Figure 4-80 will appear.

Shear Capacity g\
Show diagram for
Al spans -
[~ Diaw Legend
[ Critical Setions

Show
v Slab

Iv Beam

Cancel
Figure 4-80 View Shear Capacity Option dialog box

3. The current coordinate values can be captured based on the position of the
mouse cursor. The status bar shows the name of the diagram, two coordinate
values of the current mouse cursor position, and the current design code used
in the project.
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6.

Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting
commands from this pop-up menu.

Click the Options command from the pop-up menu to change the span for
which the shear capacity will be shown. Select which span will be shown in
the SHOW DIAGRAM FOR drop-down list. Use DRAW LEGEND checkbox and
CRITICAL SECTION checkbox to control if the legend and critical sections are
drawn or not. Select which part of the selected span will be shown in the
SHOW frame box.

Press the OK button to close the dialog box and redraw the view windows.

Viewing Reinforcement Sfab|pcABeam

Once the design has been performed, you may view the reinforcement diagrams
for any span at any available loading pattern. The reinforcement window will be
split in half horizontally. The middle strip reinforcement will occupy the upper
half, and the column strip reinforcement will occupy the lower half where each
diagram will be scaled to fill the entire half of the window.

To view reinforcement:

1.

Select the Reinforcement command from the View menu or click the =
button on the tool bar. A view window similar to Figure 4-81 will appear.

= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 1 - PCA Notes on ACI 318-05 Example 8-2.slb -- Reinfor... |Z”E\E|
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Figure 4-81 View Reinforcement
Right click on the Reinforcements view window and select Options command
from the pop-up menu. A dialog box similar to Figure 4-82 will appear.

The current coordinate values can be captured based on the position of the
mouse cursor. The status bar shows the name of the diagram, coordinate value
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of the current mouse cursor position in the design direction, and the current
design code used in the project.

4. Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting
commands from this pop-up menu.

Reinforcement El

Show diagram faor:

Al spans A

Show
¥ Column Stip

v Middie Stip
¥ Beam Stip  |Both -

¥ Show bar labels
¥ Include bar length
W Rotate bar labels

Slab thickness soale: [§
Cancel

Figure 4-82 View Reinforcement Options dialog box

5. Click the Options command from the pop-up menu to change the span for
which the shear capacity will be shown. Select the span you want to show
from the Show diagram for drop-down list. Select which part of the selected
span will be shown from the Show frame box. Checking the SHOW REBAR
LABELS will show labels beside each rebar on the view. Similarly bar length
can be included by checking INCLUDE BAR LENGTH. Bar labels can also be
arranged vertically if ROTATE BAR LABELS is checked. Set the vertical scale
(relative to the horizontal scale which is set automatically) to which members
are drawn in the SLAB THICKNESS SCALE edit box.

6. Press the OK button to close the dialog box and redraw the view windows.

Viewing Deflected Shapes slablocABeam

Once the design has been performed, you may view the deflection shapes for any

span at any available loading pattern.

To view the deflection shapes:

1. Select the Deflection command from the View menu or click the = button on
the tool bar. A view window similar to Figure 4-83 will appear.

2. Right click on the deflection view window and select Options command from
the pop-up menu. A dialog box similar to Figure 4-84 will appear.
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The current coordinate values can be captured based on the position of the
mouse cursor. The status bar shows the name of the diagram, two coordinate
values of the current mouse cursor position, and the current design code used
in the project.

= C:\Program Files\PCA\pcaSlab\Examples\Manual\Example 1 - PCA Notes on ACI 318-05 Example 8-2.slb -- Deflecti... |Z”E‘E|
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Figure 4-83 View Deflection Diagram

Click the right mouse button anywhere on the view window to show the pop-
up menu. You may Restore, Zoom, Pan or Print View directly by selecting
commands from this pop-up menu.

[w Diraw Legend

Scale factor: |1
Cancel

Figure 4-84 View Deflection Option dialog box

Click the Options command from the pop-up menu to change the span for
which the deflection will be shown. Select the span you want to show from
the SHOW DIAGRAM FOR drop-down list. Check the Draw Legend checkbox to
include the legend in the drawing. Enter the scale factor in the SCALE FACTOR
edit box. The bigger the scale factor, the more apparent the deflections will be
on the diagram.

Press the OK button to close the dialog box and redraw the view windows.
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Print Results Sfab|pcABeam
Printing Analysis and Design Results slablpcABeam

Once the analysis and/or design is performed, you can print the results. This
section provides procedures for performing these functions.

To print the analysis and design results:

1. Select Report command from the Solve menu or click the ® button from the
tool bar. A dialog box similar to Figure 4-85 will appear.

Il Results Report |;‘@

Close sekctal | o | P |

[1] INPUT ECHO

195 lines

General Information:
File name: C:\Program Files\PCA\pecaflsh)BxamplesiManuallBxanple 1 - PCi Notes on ACI Z18-(
Project: peaSlab/poaBesn Mamual, Example 1 =
Frame: PCA Motes on ACI 218-0&, Example 8-Z
Ingineer: peaStructurePoint
Code: ACI 318-0%

Reinforcement Database: ASTH AE1S
Mode: Desigm

Mumber of supports = 4

Floor System: One-Way/Beam

Live load pactern ratio = 100%
Deflections are based on cracked section properties.

In negative moment regions, Iy and Meor DO HOT include flange/slab contribution (if availak
Long-tern deflections are calculated for load duration of 60 months.

0% of live load is sustained. v

< | >

Figure 4-85 View and Print Results dialog box
2. Select the results you want to view from the drop-down list. The contents of
the results list box will be changed based on your selection.

3. Press the PRINT button on the dialog box to print the results through a printer.
The printer could be a local printer which is connected to your computer
directly, or a network printer.

4. Press the CLOSE button to close the result dialog box.

Printing Current View Window slablpcABeam
Once the design has been performed, you may print the diagrams and views for
any span at any available loading pattern by selecting the Print View command
from the File menu.

To print a displaying window:

1. To select the diagram or view you want to print, single click the left mouse
button on the diagram or view window.
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2. Select the Print View command from the File menu. A print preview window
similar to Figure 4-86 will be shown.
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Figure 4-86 Print Preview of a View Window
3. Press the ZoOM IN or ZOOM OUT buttons or simply click the left mouse button
on the preview to magnify or reduce the size of the preview paper.
Press the NEXT PAGE button if more than one page need to be printed.

5. Press the PRINT button to print the view. The printer could be a local printer
which is connected to your computer directly, or a network printer.

6. Press the CLOSE button to close the preview window and go back to pcaSlab.
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Print Preview slablocABeam

The Print Preview command allows you to preview and print the current view
window (floor system geometry in the plan, elevated and isometric views, prints
the shear and moment diagrams, and the deflected shapes).

1. To obtain a view window you must first perform the design, then select what
you want to view from the View menu. You may have more than one view
window opened. The current view window is the one activated and on top of
the others on your screen.

2. Selecting this command closes the pcaSlab main window and opens the print
preview window as shown in Figure 4-86.

3. On the print preview window, press the ZOOM IN or ZOOM OUT buttons or
simply click the left mouse button on the preview window to magnify or
reduce the size of the preview paper.

Press the NEXT PAGE button if more than one page needs to be printed.

5. Press the PRINT button to print the view. The printer could be a local printer
which is connected to your computer directly, or a network printer.

6. Press the CLOSE button to close the preview window and go back to pcaSlab.

" peaSlab - Example 5 - PCA Notes on AC 318-05 Example 20-2.51b * A=
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Figure 4-87 Print Preview Window
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Copy Graphs to Clipboard ¢lablocABeam
Copy Bitmap (BMP format) ¢lablocABeam

pcaSlab can copy any of the ten view windows onto Windows clipboard as bitmap.
The bitmap on clipboard can then be pasted into Microsoft Word or other
Windows applications including presentation software such as Microsoft
PowerPoint.

To copy view window to clipboard as bitmap:

1. Select the view window that will be copied by single clicking left mouse
button on it.
Select * from the tool bar to copy the selected view window to clipboard.

3. Switch to other word processing software, such as Microsoft Word, then press
the CTRL + V to paste the bitmap on clipboard to a Word file.

Copy Metafile (EMF format) ¢lablocABeam

Since bitmap files cannot easily be resized or re-proportioned without significant
distortion to the image, metafiles are generally used for situations requiring
scalability of the image.

Advantages of metafiles are:

e Large, simply structured images require less memory than bitmaps for display
and make optimal use of the resolution of the output device.

e Metafiles can be resized with none of the distortion which normally
accompanies resizing of bitmaps.

e A metafile can contain SelectPalette statements, allowing custom palettes to
be displayed in applications such as Microsoft Word.

The Enhanced MetaFile (EMF) format is an extension of the Windows metafiles
format developed for use with 32 bit Windows applications. It is only available to
native 32 bit applications.

To copy view window to clipboard as Enhanced MetaFile (EMF):

1. Select the view window that will be copied by single clicking left mouse
button on it.

2. Select & from the tool bar to copy the selected view window to clipboard.

3. Switch to other word processing software, such as Microsoft Word, then press
the CTRL + V to paste the bitmap on clipboard to a Word file.
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Customizing Program (menu Options) fabloc68am
Changing Colors <TablocABeam

Colors can be changed for background of views, geometry items such as slabs and
beams, text on views, result diagrams, etc.

To change colors:

1.

Select Colors command from the Options menu. Figure 4-88 will appear.
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Slah Black. Deflection [Total] Dark Red
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Drop Dark Red Reinforcement Red
Capital Dark Yel... Intemal Forces (U1) Widlet
Transverse Beam Gresn Inkemnal Forces (U2)  Blug
Area Load Red Intemal Forces (U3) Turquoise
Foint Load Pink Internal Forces (L14] Teal
Vinal nad Fraon b botarnal Foran (18] Fad
Change color tor Change color to:
‘Wh\te j |Dalk Blue j
W' Print in Black and Wwhite Printed ling thickness: 1
I Save settings for future use Border line thickness: 1
oK Cocel | Hen |

Figure 4-88 Changing Colors dialog box

From the General frame box on the left side, select the item whose color
needs to be changed from the list box.

Select a color from the Change color to drop-down list. Once a new color is
selected from the drop-down list the color in the list box above the drop-down
list is updated instantly.

From the Results category box on the right side, select the item whose color
needs to be changed from the list box.

Select a color from the Change color to drop-down list. Once a new color is
selected from the drop-down list the color in the list box above the drop-down
list is updated instantly.

If you want to print views in black and white, select the Print Black and
White check box.

If you want to save the settings as default, select the Save setting for future
use check box.
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8. Input the line thickness in the Printed Line Thickness edit box. The diagram
line thickness will be based on the number you input.

9. Press the OK button to save the settings and close the dialog box.

Changing Fonts Sfab|pcABeam
Fonts can be selected separately for both the graphical output and the text output
via Options|Font command.

To change the graphical output font:

1. Select the Font|Graphical Output command from the Options menu.
A view window similar to Figure 4-89 will appear.

Font |E| E‘

Fant Font style:
oK
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H uial Super
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I Undstine YL
Color:

I Bl=ck - Script:

“Westem -

Figure 4-89 Changing Graphical Output Font dialog box
2. Select the font, font style and size from the lists. Font sizes different from
those on the list can be typed in the Size text box.

3. In the EFFECT frame select if strikeout and/or underline effect have to be
applied. Alternatively to the COLOR dialog box, the font color can be chosen
in this dialog box too.

The script of the font by default is Western and should not be changed.
5. Press the OK button to save the new setting and close the dialog box.
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Figure 4-90 Changing Text Output Font dialog box

To change the text output font follow the same procedure as for the graphical
output font except that font effects are not available for text output and the list of
fonts only contains non-proportional fonts which are suitable for tabulated text

output (Figure 4-90).
Changing Startup Defaults

To change the startup defaults:

1.

slablpcfbeam

Select the Startup Defaults command from the Options menu. A view
window similar to Figure 4-91 will appear.

Startup Defaults

Engineer: ‘p:aStructurePomt
Design code: ACH 31805 -
Reinforcement:  |ASTM AB15 hd

Data folder, |E:\Program Filss\PLANpCaSIabAE xamples

oK Canced | Heb |

Figure 4-91 Changing Startup Defaults dialog box

2. Input the name of the engineer in the Engineer edit box. The name of the

engineer will be shown on the view print.

Select the design code from the Design code drop-down list. Four design

codes are available: ACI 318-99, ACI 318M-99, CSA A23.3-94 and CSA
A23.3-94E.

Select the rebar database from the Rebar database drop-down list. Four
defined databases are available: ASTM A615, ASTM A615M, CSA G30.18
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and prEN 10080. If you would like to use rebar defined by yourself, select the
User Defined from the drop-down list. You may define your own rebar
database by selecting the Rebar Database from the Options menu.

5. Press the OK button to save the new setting and close the dialog box.

Changing Rebar Database sfablo-A6eam

User can define his own rebar database. The defined database, such as ASTM
A615M, cannot be changed.

To change the rebar database:

1. Select the Rebar Database from the Options menu. Figure 4-92 will appear.

2. Select User-defined from the Current Bar Set drop-down list. Rebar data of
the other databases can only be viewed and cannot be changed.

Reinforcement Database El

Current Bar Set

st eets ]

Size. Diameter. in
Area in"2 “Weight; Ibdft

Figure 4-92 Changing Rebar Database

3. To select the rebar that needs to be changed from the rebar list box, single
click the left mouse button on it. The size, diameter, area, and weight of the
selected rebar are shown in the corresponding text boxes, respectively.

Enter the new values of bar size, diameter, area, and weight.

5. Press the ADD button to add the bar as a new bar into the rebar list box on the

lower part of the dialog box. If any data inconsistency is found by pcaSlab, an
error of "Inconsistent bar data" will be shown.

6. Press the MODIFY button to update an existing rebar.
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7. To delete a rebar, select the rebar from the rebar list box then click the
DELETE button.

8. After finishing the definitions of your own rebar database, you may save them
into a file on the hard drive by pressing the SAVE TO FILE button and
specifying a file name for your database. This file can be imported into
pcaSlab by pressing the READ FROM FILE button.

Working with View Windows (menu Window) SlablocBam
Cascade slablocfBeam

The Cascade command displays all the open windows in the same size, arranging
them on top of each other so that the title bar of each is visible. The current active
view widow will be on the top after the execution of the Cascade command.

Tile Horizontal sfablpcf6eam

The Tile Horizontal command arranges all open windows horizontally so that no
window overlaps another. The current active view widow will be on the most left
or on the upper-left corner of the screen after the execution of the Tile Horizontal
command.

Tile Vertical sfablpcf6eam

The Tile Vertical command arranges all open windows vertically so that no
window overlaps another. The current active view widow will be on the most left
or on the upper-left corner of the screen after the execution of the Tile Vertical
command.

Remaining Commands <TablocABeam

The remaining menu items are in a list of the windows that are available for
viewing. Selecting any window from this menu will restore the window to its
previous size and position from an icon.

Obtaining Help Information (menu Help) Sfabloc6eam
Opening Table of Contents of the Help System ¢lablocABeam

To open table of contents of the Help system:
1. Select Help Topics from the Help menu.
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2. Select the chapter you need from the content tree view in the left pane of the
Help window. The contents of the selected chapter appear in the right pane of
the Help window.

Displaying Help Topic Associated with Selected Element €fablocfGeam

To display the topic associated with the selected element:

1. Select Context Help from the Help menu. The mouse cursor changes to &?

2. Click the element for which you need information about. The program will
display the topic which is associated with the element you clicked.

Obtaining Information about the Program €fablocfGeam

The following information about the program is displayed in the ABOUT PCASLAB
dialog box:

e program version and short description
e licensing information
e the copyright information

The licensing information depends on the type of license being used. If it is a trial
license then the LICENSE ExP field shows when the trial period expires and the
LOCKING CODE field displays a unique fingerprint of the computer on which the
program is running. This locking code needs to be provided to pcaStructurePoint
in order to generate a permanent license. For other, non-trial licenses, license ID is
displayed. You may be asked to provide this ID when you contact
pcaStructurePoint for technical support.

To obtain the information about the program:

1. Select the About pcaSlab command from the Help menu. A dialog box of
Figure 4-93 will appear.
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(<)

peaSlab v2.00

License Exp:

slab

Analysis, Design, and |nwestigation of Reinforced Concrete
Beams. One-way and Two-way Slab Spstems

License Type: 15 day tial license
Dec 19, 2006 at 16:48:13
License Sever ZYAN (152 168.100.183) v.7.2.23

Locking Code: [422108
Licensed to:

Copyright € 2003-2006

Skokie, L - LISA
&l Rights Reserved

peaStucturePoint, Portland Cement Assaiation

praStucturePoint, Portland Cement Association

b)

About pcaSlab

~

pcaSlab v2.00

Analysis, Design, and Investigation of Reinforced Concrete
Beams, One-way and Two-way Slab Systems

License Type: 3 seal netwark license
License Exp: Mewer

License Sever. PCASTRUCTURE [192.168.100.200) v.7.2.23
License ID: 123451234567 4-2D20E 22104

Licensed to:

peaStructurePoint

Copyright © 2003-2008
peaStucturePoint, Potland Cement Association

Skokie, IL - USA

Al Rights Reserved

Figure 4-93 About pcaSlab dialog boxes with
(a) a trial license (b) a network license

2.

Press OK button to exit the dialog box.
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Chapter 5

Output Description

Output Elements STablpcG8am

pcaSlab generates the text and graphical output of the input data and the results of
the calculations. The text output is generated when user opens the Results Report
dialog window. An ASCII text file is generated in the same sub-folder as the input
data file. The name of the output file is created by adding the extension ".OUT" to
the name of the input data file. Depending on the report options selected, the text
output will contain a selection of the following sections (see the illustrated
examples in the following chapter):

Program Information

[1] Input Echo

[2] Design Results

[3] Column Axial Forces And Moments
[4] Internal Forces — Load Cases

[5] Internal Forces — Load Combinations
[6] Internal Forces — Envelopes
]

[7] Deflections

Program Version SfabloGeam

The program version number appears at the top of each report page along with the
licensing and copyright information. Additionally, legal disclaimer is displayed on
the first page of the text output.

Input Echo SfablocGeam

Section Input Echo reports the data used in the analysis. pcaSlab defaults common
data; all other data must be input. Carefully check the contents of the section and
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compare it with the intended design model. The following paragraphs describe the
blocks included in the section.

General Information slablocABeam

This block is similar in its content to the dialog window General Information. It
contains the information on project input data file name, project description,
selected design code and units, selected rebar database, calculation mode (design
or investigation), number of supports, cantilevers. The selections available in the
SOLVE OPTIONS dialog box are also listed in this block.

Material Properties €fablocfGeam

This block contains the information on concrete properties for slabs, beams and
columns. It also contains the information on reinforcing steel properties for slabs
and beams.

Rebar Database sfablpcf6eam

This block lists the properties of the bars from the bar table selected for the
project. Bar diameter, cross-section area and unit weight for each bar are reported.
The values reported are consistent with the units used in particular model.

Span Data <TablocABeam

This block is similar in its content to the dialog window Span Data. The block is
divided into two parts. First part reports the span-by-span geometry of the concrete
slab (length, left and right side width, depth and code required minimum
thickness). The second part contains the span-by-span geometry of longitudinal
beams and ribs (for waffle slabs).

Support Data <TablocABeam

This block is similar in its content to the dialog window Support Data. The block
is divided into four parts. The first part reports the geometry of top and bottom
columns and the stiffness share factor. For circular column the transverse
dimension C2 is reported as zero. The second part contains the geometry of drop
panels: thickness, lengths, widths. If dimensions of a drop panel are invalid it will
be marked. Invalid or excessive drop panel geometry is not used in the analysis.
The third part contains the geometry of column capitals: depth, slope
(depth/extension ratio), extensions. The fourth part contains the geometry of
transverse beams: width depth, eccentricity (offset) from column centroid.
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Load Data sfablpcf6eam

This block contains the complete information on load input. The block is divided
into three parts. The first part reports the defined load cases, load combinations
and corresponding load factors. This part summarizes the contents of the dialog
windows Load Cases and Load Combinations. The second part reports the
magnitudes of defined span loads. It summarizes the contents of the dialog
window Span Loads. The third part reports the magnitudes of lateral actions (joint
moments) if defined in the model. It summarizes the contents of the dialog
window Lateral Load Effects.

Reinforcement Criteria ¢lablocABeam

This block is similar in its content to the dialog window Reinforcement Criteria.
The block is divided into three parts. The first part reports the requirements for
slab and rib bars. The second part reports the requirements for longitudinal beams.
Both parts contain the information on bar sizes, covers, spacings and user selected
allowable steel percentages. The requirements for top and bottom bars are given.
For longitudinal beams additionally the criteria for transverse bars (stirrups) are
listed.

Reinforcing Bars <TablocABeam
This block is available only when Investigation Mode is selected. This block is
similar in its content to the dialog window Reinforcing Bars. The block is divided
into three parts. The first part reports the span-by span user selected top bars for
column, middle and beam strips accordingly. Similarly, the second part reports the
user selected bottom bars for column, middle and beam. For longitudinal bars the
program reports bar sizes, lengths and concrete cover. The third part presents the
beam transverse reinforcement (stirrups) defined by the user.

Note: When switching from Design Mode to Investigation Mode, pcaSlab
automatically assumes the results of the Design Mode as an input for Investigation
Mode.

Design Results STablpcG8am

Section Design Results presents the summary of the design results of the slab
system. The following paragraphs describe the blocks included in the section.

Top Reinforcement sfablocABeam

This block is available only when Design Mode is selected. It reports the negative
reinforcement requirements. The block contains the values of corresponding
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design strip widths (column, middle, and beam), maximum factored design
moments per strip and critical location, minimum and maximum steel areas, bar
spacings, steel areas required by ultimate condition, selected bar sizes and
numbers. The quantities are given for left, center and right location of each span.
For a detailed discussion, see Chapter 2, "Area of Reinforcement".

Note: This block does not include reinforcement quantities necessary to transfer
negative unbalanced moment at supports.

Top Bar Details sfablocABeam

The block contains a span-by-span listing of the longitudinal bars selected in
column, middle and beam strips. This reinforcement schedule is intended as a
guide for bar placement. In more complex cases the bar schedule selected by the
program may have to be adjusted by the user for constructability reasons. The
selected bar sizes are limited by user specified minimum and maximum sizes. Bar
sizes and numbers are selected to satisfy the minimum and required steel areas in
conjunction with the bar spacing requirements of the code. The program calculates
the bar lengths based on the computed inflection points and the recommended
minima of the code. The bar lengths are adjusted by appropriate development
lengths. Hooks and bends are not included in bar length tables and figures. For
beams bars are placed in single a layer (see Figure 2-21), provided there is
sufficient beam width. For a detailed discussion, see Chapter 4, "Reinforcement
Selection".

Note: This block does not include additional reinforcement bars necessary to
transfer negative unbalanced moment at supports.

Band Reinforcement at Supports <fab

This section is available only when the CSA code is selected. It describes how the
negative reinforcement in column strips should be concentrated over supports.
This section reports the width of the column strip and the widths of the band strip
and the remaining strip that the column strip is subdivided into. It also gives the
area of reinforcement as well as the number of bars required in each strip. The sum
of number of bars in the band strip and in the remaining strip should be equal to
the total number of bars in the column strip over each support. The number of bars
in the column strip should be consistent with the number of bars listed in the Top
Bar Details table.

Note: This block does not include additional reinforcement bars necessary to
transfer negative unbalanced moment at supports.
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Bottom Reinforcement <TablocABeam

This block is available only when Design Mode is selected. It reports the positive
reinforcement requirements. The block contains the values of corresponding
design strip widths (column, middle, and beam), maximum factored design
moments per strip and critical location, minimum and maximum steel areas, bar
spacings, steel areas required by ultimate condition, selected bar sizes and
numbers. The quantities are given for mid-span regions of each span. For
a detailed discussion, see Chapter 2, "Area of Reinforcement".

Bottom Bar Details sfablpcf6eam

This block contains a span-by-span listing of the longitudinal bars selected in
column, middle and beam strips. The reinforcement schedule is intended as a
guide for bar placement. In more complex cases the bar schedule selected by the
program may have to be adjusted by the user for constructability reasons. The
selected bar sizes are limited by user specified minimum and maximum sizes. Bar
sizes and numbers are selected to satisfy the minimum and required steel areas in
conjunction with the bar spacing requirements of the code. The program calculates
the bar lengths based on the computed inflection points and the recommended
minimums of the code. The bar lengths are adjusted by appropriate development
lengths. Hooks and bends are not included in bar length tables and figures. For
beams bars are placed in single a layer (see Figure 2-21), provided there is
sufficient beam width. For a detailed discussion, see Chapter 2, "Reinforcement
Selection".

Flexural Capacity slablocfBeam

This block lists the selected top and bottom steel areas and corresponding negative
and positive moment capacity values in each span. The data is subdivided between
column, middle and beam strips. Each span is subdivided into segments reflecting
the changes in geometry and bar placement.

Longitudinal Beam Shear Reinforcement Required slab|ecfBeam

This block is available only when Design Mode is selected. It reports the
requirements of transverse reinforcement for each longitudinal beam. The capacity
of concrete cross-section ¢V, in each span is shown. The table contains the
segmental values of the factored shear force Vu and required intensity of stirrups
(Ay/s). The segmental values cover the distance between left and right critical
sections, and include locations where there is change of geometry of loading.
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Longitudinal Beam Shear Reinforcement Details slablocfBeam

This block is available only when Design Mode is selected. It is intended as a
guide for stirrup placement. The output presents the program selected stirrup sizes,
numbers and spacings. Distances between groups of stirrups are also reported.

Beam Shear (and Torsion) Capacity slab|ecfBeam

If torsion is not considered then this block lists the concrete section shear capacity
oV, selected stirrup intensities and spacings and corresponding beam shear
capacity ¢V, values in each span. The maximum factored shear forces V. in
beam strip along the span also reported.

In the case of combined shear and torsion analysis (beams/one-way slab systems
only), this block lists section properties, shear and torsion transverse reinforcement
capacity, and longitudinal torsional reinforcement capacity. The provided and
required capacities are expressed in terms of the provided and required areas of
reinforcement.

Slab Shear Capacity slab

This block lists the values of one-way slab shear capacity ¢V, in each span. The
maximum factored shear force V, and the location of the critical section X, are
also reported.

Flexural Transfer of Unbalanced Moments at Supports slab

There are two blocks reporting the design values for additional reinforcement
necessary to transfer unbalanced support moments. One block is for negative
unbalanced moments and the other for positive unbalanced moment. These blocks
contain the results for critical (effective) section width as per the code, the
maximum negative or positive unbalanced moment, the corresponding load
combination and governing load pattern, the reinforcing steel areas provided and
additional steel required. The provided reinforcement area (main longitudinal bars)
is reduced by the ratio of critical (effective) strip width to total strip width and
does not include the required area due to unbalanced moments. The additional
reinforcement is the difference between that required by unbalanced moment
transfer by flexure and that provided for design bending moment. When additional
reinforcement is required, it is selected based on the bar sizes already provided at
the support. For a detailed discussion, see Chapter 2, "Area of Reinforcement" and
"Additional Reinforcement at Support".
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Punching Shear Around Columns <fab

The block contains the values pertaining to punching shear check in critical
sections around the columns. The table lists two sets of punching shear
calculations — direct shear alone and direct shear with moment transfer. The output
contains the values of the allowable shear stress ¢v,, reactions V,, unbalanced
moments M,,,, governing load pattern, fraction of unbalanced moment ¢v,
punching shear stress v,. The calculation for moment transfer adjusts the
unbalanced moment to the centroid of the critical section. The "shear transfer" is
the unbalanced moment multiplied by y,. When calculated shear stress v, exceeds
the allowable value ¢v., the program prints a warning flags for this support. For a
detailed discussion, see Chapter 2, "Shear Analysis of Slabs".

Punching Shear Around Drops slab

The block contains the values pertaining to punching shear check in a critical
section around the drop panels. The table displays the reactions V,, governing load
pattern, the punching shear stress around the drop v,, and the allowable shear
stress ¢v.. When calculated shear stress v, exceeds the allowable value ¢v,., the
program prints a warning flags for this drop panel. For a detailed discussion, see
Chapter 2, "Shear Analysis of Slabs".

Integrity Reinforcement at Supports slab

This section is available only when the CSA code is selected. It lists the shear
transferred to the column and the minimum area of bottom reinforcement crossing
one face of the periphery of a column and connecting slab to the column to provide
structural integrity. For a detailed discussion, see Chapter 2, "Integrity
Reinforcement".

Corner Reinforcement <fab

This block refers to the reinforcement required in the exterior corners of a slab
with beams between columns. The ratio of flexural stiffness of beam section to
flexural stiffness of slab is listed as well as the area of reinforcement and the
distance over which the reinforcement is required. The area applies to each layer
of reinforcement in each direction. For a detailed discussion, see Chapter 2, "Slab
Corners".

Shear Resistance at Corner Columns slab

This section is available only when the CSA code is selected. It reports results of
one-way shear check at corner columns. The results include the factored shear
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resistance and the factored shear force at the column. Also, the minimum length of
the critical shear section and the angle at which the minimum length is obtained
are listed. For a detailed discussion, see Chapter 2, "Shear Resistance at Corner
Columns" in “Shear Analysis of Slabs”.

Deflections <TablocABeam

This block lists the summary of section properties, maximum instantaneous
deflections and maximum long-term deflections, if they are selected in solution
options. Also, if a solution option "Gross (uncracked) sections" is selected, only
gross moment of inertia, I,, is reported in the section properties table and the
values of all deflections reported are based on gross section properties. If solution
option "Effective (cracked) sections" is used, the values of deflections reported are
based on averaged effective moments of inertia, Iy, which are then reported in
the section properties table together with other properties of cracked sections. For
a detailed discussion, see Chapter 2, "Deflection Calculation".

Material Takeoff sfablocABeam

This block lists the approximate total and unit quantities of concrete, and
reinforcement. Note that the reinforcement estimate is for one direction only and
ignores items such as hooks, bends, and waste. For a detailed discussion, see
Chapter 2, "Material Quantities".

Column Axial Forces and Moments <fabl - ABeam

Section Column Axial Forces and Moments presents the summary of axial forces
(reactions) and bending moments in bottom and top columns and in springs
attached to the column-slab joints. Also, moments at far ends of columns are
reported. If moment redistribution is selected (beams/one-way slab systems only)
both redistributed and un-redistributed values can be included. The values reported
represent the loading of a single floor only. Any actions on the columns from the
floors above must be added to this story’s actions to properly analyze/design the
columns. The output contains reactions due to all load cases, including all live load
patterns, and all load combinations.

Internal Forces - Load Cases sfablo-A68am

This section presents the summary of unfactored bending moments and shear
forces for individual load cases including selfweight, dead load, live load and
lateral cases. The reported values are presented using span-by-span segmental
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approach. If moment redistribution is selected (beams/one-way slab systems only)
both redistributed and un-redistributed values can be included.

Internal Forces - Load Combinations <fablpBEam

This section presents the summary of bending moments and shear forces for each
load combination. The reported values for each load combination are presented
using span-by-span segmental approach. The negative and positive values of
bending moments and shear forces are presented in separate columns in order to
provide consistent format with enveloped output. If moment redistribution is
selected (beams/one-way slab systems only) both redistributed and un-
redistributed values can be included.

Internal Forces - Envelopes SfabloGeam

This section presents the summary of bending moments and shear forces for
envelope of all load combinations. The reported values are presented using span-
by-span segmental approach. The negative and positive values of bending
moments and shear forces are presented in separate columns for user convenience.
The factored values presented in this section are used for design purposes
(longitudinal and transverse reinforcement). If moment redistribution is selected
(beams/one-way slab systems only) both redistributed and un-redistributed values
can be included.

Deﬂections slab|pc/Beam

This section presents the summary of deflections for unfactored (service) load
cases including selfweight and dead load (DL), live load (LL) and combined
(DL+LL) load cases. The reported values are presented using span-by-span
segmental approach. If solution option "Gross (uncracked) sections" is selected,
the values of deflections reported are based on gross section properties. If solution
option "Effective (cracked) sections" is used, the values of deflections reported are
based on substitute effective moment of inertia of the section. For a detailed
discussion, see Chapter 2, "Deflection Calculation".

Graphical Output STablpcG8am

pcaSlab provides the following graphical output features:

e Diagrams of Internal Forces,
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e  Moment Capacity Diagram,

e Shear (and Torsion) Capacity Diagram,
e Deflection Diagram,

e Reinforcement Diagram.

These diagram windows can be customized. The Options dialog allows selecting
either a single span or all spans. Other elements of the graphs can also be
modified. pcaSlab print preview of the current graphical window. The user has
also the choice to export the graphics to a metafile or bitmap file.

Detailed information on using the graphical output features is included in chapter
"Operating the Program".
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Chapter 6

Examples

In this chapter several examples are presented to demonstrate capabilities of the
program. These examples refer to problems solved in PCA Notes on ACI 318-02
and other established text books. Generally program results match closely the
results found in the references. When discrepancies are observed, they result from
variations in assumptions and solutions methods, and numerical accuracy.

Both beams/one-way slab systems as well as two-way slab systems are presented
in the examples. The output of beams/one-way slab examples shows that pcaBeam
program was used to solve them. This is to illustrate that pcaBeam program is
available as alimited version of pcaSlab including only beams/one-way slab
capabilities.

Example 1 Spandrel beam with moment redistribution SfablocGeam

Problem description

Determine the required reinforcement for the spandrel beam at an intermediate
floor level as shown, using moment redistribution to reduce total reinforcement
required. (Note: the self weight is already included in the specified dead load
below.) This example refers to Example 8-2 from PCA Notes on ACI 318-05
Building Code Requirements for Structural Concrete, Portland Cement
Association, 2005.

Columns: 16 x 16 in.
Story height: 10 ft
Spandrel beam: 12 x 16 in.

f. = 4000 psi
fy = 60,000 psi
DL = 1167 Ib/ft

LL = 450 Ib/ft
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Figure 6-1 Example spandrel beam problem

Preparing Input
1. From the Input menu, select General Information. A dialog box appears.
e In the LABELS section, input the names of the project, frame, and
engineer.
e Inthe FRAME section, input 4 for NO OF SUPPORTS.

e In the FLOOR SYSTEM section, click the radial button next to ONE WAY /
BEAM.

e Leave all other options in the General Information tab to their default
settings of ACI 318-05 design code, ASTM A615 reinforcement, and
DESIGN run mode option.

e In the Solve Options tab, click the check box next to MOMENT
REDISTRIBUTION. Press OK.
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General Information &\ General Information E|

General Information | Solve Options | Span Contol Gieneral Information Solve Optians | Span Control |

Design Options

Labels
Live |oad pattem ratio: %
Project:
R |FEA Wates an A0 316405, Example 6.2 ™ Compressian F\emlo.lcement r Ell?ctlve flange vwdth.
v Mament Redistibution I Rigid beanvcolumn joint
Engineer: [peaStuctueFPaint I™ Torsion Analpsis and Design
Torsion type
(o o

Optiors Run mode

Designoode:  |ACI 71805 = | 5 Design i o
FReinforcement: | ASTM AE15 - " Investigation Deflection calculation options

Sections to use in deflection calculations are

e e e £ Grass [uncracked) & Effective (cracked)
No. cf Supports [
PP I negalive moment 12gions, to caleulate Ig and Mor use
B et ] B e | (0 e Y -  T5ection
[ Distance localion as ratio of span 2 Bl e g s

Duration of load Sustained part of live lnad

B monthe 0 z
oK Camcel | Hep | oK | el | He

2. Nothing needs to be changed in the Material Properties menu.

Material Properties fg\
Conerete | Reinforcing Steel |
Slabs and
Beams Calumng

Unit density 5] [0 sz
Comp.stengh  [¢  [4 ks
Young's modulus, [3834.3 EEERT
Ruplue modulus: [047434 [047434 ks

Copy >

oK Cancel ‘ Help |

3. From the Input menu, select Spans. A dialog box appears.

e Under the Slabs/Flanges tab, input 25 for LENGTH, 0 for THICKNESS,
and 0 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.

e  Press the drop down arrow next to SPAN and select Span 2. Input 15 for
LENGTH, 0 for THICKNESS, and O for WIDTH LEFT and WIDTH RIGHT.
Press MODIFY.

Examples 6-3



slab|pcfBeam

Press the drop down arrow next to SPAN and select Span 3. Input 20 for
LENGTH, 0 for THICKNESS, and 0 for WIDTH LEFT and WIDTH RIGHT.
Press MODIFY.

Select the Longitudinal Beams tab. Input 12 for WIDTH and 16 for
DEPTH. Press MODIFY.

Press Cory. Press the CHECK ALL button. Press OK.

Press OK again.

Span Data &

Slabs/Flanges | Longitudinal Beams | Fibs |

Span: o - Length: 25 ft Width Left. |0 ft
Location: |Interiar - Thickness: |0 in width Right: |0 ft

Span Mo, ‘ Location ‘ Length Thickness width-L ‘Wwidth-R
1 Interior 25 1} 1} 1}
2 Interior 15 1} 1} 1}
3 Interior 20 1} 1} 1}

0K Cancel Help

Examples
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Span Data &

Slabs/Flanges  Lengitudinal Beams | Fibs |

Span: - Width

Depth:

Span Ne. [ width Depth
1 12 16
2 12 16
3 12 16

ok | cencel | Hen |

4. From the Input menu, select Supports. A dialog box appears.

e Under the Columns tab, input 16 for both the c1 and €2 values in both
the ABOVE and BELOW rows. Press MODIFY. (Note: the default HEIGHT
ABOVE and HEIGHT BELOW values of 10 are correct.)

e  Press COPY. Press the CHECK ALL button. Press OK.

e  Under the Moment Redistribution tab, click on SUPPORT 2 in the list in
the bottom half of the SUPPORT DATA dialog box.

e Input 20 for both the LEFT and RIGHT REDISTRIBUTION LIMITS. Press
MODIFY.

e  Press CoPY. Click the check box next to SPAN 3. Press OK.

e  Press OK again.
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Suppor a

Calumins ]Co\umn Cap\lals] Trarsverss Baams] Moment Hed\stlibut\on} Boundary Condil\ons]

Height (ft] &1 (i) &2 (in)

Suppart -| | Bbove: 10 15 16
Stitfress share %: 100 Below: 10 16 16

Sup. Mo | Seifz | Hia [ c1a 2, HIE B 2B
1 100 10 16 16 0 16 16
2 1m0 10 16 16 0 16 16
3 1m0 10 16 16 0 16 16
4 10 10 16 16 0 16 16

oK Carcel | Hep |

Support Data

Colurnns | Colurn Capitaks | Transverse Beams Moment Redistibution ]Eoundary Conditions |

Redistribution Limits [%]

Support: ~| | Leit

Right 0
Sup. No [ Lett Right
[ i i
2 20 20
3 20 20
4 i i

oK | Cancel | Help ‘

5. Nothing needs to be changed in the Reinforcement menu.
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Reinforcement Criteria rzl Reinforcement Criteria rzl
Slabs and Ribs I Beas | Slabs and Ribs  Beams I
Top bars Bottom bars Top bars Bottom bars Stimups
Cawer (in] Cawer (in] Side Cover [in)
Clear 15 Clear 15 Clar |15
Bar size: Bar size: Bar size:
M |#5 - # - M |#5 - # - M |#3 -
Maw |8 - He hd Maw |8 hd He hd Max |45 h
Spacing [in] Spacing [in] Spacing (in]
Mir 1 1 Mir 1 1 Min: |6
Maw |18 18 Maw |18 18 Max |18
FRieinf. ratio (%] FRieinf. ratio (%] Mumber of legs
bin 014 014 bin 014 014 Min: |2 -
Max |5 5 Max |5 5 Max |6 -
There is more than 12 in of Clear distance between There is more than 12 in of
concrete below lop bars. bar layers il | T concrete below lop bars.
ok Cancel ‘ Help | ok I Cancel ‘ Help |

6. From the Input menu, select Load Cases. A dialog box appears.

e Since we are not considering lateral forces, click on WIND in the LABEL
column on the list in the bottom half of the LOAD CASES dialog box and
press the DELETE button.

e Click on EQ in the LABEL column and press the DELETE button. Press

OK.
Load Cases El
Label Type: |DEAD ~|
add | |
Label ‘ Tvpe
SELF DEAD
Dead DEAD
Live LIVE

0K Cancel | Help ‘

7.  From the Input menu, select Load Combinations. A dialog box appears.

e Delete all the load combinations by clicking anywhere on the list in the
bottom half of the LOAD COMBINATIONS dialog box and pressing the
DELETE button. Repeat this procedure until all the load combinations are
gone.
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Input 0 in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE
field. Press ADD.

Press OK.

Load Combinations El

SELF Dead Live

R pz  pe [ T

s | Modiy | Delete |

Camb [ sELF | Dead Live
] 0 12 16

ok Cancel | Help ‘

8. From the Input menu, select Span Loads. A dialog box appears.

Press the drop down arrow next to TYPE, and select LINE LOAD.
Input 1167 for both the START and END MAGNITUDE.
Input 25 for the END LOCATION. Press ADD.

Use the drop down arrow next to SPAN to select SPAN 2. Keep the START
and END MAGNITUDES of 1167 Ib/ft but change the END LOCATION to
15. Click the ADD button.

Again use the drop down arrow next to SPAN to select SPAN 3. Keep the
START and END MAGNITUDES of 1167 Ib/ft but change the END
LOCATION to 20. Click the ADD button

Examples
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Span Loads El

Current Cage: Start End

Span (1 w| Copw.| Maoniude [1167 167 Ibdit
=

Type: |Line Load - Location: 1) 25 it

Span =25 ft
Case Copy ‘ Add | Modify | Delete |
SpanMo. | Type | wa [ La | i [ L6
1 LingLoad 1167 [ 1167 2
2 LingLoad 1167 0 1167 15
3 linsLoad 1167 i 1167 20
oK Carcel | Heb |

9. In the top left corner of the SPAN LOADS dialog box, there is a section called
CURRENT CASE. Click on LIVE.

Use the drop down arrow next to SPAN to select SPAN 1.

Making sure that LINE LOAD is still the selected LOAD TYPE, input 450
for both the START and END MAGNITUDE.

Input 25 for the END LOCATION. Press ADD.

Use the drop down arrow next to SPAN to select SPAN 2. Keep the START
and END MAGNITUDES of 450 Ib/ft but change the END LOCATION to 15.
Click the ADD button.

Again use the drop down arrow next to SPAN to select SPAN 3. Keep the
START and END MAGNITUDES of 1167 Ib/ft but change the END
LOCATION to 20. Click the ADD button

Press OK.
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10.
11.

12.

13.

14.

15.

16.

Span Loads E‘
Current Cage: Start End
Dead Span |1 w| Copy..| Magniude [450 450 b/t
Type: |Line Load - Location: |0 25 it
Span = 35 it
Case Copy. | Add ‘ Modity ‘ Delete ‘
SpanMo. | Type | wa | La | wio | Lb
1 LineLoad 450 0 450 £
2 LineLoad 450 0 450 15
3 Lineload 450 0 450 20
K Carcel | Help

From the Solve menu, select Execute. Press CLOSE.
From the Solve menu, select Results Report.

e  Use the scroll bars to scroll through the results file.

e Use the ARROW keys or the mouse wheel to browse through different
parts of the results quickly. Press the CLOSE button to close the RESULTS
REPORT dialog box and return to pcaBeam.

To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear
Capacity, Deflection, or Reinforcement from the View menu. Right click in
any of these diagrams to get new copy, printing, or display options.

You may print the results file by selecting Print Results from the File menu.
To print any of the diagrams you selected to view, use the Print Preview
command found by right clicking in the diagram’s window. After viewing the
results, you may decide to investigate the input beams under the same loads
but with a modified reinforcement configuration.

From the Input menu, select General Information. In the General
Information dialog box change the RUN MODE option to INVESTIGATION. Do
not change any of the other options. Press Ok

From the Input menu, select the different commands under Reinforcement
Criteria and Reinforcing Bars to modify the reinforcement configuration
computed by the program.

Repeat steps 10 and subsequent to perform the investigation and view the
results.

6-10
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Text Output (abbreviated)

0000000 000000 00000
00000000 00000000 0000000
oo oo oo oo oo oo
oo oo oo oo oo
00000000 [sle} 0000000 00000
0000000 oo oo 0000000 00000
[ele} [ele} [ele} [ele} oo
oo 00000000 oo oo
oo 000000 oo oo
00000 000000 00000 00 00
00 00 00 00 00 000 000
00 00 00 00 00 00 O 0 00
00 00 00 00 00 O 0 00
00000 00000 0000000 00 [¢] 00
00 00 00 00 00 00 00
00 00 00 00 00 00 00
00 00 00 00 00 00 00
00000 000000 00 00 00 00

pcaBeam v2.00 (TM)
A Computer Program for Analysis, Design, and Investigation of
Reinforced Concrete Beams and One-way Slab Systems

Copyright © 1992-2006, Portland Cement Association
A1l rights reserved

Licensee stated above acknowledges that Portland Cement Association
(PCR) is not and cannot be responsible for either the accuracy or
adequacy of the material supplied as input for processing by the
pcaBeam computer program. Furthermore, PCA neither makes any warranty
expressed nor implied with respect to the correctness of the output
prepared by the pcaBeam program. Although PCA has endeavored to
produce pcaBeam error free the program is not and cannot be certified
infallible. The final and only responsibility for analysis, design and
engineering documents is the licensees. Accordingly, PCA disclaims all
responsibility in contract, negligence or other tort for any analysis,
design or engineering documents prepared in connection with the use of
the pcaBeam program.

[1] INPUT ECHO

General Information:

File name Program Files\PCA\pcaSlab\Examples\Manual\Example 1 - PCA Notes on ACI 318-05 Example 8-2.slb
Project: pcaSlab/pcaBeam Manual, Example 1

Frame: PCA Notes on ACI 318-05, Example 8-2

Engineer: pcaStructurePoint

Code: ACI 318-05

Reinforcement Database: ASTM A615

Mode: Design

Number of supports = 4

Floor System: One-Way/Beam

Live load pattern ratio = 100%

Deflections are based on cracked section properties.

In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 60 months.

0% of live load is sustained.

Compression reinforcement calculations NOT selected.

Moment redistribution selected.

Effective flange width calculations NOT selected.

Rigid beam-column joint NOT selected.

Torsion analysis and design NOT selected.

Material Properties:

Slabs|Beams Columns

we = 150 150 1b/ft3
f'c = 4 4 ksi
Ec = 3834.3 3834.3 ksi
fr = 0.474342 0.47434 ksi
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60 ksi, Bars are not epoxy-coated

£y =
fyt = 60 ksi
Es = 29000 ksi
Reinforceme

nt Database:

Units: Db (in), Ab (in"2), Wb (lb/ft)

Size Db Ab Wb Size Db Ab Wh
#3 0.38 0.11 0.38 #4 0.50 0.20 0.67
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30
#11 1.41 1.56 5.31 #14 1.69 2.25 7.65
#18 2.26 4.00 13.60

Span Data:
wR (ft); t, Hmin (in)
L1l t wL WR Hmin
1 Int 25.000 0.00 0.500 0.500 0.00
2 Int 15.000 0.00 0.500 0.500 0.00
3 Int 20.000 0.00 0.500 0.500 0.00

Ribs and Longitudinal Beams: b, h, Sp (in)

Ribs Beams _ Span__
Span b h Sp b h Hmin
1 0.00 0.00 0.00 12.00 16.00 16.22 *b
2 0.00 0.00 0.00 12.00 16.00 8.57
3 0.00 0.00 0.00 12.00 16.00 12.97

NOTES:

*b- Span depth is less than minimum.

Support Dat.

Columns: cla, c2a, clb, c2b (in); Ha, Hb (ft)

Supp cla c2a Ha clb c2b Hb Red$%
1 16.00 16.00 10.000 16.00 16.00 10.000 100
2 16.00 16.00 10.000 16.00 16.00 10.000 100
3 16.00 16.00 10.000 16.00 16.00 10.000 100
4 16.00 16.00 10.000 16.00 16.00 10.000 100

Moment Redistribution Limits

Supp Left[%] Right[%]
1 0 0
2 20 20
3 20 20
4 0 0

Boundary Conditions: Kz (kip/in); Kry (kip-in/rad)

Supp Spring Kz  Spring Kry Far End A Far End B
1 0 0 Fixed Fixed
2 0 0 Fixed Fixed
3 0 0 Fixed Fixed
4 0 0 Fixed Fixed

Load Data

Load Cases and Combinations:

Case SELF Dead Live

Type DEAD DEAD LIVE

U1l 0.000 1.200 1.600

Span Loads:

Span Case Wa La Wb Lb

Line Loads - Wa | Wb (lb/ft), La | Lb (ft):

1 Dead 1167 0 1167 25

2 Dead 1167 0 1167 15

3 Dead 1167 0 1167 20

1 Live 450 0 450 25

2 Live 450 0 450 15

3 Live 450 0 450 20
Support Loads: --- NONE ---

6-12
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Support Displacements:  --- NONE ---
Reinforcement Criteria
Top bars Bottom bars__ Stirrups
Min Max Min Max Min Max
Slabs and Ribs:
Bar Size #5 #8 #5 #8
Bar spacing 1.00 18.00 1.00 18.00 in
Reinf ratio 0.14 5.00 0.14 5.00 %
Cover 1.50 1.50 in
Beams:
Bar Size #5 #8 #5 #8 #3 #5
Bar spacing 1.00 18.00 1.00 18.00 6.00 18.00 in
Reinf ratio 0.14 5.00 0.14 5.00 %
Cover 1.50 1.50 in
Side cover 1.50 1.50 in
Layer dist. 1.00 1.00 in
No. of legs 2 6
[2] DESIGN RESULTS
Moment Redistribution Factors:
Units: Org.Mu (k-ft)
Calculated __User_ _Applied_
Supp Side Org.Mu Iter.# EpsilonT Factor([%] Limit[%] Factor[%
1 Right 83.53 7 0.01796 17.96 0.00 0.00
2 Left 91.92 6 0.01526 15.26 20.00 15.26
2 Right 41.57 2 0.04168 20.00 20.00 20.00
3 Left 32.97 2 0.05368 20.00 20.00 20.00
3 Right 57.21 2 0.02909 20.00 20.00 20.00
4 Left 49.30 2 0.03446 20.00 0.00 0.00
Top Reinforcement:
Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in"2), Sp (in
Span Zone Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 Left 0.00 83.10 0.667 0.568 3.075 1.681 1.404 5-#5
Middle 0.00 0.00 12.500 0.000 3.075 0.000 0.000 -
Right 0.00 75.67 24.333 0.568 3.075 1.681 1.269 5-#5
2 Left 0.00 31.23 0.667 0.568 3.075 1.681 0.502 5-#5
Middle 0.00 0.00 7.500 0.000 3.075 0.000 0.000 -
Right 0.00 24.35 14.333 0.518 3.075 3.361 0.389 3-#5
3 Left 0.00 43.45 0.667 0.568 3.075 3.361 0.706 3-#5
Middle 0.00 0.00 10.000 0.000 3.075 0.000 0.000 -
Right 0.00 48.84 19.333 0.568 3.075 3.361 0.798 3-#5
Top Bar Details:
Units: Length (ft)
Left Continuous__ Right
Span Bars Length Bars Length Bars Length Bars Length Bars Length
1 3-#5 6.13 2-#5 2.94 - 3-#5 5.88 2-#5 2.65
2 3-#5 4.83 2-#5 1.85 - 2-#5 4.33 1-#5 1.85
3 2-#5 4.59 1-#5 2.12 - 2-#5 4.84 1-#5 2.39
Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in”2), Sp (in)
Span Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 1.00 69.82 12.625 0.568 3.075 2.241 1.164 4-#5
2 1.00 25.96 7.624 0.553 3.075 6.722 0.416 2-#5
3 1.00 47.12 9.876 0.568 3.075 3.361 0.769 3-#5

Bottom Bar Details

Examples
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Units: Start (ft), Length (ft)
Long Bars Short Bars
Span Bars Start Length Bars Start Length

1 2-#5 0.00 25.00 2-#5 5.66 14.02

2 2-#5 0.00 15.00 -—=

3 2-#5 0.00 20.00 1-#5 5.76 8.13

Units: x (ft), As (in”2), PhiMn (k-ft)

Span x AsTop AsBot PhiMn- PhiMn+
1 0.000 1.55 0.62 -91.01 38.31
0.667 1.55 0.62 -91.01 38.31
0.946 1.55 0.62 -91.01 38.31
2.943 0.93 0.62 -56.51 38.31
4.135 0.93 0.62 -56.51 38.31
5.662 0.22 0.62 -13.82 38.31
6.132 0.00 0.81 0.00 49.41
7.214 0.00 1.24 0.00 74.08
8.950 0.00 1.24 0.00 74.08
12.500 0.00 1.24 0.00 74.08
16.050 0.00 1.24 0.00 74.08
18.128 0.00 1.24 0.00 74.08
19.117 0.00 0.84 0.00 51.59
19.681 0.29 0.62 -18.25 38.31
20.922 0.93 0.62 -56.51 38.31
22.351 0.93 0.62 -56.51 38.31
24.156 1.55 0.62 -91.01 38.31
24.333 1.55 0.62 -91.01 38.31
25.000 1.55 0.62 -91.01 38.31
2 0.000 1.55 0.62 -91.01 38.31
0.667 1.55 0.62 -91.01 38.31
0.849 1.55 0.62 -91.01 38.31
1.849 0.93 0.62 -56.51 38.31
3.831 0.93 0.62 -56.51 38.31
4.831 0.00 0.62 0.00 38.31
5.450 0.00 0.62 0.00 38.31
7.500 0.00 0.62 0.00 38.31
9.550 0.00 0.62 0.00 38.31
10.666 0.00 0.62 0.00 38.31
11.666 0.62 0.62 -38.31 38.31
13.151 0.62 0.62 -38.31 38.31
14.151 0.93 0.62 -56.51 38.31
14.333 0.93 0.62 -56.51 38.31
15.000 0.93 0.62 -56.51 38.31
3 0.000 0.93 0.62 -56.51 38.31
0.667 0.93 0.62 -56.51 38.31
1.116 0.93 0.62 -56.51 38.31
2.116 0.62 0.62 -38.31 38.31
3.587 0.62 0.62 -38.31 38.31
4.587 0.00 0.62 0.00 38.31
5.755 0.00 0.62 0.00 38.31
6.755 0.00 0.93 0.00 56.51
7.200 0.00 0.93 0.00 56.51
10.000 0.00 0.93 0.00 56.51
12.800 0.00 0.93 0.00 56.51
12.883 0.00 0.93 0.00 56.51
13.883 0.00 0.62 0.00 38.31
15.164 0.00 0.62 0.00 38.31
16.182 0.62 0.62 -38.31 38.31
17.614 0.62 0.62 -38.31 38.31
18.631 0.93 0.62 -56.51 38.31
19.333 0.93 0.62 -56.51 38.31
20.000 0.93 0.62 -56.51 38.31

Longitudinal Beam Shear Reinforcement Required:

Units: d (in), Start, End, Xu (ft), PhiVec, Vu (kip), Av/s (in”2/in)

Span d Phive start End vu Xu Av/s
1 14.00 15.94 1.833 4.881 22.99 1.833  0.0112
4.881 7.929 16.53 4.881  0.0100

7.929 10.976 10.07 7.929 0.0100

10.976  14.024 3.61 10.976  0.0000

14.024  17.071 9.41  17.071  0.0100

17.071  20.119 15.87 20.119  0.0100
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20.119 23.167

2 14.00 15.94 1.833 3.452
3.452 5.071

5.071 6.690

6.690 8.310

8.310 9.929

9.929 11.548

11.548 13.167

3 14.00 15.94 1.833 4.167

4.167 6.500
6.500 8.833
8.833 11.167
11.167 13.500
13.500 15.833
15.833 18.167

Longitudinal Beam Shear Reinforcement Details:

Units: spacing & distance (in).

22.34

9.47
6.04
2.61
5.12

11.98

23.167

.833
452
071
690
.929

WO U W

[

.167

1.833
4.167
6.500
11.167
13.500
15.833
18.167

Span Size Stirrups (2 legs each unless otherwise noted)

1 #3 19 € 6.7 + <-- 36.6 -=> + 19 @ 6.7
2 #3 9@ 6.2 + <-- 58.3 --> + 9 @ 6.2
3 #3 11 € 6.7 + <-- 84.0 --> + 11 @ 6.7

Beam Shear Capacity

)

coooocoo

coooocoo

0102

0100
0100
0000
0000
0000
.0100
0100

0100
0100
0000
0000
0000
0100
0100

Units: d, Sp (in), Start, End, Xu (ft), PhiVc, PhiVn, Vu (kip), Av/s (in*2/in)
Span d Phivc Start End Av/s Sp Phivn Vu Xu
1 14.19 16.15 0.000 0.917  -=--= —mme- 37.10 26.88 0.000
0.917 10.976 0.0328 6.7 37.10 22.96 1.849
10.976 14.024  -----  ---—- 8.08 3.61 10.976
14.024 24.083 0.0328 6.7 37.10 22.30 23.151
24.083 25.000  ----- —-—-- 37.10 26.22 25.000
2 14.19 16.15 0.000 0.917  -----  —---= 38.69 16.79 0.000
0.917 5.071 0.0353 6.2 38.69 12.87 1.849
5.071 9.929  -----  ——-—= 8.08 6.04 5.071
9.929 14.083 6.2 38.69 11.95 13.151
14.083 15.000 38.69 15.87 15.000
3 14.19 16.15 0.000 0.917  ----- —---- 37.11 20.96 0.000
0.917 6.500 0.0328 6.7 37.11 17.04 1.849
6.500 13.500  -—-—-  -—-—— 8.08 7.80 13.500
13.500 19.083 0.0328 6.7 37.11 17.67 18.151
19.083 20.000  ----- —mmee 37.11 21.59 20.000
Slab Shear Capacity
: b, d (in), Xu (ft), PhivVc, Vu(kip)
Span b d Vratio Phivc vu Xu
1 - Not checked ---
2 - Not checked ---
3 --- Not checked ---
Deflections:
Section properties
Units: Ig, Icr, Ie (in”4), Mcr, Mmax (k-ft) Load Level
Te,avg Dead Dead+Live
Span Dead Dead+Live Zone Ig Icr Mcr Mmax Te Mmax Ie
1 1504 1367 Middle 4096 1229 20.24 44.81 1493 59.56 1342
Right 4096 1464 20.24 -59.62 1567 -79.25 1508
2 3856 3498 Left 4096 1464 20.24 -26.08 2694 -34.67 1988
Middle 4096 695 20.24 15.11 4096 20.08 4096
Right 4096 975 20.24 -20.68 3900 -27.49 2221
3 1857 1351 Left 4096 975 20.24 -36.48 1508 -48.50 1202
Middle 4096 975 20.24 30.15 1919 40.08 1377

Maximum Instantaneous Deflections

Units: D (in)
Span Ddead Dlive Dtotal

Examples
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1 0.402
2 0.009
3 0.138

0.178
0.005
0.098

0.580
0.013
0.236

Maximum Long-term Deflections

Time dependant factor for sustained loads = 2.000

Units: D (in)

Span Dsust Lambda Dcs Dcs+lu Dcs+1l Dtotal
1 0.402 2.000 0.805 0.983 0.983 1.385
2 0.009 2.000 0.018 0.022 0.022 0.031
3 0.138 2.000 0.276 0.374 0.374 0.512
Material Takeoff:
Reinforcement in the Direction of Analysis
Top Bars: 103.6 1b <=> 1.73 1b/ft > 1.726 1b/ft"2
Bottom Bars: 162.9 1b 2.71 1b/ft > 2.715 1lb/ft"2
Stirrups: 322.6 1b 5.38 1b/ft > 5.377 1lb/ft"2
Total Steel: 589.0 1b 9.82 1b/ft > 9.817 1lb/ft"2
Concrete: 80.0 ft"3 <=> 1.33 ft"3/ft <=> 1.333 ft"3/ft"2
[3] REDISTRIBUTED COLUMN AXIAL FORCES AND MOMENTS
Units: P (kip), M (k-ft)
Case/Patt Joint Far Ends
Supp Comb/Patt Plaxial] P[spring] Mb[top] Ma [bottom] M[spring] Mb [bottom] Ma([top]
1 SELF 2.53 0.00 -4.71 -4.71 0.00 2.35 2.35
Dead 14.75 0.00 -27.48 -27.48 0.00 13.74 13.74
Live/All 5.69 0.00 -10.60 -10.60 0.00 5.30 5.30
Live/0dd 5.74 0.00 -10.81 -10.81 0.00 5.41 5.41
Live/Even -0.05 0.00 0.22 0.22 0.00 -0.11 -0.11
Live/S1 5.73 0.00 -10.78 -10.78 0.00 5.39 5.39
Live/s2 5.68 0.00 -10.56 -10.56 0.00 5.28 5.28
Live/S3 -0.04 0.00 0.18 0.18 0.00 -0.09 -0.09
Live/S4 0.01 0.00 -0.03 -0.03 0.00 0.02 0.02
Ul/All 26.80 0.00 -49.93 -49.93 0.00 24.96 24.96
Ul/0dd 26.88 0.00 -50.27 -50.27 0.00 25.14 25.14
Ul/Even 17.62 0.00 -32.63 -32.63 0.00 16.31 16.31
Ul/s1 26.87 0.00 -50.22 -50.22 0.00 25.11 25.11
Ul/s2 26.79 0.00 -49.87 -49.87 0.00 24.94 24.94
Ul/s3 17.63 0.00 -32.68 -32.68 0.00 16.34 16.34
Ul/s4 17.71 0.00 -33.03 -33.03 0.00 16.51 16.51
2 SELF 4.02 0.00 2.45 2.45 0.00 -1.23 -1.23
Dead 23.49 0.00 14.32 14.32 0.00 =7.16 -7.16
Live/All 9.06 0.00 5.52 5.52 0.00 -2.76 -2.76
Live/0Odd 5.63 0.00 8.15 8.15 0.00 -4.07 -4.07
Live/Even 3.42 0.00 -2.63 -2.63 0.00 1.31 1.31
Live/S1 5.87 0.00 7.74 7.74 0.00 -3.87 -3.87
Live/S2 9.27 0.00 5.12 5.12 0.00 -2.56 -2.56
Live/S3 3.21 0.00 -2.22 -2.22 0.00 1.11 1.11
Live/S4 -0.23 0.00 0.51 0.51 0.00 -0.26 -0.26
Ul/All 42.67 0.00 26.01 26.01 0.00 -13.01 -13.01
Ul/0dd 37.20 0.00 30.22 30.22 0.00 -15.11 -15.11
Ul/Even 33.66 0.00 12.97 12.97 0.00 -6.49 -6.49
Ul/s1 37.58 0.00 29.57 29.57 0.00 -14.79 -14.79
uUl/s2 43.02 0.00 25.37 25.37 0.00 -12.68 -12.68
Ul/s3 33.31 0.00 13.62 13.62 0.00 -6.81 -6.81
Ul/s4 27.81 0.00 18.00 18.00 0.00 -9.00 -9.00
3 SELF 3.42 0.00 -1.16 -1.16 0.00 0.58 0.58
Dead 19.97 0.00 -6.75 -6.75 0.00 3.37 3.37
Live/All 7.70 0.00 -2.60 -2.60 0.00 1.30 1.30
Live/0dd 4.25 0.00 -5.19 -5.19 0.00 2.60 2.60
Live/Even 3.45 0.00 2.59 2.59 0.00 -1.30 -1.30
Live/S1 -0.37 0.00 -0.79 -0.79 0.00 0.39 0.39
Live/S2 3.10 0.00 1.96 1.96 0.00 -0.98 -0.98
Live/S3 8.05 0.00 -1.97 -1.97 0.00 0.99 0.99
Live/s4 4.61 0.00 -4.56 -4.56 0.00 2.28 2.28
U1l/All 36.28 0.00 -12.26 -12.26 0.00 6.13 6.13
Ul/odd 30.76 0.00 -16.40 -16.40 0.00 8.20 8.20
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Ul/Even 29.48 0.00 -3.95 -3.95 0.00
Ul/sl 23.36 0.00 -9.36 -9.36 0.00
Ul/s2 28.93 0.00 -4.96 -4.96 0.00
Ul/s3 36.84 0.00 -11.25 -11.25 0.00
Ul/s4 31.34 0.00 -15.40 -15.40 0.00
4 SELF 2.03 0.00 2.92 2.92 0.00 -1.
Dead 11.82 0.00 17.04 17.04 0.00 -8
Live/All 4.56 0.00 6.57 6.57 0.00 -3.
Live/0dd 4.63 0.00 6.83 6.83 0.00 -3
Live/Even -0.07 0.00 -0.26 -0.26 0.00
Live/S1 0.02 0.00 0.06 0.06 0.00 -0.
Live/S2 -0.05 0.00 -0.19 -0.19 0.00
Live/S3 4.54 0.00 6.51 6.51 0.00 -3
Live/S4 4.61 0.00 6.77 6.77 0.00 -3.
UL/All 21.47 0.00 30.97 30.97 0.00 -15.
Ul/0dd 21.59 0.00 31.38 31.38 0.00 -15.
Ul/Even 14.06 0.00 20.04 20.04 0.00 -10.
Ul/s1 14.21 0.00 20.55 20.55 0.00 -10.
Ul/s2 14.09 0.00 20.14 20.14 0.00 -10.
Ul/s3 21.44 0.00 30.87 30.87 0.00 -15.
Ul/s4 21.56 0.00 31.28 31.28 0.00 -15.
Sum SELF 12.00 0.00 -0.49 -0.49 0.00
Dead 70.02 0.00 -2.86 -2.86 0.00
Live/All 27.00 0.00 -1.10 -1.10 0.00
Live/0Odd 20.25 0.00 -1.03 -1.03 0.00
Live/Even 6.75 0.00 -0.08 -0.08 0.00
Live/S1 11.25 0.00 -3.76 -3.76 0.00
Live/S2 18.00 0.00 -3.68 -3.68 0.00
Live/S3 15.75 0.00 2.50 2.50 0.00 -
Live/S4 9.00 0.00 2.68 2.68 0.00 -
Ul/All 127.22 0.00 -5.20 -5.20 0.00
Ul/0dd 116.42 0.00 -5.08 -5.08 0.00
Ul/Even 94.82 0.00 -3.56 -3.56 0.00
Ul/s1 102.02 0.00 -9.45 -9.45 0.00
uUl/s2 112.82 0.00 -9.32 -9.32 0.00
Ul/s3 109.22 0.00 0.56 0.56 0.00 -
Ul/s4 98.42 0.00 0.86 0.86 0.00 -
[6] REDISTRIBUTED SEGMENTAL MOMENT AND SHEAR - ENVELOPES
Span x (ft) M- (k-ft) Comb M+ (k-ft) Comb V- (kip) Comb V+ (kip) Comb
1 0.000 -100.54 Ul 0.00 Ul 0.00 Ul 26.88 Ul
0.222 -94.62 Ul 0.00 Ul 0.00 Ul 26.41 Ul
0.444 -88.81 Ul 0.00 Ul 0.00 Ul 25.94 U1
0.667 -83.10 Ul 0.00 Ul 0.00 Ul 25.47 Ul
0.667 -83.10 Ul 0.00 U1 0.00 U1 25.47 U1
0.916 -76.82 Ul 0.00 Ul 0.00 Ul 24.94 Ul
1.165 -70.67 Ul 0.00 Ul 0.00 U1 24.41 UL
1.414 -64.66 UL 0.00 Ul 0.00 Ul 23.88 Ul
1.663 -58.77 Ul 0.00 Ul 0.00 Ul 23.35 Ul
1.912 -53.02 Ul 0.00 U1 0.00 U1 22.82 U1
2.161 -47.40 Ul 0.00 Ul 0.00 Ul 22.30 Ul
2.411 -41.91 Ul 0.00 Ul 0.00 U1 21.77 U1
2.660 -36.55 Ul 0.00 Ul 0.00 Ul 21.24 Ul
2.909 -31.33 Ul 0.00 Ul 0.00 Ul 20.71 Ul
3.158 -26.23 Ul 0.00 U1 0.00 Ul 20.18 Ul
3.407 -21.27 Ul 0.00 Ul 0.00 U1 19.66 Ul
3.656 -16.44 Ul 0.00 UL 0.00 U1 19.13 Ul
3.905 -11.74 U1 0.00 Ul 0.00 Ul 18.60 Ul
4.154 -7.17 Ul 0.00 Ul 0.00 Ul 18.07 Ul
4.404 -2.74 U1 0.00 U1 0.00 U1 17.54 U1
4.653 0.00 Ul 1.94 U1 0.00 U1 17.01 U1
4.902 0.00 Ul 6.09 UL 0.00 U1 16.49 Ul
5.151 0.00 Ul 10.10 U1 0.00 Ul 15.96 U1
5.400 0.00 Ul 13.99 Ul 0.00 Ul 15.43 U1
5.649 0.00 U1 17.75 Ul 0.00 U1 14.90 Ul
5.898 0.00 Ul 21.37 U1 0.00 U1 14.37 U1
6.147 0.00 Ul 24.86 Ul 0.00 Ul 13.84 Ul
6.396 0.00 Ul 28.22 U1 0.00 U1 13.32 U1
6.646 0.00 Ul 31.45 Ul 0.00 Ul 12.79 U1
6.895 0.00 UL 34.55 Ul 0.00 Ul 12.26 Ul
7.144 0.00 Ul 37.51 U1 0.00 Ul 11.73 U1
7.393 0.00 Ul 40.35 Ul 0.00 Ul 11.20 Ul
7.642 0.00 Ul 43.05 U1 0.00 U1 10.68 Ul

1.97
4.68
2.48
5.62
7.70

-1.46
-8.52
-3.29
-3.41

0.13
-0.03

0.10
-3.26
-3.38

-15.48
-15.69
-10.02
-10.28
-10.07
-15.44
-15.64

0.25
1.43
0.55
0.51
0.04
1.88
1.84
-1.25
-1.34

2.60
2.54
1.78
4.73
4.66
-0.28
-0.43

Examples
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891
140
389
639
888
137
386
635

.884
.133
.382
.632
.881
.130
.379
.628
.877
.126
.375
.625
.874
.123
.372
.621
.870
.119
.368
.618
.867
.116
.365
.614
.863
.112
.361
.611
.860
.109
.358
.607
.856
.105
.354
.604
.853
.102
.351
.600
.849
.098
.347
.596
.846
.095
.344
.593
.842
.091
.340
.589
.839
.088
.337
.586
.835
.084
.333
.333
.556
.778
.000

000
222
444
667
667
915
164
412
661
909

-92.

-41.
-38.
-34.
-31.
-31.
=27.
-23.
-20.
-16.
-13.

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

45.62
48.06
50.37
52.54
54.61
56.54
58.35
60.02
61.56
62.97
64.25
65.39
66.41
67.29
68.04
68.66
69.15
69.51
69.73
69.82
69.79
69.62
69.32
68.88
68.32
67.62
66.79
65.83
64.74
63.52
62.17
60.68
59.06
57.31
55.43
53.42
51.28
49.00
46.59
44.06
41.39
38.58
35.65
32.59
29.39
26.06
22.60
19.01
15.29
11.43

7.45

3.33

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
-0.06
-0.51
-1.04
-1.57
-2.09
-2.62
-3.15
-3.68
-4.21
-4.74
-5.26
-5.79
-6.32
-6.85
-7.38
-7.91
-8.43
-8.96
-9.49
-10.02
-10.55
-11.07
-11.60
-12.13
-12.66
-13.19
-13.72
-14.24
-14.77
-15.30
-15.83
-16.36
-16.89
-17.41
-17.94
-18.47
-19.00
-19.53
-20.05
-20.58
-21.11
-21.64
-22.17
-22.70
-23.22
-23.75
-24.28
-24.81
-24.81
-25.28
-25.75
-26.22

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

10.15
9.62
9.09
8.56
8.03
7.51
6.98
6.45
5.92
5.39
4.86
4.34
3.81
3.28
2.75
2.22
1.70
1.17
0.64
0.11
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

16.79
16.32
15.85
15.38
15.38
14.85
14.33
13.80
13.27
12.75

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul

Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
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158
406
655
903
152
400
648
897
145
394
642
891
139
388
636
885
133
382
630
879
127
376
624
873
121
370
618
867
115
364
612

.861
.109
.358
.606
.855
.103
.352
.600
.848
.097
.345
.594
.842
.091
.339
.588
.836
.085
.333
.333
.556
L7178
.000

000
222
444
667
667
916
164
413
662
911
160
409
658
907
156
404
653
902
151
400
649
898
147
396
644
893
142

-10.

-6.
-4.
-3.
-1.

-1.
-3.
-5.
-8.
-11.
-14.
-17.
-20.
-24.
-24.
=27.
-30.
-34.

-56.
-52.
-47.
-43.
-43.
-38.
-33.
-29.
-25.
-20.
-16.
-12.

-8.

4.

-1.

o

0000000000000 0000000000000000000

cooocoocoooooo

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
2.39
4.75
6.99
9.09
11.06
12.90
14.61
16.24
17.77
19.17
20.43
21.57
22.58
23.46
24.20
24.81
25.30
25.65
25.87
25.96
25.92
25.75
25.45
25.01
24.45
23.76
22.93
21.97
20.88
19.67
18.32
16.90
15.42
13.81
12.07
10.19
8.19
6.05
3.79
1.39
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.05
3.50
6.82
10.01
13.06
15.99
18.78
21.45
23.98
26.38
28.65
30.78
32.79

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
-0.23
-0.76
-1.29
-1.81
-2.34
-2.87
-3.39
-3.92
-4.45
-4.97
-5.50
-6.03
-6.55
-7.08
-7.61
-8.13
-8.66
-9.19
-9.72
-10.24
-10.77
-11.30
-11.82
-12.35
-12.88
-13.40
-13.93
-14.46
-14.46
-14.93
-15.40
-15.87

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

12.22
11.69
11.17
10.64
10.11
9.58
9.06
8.53
8.00
7.48
6.95
6.42
5.90
5.37
4.84
4.32
3.79
3.26
2.73
2.21
1.68
1.15
0.76
0.41
0.07
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

20.96
20.49
20.02
19.55
19.55
19.02
18.50
17.97
17.44
16.91
16.38
15.86
15.33
14.80
14.27
13.75
13.22
12.69
12.16
11.64
11.11
10.58
10.05

9.52

9.00

8.47

7.94

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul

Examples
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6.391 0.00 Ul 34.67 Ul 0.00 Ul 7.41 Ul
6.640 0.00 UL 36.41 Ul 0.00 U1 6.89 UL
6.889 0.00 Ul 38.02 U1 0.00 U1 6.36 Ul
7.138 0.00 Ul 39.50 Ul 0.00 Ul 5.83 Ul
7.387 0.00 U1 40.85 Ul 0.00 U1 5.30 Ul
7.636 0.00 Ul 42.07 Ul 0.00 Ul 4.77 U1
7.884 0.00 UL 43.16 Ul 0.00 U1 4.25 Ul
8.133 0.00 U1 44.11 U1 0.00 U1 3.72 U1
8.382 0.00 Ul 44.94 Ul 0.00 Ul 3.19 Ul
8.631 0.00 UL 45.63 Ul 0.00 U1 2.66 Ul
8.880 0.00 Ul 46.19 U1 0.00 Ul 2.14 Ul
9.129 0.00 UL 46.62 Ul 0.00 Ul 1.61 UL
9.378 0.00 U1 46.92 Ul 0.00 U1 1.08 U1
9.627 0.00 Ul 47.09 Ul 0.00 Ul 0.55 Ul
9.876 0.00 Ul 47.12 Ul -0.12 Ul 0.11 Ul
10.124 0.00 Ul 47.03 Ul -0.65 Ul 0.00 Ul
10.373 0.00 UL 46.80 Ul -1.17 Ul 0.00 Ul
10.622 0.00 U1 46.44 Ul -1.70 Ul 0.00 Ul
10.871 0.00 Ul 45.95 U1 -2.23 Ul 0.00 Ul
11.120 0.00 U1 45.33 Ul -2.76 Ul 0.00 Ul
11.369 0.00 Ul 44.58 Ul -3.29 U1 0.00 U1
11.618 0.00 Ul 43.70 Ul -3.81 Ul 0.00 Ul
11.867 0.00 Ul 42.68 Ul -4.34 U1 0.00 Ul
12.116 0.00 Ul 41.54 U1 -4.87 Ul 0.00 Ul
12.364 0.00 Ul 40.26 Ul -5.40 Ul 0.00 Ul
12.613 0.00 Ul 38.85 Ul -5.92 U1 0.00 U1
12.862 0.00 Ul 37.31 Ul -6.45 Ul 0.00 Ul
13.111 0.00 UL 35.67 Ul -6.98 Ul 0.00 Ul
13.360 0.00 Ul 33.90 Ul -7.51 U1 0.00 Ul
13.609 0.00 Ul 32.00 Ul -8.04 Ul 0.00 Ul
13.858 0.00 U1 29.97 U1 -8.56 Ul 0.00 U1
14.107 0.00 Ul 27.81 Ul -9.09 Ul 0.00 Ul
14.356 0.00 UL 25.52 Ul -9.62 Ul 0.00 Ul
14.604 0.00 Ul 23.09 U1 -10.15 U1 0.00 Ul
14.853 0.00 Ul 20.54 Ul -10.67 Ul 0.00 Ul
15.102 0.00 U1 17.85 Ul -11.20 Ul 0.00 Ul
15.351 0.00 Ul 15.03 Ul -11.73 Ul 0.00 Ul
15.600 0.00 UL 12.08 Ul -12.26 Ul 0.00 Ul
15.849 0.00 Ul 9.00 Ul -12.78 Ul 0.00 Ul
16.098 0.00 Ul 5.79 UL -13.31 Ul 0.00 Ul
16.347 0.00 U1 2.45 Ul -13.84 Ul 0.00 Ul
16.596 -1.55 U1 0.00 Ul -14.37 Ul 0.00 Ul
16.844 -5.20 Ul 0.00 U1 -14.90 Ul 0.00 Ul
17.093 -8.97 Ul 0.00 Ul -15.42 U1l 0.00 Ul
17.342 -12.87 Ul 0.00 Ul -15.95 Ul 0.00 Ul
17.591 -16.91 Ul 0.00 U1 -16.48 Ul 0.00 Ul
17.840 -21.08 Ul 0.00 Ul -17.01 Ul 0.00 Ul
18.089 -25.37 Ul 0.00 U1 -17.53 Ul 0.00 Ul
18.338 -29.80 Ul 0.00 Ul -18.06 Ul 0.00 U1
18.587 -34.37 Ul 0.00 Ul -18.59 U1 0.00 Ul
18.836 -39.06 Ul 0.00 Ul -19.12 Ul 0.00 Ul
19.084 -43.88 Ul 0.00 Ul -19.65 Ul 0.00 Ul
19.333 -48.84 Ul 0.00 Ul -20.17 Ul 0.00 Ul
19.333 -48.84 Ul 0.00 U1 -20.17 Ul 0.00 U1
19.556 -53.37 Ul 0.00 Ul -20.64 Ul 0.00 Ul
19.778 -58.01 Ul 0.00 Ul -21.12 Ul 0.00 Ul
20.000 -62.76 ULl 0.00 Ul -21.59 U1 0.00 Ul
[7] SEGMENTAL DEFLECTIONS
Units: x (ft), D (in)
Span X Ddead Dlive Dtotal
1 0.000 0.000 0.000 0.000
0.222 0.002 0.001 0.002
0.444 0.004 0.001 0.005
0.667 0.006 0.002 0.009
0.667 0.006 0.002 0.009
0.916 0.010 0.003 0.013
1.165 0.015 0.005 0.020
1.414 0.020 0.007 0.027
1.663 0.027 0.010 0.037
1.912 0.034 0.013 0.047
2.161 0.042 0.016 0.058
2.411 0.050 0.020 0.071
2.660 0.060 0.024 0.084
2.909 0.070 0.028 0.098
3.158 0.080 0.033 0.113

6-20

Examples



p Igﬁb | pcﬁﬁm

407
656
905
154
404
653
902
151
400
649
898
147
396
646
895
144
393
642
891
140
389
639
888
137
386
635

.884
.133
.382
.632
.881
.130
.379
.628
.877
.126
.375
.625
.874
.123
.372
.621
.870
.119
.368
.618
.867
.116
.365
.614
.863
.112
.361
.611
.860
.109
.358
.607
.856
.105
.354
.604
.853
.102
.351
.600
.849
.098
.347
.596
.846
.095
.344
.593
.842
.091
.340
.589
.839
.088
.337
.586

OO 0000000000000 0000000000000000000000000000000000000000000000000000000000000000000

.091

102
113
125
137
149
162
174
187
199
211
223
235
247
259
270
281
292
303
313
322
331
340
348
356
363
370
376
381
386
390
394
397
399
401
402
402
402
401
400
398
395
391
387
383
378
372
365
358
351
343
334
325
316
306
296
285
274
263
251
239
228
215
203
191
178
166
154
141
129
117
106
094
083
073
063
053
044
036
029

.022
.016

0.038
0.043
0.048
0.053
0.058
0.064
0.069
0.075
0.080
0.086
0.091
0.097
0.102
0.107
0.113
0.118
0.123
0.128
0.132
0.137
0.141
0.145
0.149
0.153
0.156
0.160
0.163
0.165
0.168
0.170
0.172
0.174
0.175
0.176
0.177
0.178
0.178
0.178
0.177
0.177
0.176
0.174
0.173
0.171
0.169
0.167
0.164
0.161
0.158
0.155
0.151
0.147
0.143
0.139
0.135
0.130
0.125
0.120
0.115
0.110
0.105
0.099
0.094
0.088
0.083
0.077
0.072
0.066
0.061
0.056
0.050
0.045
0.040
0.035
0.031
0.026
0.022
0.018
0.015
0.011
0.009
0.006

OO 0000000000000 0000000000000000000000000000000000000000000000000000000000000000000

.128
.145
.161
.178
.195
.213
.231
.249
.267
.285
.302
.320
.337
.355
.372
.388
.404
.420
.435
.449
.463
.477
.489
.501
.512
.523
.532
.541
.549
.556
.562
.568
.572
.575
.578

580

.580
.580
.579
.577
.573
.569
.564
.559
.552
.544
.536
.527
.516
.506
.494
.482
.469
.455
.441
.426
.410
.394
.378
.361
.344
.327
.309

292

.274
.256
.238
.220
.202
.185
.168
.151
.135
.119
.104
.089
.075
.063
.051
.040
.031
.022
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.835
.084
.333
.333
.556
.778
.000

000
222
444
667
667
915
164
412
661
909
158
406
655
903
152
400
648
897
145
394
642
891
139
388
636
885
133
382
630
879
127
376
624
873
121
370
618
867
115
364
612

.861
.109
.358
.606
.855
.103
.352
.600
.848
.097
.345
.594
.842
.091
.339
.588
.836
.085
.333
.333
.556
L7178
.000

000
222
444
667
667
916
164
413
662

.011

007
004
004
003

.001
.000

.000
.001
.002
.002
.002
.002
.003
.003
.003
.003
.002
.002
.001
.001
.000
.000

001

.002

002
003
004
004
005
005
006
007
007
007
008
008
008
009
009
009
009
009
009
008
008
008
007
007
007
006
005
005
004
004
003
003
002

.001
.001
.000
.000
.000
.001
.001
.001
.001
.001
.001
.000
.000

.000

001
001
003
003
004
006

.009
.012

coooocoo

o

000 0000000000000 000000000000000000O0O00 00O

o

o

cooocoooooo

.004
.003
.002
.002
.001
.000
.000

.000
.000
-0.
-0.
-0.
-0.
-0.
-0.
.001
-0.
-0.
-0.
-0.
.000
.000
.001
.001
.001
.002
.002
.002
.003
.003
.003
.003
.004
.004
.004
.004
.004
.004
.005
.005
.005
.005
.005
.004
.004
.004
.004
.004
.004
.003
.003
.003
.003
.002
.002
.002
.001
.001
.001
.001
.000
.000
.000
-0.
-0.
-0.
-0.
-0.
-0.
.000
.000

001
001
001
001
001
001

001
001
000
000

000
000
000
000
000
000

.000
.000
.001
.001
.001
.002
.003
.004
.006

cooocoocoo

=)

OO0 0000000000000 0000000000000000000000 O

=)

o

coocooooooo

.015
.010
.006
.006
.004
.002
.000

.000
.001
-0.
-0.
-0.
-0.
-0.
-0.
.004
-0.
-0.
-0.
-0.
-0.
-0.
.001
.002
.003
.004
.005
.006
.007
.008
.009
.009
.010
L011
.012
.012
.013
.013
.013
.013
.013
.013
.013
.013
.013
.012
.012
.011
.011
.010
.009
.008
.008
.007
.006
.005
.004
.003
.002
.001
.001
.000
.000
-0.
-0.
-0.
-0.
-0.
-0.
.001
.000

002
003
003
003
004
004

003
003
002
002
001
000

001
001
001
001
001
001

.000
.001
.002
.003
.003
.006
.009
.013
.018
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911
160
409
658
907
156
404
653
902
151
400
649
898
147
396
644
893
142
391
640
889
138
387
636
884
133
382
631
880
129
378
627

.876
.124
.373
.622
.871
.120
.369
.618
.867
.116
.364
.613
.862
L111
.360
.609
.858
.107
.356
.604
.853
.102
.351
.600
.849
.098
.347
.596
.844
.093
.342
.591
.840
.089
.338
.587
.836
.084
.333
.333
.556
L7178
.000

0O 0000000000000 000000000000000000000000000000000000000000000000000000000000O0

.015

019
023
028
032
037
042
047
052
058
063
068
073
078
083
088
093
098
102
107
111
115
118
121
125
127
130
132
134
135
136
137
138
138
138
137
136
135
134
132
130
127
124
121
118
114
111
106
102
098
093
088
083
078
073
068
062
057
052
047
042
037
032
027
023
019
015
012
009
006
004
004
002

.001
.000

0O 0000000000000 0000000000000000000000000000000000000000000000000000000000000

.008
.011
.014
.017
.020
.024
.027
.031
.035
.039
.042
.046
.050
.054
.058
.062
.065
.069
.072
.075
.078
.081
.084
.086
.089
.091
.093
.094
.096
.097
.097
.098
.098
.098
.098
.098
.097
.096
.095
.093
.092
.090
.088
.085
.083
.080
.077
.074
.070
.067
.063
.060
.056
.052
.048
.044
.041
.037
.033
.029
.026
.022
.019
.016
.013
.010
.007
.005
.004
.002
.001
.001
.001
.000
.000

0O 0000000000000 000000000000000000000000000000000000000000000000000000000000O0

.024
.030
.037
.045
.052
.061
.069
.078
.087
.096
.105
.114
.123
.132
.141
.150
.158
.167
.174
.182
.189
.196
.202
.208
.213
.218
.222
.226
.229
.232
.234
.235
.236
.236
.236
.235
.233
.231
.229
.225
.221
.217
.212
.207
.201
.194
.187
.180
.173
.165
.156
.148
.139
.130
L121
L112
.103
.094
.085
.076
.067
.059
.051
.043
.036
.029
.023
.017
.012
.009
.005
.005
.003
.002
.000
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Grpahical Output

Loads

‘ 450 ‘450 ‘ 450 ‘
CASE: Live
1167 1167 1167
CASE: Dead
200 200 200
\ [ [ [ 1 [ T |
\ \
CASE: SELF

pecaBearn v2.00. Licensed to: PCA . License ID: 12345-1234567-4-2D2DE-2C80D0

File: C:\Program FilestPCA\pcaSlabiExamplesiManualExample 1 - PCA Notes on AC| 318-05 Example 8-2 slb

Project pcaSlab/pcaBeam Manual, Example 1

Frame: PCA Notes on ACI 318-05, Example 8-2

Engineer: pcaStructureFoint
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Internal Forces

300
74688 ! ! !
] ! 00 96 !
1 5.79 i
=
= I
g B |
o |
o |
g 7\
[ZRY
1i 15871
4! ! 2150
1 2620 i i
-30.0
1200
| ! . I
1thoos4 6k ‘ ;
e 1 ik 6276
: L56.96
E ] h1.95 a4
g ] ! LEGEND
g 4 | | —Envelope (Redist)
5 oEm | !
I 1 I I
= i i o i
4! 5982 ! !
4! 1 | I
1 | I \
1200

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files'PCAlpcaSlabExamplesiManualExample 1- PCA Notes on ACI 313-05 Example 8-2.5lb
Project pcaSlab/pcaBeam Manual, Example 1

Frame: PCA Notes on ACI 318-05, Example 8-2 Enginser pcaStructurePoint
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.
Moment Capacity
1200
| 1 I |
, 1 I |
\ I I
- J I I
I I
= I
S . ]
' 1 I
E . .
S 1 I
@ . .
5 - I |
o J |
5 ! !
5 ! !
= I . ;
I 1 I I
i i i i
i i i i
il ! ! ! LEGEND:
| 1 | | ——Envelope Curve
il | 1 1 —— Capacity Curve
. . . — - —Support Centerline
EiL ! ! ! ——Face of Support
1200

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files'PCAlpcaSlabExamplesiManualExample 1- PCA Notes on ACI 313-05 Example 8-2.slb
Project pcaSlab/pcaBeam Manual, Example 1

Frame: PCA Notes on ACI 318-05, Example 8-2 Enginser pcaStructurePoint
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.
Shear Capacity
400
T Tt
- 1 |
i i i
] i |
299 ; :
7 ! 1708
o 7 1291
=
z 7 L [
=)
s |
o
T
© —
&
@
=
[l
€ —_ —_
& -
@
o -11.98
- | 17.70
B 2234 !
| ! LEGEND.
7 | | —Envelope Curve
| 1 — Capacity Curve
7 . — - —Support Centerline
B I - L ——Face of Support
-40.0 —--—Critical Section
pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0
File: C\Program Files'PCAlpcaSlabExamplesiManualExample 1- PCA Notes on ACI 313-05 Example 8-2.5lb
Project pcaSlab/pcaBeam Manual, Example 1
Frame: PCA Notes on ACI 318-05, Example 8-2 Enginser pcaStructurePoint
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Deflection

10,580

LEGEND:
—Dead Load
—Live Load

—— Total Deflection

Instantaneous Deflection - in
|

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files'PCAlpcaSlabExamplesiManualExample 1- PCA Notes on ACI 313-05 Example 8-2.slb
Project pcaSlab/pcaBeam Manual, Example 1

Frame: PCA Notes on ACI 318-05, Example 8-2 Enginser pcaStructurePoint
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Reinforcement

— 2-#5(35.3)

| 3.445(73.6)

| 0.450318)

—2-#5(22.2)

| 3.45(58.0)

—1-#5(22.2)

—1-#5(25.4)

| 3.45(70.6)
{ 2.45(52.0)
| 2.445(55 0}
| 1-465(26.6)

= 2-#5(58.0)

Il

I

[

I

L

1-#5(87 5)—

19-43@6 7
2-#5(168 20—
19-43@6 7

QHA@6 2
2-45(180.0)c—
9#3@6.2

11-43@6 7

11-43@6 7
2-45(240.0)c—

2-#5(300.0)c—

Flexural and Transverse Reinforcement

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files'PCAlpcaSlabExamplesiManualExample 1- PCA Notes on ACI 313-05 Example 8-2.5lb
Project pcaSlab/pcaBeam Manual, Example 1

Frame: PCA Notes on ACI 318-05, Example 8-2 Enginser pcaStructurePoint
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Example 2 Spandrel beam with torsion SfablocGeam

Problem description

Design a precast, nonprestressed concrete spandrel beam for combined shear and
torsion. Roof members are simply supported on spandrel ledge. Spandrel beams
are connected to columns to transfer torsion. Continuity between spandrel beams is
not provided. This example refers to Example 13-1 from PCA Notes on ACI 318-
05 Building Code Requirements for Structural Concrete, Portland Cement
Association, 2005.

Interior ledge beam
! !« A ! ! !
| | | | 4 | |
= H H H e e—
T T T T T
| | | | | o 16
. . 10' - 0" x 24" - . x 16"
| l ‘//I/ double tee (typ) I l P/C cols
| c I I I |
60'- 0" | 31 | | I !
. g . . .
I [ I I I I
| | | | |
P/C cols
| I I ‘L spandrél beam I o
| | | | | /
1 - S - g
] H H H e —
| | A I I |

Partial plan of precast roof system

Design Criteria:

Live load = 30 1b/ft

Dead Load= 64 Ib/ft?

f. = 5000 psi (w, = 150 pcf)
fy = 60,000 psi

Roof members are 10 ft wide double tee units, 24 in. deep. Design of these units is
not included in this design example. For lateral support, alternate ends of roof
members are fixed to supporting beams.
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. " [ -
L 24" TT .
| = .
T )
<l | |3
{

V .
8" 4 3/8" welded pad ’ 4
i . (reverse ends on alternate TT's) .

3/8" elastomeric pad

Section A-A

Preparing Input

1.

From the Input menu, select General Information. A dialog box appears.

In the LABELS section, input the names of the project, frame, and
engineer.

In the FRAME section, input 2 for NO OF SUPPORTS.

In the FLOOR SYSTEM section, click the radial button next to ONE WAY /
BEAM.

Leave all other options in the General Information tab to their default
settings of ACI 318-05 design code, ASTM A615 reinforcement, and
DESIGN run mode option.

In the Solve Options tab, click the check box next to TORSION ANALYSIS
AND DESIGN.

Under TORSION TYPE, click the radial button next to EQUILIBRIUM.

Under the heading STIRRUPS IN FLANGES, click the radial button next to
YES.

Examples
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e Press OK.

General Information &‘ General Information El

General Information | Solve Options | Span Contiol | Generl Information Solve Options | Span Control |

Design Options

Labels

Live load patter ratio: {100 %
Frsjes: a
R |FEA Wates an #01 316405, Examgle 131 ™ Compression Hemlo.lcement r E"FTCEIVE flange wnjth.

™ Mament Redistibution I Rigid beanvcalumn joint
Engineer: [peaStuctuePaint W' Torsion Analysis and Design

Torsion type Stirnups in flangss

Options Fur mode & Equiibrium " Mo

Designcode: | ACI 31805 = = Design " Compatibity e ‘es

Reinforcement: | ASTM AE15 - " Investigation Deflection calculation options
Sections to use in deflection calculations are

IAEme e e £ Grass [uncracked) & Effective (cracked)
No. cf Supports |2
PP I negalive moment r2gions, to calculate Ig and Mor use
W it B ey | (0 e Y - r TSection
[ Distance localion as ratio of span 7 Bl e g s

Duration of load Sustained part of ive load

B0 months 0 %
oK Camcel | Hep | oK | cancel | Heb |

2. From the Input menu, select Material Properties. A dialog box appears.

e Input 5 for Comp. strength for both Slabs and Beams and Columns.

e Press OK.

Material Properties E

Cancrete I Reinforcing Steel |

Slabs and
Beams Columis

Unit density: W Ibft2
Comp stengte  [5 [5 ks
Young's modulus: [4286.8 [42868 ks
Fupture modulus: ’m ,m ksi

Copy >

0K Cancel | Help |

3. From the Input menu, select Spans. A dialog box appears.

e  Under the Slabs/Flanges tab, input 30 for LENGTH, 8 for THICKNESS,
and 0.667 for WIDTH LEFT and 1. 167 WIDTH RIGHT. Press MODIFY.
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e Select the Longitudinal Beams tab. Input 16 for WIDTH and 32 for

DEPTH. Press MODIFY.

e  Press OK.

Span Data

Slabs/Flanges 1 Longitudinal Beams | Ribs |

Span - Length 30 ft Width Left: [0.BE7 it
Location: |Interior - Thickness: |8 in Width Right. | 1167t
Span Mo | Lacation [ Length Thickness wiidthl Wwidih R
1 Interior 30 g 0.667 1.167
oK | Cancel | Help

Slabs/Flanges Lunglludma\EeamSIHihs |

Span: hd width; 16 in
Depth: 32 in
Span Mo | width | Depth
1 168 32
oK | Cancel | Help ‘

4. From the Input menu, select Supports. A dialog box appears.
e  Under the Columns tab, input 0 for STIFFNESS SHARE %.

Examples
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Next, input 16 for both the cl1 and €2 values in both the ABOVE and
BELOW rows. Press MODIFY. (Note: the default HEIGHT ABOVE and
HEIGHT BELOW values of 10 are correct.)

Press Cory. Press the CHECK ALL button. Press OK.

Press OK again.

Support Data &
Columns ] Colurnn Capitals I Transverse Beams I Boundary Conditions I

Height [ft) 1 (in] o2 [in)

Support I - | sbove 10 15
Stifiness share % [0 Below 10 16

Sup No | Shifz__ | Hia [ o2, HIE clf ]
1 i 10 18 16 10 18 18
2 i 10 18 16 10 18 18

1

oK Cancel | Help ‘

5. From the Input menu, select Reinforcement. A dialog box appears.

Under the Slabs and Ribs tab, change the CLEAR COVER for both Top
and BOTTOM BARS to 1.75.

Under the Beams tab, change the CLEAR COVER for both ToP and
BOTTOM BARS againto 1. 75.

Use the drop down arrow for MINIMUM STIRRUP BAR SIZE to select #4.

Press OK.
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6. From the Input menu, select Load Cases. A dialog box appears.

Reinforcement Criteria g\
Slabs and Ribs 1 Beams ]
Top bars Battom bars
Caver [in]
Clear: 1.75
Bar size
Min: |45 - #5 h
Maw  |#8 hd Ha ha
Spacing [in]
Min: |1 1
Max: |18 18
Reint. ratio [%)
Min: 014 014
Max |5 5
There iz more than 12 in of
conciete below top bars,
[ Cacel | Hep |
Reinforcement Criteria E‘
Slabs and Ribs  Beams I
Top bars Bottom bars Stirmups
Cover [in] Side: Cover [in]
Clear 1.75 Clear: |15
Bar size Bar size:
bdin HE hd HE - bin E:2 ha
Maw: | #8 - #a - Mae | #5 -
Spacing [in] Spacing [in)
Min: |1 1 Min:  |E
Max: |18 18 Max |18
Reint. ratio [%) Mumber of l2gs
Min: 014 014 Mine |2 -
Max |5 5 Max |6 -
Clear distance between There is more than 12 in of
o s 1 L e e vt
0K Cacel | Hep |

e Since we are not considering lateral forces, click on WIND in the LABEL
column on the list in the bottom half of the LOAD CASES dialog box and

press the DELETE button.
e Click on EQ in the LABEL column and press the DELETE button.

e  Press OK.
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Load Cases E|
Label Type: |DEAD =]
sdd | |
Label | Type
SELF DEAD
Dead DEAD

Live LIWE

oK Cancel | Heb |

7. From the Input menu, select Load Combinations. A dialog box appears.

e Delete all the load combinations by clicking anywhere on the list in the
bottom half of the LOAD COMBINATIONS dialog box and pressing the
DELETE button. Repeat this procedure until all the load combinations are
gone.

e Input O in the SELF field, 1.2 in the DEAD field, and 1.6 in the LIVE
field. Press ADD.

e  Press OK.

Load Combinations rzl

SELF Dead Live

e pfz [ [ [ [

sad | Mogly | Delete |

Comb [ sELF [ Dead Live
un 0 12 16

K Cancel | Hep |

8. From the Input menu, select Span Loads. A dialog box appears.
e  Press the drop down arrow next to TYPE, and select LINE LOAD.
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9.

(64psf X

Input 2500 for both the START and END MAGNITUDE. (Note: this value
was obtained by converting the area loads on the roof and the beam’s self
weight into line loads.)

Dead Load = Superimposed Load + Self Weight of Spandrel Beam =

6?) +[(1.33ft x 2.67ft)+ (0.5ft x 0.67ft)]x 150pcf = 2.5kip/ ft

Input 30 for the END LOCATION. Press ADD.
Use the drop down arrow next to TYPE, and select LINE TORSION.

Input 1.76 for both the START and END MAGNITUDE. (Note: this value
was obtained by multiplying the superimposed line load by the moment
arm of 11 in.)

60&} w0y a6kip fi/ ft

Torsion Line Load (Dead) = | 64psf x — -
2 12in/ft

Keep the END LOCATION of 30 and press ADD.

Span Loads g\

Cunrent Case: Start End

Span: (1 =| Copy. Magnitude: |2500 2500 bt
Type: |Line Load - Location: |0 an ft

Span=301

Liwe:

Case Copy._ | add | Modiy | Delere |

Span Mo | Type | Wa | La | Wh ‘ Lb
1 Line Load 2500 1} 2500 a0
1 Line Torsion 176 1} 176 a0

o]

Cancel |

Help |

In the top left corner of the SPAN LOADS dialog box, there is a section called

CURRENT CASE. Click on LIVE.

e  Use the drop down arrow next to TYPE to select LINE LOAD. I

Examples
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e Input 900 for both the START and END MAGNITUDE. (Note: this value
was obtained by converting the area loads on the roof to line loads on the
beam.)

Live Load = 30psf x (%ﬂj =9001b/ ft

e Input 30 for the END LOCATION. Press ADD.
e Use the drop down arrow next to TYPE, and select LINE TORSION.

e Input 0.825 for both the START and END MAGNITUDE. (Note: this value
was obtained by multiplying the live line load by the moment arm of 11
in.)

30pst x| S0 | I _ o goskip- i/ fi
2 12in / ft

e Input 30 for the END LOCATION. Press ADD.

e Press OK.

Span Loads El

Current Case Start End

Dead Spar: {1 =| Copw. Magnitude: |300 900 Ib/it
Tvpe: |Line Load - Location: 1) a0 it

Span=30ft

Case Copy.. | Add | todify | Delste |

SpanMo_ | Type [ wa [La [ wh i
1 Line Load 900 1} 900 30
1 Line Torsion 0825 o 0825 30

oK Carcel | Help

10. From the Solve menu, select Execute. Press CLOSE.
11. From the Solve menu, select Results Report.

e  Use the scroll bars to scroll through the results file.
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12.

13.

14.

15.

16.

e Use the ARROW keys or the mouse wheel to browse through different
parts of the results quickly. Press the CLOSE button to close the RESULTS
REPORT dialog box and return to pcaBeam.

To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear
Capacity, Deflection, or Reinforcement from the View menu. Right click in
any of these diagrams to get new copy, printing, or display options.

You may print the results file by selecting Print Results from the File menu.
To print any of the diagrams you selected to view, use the Print Preview
command found by right clicking in the diagram’s window. After viewing the
results, you may decide to investigate the input beams under the same loads
but with a modified reinforcement configuration.

From the Input menu, select General Information. In the General
Information dialog box change the RUN MODE option to INVESTIGATION. Do
not change any of the other options. Press OK

From the Input menu, select the different commands under Reinforcement
Criteria and Reinforcing Bars to modify the reinforcement configuration
computed by the program.

Repeat steps 10 and subsequent to perform the investigation and view the
results.

Examples
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Text Output

0000000 000000 00000
00000000 00000000 0000000
oo oo oo oo oo oo
oo oo oo oo oo
00000000 [sle} 0000000 00000
0000000 oo oo 0000000 00000
[ele} [ele} [ele} [ele} oo
oo 00000000 oo oo
oo 000000 oo oo
00000 000000 00000 00 00
00 00 00 00 00 000 000
00 00 00 00 00 00 O 0 00
00 00 00 00 00 O 0 00
00000 00000 0000000 00 [¢] 00
00 00 00 00 00 00 00
00 00 00 00 00 00 00
00 00 00 00 00 00 00
00000 000000 00 00 00 00

pcaBeam v2.00 (TM)
A Computer Program for Analysis, Design, and Investigation of
Reinforced Concrete Beams and One-way Slab Systems

Copyright © 1992-2006, Portland Cement Association
A1l rights reserved

Licensee stated above acknowledges that Portland Cement Association
(PCR) is not and cannot be responsible for either the accuracy or
adequacy of the material supplied as input for processing by the
pcaBeam computer program. Furthermore, PCA neither makes any warranty
expressed nor implied with respect to the correctness of the output
prepared by the pcaBeam program. Although PCA has endeavored to
produce pcaBeam error free the program is not and cannot be certified
infallible. The final and only responsibility for analysis, design and
engineering documents is the licensees. Accordingly, PCA disclaims all
responsibility in contract, negligence or other tort for any analysis,
design or engineering documents prepared in connection with the use of
the pcaBeam program.

[1] INPUT ECHO

General Information:

File nam

Project: pcaSlab/pcaBeam Manual, Example 2

Frame:

PCA Notes on ACI 318-05, Example 13-1

Engineer: pcaStructurePoint

Code:

ACI 318-05

Reinforcement Database: ASTM A615

Mode:

Design

Number of supports = 2

Floor

System: One-Way/Beam

Live load pattern ratio = 100%

Deflections are based on cracked section properties.

In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution
Long-term deflections are calculated for load duration of 60 months.

0% of

live load is sustained.

Compression reinforcement calculations NOT selected.
Moment redistribution NOT selected.
Effective flange width calculations NOT selected.

Rigid

beam-column joint NOT selected.

Torsion analysis and design selected.
Stirrups in flanges (if available) selected.
Compatibility torsion NOT selected.

Material

we
f'e

Properties

Slabs|Beams Columns
= 150 150 1b/ft3
= 5 5 ksi

(if available)
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Ec = 4286.8 4286.8 ksi

fr = 0.53033 0.53033 ksi

fy = 60 ksi, Bars are not epoxy-coated
fyt = 60 ksi

Es = 29000 ksi

Reinforcement Database:

Units: Db (in), Ab (in”
b

2), Wo (lb/ft)

Size Db Wb Size Db 2b Wb
#3 0.38 0.11 0.38 #4 0.50 0.20 0.67
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30
#11 1.41 1.56 5.31 #14 1.69 2.25 7.65
#18 2.26 4.00 13.60

Span Data:
Slabs: L1, wL, wR (ft); t, Hmin (in)
Span Loc L1 t WL WR Hmin
1 Int 30.000 8.00 0.667 1.167 0.00

Ribs and Longitudinal Beams: b, h, Sp (in)

Ribs Beams _ Span__

Span b h Sp b h Hmin

1 0.00 0.00 0.00 16.00 32.00 22.50
cla, c2a, clb, c2b (in); Ha, Hb (ft)
cla c2a Ha clb c2b Hb Red$%
1 16.00 16.00 10.000 16.00 16.00 10.000 0
2 16.00 16.00 10.000 16.00 16.00 10.000 0
Boundary Conditions: Kz (kip/in); Kry (kip-in/rad)
Supp Spring Kz Spring Kry Far End A Far End B
1 0 0 Fixed Fixed
2 0 0 Fixed Fixed
Load Dat

Load Cases and Combinations:

Case SELF Dead Live

Type DEAD DEAD LIVE

Ul 0.000 1.200 1.600

Span Loads:

Span Case Wa La Wb Lb

Line Loads - Wa | Wb (lb/ft), La | Lb (ft):

1 Dead 2500 0 2500 30
1 Live 900 0 900 30

Line Torque - Wa | Wb (k-ft/ft), La | Lb (ft):

1 Dead . 0 1.76 30

1 Live 0.825 0 0.825 30
Support Loads: --- NONE ---
Support Displacements: --- NONE ---

Reinforcement Criteria
Top bars Bottom bars__ Stirrups
Min Max Min Max Min Max

Slabs and Ribs:

Bar Size #5 #8 #5 #8

Bar spacing 1.00 18.00 1.00 18.00 in

Reinf ratio 0.14 5.00 0.14 5.00 %

Cover 1.75 1.75 in

Beams:

Bar Size #5 #8 #5 #8 #4 #5
Bar spacing 1.00 18.00 1.00 18.00 6.00 18.00 in
Reinf ratio 0.14 5.00 0.14 5.00 %

Examples

6-41



o Aslab|ocBeam

Cover 1.75 1.75 in
Side cover 1.50 1.50 in
Layer dist. 1.00 1.00 in
No. of legs 2 6
[2] DESIGN RESULTS
Top Reinforcement
Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in”2), Sp (in)
Span Zone Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 Left 1.83 0.00 0.667 0.000 10.179 0.000 0.000
Middle 1.83 0.00 15.000 0.000 10.179 0.000 0.000
Right 1.83 0.00 29.333 0.000 10.179 0.000 0.000
Top Bar Detail
Length (ft)
Left Continuous__ Right
Span Bars Length Bars Length Bars Length Bars Length Bars Length
1 - - - — -
Width (ft), Mmax (k-ft), Xmax (ft), As (in”2), Sp (in)
Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 1.33 499.50 15.000 1.683 13.520 2.614 3.891 5-#8
Bottom Bar Details
Units: Start (ft), Length (ft)
Long Bars Short Bars
Span Bars Start Length Bars Start Length
1 5-#8 0.00 30.00 -
Flexural Capacity:
Units: x (ft), As (in"2), PhiMn (k-ft)
Span x AsTop AsBot PhiMn- PhiMn+
1 0.000 0.00 3.95 0.00 506.29
0.667 0.00 3.95 0.00 506.29
10.700 0.00 3.95 0.00 506.29
15.000 0.00 3.95 0.00 506.29
19.300 0.00 3.95 0.00 506.29
29.333 0.00 3.95 0.00 506.29
30.000 0.00 3.95 0.00 506.29
Longitudinal Beam Shear And Torsion Reinforcement Required:
Section properties:
Units: d, pcp, pch (in), Acp, Ach, Ao (in”2)
PhiVe (kip), PhiTer (k-ft), PhiSvt (ksi)
Span pcp ph Acp Aoh Ao PhiVe  PhiTer  PhiSvt
1 29.75 108.02 95.02 560.064 392.540 333.659 50.49 51.33 0.530
Required transverse reinforcement:
Units: Start, End, Xu (ft), Vu (kip), Tu (k-ft), vf (ksi)
Av/s, Av/s, A(v+2t)/s (in~2/in)
Span Start End Vu Tu vE Xu Case/Patt Av/s At/s A(v+2t)/s
1 3.146 6.533 52.63 40.68 0.209 3.15 Ul/All 0.0016 0.0163 0.0341
6.533 9.920 37.59 29.06 0.149 6.53 Ul/All 0.0000 0.0116 0.0232 *5
9.920 13.307 22.56 17.44 0.089 9.92 Ul/All 0.0000 0.0070 0.0141 *5
13.307 16.693 7.52 5.81 0.030 13.31 Ul/All 0.0000 0.0000 0.0000 *2
16.693 20.080 22.56 17.44 0.089 20.08 Ul/A1l 0.0000 0.0070 0.0141 *5
20.080 23.467 37.59 29.06 0.149 23.47 Ul/All 0.0000 0.0116 0.0232 *5
23.467 26.854 52.63 40.68 0.209 26.85 Ul/All 0.0016 0.0163 0.0341
NOTES:

*2 - Torsion ignored (Tu < PhiTcr/4).
*5 - Minimum transverse (stirrup) reinforcement required.

Required longitudinal reinforcement:

Units: Start, End, Xu (ft), Tu (k-ft), Al (in"2)
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Span Start End Tu Xu Case/Patt Al
1 3.146 6.533 29.06 6.53 Ul/A11 2.197 *5
6.533 9.920 17.44 9.92 Ul/All 2.638 *5
9.920 13.307 15.74 10.41 Ul/All 2.667 *5
13.307 16.693 5.81 13.31 Ul/All 0.000 *2
16.693 20.080 13.77 19.01 U1l/All 2.667 *5
20.080 23.467 17.44 20.08 U1l/Al11 2.638 *5
23.467 26.854 29.06 23.47 U1l/All 2.197 *5
NOTES:
*2 - Torsion ignored (Tu < PhiTcr/4).
*5 - Minimum longitudinal reinforcement required.
Longitudinal Beam Shear Reinforcement Details:
Units: spacing & distance (in)
Span Size Stirrups (2 legs each unless otherwise noted)
1 #4 14 @ 11.4 + <-- 40.6 --> + 14 @ 11.4
Longitudinal Torsional Reinforcement Details:
Units: Start (ft), Length (ft)
Long Bars Short Bars
Span Bars Start Length Bars Start Length
1 12-#5 0.00 12.27
12-#5 17.73 12.27
Beam Shear And Torsion Capacity:
Section properties:
Units: d, pcp, pch (in), Acp, Ach, Ao (in”2)
Phivc (kip), PhiTcr (k-ft), Phisvt (ksi)
Span d pcp ph Acp Aoh Ao Phive PhiTcr Phisvt
1 29.75 108.02 95.02 560.064 392.540 333.659 50.49 51.33 0.530
Beam shear and torsion transverse reinforcement capacity in terms of provided and required area:
Units: Start, End, Xu (ft), Sp (in), A(v+2t)/s (in"2/in)
Vu (kip), Tu (k-ft), vf (ksi)
Provided Required
Span Start End A(v+2t) Sp A(v+2t)/s Xu Vu Tu Case/Patt vE A(v+2t)/s
1 0.000 0.917  ----=  —=mm= —mmme— 0.00 66.60 51.48 Ul/All 0.26 0.0532
0.917 11.273 0.400 11.44 0.0350 3.15 52.63 40.68 U1l/All 0.21 0.0341
11.273 13.307 0.400 11.44 0.0350 11.27 16.55 12.79 Ul/All 0.07 0.0000
13.307 16.693  -—-—-  -—-——  ——-——— 13.31 7.52 5.81 U1l/All 0.03 0.0000
16.693 18.727 0.400 11.44 0.0350 18.73 16.55 12.79 Ul/All 0.07 0.0000
18.727 29.083 0.400 11.44 0.0350 26.85 52.63 40.68 Ul/All 0.21 0.0341
29.083 30.000  ----= -m-mm ——m—e- 30.00 66.60 51.48 U1l/All 0.26 0.0532

NOTES:
*2 - Torsion ignored (Tu < PhiTcr/4).
*5 - Minimum transverse (stirrup)

reinforcement required.

Beam torsion longitudinal reinforcement capacity in terms of provided and required area:

Units: Start, End, Xu (ft), Al (in*2), Tu (kip)
Provided Required
Span Start End Al Xu Tu Case/Patt Al
1 0.000 0.917  -—-—- 0.00 51.48 Ul/All 1.955
0.917 11.273 10.41 15.74 Ul/All 2.667 *5
11.273 13.307 11.27 12.79 U1l/All 0.000 *2
13.307 16.693 13.31 5.81 Ul/All 0.000 *2
16.693 18.727 16.69 5.81 Ul/All 0.000 *2
18.727 29.083 19.01 13.77 U1l/All 2.667 *5
29.083 30.000 30.00 51.48 Ul/All 1.955
NOTES:
*2 - Torsion ignored (Tu < PhiTcr/4).
*5 - Minimum longitudinal reinforcement required.
Slab Shear Capacity:
b, d (in), Xu (ft), PhivVc, Vu(kip)
b d Vratio Phive Vu Xu
1 --- Not checked ---
Deflections:

Section properties
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Units: Ig, Icr, Ie (in"4), Mcr, Mmax (k-ft) Load Level
. Iejavg_____ _
Span Dead Dead+Live Zone Ig Icr Mcr Mmax Ie Mmax Ie
1 18127 17158 Middle 50274 16321 130.47 346.88 18127 448.13 17158

Maximum Instantaneous Deflections

Units: D (in)
Span Ddead Dlive Dtotal

1 0.723 0.264 0.987

Maximum Long-term Deflections

Time dependant factor for sustained loads = 2.000
Units: D (in)
Span Dsust Lambda Dcs Dcs+lu Dcs+l Dtotal

1 0.723 2.000 1.446 1.710 1.710 2.433

Material Takeof

Reinforcement in the Direction of Analysis

Top Bars: 0.0 0.00 1b/ft < 0.000 1b/ft~2
Bottom Bars: 400.5 13.35 1b/ft < 7.279 1b/ft"2
Torsion Bars: 307.2 10.24 1b/ft < 5.584 1b/ft"2
Stirrups: 383.4 12.78 1b/ft < 6.969 1b/ft"2
Total Steel: 1091.2 36.37 lb/ft < 19.832 1b/ft"2
Concrete: 116.7 3.89 ft"3/ft <=> 2.121 ft~3/ft 2

[3] COLUMN AXIAL FORCES AND MOMENTS

Units: P (kip), M (k-ft)

Case/Patt Joint Far Ends
Supp Comb/Patt Plaxial] P[spring] Mb[top] Ma [bottom] M[spring] Mb [bottom] Ma[top]
1 SELF 8.75 0.00 0.00 0.00 0.00 0.00 0.00
Dead 37.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/All 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/0Odd 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/Even 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/S1 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/S2 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Ul/All 66.60 0.00 0.00 0.00 0.00 0.00 0.00
Ul/0dd 66.60 0.00 0.00 0.00 0.00 0.00 0.00
Ul/Even 45.00 0.00 0.00 0.00 0.00 0.00 0.00
Ul/s1 66.60 0.00 0.00 0.00 0.00 0.00 0.00
uUl/s2 66.60 0.00 0.00 0.00 0.00 0.00 0.00
2 SELF 8.75 0.00 0.00 0.00 0.00 0.00 0.00
Dead 37.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/All 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/0dd 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/Even 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/S1 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Live/S2 13.50 0.00 0.00 0.00 0.00 0.00 0.00
Ul/All 66.60 0.00 0.00 0.00 0.00 0.00 0.00
Ul/0dd 66.60 0.00 0.00 0.00 0.00 0.00 0.00
Ul/Even 45.00 0.00 0.00 0.00 0.00 0.00 0.00
Ul/s1 66.60 0.00 0.00 0.00 0.00 0.00 0.00
ul/s2 66.60 0.00 0.00 0.00 0.00 0.00 0.00
Sum SELF 17.50 0.00 0.00 0.00 0.00 0.00 0.00
Dead 75.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/All 27.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/0dd 27.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/Even 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/S1 27.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/S2 27.00 0.00 0.00 0.00 0.00 0.00 0.00
U1l/All 133.20 0.00 0.00 0.00 0.00 0.00 0.00
Ul/odd 133.20 0.00 0.00 0.00 0.00 0.00 0.00
Ul/Even 90.00 0.00 0.00 0.00 0.00 0.00 0.00
Ul/s1 133.20 0.00 0.00 0.00 0.00 0.00 0.00
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Ul/s2 133.20 .00 0.00 0.00 0.00 0.00 0.00
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES
Span  x (ft) M- (k-ft) Comb M+ (k-ft) Comb V- (kip) Comb V+ (kip) Comb
1 0.000 0.00 Ul 0.00 Ul 0.00 Ul 66.60 UL
0.222 0.00 UL 14.69 UL 0.00 Ul 65.61 UL
0.444 0.00 Ul 29.16 Ul 0.00 Ul 64.63 UL
0.667 0.00 UL 43.41 UL 0.00 Ul 63.64 UL
0.667 0.00 Ul 43.41 Ul 0.00 Ul 63.64 UL
0.953 0.00 Ul 61.47 UL 0.00 Ul 62.37 UL
1.240 0.00 UL 79.17 Ul 0.00 Ul 61.09 UL
1.527 0.00 Ul 96.50 UL 0.00 Ul 59.82 UL
1.813 0.00 Ul 113.47 Ul 0.00 Ul 58.55 UL
2.100 0.00 Ul 130.07 Ul 0.00 Ul 57.28 UL
2.387 0.00 Ul 146.31 Ul 0.00 Ul 56.00 UL
2.673 0.00 UL 162.18 Ul 0.00 Ul 54.73 Ul
2.960 0.00 Ul 177.69 Ul 0.00 Ul 53.46 UL
3.247 0.00 Ul 192.83 Ul 0.00 Ul 52.18 UL
3.533 0.00 Ul 207.60 UL 0.00 Ul 50.91 UL
3.820 0.00 Ul 222.02 UL 0.00 Ul 49.64 UL
4.107 0.00 UL 236.06 UL 0.00 Ul 48.37 Ul
4.393 0.00 Ul 249.75 UL 0.00 Ul 47.09 Ul
4.680 0.00 Ul 263.06 UL 0.00 Ul 45.82 UL
4.967 0.00 UL 276.02 UL 0.00 Ul 44.55 Ul
5.253 0.00 Ul 288.61 UL 0.00 Ul 43.28 UL
5.540 0.00 UL 300.83 UL 0.00 Ul 42.00 Ul
5.827 0.00 Ul 312.69 Ul 0.00 Ul 40.73 UL
6.113 0.00 Ul 324.18 Ul 0.00 Ul 39.46 UL
6.400 0.00 ULl 335.31 Ul 0.00 Ul 38.18 Ul
6.687 0.00 Ul 346.07 Ul 0.00 Ul 36.91 UL
6.973 0.00 UL 356.47 UL 0.00 Ul 35.64 UL
7.260 0.00 Ul 366.50 UL 0.00 Ul 34.37 Ul
7.547 0.00 Ul 376.17 Ul 0.00 Ul 33.09 UL
7.833 0.00 UL 385.48 UL 0.00 Ul 31.82 UL
8.120 0.00 Ul 394.42 UL 0.00 Ul 30.55 Ul
8.407 0.00 UL 402.99 Ul 0.00 Ul 29.27 Ul
8.693 0.00 Ul 411.20 UL 0.00 Ul 28.00 Ul
8.980 0.00 Ul 419.05 UL 0.00 Ul 26.73 Ul
9.267 0.00 UL 426.53 UL 0.00 Ul 25.46 Ul
9.553 0.00 Ul 433.64 UL 0.00 Ul 24.18 Ul
9.840 0.00 Ul 440.39 Ul 0.00 Ul 22.91 Ul
10.127 0.00 Ul 446.78 UL 0.00 Ul 21.64 Ul
10.413 0.00 Ul 452.80 UL 0.00 Ul 20.36 Ul
10.700 0.00 UL 458.45 UL 0.00 Ul 19.09 UL
10.987 0.00 Ul 463.74 UL 0.00 Ul 17.82 Ul
11.273 0.00 Ul 468.67 UL 0.00 Ul 16.55 Ul
11.560 0.00 UL 473.23 UL 0.00 Ul 15.27 Ul
11.847 0.00 Ul 477.43 UL 0.00 Ul 14.00 Ul
12.133 0.00 UL 481.26 UL 0.00 Ul 12.73 Ul
12.420 0.00 UL 484.72 UL 0.00 Ul 11.46 Ul
12.707 0.00 Ul 487.82 Ul 0.00 Ul 10.18 UL
12.993 0.00 UL 490.56 UL 0.00 Ul 8.91 Ul
13.280 0.00 Ul 492.93 UL 0.00 Ul 7.64 UL
13.567 0.00 UL 494.94 UL 0.00 Ul 6.36 Ul
13.853 0.00 UL 496.58 UL 0.00 Ul 5.09 UL
14.140 0.00 Ul 497.86 Ul 0.00 Ul 3.82 Ul
14.427 0.00 UL 498.77 UL 0.00 Ul 2.55 Ul
14.713 0.00 Ul 499.32 UL 0.00 Ul 1.27 Ul
15.000 0.00 UL 499.50 Ul 0.00 Ul 0.00 UL
15.287 0.00 UL 499.32 UL -1.27 Ul 0.00 UL
15.573 0.00 Ul 498.77 Ul -2.55 UL 0.00 UL
15.860 0.00 UL 497.86 UL -3.82 UL 0.00 UL
16.147 0.00 Ul 496.58 UL -5.09 Ul 0.00 UL
16.433 0.00 UL 494.94 Ul -6.36 UL 0.00 UL
16.720 0.00 UL 492.93 UL -7.64 UL 0.00 UL
17.007 0.00 Ul 490.56 UL -8.91 UL 0.00 UL
17.293 0.00 UL 487.82 UL -10.18 UL 0.00 UL
17.580 0.00 Ul 484.72 UL -11.46 UL 0.00 UL
17.867 0.00 Ul 481.26 Ul -12.73 Ul 0.00 UL
18.153 0.00 UL 477.43 UL -14.00 UL 0.00 UL
18.440 0.00 Ul 473.23 UL -15.27 Ul 0.00 UL
18.727 0.00 UL 468.67 UL -16.55 UL 0.00 UL
19.013 0.00 UL 463.74 UL -17.82 UL 0.00 UL
19.300 0.00 Ul 458.45 Ul -19.09 UL 0.00 UL
19.587 0.00 UL 452.80 UL -20.36 UL 0.00 UL
19.873 0.00 Ul 446.78 UL -21.64 UL 0.00 UL
20.160 0.00 UL 440.39 UL -22.91 UL 0.00 UL
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20.447 0.00 UL 433.64 UL -24.18 UL 0.00 UL
20.733 0.00 Ul 426.53 Ul -25.46 UL 0.00 UL
21.020 0.00 UL 419.05 UL -26.73 UL 0.00 UL
21.307 0.00 Ul 411.20 UL -28.00 UL 0.00 UL
21.593 0.00 Ul 402.99 Ul -29.27 UL 0.00 UL
21.880 0.00 UL 394.42 UL -30.55 Ul 0.00 UL
22.167 0.00 Ul 385.48 Ul -31.82 UL 0.00 UL
22.453 0.00 UL 376.18 UL -33.09 Ul 0.00 UL
22.740 0.00 Ul 366.51 Ul -34.37 UL 0.00 UL
23.027 0.00 Ul 356.47 Ul -35.64 UL 0.00 UL
23.313 0.00 UL 346.07 UL -36.91 UL 0.00 UL
23.600 0.00 Ul 335.31 Ul -38.18 UL 0.00 UL
23.887 0.00 UL 324.18 UL -39.46 UL 0.00 UL
24.173 0.00 Ul 312.69 UL -40.73 UL 0.00 UL
24.460 0.00 Ul 300.83 Ul -42.00 UL 0.00 UL
24.747 0.00 UL 288.61 UL -43.28 UL 0.00 UL
25.033 0.00 Ul 276.02 UL -44.55 UL 0.00 UL
25.320 0.00 Ul 263.07 UL -45.82 Ul 0.00 UL
25.607 0.00 Ul 249.75 UL -47.09 UL 0.00 UL
25.893 0.00 Ul 236.07 UL -48.37 UL 0.00 UL
26.180 0.00 UL 222.02 UL -49.64 UL 0.00 UL
26.467 0.00 Ul 207.61 UL -50.91 UL 0.00 UL
26.753 0.00 Ul 192.83 Ul -52.18 UL 0.00 UL
27.040 0.00 Ul 177.69 Ul -53.46 UL 0.00 UL
27.327 0.00 Ul 162.18 Ul -54.73 UL 0.00 UL
27.613 0.00 UL 146.31 UL -56.00 UL 0.00 UL
27.900 0.00 Ul 130.07 Ul -57.28 UL 0.00 UL
28.187 0.00 Ul 113.47 Ul -58.55 UL 0.00 UL
28.473 0.00 UL 96.50 UL -59.82 UL 0.00 UL
28.760 0.00 Ul 79.17 Ul -61.09 UL 0.00 UL
29.047 0.00 UL 61.48 UL -62.37 UL 0.00 UL
29.333 0.00 Ul 43.42 Ul -63.64 UL 0.00 UL
29.333 0.00 Ul 43.42 Ul -63.64 UL 0.00 UL
29.556 0.00 UL 29.16 UL -64.63 UL 0.00 UL
29.778 0.00 Ul 14.69 Ul -65.61 UL 0.00 UL
30.000 -0.00 UL 0.00 Ul -66.60 UL 0.00 UL

[6b] SEGMENTAL TORSION - ENVELOPES

Span  x (ft) T+ (k-ft) Comb (k-ft) Comb
1 0.000 51.48 UL 0.00 Ul
0.222 50.72 Ul 0.00 Ul
0.444 49.95 UL 0.00 Ul
0.667 49.19 Ul 0.00 Ul
0.667 49.19 Ul 0.00 Ul
0.953 48.21 UL 0.00 Ul
1.240 47.22 Ul 0.00 Ul
1.527 46.24 UL 0.00 Ul
1.813 45.26 UL 0.00 UL
2.100 44.27 Ul 0.00 Ul
2.387 43.29 Ul 0.00 Ul
2.673 42.31 Ul 0.00 Ul
2.960 41.32 Ul 0.00 Ul
3.247 40.34 UL 0.00 Ul
3.533 39.35 UL 0.00 Ul
3.820 38.37 UL 0.00 Ul
4.107 37.39 Ul 0.00 Ul
4.393 36.40 UL 0.00 Ul
4.680 35.42 UL 0.00 Ul
4.967 34.43 Ul 0.00 UL
5.253 33.45 Ul 0.00 Ul
5.540 32.47 Ul 0.00 UL
5.827 31.48 Ul 0.00 Ul
6.113 30.50 UL 0.00 Ul
6.400 29.52 Ul 0.00 Ul
6.687 28.53 UL 0.00 Ul
6.973 27.55 Ul 0.00 Ul
7.260 26.56 UL 0.00 Ul
7.547 25.58 UL 0.00 Ul
7.833 24.60 UL 0.00 Ul
8.120 23.61 UL 0.00 Ul
8.407 22.63 UL 0.00 Ul
8.693 21.64 UL 0.00 Ul
8.980 20.66 UL 0.00 Ul
9.267 19.68 UL 0.00 UL
9.553 18.69 UL 0.00 Ul
9.840 17.71 Ul 0.00 UL
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10.127 16.73 U1 0.00 U1
10.413 15.74 Ul 0.00 Ul
10.700 14.76 UL 0.00 U1
10.987 13.77 U1 0.00 U1
11.273 12.79 Ul 0.00 Ul
11.560 11.81 U1 0.00 U1
11.847 10.82 U1 0.00 U1
12.133 9.84 U1 0.00 Ul
12.420 8.85 UL 0.00 Ul
12.707 7.87 UL 0.00 UL
12.993 6.89 UL 0.00 U1
13.280 5.90 Ul 0.00 UL
13.567 4.92 U1 0.00 Ul
13.853 3.94 Ul 0.00 Ul
14.140 2.95 Ul 0.00 Ul
14.427 1.97 UL 0.00 U1
14.713 0.98 UL 0.00 U1
15.000 0.00 Ul -0.00 U1
15.287 0.00 U1 -0.98 U1
15.573 0.00 U1 -1.97 U1
15.860 0.00 U1 -2.95 U1
16.147 0.00 U1 -3.94 U1
16.433 0.00 Ul -4.92 U1
16.720 0.00 U1 -5.90 U1
17.007 0.00 Ul -6.89 Ul
17.293 0.00 UL -7.87 U1
17.580 0.00 U1 -8.85 Ul
17.867 0.00 Ul -9.84 Ul
18.153 0.00 U1 -10.82 Ul
18.440 0.00 U1 -11.81 Ul
18.727 0.00 UL -12.79 U1
19.013 0.00 U1 -13.77 U1
19.300 0.00 Ul -14.76 Ul
19.587 0.00 U1 -15.74 Ul
19.873 0.00 Ul -16.73 Ul
20.160 0.00 UL -17.71 U1
20.447 0.00 Ul -18.69 Ul
20.733 0.00 UL -19.68 Ul
21.020 0.00 UL -20.66 UL
21.307 0.00 Ul -21.64 Ul
21.593 0.00 Ul -22.63 Ul
21.880 0.00 Ul -23.61 Ul
22.167 0.00 UL -24.60 Ul
22.453 0.00 UL -25.58 Ul
22.740 0.00 U1 -26.56 UL
23.027 0.00 U1 -27.55 U1
23.313 0.00 U1 -28.53 U1
23.600 0.00 UL -29.52 Ul
23.887 0.00 UL -30.50 U1
24.173 0.00 U1 -31.48 U1
24.460 0.00 Ul -32.47 Ul
24.747 0.00 U1 -33.45 U1
25.033 0.00 Ul -34.43 Ul
25.320 0.00 UL -35.42 U1
25.607 0.00 U1 -36.40 U1
25.893 0.00 Ul -37.39 U1
26.180 0.00 U1 -38.37 U1
26.467 0.00 Ul -39.35 Ul
26.753 0.00 U1 -40.34 U1
27.040 0.00 U1 -41.32 U1
27.327 0.00 Ul -42.31 Ul
27.613 0.00 UL -43.29 U1
27.900 0.00 Ul -44.27 Ul
28.187 0.00 U1 -45.26 Ul
28.473 0.00 UL -46.24 U1
28.760 0.00 Ul -47.22 Ul
29.047 0.00 UL -48.21 Ul
29.333 0.00 Ul -49.19 Ul
29.333 0.00 Ul -49.19 Ul
29.556 0.00 UL -49.95 U1
29.778 0.00 Ul -50.72 Ul
30.000 0.00 U1 -51.48 Ul
[7] SEGMENTAL DEFLECTIONS
Units: x (ft), D (in)
Span x Ddead Dlive Dtotal
1 0.000 0.000 0.000 0.000

Examples

6-47



p Igﬁb | pcﬁﬁm

222
444
667
667
953
240
527
813
100
387
673
960
247
533
820
107
393
680
967
253
540
827
113
400
687
973
260
547
833
120
407
693
980
267
553

.840
.127
.413
.700
.987
.273
.560
.847
.133
.420
.707
.993
.280
.567
.853
.140
L427
L7713
.000
.287
.573
.860
.147
.433
.720
.007
.293
.580
.867
.153
.440
L727
.013
.300
.587
.873
.160
.447
L7133
.020
.307
.593
.880
.167
.453
.740
.027

0000000000000 00000000000000000000000000000000000000000000000000000000000000000O000

017
034
051
051
073
095
117
139
160
182
203
224
245
265
286
306
325
345
364
382
401
419
436
453
470
486
502
518
532
547
561
574
587
599
611
622
633
643
653
662
670
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685
692
697
703
708
712
715
718
720
722
723
723
723
722
720
718
715
712
708
703
697
692
685
678
670
662
653
643
633
622
611
599
587
574
561
547
532
518

.502
.486

0.006
0.012
0.019
0.019
0.027
0.035
0.043
0.051
0.059
0.066
0.074
0.082
0.089
0.097
0.104
0.111
0.119
0.126
0.133
0.140
0.146
0.153
0.159
0.165
0.172
0.177
0.183
0.189
0.194
0.199
0.205
0.209
0.214
0.219
0.223
0.227
0.231
0.235
0.238
0.241
0.244
0.247
0.250
0.252
0.254
0.256
0.258
0.260
0.261
0.262
0.263
0.263
0.264
0.264
0.264
0.263
0.263
0.262
0.261
0.260
0.258
0.256
0.254
0.252
0.250
0.247
0.244
0.241
0.238
0.235
0.231
0.227
0.223
0.219
0.214
0.209
0.205
0.200
0.194
0.189
0.183
0.177

OO0 0000000000000 0000000000000000000000000000000000000000000000000000000000000000000

.023
.047
.070
.070
.100
.130
.160
.189
.219
.248
.277
.306
.334
.362
.390
.417
.444
.470
.496
.522
.547
.571
.595
.619
.642
.664
.685
.706
727
.746
.765
.784
.801
.818
.834

849

.864
.878
.891
.903
.914
.925
.935
.944
.952
.959
.966
L971
.976
.980
.983
.985
.986
.987
.986
.985
.983
.980
.976
.971
.966
.959
.952

944

.935
.925
.914
.903
.891
.878
.864
.849
.834
.818
.801
.784
.765
.746
727
.706
.685
.664
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.313
.600
.887
.173
.460
.747
.033
.320
.607
.893
.180
L4677
.753
.040
.327
.613
.900
.187
.473
.760
.047
.333
.333
.556
L7178
.000

CO0000000000000000OO00 OO OO

.470

453
436
419
401
382
364
345
325
306
286
265
245
224
203
182
160
139
117
095
073
051
051
034
017

.000

0000000000000 00000000O0OO0 OO

.172
.165
.159
.153
.146
.140
.133
.126
.119
L111
.104
.097
.089
.082
.074
.066
.059
.051
.043
.035
.027
.019
.019
.012
.006
.000

CO0000000000000000OOO00OO OO

.642
.619
.595
.571
.547
.522
.496
.470
.444
L417
.390
.362
.334
.306
L2717
.248
.219
.189
.160
.130
.100
.070
.070
.047
.023
.000
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.
Graphical Output
Loads
900
[ [ [
CASE: Live
2500
176
CASE: Dead
100
400
CASE: SELF
peaBearn v2 00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0
File: C:\Program Files\P CAlpcaSlab\ExamplesiManualExample 2 - PCA Notes on ACI 318-05 Example 12-1.slb
Project: pcaSlab/pcaBeam Manual, Example 2
Frame: PCA Notes an AC| 318-05, Example 13-1 Engineer: pcaStructurePoint
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Internal Forces

60

& 5148 |
= i
¢ .
<] i
g .
ol
[a] f
5 |
S f
5 I
- i 5148

60.0 )

70.0 6660
o !
= |
£ i
<] .
=)
ol
[ i
o I
3 \
=4 I
o] \

I
270 -66.60
-500

§ | ! LEGEND:
. | | ——Envelope
£
I I |
=
@ f |
]
£ | |
= I |

5000 49950

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files\PCA\pcaSlabExamplesivanualExample 2 - PCA Notes on ACI 318-05 Example 13-1.5lb
Project pcaSlab/pcaBeam Manual, Example 2

Frame: PCA Notes on ACI 318-05, Exampls 13-1 Enginser pcaStructurePoint
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.
Moment Capacity
6000
I I
! |
I I
— ! |
I I
-1 I
I I
5 1 i
S
' I I
> |
= I |
g
53 -
O
=
I3
2 |
<
=
T LEGEND:
——Envelope Curve
— — Capacity Curve
. . — - —Support Centerline
! ——Face of Support
600.0

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files\PCA\pcaSlabExamples\ivanualExample 2 - PCA MNotes on ACI 318-05 Example 13-1.5lb
Project pcaSlab/pcaBeam Manual, Example 2

Frame: PCA Notes on ACI 318-05, Exampls 13-1 Enginser pcaStructurePoint
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Shear Capacity

Beam Shear and Torsion Capacity, Stirmup Intensity - in*2fin

B LEGEND:

! a8 ——Demand - (Av+2At)is
" . ------Demand - Atis
e — —Demand - Avis
—~Demand - Al
—Provided - (Av+2At)/s
— - —Provided - Al

. L — - —Support Centerline

B ——Face of Support

40 —--—Critical Section

I
I
I
|
A+ 176 I

Beam Shear and Torsion Capacity. Longitudinal Bar Area- in"2

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files\PCA\pcaSlabExamplesivanualExample 2 - PCA Notes on ACI 318-05 Example 13-1.5lb
Project pcaSlab/pcaBeam Manual, Example 2

Frame: PCA Notes on ACI 318-05, Exampls 13-1 Enginser pcaStructurePoint
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Deflection

0987
| |
| |
i |
i |
= ; I
1 ; I
= i i
< N !
5 .
g ! !
@ .
o) ! !
3 .
m 1y |
B
=] . .
2 -1 |
S . .
= =1 |
kot . .
@ — ! I
2 . .
— 1 |
HN i
i i
4 I LEGEND.
_| | —Dead Load
i i —Live Load
- . —— Total Deflection
I I
0.867

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files\PCA\pcaSlabExamples\ivanualExample 2 - PCA MNotes on ACI 318-05 Example 13-1.5lb
Project pcaSlab/pcaBeam Manual, Example 2

Frame: PCA Notes on ACI 318-05, Exampls 13-1 Enginser pcaStructurePoint
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Reinforcement

Flexural and Transverse Reinforcement

14-#4@11.4
14-4#4@11.4

5-#3(360.0)c

pcaBeam v2.00. Licensed to: PCA. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files\PCA\pcaSlabExamplesivanualExample 2 - PCA Notes on ACI 318-05 Example 13-1.5lb
Project pcaSlab/pcaBeam Manual, Example 2

Frame: PCA Notes on ACI 318-05, Exampls 13-1 Enginser pcaStructurePoint
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Example 3 One-way slab system SfablocGeam

Problem description

The system shown in the following figure consists of five spans symmetric about
the centerline. We will be designing beam ABCD assuming that the other half of
the beam will be loaded and designed the same way. All beams have a width of 12
in. and a depth of 22 in. — including the 5 in. thick deck. Span length and widths
are shown in the figure. Columns have a 12 in. x 12in. cross-section and a length
equal to a typical story height of 13 ft. The system will be analyzed and designed
under a uniform live load of 130 psf and a dead load that consists of the slab
system’s own weight plus 80 psf. Use f°. = 4 ksi, f, = 60 ksi, and %.oncrere = 150 pef.
This exemple refers to example 16.1 from Structural Concrete: Theory and Design
by Hassoun and Al-Manaseer, Third Edition, 2005.

about q:_

— B L L —
' Symmetrical

Preparing Input
1. From the Input menu, select General Information. A dialog box appears.
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e In the LABELS section, input the names of the project, frame, and
engineer.

e In the FRAME section, input 6 for NO OF SUPPORTS.

e In the FLOOR SYSTEM section, click the radial button next to ONE-WAY /
BEAM.

e Leave all other options in the General Information tab to their default
settings of ACI 318-05 design code, ASTM A615 reinforcement, and
DESIGN run mode option.

e In the Solve Options tab, keep the default settings. Press OK.

General Information g\ General Information g|
General Informatian | Solve Optians | Span Contol GeneralInformation Salve Dptians | Span Contral |
et Design Dptions =
Live load patterm ratioc | %
Project:
Fiame:  [Structural Conciete by Hassoun and AFM anaser, 2 B Comyeesn Fiemonzs M EiEeho g vk
™ Moment Redistibution [ PRigid beam-column joint
Engineer: |pca5lruclulePoml [ Tarsion Analusis and Design
Torsion type
Options Fiun mode E (‘
. iy e
Design code: ACI 31805 - * Design
Reinfoicement: |4STMABIE = | © Investigation Deflection calculation aptions
Sections to use in deflection caloulations are
Frame Flaor System

" Gross [uncracked) * Effective [cracked)

Mo. of Supports: |6

I hegative mament regions, to calculate 1g and Mer use

[ Left cantiever [~ Right cantilever | & OneWay/Beam O Rt Sosfios © TSestion

[ Distance location a3 ratio of span v Calculate long-term deflections:
Duration of lnad Sustained part of live lnad
&0 months o %

i3 Cancel | Hep | 0K | Camed | Hem

2. Nothing needs to be changed in the Material Properties menu.
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Material Properties &

Conrete | Reinforcing Steel |

Slabs and
Beams Columns

Urit derusity ERE]
Comp. strength; ,4— ,4— ksi

Youngsmodulus: [38343  [38343 ks
Ruptus modulus: [0.47434 [047434 ks

Copy >

1] Cancel ‘ Help |

3. From the Input menu, select Spans. A dialog box appears.

Under the Slabs/Flanges tab, input 24 for LENGTH, 5 for THICKNESS,
and O for WIDTH LEFT and WIDTH RIGHT. Press MODIFY. (Note: Since
the slab has no width, we must convert the area loads to line loads along
the beam and also add the self-weight of the slab to the dead load. This
calculation will be shown in Step 8.)

Press CoPY. Select the check box next to Span 5. Press OK. This will give
Span 5 the same geometry as Span 1.

Press the drop down arrow next to SPAN and select Span 2. Input 26 for
LENGTH, 5 for THICKNESS, and O for WIDTH LEFT and WIDTH RIGHT.
Press MODIFY.

Press Cory. Unselect the check box next to Span 1 and select the check
boxes next to Spans 3 and 4. Press OK.

Select the Longitudinal Beams tab. Input 12 for WIDTH and 22 for
DEPTH. Press MODIFY.

Press Cory. Press the CHECK ALL button. Press OK.

Press OK again.
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Span Data &

Slabs/Flanges | Longitudinal Beams | Fibs |

Span 1 - Length 24 it Width Left: [0 it
Location; [Interior  ~ Thickness. |5 in Wicth Right. [ it

Span No. ‘ Location | Length Thickness wfidthL width-F
1 Interior 24 & 1} 1}
2 Inkerior 26 5 1} 1}
3 Interior 26 ] 1} 1}
4 Inkerior 26 5 a a
5 Inkerior 24 5 o o
ok | cencel | Hep |
Span Data &‘

Slabs/Flanges  Lengtudinal Beams | Rigs |

Span, - Width, 12
Depth: 22 in

Span No | width Depth
1 12 2
2 12 22
3 12 22
4 12 22
5 12 2
1] ‘ Cancel | Help ‘

4. From the Input menu, select Supports. A dialog box appears.

e  Under the Columns tab, input 13 for both HEIGHT ABOVE and HEIGHT
BELOW. Press MODIFY. (Note: the default C1 and €2 values for both the
column above and below the support can be left alone since all the
columns’ cross sections are 12 in. x 12 in.)

e  Press COPY. Press the CHECK ALL button. Press OK.

e  Press OK again.
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5.

6.

Support Data

Columns | Column Capitals | Transverse Beams | Boundary Conditions |

X

Height (if 1 (in] <2 fin)
Support ~| | sbove: 13 12 12
Stffness share % [100 | Belaw: 13 12 2
Sup. Mo | Stz | Hea [c1a 24 HIE 18 c28
1 100 13 12 12 13 12 12
2 100 13 12 12 13 12 12
3 100 13 12 12 12 12 12
4 100 13 12 12 12 12 12
5 100 13 12 12 13 12 12
] 100 13 12 12 13 12 12
i3 Concel | Help

From the Input menu, select Reinforcement Criteria. A dialog box appears.

Under the Beams tab, use the drop down arrows to change both the MIN
and MAX BAR SIZE for TOP BARS to #9.

Use the drop down arrows to change both the MIN and MAX BAR SIZE for
BOTTOM BARS to #8. Press OK.

Reinforcement Criteria

Slabs and Ribs  Beams I

Top bars
Cover [in]

Clear: |l
Bar size:
hin:
Maw  |#3 hd
Spacing [in]

Min: ,1—
M B

Fiein. ratio (%]
Min:  [014
5

Ma:

bar layers fin)

Clear distance between

Bottom bars Stinups
Sidle Cover in]

[s Cear [15
Bar size

W M [43 >

[#5 =] Maz (85 =
Spacing fin)

,1— Min: ,E—

O Maw 13
Nurer of lags

o4 i |2 =]

[ [ Treemeethen 2ing
concrete below top bars.

3

Cancel | b |

From the Input menu, select Load Cases. A dialog box appears.

Since we are not considering lateral forces, click on WIND in the LABEL
column on the list in the bottom half of the LOAD CASES dialog box and

press the DELETE button.
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e Click on EQ in the LABEL column and press the DELETE button. Press

OK.

Load Cases

Label

Add

Type: |DEAD

Label

[ Tupe

SELF
Dead
Live

DEAD
DEAD
LWE

-

Cancel |

Help

7. From the Input menu, select Load Combinations. A dialog box appears.

e Delete all the load combinations by clicking anywhere on the list in the
bottom half of the LOAD COMBINATIONS dialog box and pressing the
DELETE button. Repeat this procedure until all the load combinations are
gone.

e Input 1.2 inthe SELF field, 1.2 in the DEAD field, and 1. 6 in the LIVE
field. Press ADD.

e Press OK.

Load Combinations g|
SELF D Live

fz— [ [ [ r

sid | Modiy | Delete |
Comb [ sELF [ Dead Live
m 1z 12 15
k. Cancel Help
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8. From the Input menu, select Span Loads. A dialog box appears.

Press the drop down arrow next to TYPE, and select LINE LOAD.

Input 1647.5 for both the START and END MAGNITUDE. (Note: This
value was obtained by converting the area loads of the of the slab’s self
weight (without the beam) and superimposed dead load into a line load.)

Dead Load =

(i ft x150pct x 12ft) + (80psf *12ft) — (M x150pct) =
12 144in?/ft

=1647.51b/ ft

Input 24 for the END LOCATION. Press ADD.

Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog
box. Press the CoPYy button. (Note: there is a CASE COPY button that
should not be pressed.)

Click the check box next to SPAN 5 and press OK.

Back in the SPAN LOADS dialog box, use the drop down arrow next to
SPAN to select SPAN 2. Keep the START and END MAGNITUDES of
1647.5 lb/ft but change the END LOCATION to 26. Click the ADD
button.

Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog
box. Press the COPY button.

Click the check boxes next to SPAN 3 and 4. Press OK.

Span Loads El

Current Case Start End

Span: |1 «| Copw. Magnitude: |1647.5 16475 bt
Type: |Line Load -| Location: |0 24 It

Span= 24 it

Live

Case Copy.. | Add | M adify | Delste |

SpanNo. | Tupe [ wa [La [ wh [ b
Lineload 16475 0 1647.5 2
Lineload 16475 1647.5 %
LineLoad 16475 1647.5 %
LineLoad 16475 1647.5 %
lineload 16475 16475 24

o = oo —

o
o
o
1}

0K Cancel Help
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In the top left corner of the SPAN LOADS dialog box, there is a section called
CURRENT CASE. Click on LIVE.

Use the drop down arrow next to SPAN to select SPAN 1.

Making sure that LINE LOAD is still the selected LOAD TYPE, input 1560
for both the START and END MAGNITUDE.

Live Load = (130psf x12ft) =15601b/ ft
Input 24 for the END LOCATION. Press ADD.

Click on SPAN 1 on the list in the bottom half of the SPAN LOADS dialog
box. Press the COPY button. (Note: the CASE COPY button should not be

pressed.)

Click the check box next to SPAN 5 and press OK.

Back in the SPAN LOADS dialog box, use the drop down arrow next to
SPANS to select SPAN 2. Keep the START and END MAGNITUDES of 1560

Ib/ft but change the END LOCATION to 2 6. Click the ADD button.

Click on SPAN 2 in the list at the bottom half of the SPAN LOADS dialog
box. Press the COPY button.

Click the check boxes next to SPAN 3 AND 4. Press OK.

Press OK again.

Span Loads

Cunent Case:
Dead

Start End

Sparc [1 v| Copw.| Magnitude: [1550  [1560

Ib#ft

Type: |Line Load =|  Location: |0 24 It

Span=24ft

Casze Copy.. | Add | Modify | Delete |

Span Mo,

[ Type [ wia [La [wib [ 6

e R

Line Load 1580
Line Load 1580
Line Load 1560
Line Load 1560
Line Load 1560

1560 24
1560 26
1560 26
1560 26
1560 24

coooo|r

Ok Cancal ‘

Help

10. From the Solve menu, select Execute. Press CLOSE.

11. From the Solve menu, select Results Report.
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12.

13.

14.

15.

16.

e  Use the scroll bars to scroll through the results file.

e Use the ARROW keys or the mouse wheel to browse through different
parts of the results quickly. Press the CLOSE button to close the RESULTS
REPORT dialog box and return to pcaBeam.

To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear
Capacity, Deflection, or Reinforcement from the View menu. Right click in
any of these diagrams to get new copy, printing, or display options.

You may print the results file by selecting Print Results from the File menu.
To print any of the diagrams you selected to view, use the Print Preview
command found by right clicking in the diagram’s window. After viewing the
results, you may decide to investigate the input beams under the same loads
but with a modified reinforcement configuration.

From the Input menu, select General Information. In the General
Information dialog box change the RUN MODE option to INVESTIGATION. Do
not change any of the other options. Press OK

From the Input menu, select the different commands under Reinforcement
Criteria and Reinforcing Bars to modify the reinforcement configuration
computed by the program.

Repeat steps 10 and subsequent to perform the investigation and view the
results.
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Text Output (abbreviated)

0000000 000000 00000
00000000 00000000 0000000
oo oo oo oo oo oo
oo oo oo oo oo
00000000 [sle} 0000000 00000
0000000 oo oo 0000000 00000
[ele} [ele} [ele} [ele} oo
oo 00000000 oo oo
oo 000000 oo oo
00000 000000 00000 00 00
00 00 00 00 00 000 000
00 00 00 00 00 00 O 0 00
00 00 00 00 00 O 0 00
00000 00000 0000000 00 [¢] 00
00 00 00 00 00 00 00
00 00 00 00 00 00 00
00 00 00 00 00 00 00
00000 000000 00 00 00 00

pcaBeam v2.00 (TM)
A Computer Program for Analysis, Design, and Investigation of
Reinforced Concrete Beams and One-way Slab Systems

Copyright © 1992-2006, Portland Cement Association
All rights reserved

Licensee stated above acknowledges that Portland Cement Association
(PCR) is not and cannot be responsible for either the accuracy or
adequacy of the material supplied as input for processing by the
pcaBeam computer program. Furthermore, PCA neither makes any warranty
expressed nor implied with respect to the correctness of the output
prepared by the pcaBeam program. Although PCA has endeavored to
produce pcaBeam error free the program is not and cannot be certified
infallible. The final and only responsibility for analysis, design and
engineering documents is the licensees. Accordingly, PCA disclaims all
responsibility in contract, negligence or other tort for any analysis,
design or engineering documents prepared in connection with the use of
the pcaBeam program.

[1] INPUT ECHO

General Information:

File name Program Files\PCA\pcaSlab\Examples\Manual\Example 3 - Structural Concrete by Hassoun Example 16.1.slb
Project: pcaSlab/pcaBeam Manual, Example 3

Frame: Structural Concrete by Hassoun and Al-Manaseer, 2005, Ex.16.1

Engineer: pcaStructurePoint

Code: ACI 318-05

Reinforcement Database: ASTM A615

Mode: Design

Number of supports = 6

Floor System: One-Way/Beam

Live load pattern ratio = 100%

Deflections are based on cracked section properties.

In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 60 months.

0% of live load is sustained.

Compression reinforcement calculations NOT selected.

Moment redistribution NOT selected.

Effective flange width calculations NOT selected.

Rigid beam-column joint NOT selected.

Torsion analysis and design NOT selected.

Material Properties:

Slabs|Beams Columns

we = 150 150 1b/ft3
f'c = 4 4 ksi
Ec = 3834.3 3834.3 ksi
fr = 0.474342 0.47434 ksi
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£y = 60 ksi, Bars are not epoxy-coated
fyt = 60 ksi
Es = 29000 ksi

Reinforcement Database:

Units: Db (in), Ab (in"2), Wb (lb/ft)

Size Db ab Wb size Db Ab Wh
43 0.38 0.11 0.38 #4 0.50 0.20 0.67
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30
#11 1.41 1.56 5.31 #14 1.69 2.25 7.65
#18 2.26 4.00 13.60

Span Data:

wR (ft); t, Hmin (in)

Ll t wL wR Hmin
1 Int 24.000 5.00 0.500 0.500 0.00
2 Int 26.000 5.00 0.500 0.500 0.00
3 Int 26.000 5.00 0.500 0.500 0.00
4 Int 26.000 5.00 0.500 0.500 0.00
5 Int 24.000 5.00 0.500 0.500 0.00

Ribs and Longitudinal Beams: b, h, Sp (in)

Ribs Beams __Span__

Span b h Sp b h Hmin
1 0.00 0.00 0.00 12.00 22.00 15.57

2 0.00 0.00 0.00 12.00 22.00 14.86

3 0.00 0.00 0.00 12.00 22.00 14.86

4 0.00 0.00 0.00 12.00 22.00 14.86

5 0.00 0.00 0.00 12.00 22.00 15.57

Columns: cla, c2a, clb, c2b (in); Ha, Hb (ft)

Supp cla c2a Ha clb c2b Hb Red$%
1 12.00 12.00 13.000 12.00 12.00 13.000 100
2 12.00 12.00 13.000 12.00 12.00 13.000 100
3 12.00 12.00 13.000 12.00 12.00 13.000 100
4 12.00 12.00 13.000 12.00 12.00 13.000 100
5 12.00 12.00 13.000 12.00 12.00 13.000 100
6 12.00 12.00 13.000 12.00 12.00 13.000 100

Boundary Conditions: Kz (kip/in); Kry (kip-in/rad)

Supp Spring Kz  Spring Kry Far End A Far End B
1 0 0 Fixed Fixed
2 0 0 Fixed Fixed
3 0 0 Fixed Fixed
4 0 0 Fixed Fixed
5 0 0 Fixed Fixed
6 0 0 Fixed Fixed
Load Data:

Load Cases and Combinations:

Case SELF Dead Live
Type DEAD DEAD LIVE
Ul 1.200 1.200 1.600

Span Loads:
Span Case Wa La Wb Lb

Line Loads - Wa | Wb (lb/ft), La | Lb (ft):
5

1 Dead 1647. 0 1647.5 24
2 Dead 1647.5 0 1647.5 26
3 Dead 1647.5 0 1647.5 26
4 Dead 1647.5 0 1647.5 26
5 Dead 1647.5 0 1647.5 24
1 Live 1560 0 1560 24
2 Live 1560 0 1560 26
3 Live 1560 0 1560 26
4 Live 1560 0 1560 26
5 Live 1560 0 1560 24
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Support Loads: --- NONE ---
Support Displacements: --- NONE ---
Reinforcement Criteria:
Top bars Bottom bars__ Stirrups
Min Max Min Max Min Max
Slabs and Ribs:
Bar Size #9 #9 #8 #8
Bar spacing 1.00 18.00 1.00 18.00 in
Reinf ratio 0.14 5.00 0.14 5.00 %
Cover 1.50 1.50 in
Beams:
Bar Size #9 #9 #8 #8 #3 #5
Bar spacing 1.00 18.00 1.00 18.00 6.00 18.00 in
Reinf ratio 0.14 5.00 0.14 5.00 %
Cover 1.50 1.50 in
Side cover 1.50 1.50 in
Layer dist. 1.00 1.00 in
No. of legs 2 6
[2] DESIGN RESULTS
Top Reinforcement:
Width (ft), Mmax (k-ft), Xmax (ft), As (in”2), Sp (in)
Span Zone Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 Left 0.00 77.75 0.500 0.797 4.321 6.367 0.896 2-%9
Middle 0.00 0.00 12.000 0.000 4.321 0.000 0.000 -—=
Right 0.00 268.24 23.500 0.776 4.206 3.183 3.549 4-#9 2L
2 Left 0.00 267.45 0.500 0.776 4.206 3.183 3.537 4-#9 2L
Middle 0.00 0.00 13.000 0.000 4.321 0.000 0.000 -
Right 0.00 264.30 25.500 0.776 4.206 3.183 3.488 4-#9 2L
3 Left 0.00 265.14 0.500 0.776 4.206 3.183 3.501 2L
Middle 0.00 0.00 13.000 0.000 4.321 0.000 0.000
Right 0.00 265.14 25.500 0.776 4.206 3.183 3.501 2L
4 Left 0.00 264.30 0.500 0.776 4.206 3.183 3.488 4-#9 2L
Middle 0.00 0.00 13.000 0.000 4.321 0.000 0.000 -
Right 0.00 267.45 25.500 0.776 4.206 3.183 3.537 4-#9 2L
5 Left 0.00 268.24 0.500 0.776 4.206 3.183 3.549 4-#9 2L
Middle 0.00 0.00 12.000 0.000 4.321 0.000 0.000 -
Right 0.00 77.75 23.500 0.797 4.321 6.367 0.896 2-%9
Top Bar Details:
Units: Length (ft)
Left Continuous_ Right
Span Bars Length Bars Length Bars Length Bars Length Bars Length
1 1-#9 3.91 1-#9 2.16 - 2-#9 9.62 2-#9 4.71
2 2-49 10.37 2-%#9 4.69 - 2-%9 10.37 2-#9 4.63
3 2-49 10.12 2-49 4.65 - 2-49 10.12 2-49 4.65
4 2-49 10.37 2-49 4.63 - 2-49 10.37 2-49 4.69
5 2-#9 9.62 2-#9 4.71 - 1-#9 3.91 1-#9 2.16
Bottom Reinforcemen
: Width (ft), Mmax (k-ft), Xmax (ft), As (in"2), Sp (in)
Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 1.00 183.86 11.000 0.800 4.335 3.228 2.213 3-#8
2 1.00 171.61 13.250 0.800 4.335 3.228 2.055 3-#8
3 1.00 177.76 13.000 0.800 4.335 3.228 2.134 3-#8
4 1.00 171.61 12.750 0.800 4.335 3.228 2.055 3-#8
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5 1.00 183.86 13.000 0.800 4.335
Bottom Bar Details
Units: Start (ft), Length (ft)
Long Bars Short Bars

Span Bars Start Length Bars Start Length

1 2-#8 0.00 24.00 1-#8 2.95 15.98

2 2-#8 0.00 26.00 1-#8 6.05 14.29

3 2-#8 0.00 26.00 1-#8 5.42 15.16

4 2-#8 0.00 26.00 1-#8 5.66 14.29

5 2-#8 0.00 24.00 1-#8 5.07 15.98

As (in”2), PhiMn (k-ft)

Span x AsTop AsBot PhiMn- PhiMn+

1 0.000 2.00 1.58 -166.19 133.94

0.500 2.00 1.58 -166.19 133.94

0.523 2.00 1.58 -166.19 133.94

2.161 1.00 1.58 -86.40 133.94

2.273 1.00 1.58 -86.40 133.94

2.949 0.59 1.58 -51.55 133.94

3.911 0.00 1.80 0.00 151.40

6.380 0.00 2.37 0.00 194.71

8.550 0.00 2.37 0.00 194.71

12.000 0.00 2.37 0.00 194.71

14.383 0.00 2.37 0.00 194.71

15.450 0.51 2.37 -44.67 194.71

15.497 0.53 2.37 -46.59 194.71

18.589 2.00 1.66 -166.19 140.12

18.927 2.00 1.58 -166.19 133.94

19.293 2.00 1.58 -166.19 133.94

23.499 4.00 1.58 -296.33 133.94

23.500 4.00 1.58 -296.33 133.94

24.000 4.00 1.58 -296.33 133.94

2 0.000 4.00 1.58 -296.33 133.94

0.500 4.00 1.58 -296.33 133.94

0.501 4.00 1.58 -296.33 133.94

4.692 2.00 1.58 -166.19 133.94

6.045 2.00 1.58 -166.19 133.94

6.176 2.00 1.61 -166.19 136.51

9.231 0.54 2.37 -47.68 194.71

9.250 0.53 2.37 -46.88 194.71

10.367 0.00 2.37 0.00 194.71

13.000 0.00 2.37 0.00 194.71

15.633 0.00 2.37 0.00 194.71

16.750 0.54 2.37 -47.52 194.71

17.150 0.73 2.37 -64.08 194.71

19.766 2.00 1.72 -166.19 145.11

20.335 2.00 1.58 -166.19 133.94

21.366 2.00 1.58 -166.19 133.94

25.499 4.00 1.58 -296.33 133.94

25.500 4.00 1.58 -296.33 133.94

26.000 4.00 1.58 -296.33 133.94

3 0.000 4.00 1.58 -296.33 133.94

0.500 4.00 1.58 -296.33 133.94

0.501 4.00 1.58 -296.33 133.94

4.650 2.00 1.58 -166.19 133.94

5.421 2.00 1.58 -166.19 133.94

5.968 2.00 1.71 -166.19 144.28

8.729 0.67 2.37 -58.55 194.71

9.250 0.42 2.37 -36.92 194.71

10.117 0.00 2.37 0.00 194.71

13.000 0.00 2.37 0.00 194.71

15.883 0.00 2.37 0.00 194.71

16.750 0.42 2.37 -36.92 194.71

17.271 0.67 2.37 -58.55 194.71

20.032 2.00 1.71 -166.19 144.28

20.579 2.00 1.58 -166.19 133.94

21.350 2.00 1.58 -166.19 133.94

25.499 4.00 1.58 -296.33 133.94

25.500 4.00 1.58 -296.33 133.94

3.228

2.213

3-#8
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Longitudinal Beam Shear Reinforcement Required:

.000

000
500
501
634
665
234
850

.250
.367
.000
.633
.750
.769
.824
. 955
.308
.499
.500
.000

000
500
501
707
073
411
503
550
617

.000
.450
.620
.089
.051
727
.839
L4777
.500
.000
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.58

-296.

-296.
-296.
-296.
-166.
-166.
-166.

-64.

-47.

-46.

-47.
-166.
-166.
-166.
-296.
-296.
-296.

-296.
-296.
-296.
-166.
-166.
-166.

-46.

-51

-86.
-86.
-166.
-166.
-166.

19

Units:

Span

1

133.94

133.94
133.94
133.94
133.94
133.94
145.11
194.71
194.71
194.71
194.71
194.71
194.71
194.71
136.51
133.94
133.94
133.94
133.94
133.94

133.94
133.94
133.94
133.94
133.94
140.12
194.71
194.71
194.71
194.71
194.71
194.71
151.40
133.94
133.94
133.94
133.94
133.94
133.94

d (in), Start, End, Xu (ft), Phive, Vu (kip), Av/s (in"2/in)
Phive Start End Vu Xu Av/s

19.94 22.70 2.161 4.972 42.15 2.161 0.0217
4.972 7.783 28.65 4.972 0.0100

7.783 10.594 15.15 7.783 0.0100

10.594 13.406 15.67 13.406 0.0100

13.406 16.217 29.18 16.217 0.0100

16.217 19.028 42.68 19.028 0.0223

19.028 21.839 56.18 21.839 0.0373

19.94 22.70 2.161 5.258 55.31 2.161 0.0364
5.258 8.355 40.44 5.258 0.0198

8.355 11.452 25.56 8.355 0.0100

11.452 14.548 10.69 11.452 0.0000

14.548 17.645 25.20 17.645 0.0100

17.645 20.742 40.07 20.742 0.0194

20.742 23.839 54.95 23.839 0.0359

19.94 22.70 2.161 5.258 55.23 2.161 0.0363
5.258 8.355 40.36 5.258 0.0197

8.355 11.452 25.49 8.355 0.0100

11.452 14.548 10.61 14.548 0.0000

14.548 17.645 25.49 17.645 0.0100

17.645 20.742 40.36 20.742 0.0197

20.742 23.839 55.23 23.839 0.0363

19.94 22.70 2.161 5.258 54.95 2.161 0.0359
5.258 8.355 40.07 5.258 0.0194

8.355 11.452 25.20 8.355 0.0100

11.452 14.548 10.69 14.548 0.0000

14.548 17.645 25.56 17.645 0.0100

17.645 20.742 40.44 20.742 0.0198

20.742 23.839 55.31 23.839 0.0364

19.94 22.70 2.161 4.972 56.18 2.161 0.0373
4.972 7.783 42.68 4.972 0.0223

7.783 10.594 29.18 7.783 0.0100
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10.594 13.406 15.67 10.594 0.0100
13.406 16.217 15.15 16.217 0.0100
16.217 19.028 28.65 19.028 0.0100
19.028 21.839 42.15 21.839 0.0217
Longitudinal Beam Shear Reinforcement Details:
Units: spacing & distance (in).
Span Size Stirrups (2 legs each unless otherwise noted)
1 #3 19 @ 9.8 + 4 @ 8.4+ 10 @ 5.6
2 #3 10 @ 5.4 + 9 @ 9.3 + <-- 37.2 --> + 8 @ 9.3 + 11 @ 5.4
3 #3 10 @ 5.4 + 9 @ 9.3 + <-- 37.2 --> + 8 @ 9.3 + 11 @ 5.4
4 #3 10 @ 5.4 + 9 @ 9.3 + <-- 37.2 --> + 8 @ 9.3 + 11 @ 5.4
5 #3 9@ 5.6+ 4@8.4+ 20 9.8
d, Sp (in), Start, End, Xu (ft), PhiVe, Phivn, Vu (kip), Av/s (in”2/in)
d Phivc start End Av/s sp Phivn Vu Xu
1 19.94 22.70 0.000 0.750  -----=  —---= 42.90 52.53 0.000
0.750 16.217 0.0225 9.8 42.90 42.15 2.161
16.217 19.028 0.0261 8.4 46.10 42.68 19.028
19.028 23.250 0.0391 5.6 57.75 56.18 21.839
23.250 24.000  ----- —-m-- 57.75 66.56 24.000
2 19.94 22.70 0.000 0.750  -=--- —m--- 59.18 65.69 0.000
0.750 5.258 0.0407 5.4 59.18 55.31 2.161
5.258 11.452 0.0237 9.3 43.94 40.44 5.258
11.452 14.548  ---—-  -—-—— 11.35 10.69 11.452
14.548 20.742 0.0237 9.3 43.94 40.07 20.742
20.742 25.250 0.0407 5.4 59.18 54.95 23.839
25.250 26.000  -----  —-—-- 59.18 65.33 26.000
3 19.94 22.70 0.000 0.750  ----=  —---- 59.18 65.62 0.000
0.750 5.258 0.0407 5.4 59.18 55.23 2.161
5.258 11.452 0.0237 9.3 43.94 40.36 5.258
11.452 14.548  ----=  -—-—- 11.35 10.61 14.548
14.548 20.742 0.0237 9.3 43.94 40.36 20.742
20.742 25.250 0.0407 5.4 59.18 55.23 23.839
25.250 26.000  -----  —---- 59.18 65.62 26.000
4 19.94 22.70 0.000 0.750  ----- —---- 59.18 65.33 0.000
0.750 5.258 0.0407 5.4 59.18 54.95 2.161
5.258 11.452 0.0237 9.3 43.94 40.07 5.258
11.452 14.548  -—-—-  -—-—— 11.35 10.69 14.548
14.548 20.742 0.0237 9.3 43.94 40.44 20.742
20.742 25.250 0.0407 5.4 59.18 55.31 23.839
25.250 26.000  -----  —---- 59.18 65.69 26.000
5 19.94 22.70 0.000 0.750  ---m=  —---= 57.75 66.56 0.000
0.750 4.972 0.0391 5.6 57.75 56.18 2.161
4.972 7.783 0.0261 8.4 46.10 42.68 4.972
7.783 23.250 0.0225 9.8 42.90 42.15 21.839
23.250 24.000  ----- —m--- 42.90 52.53 24.000
Slab Shear Capacit
Units: b, d (in), Xu (ft), Phivc, Vu(kip)
Span b d Vratio Phive Vu Xu
1 Not checked
2 Not checked
3 Not checked
4 Not checked
5 --- Not checked ---
Units: Ig, Icr, Ie (in"4), Mcr, Mmax (k-ft) Load Level
Ie,avg Dead, Dead+Live
Span Dead Dead+Live Zone Ig Tcr Mcr Mmax Te Mmax Ie
1 5757 4847 Middle 10648 4364 38.26 65.37 5624 118.42 4576
Right 10648 6354 38.26 -116.34 6507 -210.74 6380
2 6715 5256 Left 10648 6354 38.26 -112.93 6521 -204.58 6382
Middle 10648 4364 38.26 52.53 6792 95.16 4773
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Right 10648 6354 38.26 -106.90 6551 -193.64 6387
3 6519 5223 Left 10648 6354 38.26 -107.69 6547 -195.08 6386
Middle 10648 4364 38.26 54.76 6508 99.20 4725
Right 10648 6354 38.26 -107.69 6547 -195.08 6386
4 6715 5256 Left 10648 6354 38.26 -106.90 6551 -193.64 6387
Middle 10648 4364 38.26 52.53 6792 95.16 4773
Right 10648 6354 38.26 -112.93 6521 -204.58 6382
5 5757 4847 Left 10648 6354 38.26 -116.34 6507 -210.74 6380
Middle 10648 4364 38.26 65.37 5624 118.42 4576

Maximum Instantaneous Deflections

Units: D (in)

Span Ddead Dlive Dtotal
1 0.191 0.201 0.392
2 0.141 0.182 0.322
3 0.151 0.183 0.334
4 0.141 0.182 0.322
5 0.191 0.201 0.392

Maximum Long-term Deflections

Time dependant factor for sustained loads = 2.000
Units: D (in)

Span Dsust Lambda Dcs Dcs+lu Dcs+1 Dtotal
1 0.191 2.000 0.382 0.582 0.582 0.773
2 0.141 2.000 0.281 0.463 0.463 0.604
3 0.151 2.000 0.302 0.485 0.485 0.636
4 0.141 2.000 0.281 0.463 0.463 0.604
5 0.191 2.000 0.382 0.582 0.582 0.773

Material Takeof

Reinforcement in the Direction of Analysis

Top Bars: 845.7 6.71 1b/ft <=> 6.712 1b/ft"2
Bottom Bars: 874.9 6.94 1b/ft 6.944 1b/ft"2
Stirrups: 947.5 7.52 1b/ft 7.520 1b/ft"2
Total Steel: 2668.2 21.18 1b/ft <=> 21.176 1lb/ft"2
Concrete: 178.5 1.42 ft"3/ft <=> 1.417 ft3/ft"2

[3] COLUMN AXIAL FORCES AND MOMENTS

Units: P (kip), M (k-ft)

Case/Patt Joint, Far Ends
Supp Comb/Patt Plaxial] P[spring] Mb(top]  Ma[bottom] M{spring]  Mb[bottom] Ma[top]
1 SELF 2.82 0.00 -2.55 -2.55 0.00 1.27 1.27
Dead 16.89 0.00 -15.27 -15.27 0.00 7.64 7.64
Live/All 15.99 0.00 -14.46 -14.46 0.00 7.23 7.23
Live/0dd 18.05 0.00 -18.95 -18.95 0.00 9.48 9.48
Live/Even -2.06 0.00 4.49 4.49 0.00 -2.25 -2.25
Live/sl 17.65 0.00 -18.07 -18.07 0.00 9.04 9.04
Live/S2 15.66 0.00 -13.75 -13.75 0.00 6.87 6.87
Live/S3 -1.60 0.00 3.48 3.48 0.00 -1.74 -1.74
Live/s4 0.31 0.00 -0.68 -0.68 0.00 0.34 0.34
Live/S5 -0.06 0.00 0.14 0.14 0.00 -0.07 -0.07
Live/S6 0.01 0.00 -0.03 -0.03 0.00 0.02 0.02
U1l/All 45.85 0.00 -41.46 -41.46 0.00 20.73 20.73
Ul/odd 49.15 0.00 -48.65 -48.65 0.00 24.33 24.33
Ul/Even 16.97 0.00 -11.14 -11.14 0.00 5.57 5.57
Ul/s1 48.50 0.00 -47.24 -47.24 0.00 23.62 23.62
Ul/s2 45.33 0.00 -40.32 -40.32 0.00 20.16 20.16
Ul/s3 17.71 0.00 -12.76 -12.76 0.00 6.38 6.38
Ul/s4 20.77 0.00 -19.42 -19.42 0.00 9.71 9.71
Ul/ss 20.17 0.00 -18.11 -18.11 0.00 9.05 9.05
Ul/s6 20.29 0.00 -18.37 -18.37 0.00 9.19 9.19
2 SELF 7.39 0.00 0.24 0.24 0.00 -0.12 -0.12
Dead 44.27 0.00 1.46 1.46 0.00 -0.73 -0.73
Live/All 41.92 0.00 1.38 1.38 0.00 -0.69 -0.69
Live/0Odd 19.18 0.00 15.75 15.75 0.00 -7.88 -7.88
Live/Even 22.74 0.00 -14.37 -14.37 0.00 7.18 7.18
Live/S1 21.64 0.00 12.94 12.94 0.00 -6.47 -6.47
Live/S2 43.91 0.00 -0.90 -0.90 0.00 0.45 0.45
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Live/S3
Live/S4
Live/s5
Live/S6

Ul/All
Ul/0dd
Ul/Even
Ul/s1
ul/s2
Ul/s3
Ul/s4
Ul/ss
Ul/sée

w

SELF
Dead
Live/All
Live/0dd
Live/Even
Live/S1
Live/S2
Live/s3
Live/s4
Live/S5
Live/S6

U1l/All
Ul/0dd
Ul/Even
Ul/sl
ul/s2
Ul/s3
Ul/s4
Ul/s5
Ul/s6é

IS

SELF
Dead
Live/All
Live/0dd
Live/Even
Live/S1
Live/S2
Live/S3
Live/s4
Live/S5
Live/S6

Ul/All
Ul/0dd
Ul/Even
Ul/s1
Ul/s2
Ul/s3
Ul/s4
Ul/s5
Ul/s6

o

SELF
Dead
Live/All
Live/0dd
Live/Even
Live/s1
Live/S2
Live/S3
Live/s4
Live/S5
Live/S6

Ul/All
Ul/0dd
Ul/Even
Ul/s1
Ul/s2
Ul/s3
Ul/s4
Ul/ss
Ul/sé

6 SELF

.90
.91
.38
.09

.19
.81

.75
.38
.95
.06
.73
.99

.76
.95
.97

.23
.40
.99
.06
.86

.12

.37
.49
.88
.43
.94
.89

.04
.21

CO00000000O0 0O0O0000O000 O0O000000000 000000000 00000000000 000000000

coooooocoo

cooo

-11.13
2.18
-0.43
0.10

0.92
27.51
-26.18
1.20
-3.15
18.30

-17.76
4.47

-0.24
-1.46
-1.38
-15.75
14.37
-0.10
0.43
-2.18
11.13

-12.94

-11.
.18
.43
.10

22.

-17.

-1.

13

.92
.51
.18

.76
.42
.30
.15

20

0.00
0.00
0.00
0.00

0.00

0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00

0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00

0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

5.56
-1.09
0.22
-0.05

-1.98
-13.48
10.62
-11.23
-0.16
8.03
-2.62
-0.53
-0.95

0.03
0.17
0.16
8.47
-8.31
1.27
-5.68
0.01
5.59
-1.11
0.25

0.46
13.75
-13.09
2.23
-8.88
0.21
9.15
-1.58
0.60

-0.03
-0.17
-0.16
-8.47

8.31
-0.25

1.11
-5.59
-0.01

5.68
-1.27

-0.46
-13.75
13.09
-0.60
1.58
-9.15
-0.21
8.88
-2.23

0.12
0.73
0.69
7.88
-7.18
0.05
-0.22
1.09
-5.56
-0.45
6.47

1.98
13.48
-10.62
0.95
0.53
2.62
-8.03
0.16
11.23

-1.27
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.73
.33
.57
.19
.05
L1
.38
.16
.62

Dead 16.89 0.00 15.27 15.27 0.00 -7.
Live/All 15.99 0.00 14.46 14.46 0.00 -7.
Live/0dd 18.05 0.00 18.95 18.95 0.00 -9.
Live/Even -2.06 0.00 -4.49 -4.49 0.00
Live/s1 0.01 0.00 0.03 0.03 0.00 -0
Live/s2 -0.06 0.00 -0.14 -0.14 0.00
Live/S3 0.31 0.00 0.68 0.68 0.00 -0
Live/s4 -1.60 0.00 -3.48 -3.48 0.00
Live/S5 15.66 0.00 13.75 13.75 0.00 -6.
Live/S6 17.65 0.00 18.07 18.07 0.00 -9.
UL/All 45.85 0.00 41.46 41.46 0.00 -20
U1/0dd 49.15 0.00 48.65 48.65 0.00 -24
Ul/Even 16.97 0.00 11.14 11.14 0.00 -5
U1/s1 20.29 0.00 18.37 18.37 0.00 -9
Ul/s2 20.17 0.00 18.11 18.11 0.00 -9
U1/s3 20.77 0.00 19.42 19.42 0.00 -9
U1/s4 17.71 0.00 12.76 12.76 0.00 -6
U1/s5 45.33 0.00 40.32 40.32 0.00 -20
U1/s6 48.50 0.00 47.24 47.24 0.00 -23

Sum SELF 34.65 0.00 -0.00 -0.00 0.00
Dead 207.58 0.00 -0.00 -0.00 0.00
Live/All 196.56 0.00 -0.00 -0.00 0.00
Live/0dd 115.44 0.00 0.00 0.00 0.00 -
Live/Even 81.12 0.00 -0.00 -0.00 0.00
Live/S1 37.44 0.00 -7.24 -7.24 0.00
Live/s2 78.00 0.00 -5.22 -5.22 0.00
Live/s3 81.12 0.00 2.02 2.02 0.00 -
Live/S4 81.12 0.00 -2.02 -2.02 0.00
Live/S5 78.00 0.00 5.22 5.22 0.00 -2.
Live/S6 37.44 0.00 7.24 7.24 0.00 -3
Ul/A11 563.60 0.00 -0.00 -0.00 0.00
U1/0dd 433.81 0.00 0.00 0.00 0.00 -0.
U1/Even 378.89 0.00 -0.00 -0.00 0.00 0
U1/s1 309.01 0.00 -11.58 -11.58 0.00
Ul/s2 373.90 0.00 -8.34 -8.34 0.00
U1/s3 378.89 0.00 3.24 3.24 0.00 -1.
Ul/s4 378.89 0.00 -3.24 -3.24 0.00
U1/s5 373.90 0.00 8.34 8.34 0.00 -4.
Ul/s6 309.01 0.00 11.58 11.58 0.00 -5.
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES
Span  x (ft) M- (k-ft) Comb M+ (k-ft) Comb (kip) Comb V+ (kip) Comb
1 0.000 -103.42 UL 0.00 Ul 0.00 Ul 52.53 UL
0.250 -90.43 UL 0.00 Ul 0.00 Ul 51.33 Ul
0.500 -77.75 UL 0.00 Ul 0.00 Ul 50.13 Ul
0.500 -77.75 UL 0.00 UL 0.00 Ul 50.13 Ul
0.750 -65.37 UL 0.00 Ul 0.00 Ul 48.93 UL
1.000 -53.29 UL 0.00 Ul 0.00 Ul 47.73 UL
1.250 -41.50 UL 0.00 Ul 0.00 Ul 46.53 UL
1.500 -30.02 UL 0.00 Ul 0.00 Ul 45.33 UL
1.750 -18.84 UL 3.69 UL 0.00 Ul 44.13 Ul
2.000 -7.96 UL 7.70 UL 0.00 Ul 42.93 Ul
2.250 0.00 Ul 11.56 UL 0.00 Ul 41.73 UL
2.500 0.00 UL 20.01 Ul 0.00 Ul 40.52 Ul
2.750 0.00 Ul 29.04 UL 0.00 Ul 39.32 Ul
3.000 0.00 UL 37.76 UL 0.00 Ul 38.12 UL
3.250 0.00 UL 46.19 UL 0.00 Ul 36.92 UL
3.500 0.00 Ul 54.31 UL 0.00 Ul 35.72 UL
3.750 0.00 UL 62.14 UL 0.00 Ul 34.52 Ul
4.000 0.00 Ul 69.67 UL 0.00 Ul 33.32 Ul
4.250 0.00 UL 76.89 UL 0.00 Ul 32.12 Ul
4.500 0.00 UL 84.35 UL 0.00 Ul 30.92 Ul
4.750 0.00 Ul 91.93 UL 0.00 Ul 29.72 Ul
5.000 0.00 UL 99.21 UL 0.00 Ul 28.52 Ul
5.250 0.00 Ul 106.19 Ul 0.00 Ul 27.32 Ul
5.500 0.00 Ul 112.86 Ul 0.00 Ul 26.12 Ul
5.750 0.00 UL 119.24 Ul 0.00 Ul 24.91 U1
6.000 0.00 Ul 125.32 Ul 0.00 Ul 23.71 Ul
6.250 0.00 UL 131.10 ULl 0.00 Ul 22.51 Ul
6.500 0.00 UL 136.58 Ul 0.00 Ul 21.31 Ul
6.750 0.00 Ul 141.76 Ul 0.00 Ul 20.11 Ul
7.000 0.00 UL 146.63 UL 0.00 Ul 18.91 UL
7.250 0.00 Ul 151.21 Ul 0.00 Ul 17.71 Ul
7.500 0.00 UL 155.49 Ul 0.00 Ul 16.51 Ul

-7.64
=7.23
-9.48

2.25
-0.02

0.07
-0.34

1.74
-6.87
-9.04

-20.73
-24.33
-5.57
-9.19
-9.05
-9.71
-6.38
-20.16
-23.62

0.00
0.00
0.00
-0.00
0.00
3.62
2.61
-1.01
1.01
-2.61
-3.62

0.00
-0.00
0.00
5.79
4.17
-1.62
1.62
-4.17
-5.79

Examples
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750
000
250
500
750
000
250
500

.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.500
.750
.000

000
250
500
500
750
000
250
500
750
000
250
500
750
000

-2.
-6.
-11.
-15.
-20.
-25.
-30.
-35.
-41.
-46.
-52.
-58.
-64.
-70.
-76.
-82.
-89.
-97.
-109.
-122.
-136.
-149.
-163.
-177.
-191.
-206.
-221.
-236.
-252.
-268.
-268.
-284.
-300.

-299.
-283.
-267.
-267.
-251.
-236.
-221.
-206.
-192.
-177.
-164.
-150.
-137.
-124.

O 000 0000000000000 00000000000000 OO

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

159.47
163.14
166.52
169.60
172.37
174.85
177.03
178.90
180.48
181.75
182.73
183.41
183.78
183.86
183.63
183.10
182.28
181.15
179.73
178.00
175.97
173.65
171.02
168.09
164.87
161.34
157.51
153.38
148.96
144.23
139.20
133.87
128.24
122.31
116.08
109.56
102.73
95.60
88.17
80.44
72.41
64.08
55.45
46.52
37.28
27.75
17.92
7.79
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
-0.41
-0.99
-1.56
-2.14
-2.72
-3.29
-3.87
-4.45
-5.02
-5.60
-6.52
=7.72
-8.92
-10.12
-11.32
-12.53
-13.73
-14.93
-16.13
-17.33
-18.53
-19.73
-20.93
-22.13
-23.33
-24.53
-25.73
-26.93
-28.14
-29.34
-30.54
-31.74
-32.94
-34.14
-35.34
-36.54
-37.74
-38.94
-40.14
-41.34
-42.54
-43.74
-44.95
-46.15
-47.35
-48.55
-49.75
-50.95
-52.15
-53.35
-54.55
-55.75
-56.95
-58.15
-59.35
-60.56
-61.76
-62.96
-64.16
-64.16
-65.36
-66.56

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

15.31
14.11
12.91
11.71
10.51
9.31
8.10
6.90
5.70
4.50
3.30
2.10
0.90
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

65.69
64.49
63.29
63.29
62.09
60.89
59.69
58.49
57.29
56.09
54.89
53.68
52.48
51.28

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
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250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500

-111.
-99.
-87.
-78.
=72,
-66.
-61.
-55.
-50.
-45.
-40.
-35.
-30.
-25.
-21.
-18.
-15.
-11.

-8.
-5.
-2.
-0.

-0.
-3.
-6.
-9.
-12.
-15.
-19.
-22.
-26.
-30.
-34.
-38.
-42.
-46.
-51.
-56.
-61.
-66.
-73.
-85.
-97.
-109.
-121.
-134.
-148.

OO0 0000000000000 0000000000O000000 0O

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
7.42
16.46
25.19
33.63
41.76
49.59
57.12
64.36
71.99
79.57
86.86
93.84
100.52
106.91
112.99
118.77
124.26
129.44
134.32
138.90
143.18
147.17
150.85
154.23
157.31
160.09
162.57
164.75
166.63
168.21
169.49
170.47
171.15
171.53
171.61
171.39
170.87
170.05
168.92
167.50
165.78
163.76
161.44
158.81
155.89
152.67
149.15
145.32
141.20
136.78
132.05
127.03
121.70
116.08
110.15
103.93
97.40
90.58
83.45
76.03
68.30
60.28
51.95
43.33
34.40
25.17
15.65
5.82
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
-0.55
-1.13
-1.70
-2.89
-4.09
-5.29
-6.49
-7.69
-8.89
-10.09
-11.29
-12.49
-13.70
-14.90
-16.10
-17.30
-18.50
-19.70
-20.90
-22.10
-23.30
-24.50
-25.70
-26.90
-28.10
-29.31
-30.51
-31.71
-32.91
-34.11
-35.31
-36.51
-37.71
-38.91
-40.11
-41.31
-42.51
-43.71
-44.91
-46.12
-47.32
-48.52
-49.72
-50.92
-52.12
-53.32

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

50.08
48.88
47.68
46.48
45.28
44.08
42.88
41.68
40.48
39.28
38.07
36.87
35.67
34.47
33.27
32.07
30.87
29.67
28.47
27.27
26.07
24.87
23.67
22.47
21.26
20.06
18.86
17.66
16.46
15.26
14.06
12.86
11.66
10.46
9.26
8.06
6.86
5.65
4.45
3.25
2.66
2.08
1.51
0.93
0.35
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
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Ul

Examples

6-75



pC gﬁb | pcﬁﬁm

.750
.000
.250
.500
.750
.000
.250
.500
.500
.750
.000

000
250
500
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000

-161.
-175.
-189.
-203.
-218.
-233.
-248.
-264.
-264.
-280.
-296.

-297.
-281.
-265.
-265.
-249.
-234.
-219.
-204.
-189.
-175.
-161.
-148.
-135.
-122.
-109.
-97.
-85.
-73.
-63.
-58.
-53.
-49.
-44.
-40.
-35.
-31.
-27.
-23.
-20.
-16.
-13.
-10.
=7.
4.
-1.

o

OO0 0000000000000 0000000000000000 0O
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Ul
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Ul
Ul
Ul
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Ul
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Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
4.25
14.31
24.07
33.52
42.68
51.53
60.09
68.34
76.30
83.95
91.31
98.36
105.12
111.57
117.72
123.58
129.13
134.38
139.34
143.99
148.34
152.40
156.15
159.60
162.75
165.60
168.16
170.41
172.36
174.01
175.36
176.41
177.16
177.61
177.76
177.61
177.16
176.41
175.36
174.01
172.36
170.41
168.16
165.60
162.75
159.60
156.15
152.40
148.34
143.99
139.34
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
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Ul
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Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
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Ul
Ul
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-54.52
-55.72
-56.92
-58.12
-59.32
-60.52
-61.73
-62.93
-62.93
-64.13
-65.33

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
-0.29
-0.87
-1.44
-2.02
-3.18
-4.38
-5.58
-6.78
-7.98
-9.18
-10.38
-11.58
-12.78
-13.98
-15.18
-16.39
-17.59
-18.79
-19.99
-21.19
-22.39
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
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Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
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Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

65.62
64.42
63.21
63.21
62.01
60.81
59.61
58.41
57.21
56.01
54.81
53.61
52.41
51.21
50.01
48.81
47.60
46.40
45.20
44.00
42.80
41.60
40.40
39.20
38.00
36.80
35.60
34.40
33.20
31.99
30.79
29.59
28.39
27.19
25.99
24.79
23.59
22.39
21.19
19.99
18.79
17.59
16.39
15.18
13.98
12.78
11.58
10.38
9.18
7.98
6.78
5.58
4.38
3.18
2.02
1.44
0.87
0.29
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.500
.750
.000

000
250
500
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500

-1.
-4.
=7.
-10.
-13.
-16.
-20.
-23.
-27.
-31.
-35.
-40.
-44.
-49.
-53.
-58.
-63.
-73.
-85.
-97.
-109.
-122.
-135.
-148.
-1l61.
-175.
-189.
-204.
-219.
-234.
-249.
-265.
-265.
-281.
-297.

-296.
-280.
-264.
-264.
-248.
-233.
-218.
-203.
-189.
-175.
-161.
-148.
-134.
-121.
-109.
-97.
-85.
-73.
-66.
-61.
-56.
-51.
-46.
-42.
-38.
-34.
-30.
-26.
-22.
-19.
-15.
-12.

-6.
-3.
-0.

coooooo
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134.38
129.13
123.58
117.72
111.57
105.12
98.36
91.31
83.95
76.30
68.34
60.09
51.53
42.68
33.52
24.07
14.31
4.25
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
5.82
15.65
25.17
34.40
43.33
51.95
60.28
68.30
76.03
83.45
90.58
97.40
103.93
110.15
116.08
121.70
127.03
132.05
136.78
141.20
145.32
149.15
152.67
155.89
158.81
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-23.59
-24.79
-25.99
-27.19
-28.39
-29.59
-30.79
-31.99
-33.20
-34.40
-35.60
-36.80
-38.00
-39.20
-40.40
-41.60
-42.80
-44.00
-45.20
-46.40
-47.60
-48.81
-50.01
-51.21
-52.41
-53.61
-54.81
-56.01
-57.21
-58.41
-59.61
-60.81
-62.01
-63.21
-63.21
-64.42
-65.62

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

65.33
64.13
62.93
62.93
61.73
60.52
59.32
58.12
56.92
55.72
54.52
53.32
52.12
50.92
49.72
48.52
47.32
46.12
44.91
43.71
42.51
41.31
40.11
38.91
37.71
36.51
35.31
34.11
32.91
31.71
30.51
29.31
28.10
26.90
25.70
24.50
23.30
22.10
20.90
19.70
18.50
17.30
16.10
14.90
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.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.500
.750
.000

000
250
500
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000

-0.
-2.
-5.
-8.
-11.
-15.
-18.
-21.
-25.
-30.
-35.
-40.
-45.
-50.
-55.
-61.
-66.
-72.
-78.
-87.
-99.
-111.
-124.
-137.
-150.
-164.
-177.
-192.
-206.
-221.
-236.
-251.
-267.
-267.
-283.
-299.

-300.
-284.
-268.
-268.
-252.
-236.
-221.
-206.
-191.
-177.
-163.
-149.
-136.
-122.
-109.

-97.

-89.

-82.
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161.44
163.76
165.78
167.50
168.92
170.05
170.87
171.39
171.61
171.53
171.15
170.47
169.49
168.21
166.63
164.75
162.57
160.09
157.31
154.23
150.85
147.17
143.18
138.90
134.32
129.44
124.26
118.77
112.99
106.91
100.52
93.84
86.86
79.57
71.99
64.36
57.12
49.59
41.76
33.63
25.19
16.46
7.42
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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0.00
0.00
0.00
0.00
-0.35
-0.93
-1.51
-2.08
-2.66
-3.25
-4.45
-5.65
-6.86
-8.06
-9.26
-10.46
-11.66
-12.86
-14.06
-15.26
-16.46
-17.66
-18.86
-20.06
-21.26
-22.47
-23.67
-24.87
-26.07
-27.27
-28.47
-29.67
-30.87
-32.07
-33.27
-34.47
-35.67
-36.87
-38.07
-39.28
-40.48
-41.68
-42.88
-44.08
-45.28
-46.48
-47.68
-48.88
-50.08
-51.28
-52.48
-53.68
-54.89
-56.09
-57.29
-58.49
-59.69
-60.89
-62.09
-63.29
-63.29
-64.49
-65.69

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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0.00
0.00
0.00
0.00
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13.70
12.49
11.29
10.09
8.89
7.69
6.49
5.29
4.09
2.89
1.70
1.13
0.55
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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66.56
65.36
64.16
64.16
62.96
61.76
60.56
59.35
58.15
56.95
55.75
54.55
53.35
52.15
50.95
49.75
48.55
47.35
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250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500
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.000
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.500
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.500
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.000
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.500
.750
.000
.250
.500
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.250
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.000
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.000
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.250
.500
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.000
.250
.500
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.000
.250
.500
.750
.000
.250
.500
.500
.750
.000

-76.
-70.
-64.
-58.
-52.
-46.
-41.
-35.
-30.
-25.
-20.
-15.
-11.

-6.

-2.

-7.
-18.
-30.
-41.
-53.
-65.
-77.
-77.
-90.

-103.

0O 0000000000000 0000000000000000000000000000000000000000
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0.00
7.79
17.92
27.75
37.28
46.52
55.45
64.08
72.41
80.44
88.17
95.60
102.73
109.56
116.08
122.31
128.24
133.87
139.20
144.23
148.96
153.38
157.51
161.34
164.87
168.09
171.02
173.65
175.97
178.00
179.73
181.15
182.28
183.10
183.63
183.86
183.78
183.41
182.73
181.75
180.48
178.90
177.03
174.85
172.37
169.60
166.52
163.14
159.47
155.49
151.21
146.63
141.76
136.58
131.10
125.32
119.24
112.86
106.19
99.21
91.93
84.35
76.89
69.67
62.14
54.31
46.19
37.76
29.04
20.01
11.56
7.70
3.69
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
-0.90
-2.10
-3.30
-4.50
-5.70
-6.90
-8.10
-9.31
-10.51
-11.71
-12.91
-14.11
-15.31
-16.51
-17.71
-18.91
-20.11
-21.31
-22.51
-23.71
-24.91
-26.12
-27.32
-28.52
-29.72
-30.92
-32.12
-33.32
-34.52
-35.72
-36.92
-38.12
-39.32
-40.52
-41.73
-42.93
-44.13
-45.33
-46.53
-47.73
-48.93
-50.13
-50.13
-51.33
-52.53
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46.15
44.95
43.74
42.54
41.34
40.14
38.94
37.74
36.54
35.34
34.14
32.94
31.74
30.54
29.34
28.14
26.93
25.73
24.53
23.33
22.13
20.93
19.73
18.53
17.33
16.13
14.93
13.73
12.53
11.32
10.12
8.92
7.72
6.52
5.60
5.02
4.45
3.87
3.29
2.72
2.14
1.56
0.99
0.41
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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[7] SEGMENTAL DEFLECTIONS

Units:

Span

1

x (ft), D (in)

x Ddead Dlive Dtotal
0.000 0.000 0.000 0.000
0.250 0.005 0.005 0.010
0.500 0.011 0.010 0.021
0.500 0.011 0.010 0.021
0.750 0.016 0.015 0.032
1.000 0.022 0.021 0.043
1.250 0.028 0.027 0.054
1.500 0.034 0.033 0.066
1.750 0.040 0.039 0.078
2.000 0.046 0.045 0.091
2.250 0.052 0.051 0.103
2.500 0.058 0.057 0.116
2.750 0.064 0.064 0.128
3.000 0.071 0.070 0.141
3.250 0.077 0.077 0.154
3.500 0.083 0.083 0.166
3.750 0.089 0.090 0.179
4.000 0.095 0.096 0.192
4.250 0.101 0.103 0.204
4.500 0.107 0.109 0.216
4.750 0.113 0.115 0.228
5.000 0.119 0.121 0.240
5.250 0.124 0.127 0.251
5.500 0.130 0.133 0.262
5.750 0.135 0.138 0.273
6.000 0.140 0.144 0.284
6.250 0.145 0.149 0.294
6.500 0.149 0.154 0.304
6.750 0.154 0.159 0.313
7.000 0.158 0.164 0.322
7.250 0.162 0.168 0.330
7.500 0.166 0.172 0.338
7.750 0.169 0.176 0.345
8.000 0.173 0.180 0.352
8.250 0.176 0.183 0.359
8.500 0.178 0.186 0.365
8.750 0.181 0.189 0.370
9.000 0.183 0.192 0.375
9.250 0.185 0.194 0.379
9.500 0.187 0.196 0.382
9.750 0.188 0.197 0.385
10.000 0.189 0.199 0.388
10.250 0.190 0.200 0.390
10.500 0.191 0.200 0.391
10.750 0.191 0.201 0.392
11.000 0.191 0.201 0.392
11.250 0.191 0.201 0.391
11.500 0.190 0.200 0.390
11.750 0.189 0.199 0.388
12.000 0.188 0.198 0.386
12.250 0.186 0.197 0.383
12.500 0.185 0.195 0.380
12.750 0.183 0.193 0.376
13.000 0.181 0.191 0.371
13.250 0.178 0.188 0.366
13.500 0.175 0.185 0.360
13.750 0.172 0.182 0.354
14.000 0.169 0.178 0.348
14.250 0.166 0.175 0.341
14.500 0.162 0.171 0.333
14.750 0.158 0.167 0.325
15.000 0.154 0.162 0.316
15.250 0.150 0.158 0.308
15.500 0.145 0.153 0.298
15.750 0.141 0.148 0.289
16.000 0.136 0.143 0.279
16.250 0.131 0.138 0.269
16.500 0.126 0.132 0.258
16.750 0.121 0.127 0.247
17.000 0.115 0.121 0.236
17.250 0.110 0.115 0.225
17.500 0.105 0.109 0.214
17.750 0.099 0.103 0.202
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.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
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.500
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500
750
000
250
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.320
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.322
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.322
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.750
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.180
.178
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.175
L173
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.168
.165
.162
.159
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.148
.144
.139
.135
.130
.125
.120
L1115
.110
.105
.099
.094
.088
.083
.077
.072
.066
.061
.056
.050
.045
.040
.035
.031
.026
.022
.018
.015
.012
.009
.006
.004
.002
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.000
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.067
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.288
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.276
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.248
.240
.232
.223
.214
.205
.196
.187
177
.168
.158
.148
.138
.129
L119
.109
.100
.091
.081
.073
.064
.056
.048
.041
.034
.027
.021
.016
.011
.008
.004
.002
.001
.001
.000
.000

.000
.000
.001
.001
.003
.005
.008
.013
.017
.023
.029
.036
.043
.050
.059
.067
.076
.085
.094
.104
.114
.124
.134
.144
.154
.164
.174
.183
.193
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0.180
0.181
0.182
0.182
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0.174
0.171
0.169
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0.163
0.160
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0.148
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0.140
0.135
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0.121
0.116
0.110
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.144
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.325
.333
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.383
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.391
.392
.392
.391
.390
.388
.385
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.370
.365
.359
.352
.345
.338
.330
.322
.313
.304
.294
.284
.273
.262
.251
.240
.228
.216
.204
.192
179
.166
.154
.141
.128
.116
.103
.091
.078
.066
.054
.043
.032
.021
.021
.010
.000
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Graphical Output
Loads

156 1560 156 156 156
CASE: Live
1647 5 16475 1647 5 16475 16475
CASE: Dead
625 625 625 625 625
21215 R1256 2126 R12.5 212
CASE: SELF

pcaBeam v2.00. Licensed to: PCA. License |D: 12345-1234567-4-2020DE-2C800

File: C:\Program Files\PCAYcaSlab\ExamplesivanualExample 3 - Structural Concrete by Hassoun Example 16.1 slb
Project pcaSlab/pcaBeam Manual, Example 3

Frame: Structural Concrete by Hassoun and Al-Manaseer, 2005, Ex 161 Engineer: pcaStructurePoint
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Internal Forces
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Moment Capacity
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Shear Capacity
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Deflection
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Flexural Rebar
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Transverse Rebar
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Example 4 Flat Plate Floor System sfab

Problem description

An office building is planned using a flat plate floor system with the column
layout as shown in figure below. No beams, drop panels, or column capitals are
permitted. Specified live load is 100 psf and dead load will include the weight of
the slab plus an allowance of 20 psf for finish floor plus suspended loads. The
columns will be 18 in. square, and the floor-to-floor height of the structure will be
12 ft. The slab thickness will be 8.5 in. according to ACI Code. Design the interior
panel C, using material strengths £, = 60,000 psi and /. = 4000 psi. Straight-bar
reinforcement will be used. This example refers to Example 13-3 from Design of
Concrete Structures by Nilson, Darwin, and Dolan, Thirteenth Edition, 2004

9"—» i 22'-0" i 22'-0" i 22'-0" i —9"
QJ | | ] |

I A'j_ ......... _L'j_ _________ _L'j_ __________ LF —
| I I I
Y| | | |
22'-0¢ | A | B | |
| ! | |
| | | |
| | | |
22'-0¢ | B | C | |
| | | |
| | I I

I B _} _________ _E_ _________ _E_ __________ ’_T: —
| | | |
| | | |
S | | |
| | | |

= %T ......... 4';____4'@ .......... ﬁ_
9" | I I I
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Preparing Input
1.  From the Input menu, select General Information. A dialog box appears.
e In the LABELS section, input the names of the project, frame, and
engineer.
e In the FRAME section, input 4 for NO OF SUPPORTS.
e Inthe FLOOR SYSTEM section, click the radial button next to TWO-WAY.

e Leave all other options in the General Information tab to their default
settings of ACI 318-02 design code, ASTM A615 reinforcement, and
DESIGN run mode option.

General Information [‘57\
GeneralInformation | Salve Optians | Span Centrol |

Labels

Project.

Frame: | Design of Concrete Shuctures by Nilson, Damin, an

Engineer: |pca5tructureFomt

Options Run mode

Design code: ACI 318-02 - * Design
Reinforcement  |[ASTMAE1S =] | Investigation

Frame Floar System
Mo. of Supports: 4 * Twoway

™ Leftcantilever [ Fight cantilever | ¢ OneWay/Beam

[ Distance location as ratio of span

i3 Cancel | b |

2. Nothing needs to be changed in the Material Properties menu.
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Material Properties rz‘
Conrete | Reinforcing Steel |
Slabs and
Beams Columns
Uit denzity: 150} 150 Ib/ft3
Comp. strength; 4 4 ksi
‘foung's modulus: |3834.3 3634.3 kesi
Rupture modulus: |0.47434 047424 ks
Copy >
1] Cancel ‘ Help |

3. From the Input menu, select Spans. A dialog box appears.

Under the Slabs/Flanges tab, input 22 for LENGTH, 8.5 for THICKNESS,
and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.

Press COPY. Press the CHECK ALL button. Press OK.

Press OK again.

Span Data E‘
Slabs/Flanges | Longitudinal Beams | Fibs |
Span - Length 22 ft Width Left. |11 ft
Location: | Interiar hd Thickness: |85 in Width Right: |11 ft
Span No. ‘ Location | Length Thickness “width-L “‘width-F
1 Interior 22 85 i 1
2 Inkerior 22 85 il 1
3 Inkerior 22 858 n 1
[ilg Concel | Hep |

4. From the Input menu, select Supports. A dialog box appears.

Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and

BELOW rows.
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e Input 18 for both the Cl and C2 values in both the ABOVE and BELOW
rows. Press MODIFY.

e  Press CoPY. Press the CHECK ALL button. Press OK.

e Press OK again.

Support Data &
Columns | Diop Pansts | Column Capilals | Transverse Beams | Boundary Conditions |

Height (] ¢l in) 2(in)
Support ~| | sbove: 12 18 18
Sifinessshare % [100 | Belows 12 18 18

[¥ Checl punching shear around column

Sup.No [ Stz [ Hi [ clA | c2a HiB 1B 28 | Shea

1 100 12 18 18 12 18 13 ‘Yes
2 100 12 18 18 12 18 13 Yes
3 100 12 18 18 12 18 12 Yes
4 100 12 18 18 12 18 12 Tes

i3 Concel | Help

5. From the Input menu, select Reinforcement Criteria.

e  Use the drop down arrow next to MAX BAR SIZE for both ToP BARS and
BOTTOM BARS to select # 6 bars.

e  Press OK.
Reinforcement Criteria I‘X‘
Slabs and Fibs | Beams |
Top bars Bottom bars
Cower [in)
Clear: 1.5
Bar size
Min: | #5 - #5 il
Maw w6 | [ws <
Spacing [in)
bdin 1 1
Max: |18 18
Reint. ratio [%]
Min: |0.14 0.14
Max |5 5
There is mare than 12 in of
concrete below top bars,
ok Cancel Help
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6. From the Input menu, select Load Cases. A dialog box appears.

Load Cases

Label Type: |DEAD

sdd | |

Label | Type

SELF DEAD
Dead DEAD
Live LIWE

]

Since we are not considering lateral forces, click on WIND in the LABEL
column on the list in the bottom half of the LOAD CASES dialog box and
press the DELETE button.

Click on EQ in the LABEL column and press the DELETE button. Press

7. From the Input menu, select Load Combinations. A dialog box appears.

Delete all the load combinations by clicking anywhere on the list in the
bottom half of the LOAD COMBINATIONS dialog box and pressing the
DELETE button. Repeat this procedure until all the load combinations are

Input 1.2 in the SELF field, 1. 2 in the DEAD field, and 1. 6 in the LIVE
field. Press ADD.
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8. From the Input menu, select Span Loads. A dialog box appears.

3

Load Combinations
SELF D Live
12 G
sid | Modiy | Delete |
Comb [ sELF [ Dead Live
m 1z 12 15
oK Cancd | Hep

Input 20 for the MAGNITUDE. Press ADD.

Press Cory. Press the CHECK ALL button. Press OK.

In the top left corner of the SPAN LOADS dialog box, there is a section

called CURRENT CASE. Click on LIVE.

Input 100 for MAGNITUDE. Press ADD.

Press Cory. Press the CHECK ALL button. Press OK.

Press OK again.

X

Span Loads

Cunent Case:

Sparc [1 = | Copw. | Magritude: [20 ]
= e |

Type: |dreslosd =

Span=22ft
LCasze Copy... | Add | Modify | Delete |

SpanMo_ | Type [ wia [La [wib [ 6
1 Area Load 20 - - -
2 Area Load 20
3 Area Load 20

Ok Cancel

Help
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10.

11.

12.

13.

14.

15.

Span Loads

3

Current Case:
Dead

Span: |1 =| Copy Magnitude: 100
Type: |Area Load -

Span=22 1t

Ib/ft2

Case Cony. | add | Modiy | Dele |

[ Type
1 freaload 100
2 freaload 100
3 freaload 100

Span Na.

[wia [Ls [wit [ o

o]

Help

cael |

From the Solve menu, select Execute. Press CLOSE.
From the Solve menu, select Results Report.

e  Use the scroll bars to scroll through the results file.

e Use the ARROW keys or the mouse wheel to browse through different
parts of the results quickly. Press the CLOSE button to close the RESULTS
REPORT dialog box and return to pcaBeam.

To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear
Capacity, Deflection, or Reinforcement from the View menu. Right click in
any of these diagrams to get new copy, printing, or display options.

You may print the results file by selecting Print Results from the File menu.
To print any of the diagrams you selected to view, use the Print Preview
command found by right clicking in the diagram’s window. After viewing the
results, you may decide to investigate the input beams under the same loads
but with a modified reinforcement configuration.

From the Input menu, select General Information. In the General
Information dialog box change the RUN MODE option to INVESTIGATION. Do
not change any of the other options. Press OK

From the Input menu, select the different commands under Reinforcement
Criteria and Reinforcing Bars to modify the reinforcement configuration
computed by the program.

Repeat steps 10 and subsequent to perform the investigation and view the
results.
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Text Output (abbreviated)

0000000 000000 00000
00000000 00000000 0000000
oo oo oo oo oo oo
oo oo oo oo 0o
00000000 oo 0000000 00000
0000000 oo oo 0000000 00000
oo oo oo oo 0o
oo 00000000 oo oo
oo 000000 oo 0o
000000 o o
00000000 oo 00000 oo
oo oo o oo oo
0000 oo o oo oo
000000 oo 000000 000000
0000 oo oo 00 oo 0o
oo oo oo oo oo oo
00000000 oo o oo oo oo oo
000000 ooo 00000 0 00000

pcaSlab v2.00 (TM)
A Computer Program for Analysis, Design, and Investigation of
Reinforced Concrete Beams, One-way and Two-way Slab Systems

Copyright © 2003-2006, Portland Cement Association
A1l rights reserved

Licensee stated above acknowledges that Portland Cement Association
(PCR) is not and cannot be responsible for either the accuracy or
adequacy of the material supplied as input for processing by the
pcaSlab computer program. Furthermore, PCA neither makes any warranty
expressed nor implied with respect to the correctness of the output
prepared by the pcaSlab program. Although PCA has endeavored to
produce pcaSlab error free the program is not and cannot be certified
infallible. The final and only responsibility for analysis, design and
engineering documents is the licensees. Accordingly, PCA disclaims all
responsibility in contract, negligence or other tort for any analysis,
design or engineering documents prepared in connection with the use of
the pcaSlab program.

[1] INPUT ECHO

General Information:

File name:
13.3.slb

Project: pcaSlab/pcaBeam Manual, Example 4

Frame: Design of Concrete Structures by Nilson, Darwin, and Dolan, 2004, Example 13.3

Engineer: pcaStructurePoint

Code: ACI 318-02

Reinforcement Database: ASTM A615

Mode: Design

Number of supports = 4

Floor System: Two-Way

Program Files\PCA\pcaSlab\Examples\Manual\Example 4 - Design of Concrete Structures by Nilson Example

Live load pattern ratio = 75%

Minimum free edge for punching shear = 10 times slab thickness

Deflections are based on cracked section properties.

In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 60 months.

0% of live load is sustained.

Compression reinforcement calculations NOT selected.

Material Properties:

Slabs|Beams Columns

we = 150 150 1b/ft3

f'e = 4 4 ksi

Ec = 3834.25 3834.25 ksi

fr = 0.474342 0.474342 ksi

fy = 60 ksi, Bars are not epoxy-coated
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fyv = 60 ksi
Es = 29000 ksi

Reinforcement Database:

Units: Db (in), Ab (in"2), Wb (lb/ft)

Size Db Ab Wb Size Db Ab Wb
0.38 0.11 0.38 0.50 0.20 0.67
0.63 0.31 1.04 0.75 0.44 1.50
0.88 0.60 2.04 1.00 0.79 2.67
1.13 1.00 3.40 1.27 1.27 4.30
#11 1.41 1.56 5.31 1.69 2.25 7.65
#18 2.26 4.00 13.60
Span Data
Slabs: L1, wL, wR (ft); t, Hmin (in)
Span Loc Ll t wL wR Hmin
1 Int 22.000 8.50 11.000 11.000 8.20
2 Int 22.000 8.50 11.000 11.000 7.45
3 Int 22.000 8.50 11.000 11.000 8.20
Support Data:
Columns: cla, c2a, clb, c2b (in); Ha, Hb (ft)
Supp cla c2a Ha clb c2b Hb Red%
1 18.00 18.00 12.000 18.00 18.00 12.000 100
2 18.00 18.00 12.000 18.00 18.00 12.000 100
3 18.00 18.00 12.000 18.00 18.00 12.000 100
4 18.00 18.00 12.000 18.00 18.00 12.000 100
Boundary Conditions: Kz (kip/in); Kry (kip-in/rad)
Supp Spring Kz  Spring Kry Far End A Far End B
1 0 0 Fixed Fixed
2 0 0 Fixed Fixed
3 0 0 Fixed Fixed
4 0 0 Fixed Fixed
Load Data:
Load Cases and Combinations:
Case SELF Dead Live
Type DEAD DEAD LIVE
Ul 1.200 1.200 1.600
Span Loads:
Span Case Wa
Area Loads - Wa (lb/ft2):
1 Dead 20
2 Dead 20
3 Dead 20
1 Live 100
2 Live 100
3 Live 100
Support Loads: --- NONE ---
Support Displacements: --- NONE ---
Reinforcement Criteria:
Top bars Bottom bars__ Stirrups
Min Max Min Max Min Max
Slabs and Ribs:
Bar Size #5 #6 #5 #6
Bar spacing 1.00 18.00 1.00 18.00 in
Reinf ratio 0.14 5.00 0.14 5.00 %
Cover 1.50 1.50 in
Beams:
Bar Size #5 #8 #5 #8 #3 #5
Bar spacing 1.00 18.00 1.00 18.00 6.00 18.00 in
Reinf ratio 0.14 5.00 0.14 5.00 %
Cover 1.50 1.50 in
Side cover 1.50 1.50 in
Layer dist. 1.00 1.00 in
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No. of legs 2 6

[2] DESIGN RESULTS*

*Unless otherwise noted, all results are in the direction of analysis only. Another analysis

in the perpendicular direction has to be carried out for two-way slab systems.

Top Reinforcement:

Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in"2), Sp (in)

Span Strip Zone Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 Column Left 11.00 21.63 0.750 2.020 15.945 16.500 0.724 8-#5
Middle 11.00 0.00 11.000 0.000 15.945 0.000 0.000 -
Right 11.00 211.61 21.250 2.020 15.945 5.280 7.610 25-#5
Middle Left 11.00 -0.00 0.750 0.000 15.945 0.000 0.000 -
Middle 11.00 0.00 11.000 0.000 15.945 0.000 0.000 -
Right 11.00 70.54 21.250 2.020 15.945 16.500 2.402 8-#5
2 Column Left 11.00 188.13 0.750 2.020 15.945 5.280 6.700 25-#5
Middle 11.00 0.17 7.925 2.020 15.945 16.500 0.006 8-#5
Right 11.00 188.13 21.250 2.020 15.945 5.280 6.700 25-#5
Middle Left 11.00 62.71 0.750 2.020 15.945 16.500 2.129 8-#5
Middle 11.00 0.06 7.925 2.020 15.945 16.500 0.002 8-#5
Right 11.00 62.71 21.250 2.020 15.945 16.500 2.129 8-#5
3 Column Left 11.00 211.61 0.750 2.020 15.945 5.280 7.610 25-#5
Middle 11.00 0.00 11.000 0.000 15.945 0.000 0.000 -
Right 11.00 21.63 21.250 2.020 15.945 16.500 0.724 8-#5
Middle Left 11.00 70.54 0.750 2.020 15.945 16.500 2.402 8-#5
Middle 11.00 0.00 11.000 0.000 15.945 0.000 0.000 -
Right 11.00 -0.00 21.250 0.000 15.945 0.000 0.000 -
NOTES:
*5 - Number of bars governed by maximum allowable spacing.
Top Bar Details:
Length (ft)
Left Continuous__ Right
Span Strip Bars Length Bars Length Bars Length Bars Length Bars Length
1 Column T-#5 7.52 1-#5 4.85 13-#5 7.53 12-#5 4.85
Middle == == 8-#5 7.53 -
2 Column 9-#5 7.52 8-#5 4.85 8-#5 22.00 9-#5 7.52 8-#5 4.85
Middle - - 8-#5 22.00 - -
3 Column 13-#5 7.53 12-#5 4.85 7-#5 7.52 1-#5 4.85
Middle 8-#5 7.53 - - -
Bottom Reinforcemen
Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in”2), Sp (in)
Span Strip Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 Column 11.00 132.42 9.250 2.020 15.945 8.800 4.613 15-#5
Middle 11.00 88.28 9.250 2.020 15.945 13.200 3.025 10-#5
2 Column 11.00 78.82 11.000 2.020 15.945 14.667 2.692 9-#5
Middle 11.00 52.55 11.000 2.020 15.945 16.500 1.778 8-#5 *5
3 Column 11.00 132.42 12.750 2.020 15.945 8.800 4.613 15-#5
Middle 11.00 88.28 12.750 2.020 15.945 13.200 3.025 10-#5
NOTES:

*5 - Number of bars governed by maximum allowable spacing.

Bottom Bar Details:

Units: Start (ft), Length (ft)
Long Bars Short Bars
Span Strip Bars Start Length Bars Start Length
1 Column 15-#5 0.00 22.00 ==
Middle T-#5 0.00 22.00 3-#5 3.30 15.40
2 Column 9-#5 0.00 22.00 -
Middle T-#5 0.00 22.00 1-#5 3.30 15.40

*5
*5
*5
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3

Column
Middle

15-
7-

Flexural Capacity:

Unit
Span

Strip

x (ft),

As

#5 0.00 22.00
#5 0.00 22.00

(in”2), PhiMn (k-ft)

x AsTop AsBot

1

2

3

Column

Middle

Column

Middle

Column

Middle

.000 2.48 4.65
.750 2.48 4.65
.851 2.48 4.65
.851 2.17 4.65
.515 2.17 4.65
.515 0.00 4.65
.925 0.00 4.65
.000 0.00 4.65
.075 0.00 4.65
.469 0.00 4.65
.633  4.03 4.65
.149 4.03 4.65
.314 7.75 4.65
.250 7.75 4.65
.000 7.75 4.65
.000 0.00 2.17
.750 0.00 2.17
L300 0.00 2.17
.457 0.00 3.10
.925 0.00 3.10
.000 0.00 3.10
.075 0.00 3.10
.469 0.00 3.10
.617 2.48 3.10
.543 2.48 3.10
.700 2.48 2.17
.250 2.48 2.17
.000 2.48 2.17
.000 7.75 2.79
.750 7.75 2.79
.825 7.75 2.79
.851 5.27 2.79
.490 5.27 2.79
.515 2.48 2.79
.925 2.48 2.79
.000 2.48 2.79
.075 2.48 2.79
.485 2.48 2.79
.510 5.27 2.79
.149 5.27 2.79
L1755 7.75  2.79
.250 7.75 2.79
.000 7.75 2.79
.000 2.48 2.17
.750 2.48 2.17
L300 2.48 2.17
.300 2.48 2.48
.925  2.48 2.48
.000 2.48 2.48
.075 2.48 2.48
.700 2.48 2.48
.700 2.48 2.17
.250 2.48 2.17
.000 2.48 2.17
.000 7.75 4.65
.750 7.75 4.65
.686 7.75 4.65
.851 4.03 4.65
.367 4.03 4.65
.531 0.00 4.65
.925 0.00 4.65
.000 0.00 4.65
.075 0.00 4.65
.485 0.00 4.65
.485 2.17 4.65
.149 2.17 4.65
.149 2.48 4.65
.250 2.48 4.65
.000 2.48 4.65
.000 2.48 2.17
.750 2.48 2.17

3-#5 3.30 15.40
PhiMn- PhiMn+
-72.78 133.43
-72.78 133.43
-72.78 133.43
-63.89 133.43
-63.89 133.43

0.00 133.43

0.00 133.43

0.00 133.43

0.00 133.43

0.00 133.43
-116.39 133.43
-116.39 133.43
-215.16 133.43
-215.16 133.43
-215.16 133.43

0.00 63.89

0.00 63.89

0.00 63.89

0.00 90.40

0.00 90.40

0.00 90.40

0.00 90.40

0.00 90.40
-72.78 90.40
-72.78 90.40
-72.78 63.89
-72.78 63.89
-72.78 63.89
-215.16 81.62
-215.16 81.62
-215.16 81.62
-150.24 81.62
-150.24 81.62
-72.78 81.62
-72.78 81.62
=72.78 81.62
-72.78 81.62
-72.78 81.62
-150.24 81.62
-150.24 81.62
-215.16 81.62
-215.16 81.62
-215.16 81.62
=72.78 63.89
=-72.78 63.89
-72.78 63.89
=-72.78 72.78
-72.78 72.78
=72.78 72.78
-72.78 72.78
=72.78 72.78
-72.78 63.89
-72.78 63.89
-72.78 63.89
-215.16 133.43
-215.16 133.43
-215.16 133.43
-116.39 133.43
-116.39 133.43

0.00 133.43

0.00 133.43

0.00 133.43

0.00 133.43

0.00 133.43
-63.89 133.43
-63.89 133.43
=72.78 133.43
-72.78 133.43
=72.78 133.43
-72.78 63.89
=-72.78 63.89
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3.300 2.48 2.17 =72.78 63.89

4.457 2.48 3.10 -72.78 90.40

6.383 2.48 3.10 =72.78 90.40

7.531 0.00 3.10 0.00 90.40

7.925 0.00 3.10 0.00 90.40

11.000 0.00 3.10 0.00 90.40

14.075 0.00 3.10 0.00 90.40

17.543 0.00 3.10 0.00 90.40

18.700 0.00 2.17 0.00 63.89

21.250 0.00 2.17 0.00 63.89

22.000 0.00 2.17 0.00 63.89

Slab Shear Capacity:
b, d (in), Xu (ft), PhiVc, Vu(kip)

b d Vratio Phivc Vu Xu
1 264.00 6.69 1.000 167.49 79.20 20.69
2 264.00 6.69 1.000 167.49 66.42 1.31
3 264.00 6.69 1.000 167.49 79.20 1.31

Flexural Transfer of Negative Unbalanced Moment at Supports:

Units: Width (in), Munb (k-ft), As (in"2)
AsReq AsProv Additional Bars

Supp Width GammaF*Munb Comb Pat

1 43.50 44.32 Ul All 1.545 0.817 3-#5
2 43.50 45.11 Ul 0dd 1.574 2.554 -
3 43.50 45.11 Ul 0Odd 1.574 2.554 -
4 43.50 44.32 Ul All 1.545 0.817 3-#5
Punching Shear Around Columns:
Units: Vu (kip), Munb (k-ft), vu (psi), Phi*vc (psi)
Supp Vu vu Munb Comb Pat GammaV vu Phi*vc
1 61.95 189.9 17.54 Ul All 0.320 226.0 189.7 *EXCEEDED
2 162.23 248.6 -40.89 Ul All 0.400 284.6 189.7 *EXCEEDED
3 162.23 248.6 40.89 Ul All 0.400 284.6 189.7 *EXCEEDED
4 61.95 189.9 -17.54 Ul All 0.320 226.0 189.7 *EXCEEDED
Deflections:
Units: Ig, Icr, Ie (in”4), Mcr, Mmax (k-ft) Load Level
Ie,avg Dead_ (d) Dead+Live_(d+l)__
Span Dead Dead+Live Zone Ig Icr Mcr Mmax Ie Mmax Ie
1 13038 6920 Middle 13511 1874 125.66 89.45 13511 160.30 7480
Right 13511 2357 125.66 -140.37 10359 -251.55 3747
2 13511 10773 Left 13511 2357 125.66 -123.80 13511 -221.86 4384
Middle 13511 1350 125.66 44.24 13511 79.28 13511
Right 13511 2357 125.66 -123.80 13511 -221.86 4384
3 13038 6920 Left 13511 2357 125.66 -140.37 10359 -251.55 3747
Middle 13511 1874 125.66 89.45 13511 160.30 7480
Maximum Instantaneous Deflections - Direction of Analysis
Units: D (in), Ig (in~4)
Frame Strips
Span Ddead Dlive Dtotal Strip Ig LDF Ratio Ddead Dlive Dtotal
1 0.120 0.221 0.341 Column 6755.38 0.738 1.475 0.176 0.327 0.503
Middle 6755.38 0.262 0.525 0.063 0.116 0.179
2 0.033 0.037 0.069 Column 6755.38 0.675 1.350 0.044 0.050 0.094
Middle 6755.38 0.325 0.650 0.021 0.024 0.045
3 0.120 0.221 0.341 Column 6755.38 0.738 1.475 0.176 0.327 0.503
Middle 6755.38 0.262 0.525 0.063 0.116 0.179
Maximum Long-term Deflections - Direction of Analysis
Time dependant factor for sustained loads = 2.000
Units: D (in)
Column Strip Middle Strip
Span Dsust Lambda Dcs Dcs+lu Dcs+1 Dtotal Dsust Lambda Dcs Dcs+1lu Decs+1 Dtotal
1 0.176 2.000 0.353 0.679 0.679 0.856 0.063 2.000 0.126 0.242 0.242 0.305
2 0.044 2.000 0.088 0.138 0.138 0.182 0.021 2.000 0.042 0.066 0.066 0.087
3 0.176 2.000 0.353 0.679 0.679 0.856 0.063 2.000 0.126 0.242 0.242 0.305

Material Takeoff:
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Reinforcement in the Direction of Analysis

Top Bars: 1160.4 1b <=> 17.58 1lb/ft <=> 0.799 1lb/ft"2
Bottom Bars: 1489.2 1b <=> 22.56 1lb/ft <=> 1.026 1lb/ft"2
Stirrups: 0.0 <=> 0.00 1b/ft <=> 0.000 1b/ft"2
Total Steel: 2649.6 < 40.14 1b/ft < 1.825 1b/ft"2
Concrete: 1028.5 < 15.58 ft"3/ft <=> 0.708 ft"3/ft"2

[3] COLUMN AXIAL FORCES AND MOMENTS

Units: P (kip), M (k-ft)

Case/Patt Joint Far Ends
Supp Comb/Patt Plaxial] P[spring] Mb[top] Ma [bottom] M[spring] Mb [bottom] Ma([top]
1 SELF 21.35 0.00 -11.12 -11.12 0.00 6.06 6.06
Dead 4.02 0.00 -2.09 -2.09 0.00 1.14 1.14
Live/All 20.10 0.00 -10.47 -10.47 0.00 5.70 5.70
Live/0Odd 16.42 0.00 -9.62 -9.62 0.00 5.24 5.24
Live/Even -1.35 0.00 1.77 1.77 0.00 -0.96 -0.96
Live/S1 16.11 0.00 -9.21 -9.21 0.00 5.02 5.02
Live/S2 14.76 0.00 =7.44 =7.44 0.00 4.06 4.06
Live/S3 -1.04 0.00 1.36 1.36 0.00 -0.74 -0.74
Live/s4 0.31 0.00 -0.41 -0.41 0.00 0.22 0.22
U1l/All 36.98 0.00 -19.26 -19.26 0.00 10.50 10.50
Ul/0dd 31.10 0.00 -17.90 -17.90 0.00 9.76 9.76
Ul/Even 2.66 0.00 0.32 0.32 0.00 -0.17 -0.17
Ul/s1 30.60 0.00 -17.25 -17.25 0.00 9.40 9.40
uUl/s2 28.44 0.00 -14.42 -14.42 0.00 7.86 7.86
Ul/s3 3.16 0.00 -0.34 -0.34 0.00 0.18 0.18
Ul/s4 5.32 0.00 -3.17 -3.17 0.00 1.73 1.73
2 SELF 55.78 0.00 6.97 6.97 0.00 -3.80 -3.80
Dead 10.50 0.00 1.31 1.31 0.00 -0.72 -0.72
Live/All 52.50 0.00 6.56 6.56 0.00 -3.58 -3.58
Live/0dd 19.88 0.00 17.28 17.28 0.00 -9.42 -9.42
Live/Even 19.50 0.00 -12.36 -12.36 0.00 6.73 6.73
Live/S1 22.29 0.00 14.42 14.42 0.00 -7.86 -7.86
Live/S2 41.79 0.00 2.06 2.06 0.00 -1.12 -1.12
Live/S3 17.09 0.00 -9.50 -9.50 0.00 5.18 5.18
Live/s4 -2.41 0.00 2.86 2.86 0.00 -1.56 -1.56
U1l/All 96.60 0.00 12.08 12.08 0.00 -6.58 -6.58
Ul/odd 44.40 0.00 29.22 29.22 0.00 -15.93 -15.93
Ul/Even 43.80 0.00 -18.20 -18.20 0.00 9.92 9.92
Ul/s1 48.26 0.00 24.65 24.65 0.00 -13.43 -13.43
uUl/s2 79.46 0.00 4.87 4.87 0.00 -2.66 -2.66
Ul/s3 39.94 0.00 -13.62 -13.62 0.00 7.42 7.42
Ul/s4 8.74 0.00 6.15 6.15 0.00 -3.35 -3.35
3 SELF 55.78 0.00 -6.97 -6.97 0.00 3.80 3.80
Dead 10.50 0.00 -1.31 -1.31 0.00 0.72 0.72
Live/All 52.50 0.00 -6.56 -6.56 0.00 3.58 3.58
Live/0dd 19.88 0.00 -17.28 -17.28 0.00 9.42 9.42
Live/Even 19.50 0.00 12.36 12.36 0.00 -6.73 -6.73
Live/S1 -2.41 0.00 -2.86 -2.86 0.00 1.56 1.56
Live/S2 17.09 0.00 9.50 9.50 0.00 -5.18 -5.18
Live/S3 41.79 0.00 -2.06 -2.06 0.00 1.12 1.12
Live/s4 22.29 0.00 -14.42 -14.42 0.00 7.86 7.86
U1l/All 96.60 0.00 -12.08 -12.08 0.00 6.58 6.58
Ul/0dd 44.40 0.00 -29.22 -29.22 0.00 15.93 15.93
Ul/Even 43.80 0.00 18.20 18.20 0.00 -9.92 -9.92
Ul/s1 8.74 0.00 -6.15 -6.15 0.00 3.35 3.35
Ul/s2 39.94 0.00 13.62 13.62 0.00 =7.42 =7.42
Ul/s3 79.46 0.00 -4.87 -4.87 0.00 2.66 2.66
Ul/s4 48.26 0.00 -24.65 -24.65 0.00 13.43 13.43
4 SELF 21.35 0.00 11.12 11.12 0.00 -6.06 -6.06
Dead 4.02 0.00 2.09 2.09 0.00 -1.14 -1.14
Live/All 20.10 0.00 10.47 10.47 0.00 -5.70 -5.70
Live/0dd 16.42 0.00 9.62 9.62 0.00 -5.24 -5.24
Live/Even -1.35 0.00 -1.77 -1.77 0.00 0.96 0.96
Live/S1 0.31 0.00 0.41 0.41 0.00 -0.22 -0.22
Live/S2 -1.04 0.00 -1.36 -1.36 0.00 0.74 0.74
Live/S3 14.76 0.00 7.44 7.44 0.00 -4.06 -4.06
Live/S4 16.11 0.00 9.21 9.21 0.00 -5.02 -5.02

6-106 Examples



pC gﬁb | pcﬁﬁm

U1l/All 36.98 0.00 19.26 19.26 0.00 -10.
Ul/odd 31.10 0.00 17.90 17.90 0.00 -9.
Ul/Even 2.66 0.00 -0.32 -0.32 0.00 0
Ul/sl 5.32 0.00 3.17 3.17 0.00 -1.
uUl/s2 3.16 0.00 0.34 0.34 0.00 -0.
Ul/s3 28.44 0.00 14.42 14.42 0.00 =-7.
Ul/s4 30.60 0.00 17.25 17.25 0.00 -9.
Sum SELF 154.27 0.00 -0.00 -0.00 0.00 0.
Dead 29.04 0.00 -0.00 -0.00 0.00 0.
Live/All 145.20 0.00 -0.00 -0.00 0.00 0.
Live/0dd 72.60 0.00 0.00 0.00 0.00 -0.
Live/Even 36.30 0.00 -0.00 -0.00 0.00 0.
Live/S1 36.30 0.00 2.76 2.76 0.00 -1.
Live/S2 72.60 0.00 2.76 2.76 0.00 -1.
Live/S3 72.60 0.00 -2.76 -2.76 0.00 1.
Live/s4 36.30 0.00 -2.76 -2.76 0.00 1.
UL/All 267.17 0.00 -0.00 -0.00 0.00 0
Ul/odd 151.01 0.00 0.00 0.00 0.00 -0
Ul/Even 92.93 0.00 -0.00 -0.00 0.00 0
Ul/sl 92.93 0.00 4.42 4.42 0.00 -2
uUl/s2 151.01 0.00 4.42 4.42 0.00 -2
Ul/s3 151.01 0.00 -4.42 -4.42 0.00 2
Ul/s4 92.93 0.00 -4.42 -4.42 0.00 2
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES
Span x (ft) M- (k-ft) Comb M+ (k-ft) Comb (kip) Comb V+ (kip) Comb
1 0.000 -65.21 Ul 0.00 Ul 0.00 Ul 62.60 UL
0.250 -49.78 Ul 0.00 U1 0.00 U1 60.89 UL
0.500 -34.88 Ul 0.00 Ul 0.00 Ul 59.18 UL
0.750 -21.63 Ul 0.00 U1 0.00 U1 57.46 UL
0.750 -21.63 Ul 0.00 Ul 0.00 U1 57.46 Ul
1.000 -8.76 Ul 0.56 UL 0.00 Ul 55.75 U1
1.250 0.00 U1 7.69 UL 0.00 U1 54.04 ULl
1.500 0.00 Ul 20.98 UL 0.00 Ul 52.33 Ul
1.750 0.00 U1 33.85 UL 0.00 U1 50.61 UL
2.000 0.00 Ul 46.29 Ul 0.00 Ul 48.90 U1
2.250 0.00 Ul 58.30 Ul 0.00 Ul 47.19 U1
2.500 0.00 U1 69.88 Ul 0.00 U1 45.47 ULl
2.750 0.00 Ul 81.04 Ul 0.00 Ul 43.76 Ul
3.000 0.00 U1 91.76 Ul 0.00 Ul 42.05 ULl
3.250 0.00 Ul 102.06 U1 0.00 U1 40.33 U1
3.500 0.00 Ul 111.93 Ul 0.00 Ul 38.62 Ul
3.750 0.00 U1 121.37 Ul 0.00 U1 36.91 Ul
4.000 0.00 Ul 130.38 Ul 0.00 Ul 35.19 U1
4.250 0.00 Ul 138.96 Ul 0.00 Ul 33.48 UL
4.500 0.00 Ul 147.12 Ul 0.00 U1 31.77 U1
4.750 0.00 Ul 154.85 Ul 0.00 Ul 30.05 U1
5.000 0.00 U1 162.15 Ul 0.00 U1 28.34 U1
5.250 0.00 Ul 169.02 Ul 0.00 Ul 26.63 Ul
5.500 0.00 Ul 175.46 UL 0.00 Ul 24.91 Ul
5.750 0.00 Ul 181.47 Ul 0.00 U1 23.20 U1
6.000 0.00 Ul 187.06 U1 0.00 Ul 21.49 U1
6.250 0.00 U1 192.22 Ul 0.00 U1 19.77 Ul
6.500 0.00 Ul 196.95 Ul 0.00 Ul 18.06 Ul
6.750 0.00 Ul 201.25 Ul 0.00 Ul 16.41 Ul
7.000 0.00 UL 205.12 U1 0.00 U1 14.92 Ul
7.250 0.00 Ul 208.56 Ul 0.00 U1 13.42 U1
7.500 0.00 U1 211.58 Ul 0.00 U1 11.93 Ul
7.750 0.00 Ul 214.17 U1 0.00 Ul 10.44 U1
8.000 0.00 Ul 216.33 Ul 0.00 U1 8.94 Ul
8.250 0.00 U1 218.06 Ul 0.00 U1 7.45 UL
8.500 0.00 Ul 219.36 Ul -0.04 U1 5.96 U1
8.750 0.00 U1 220.23 U1 -0.88 UL 4.46 UL
9.000 0.00 Ul 220.68 Ul -1.71 U1 2.97 U1
9.250 0.00 Ul 220.70 Ul -2.54 U1 1.48 Ul
9.500 0.00 U1 220.29 U1 -3.38 Ul 0.00 UL
9.750 0.00 Ul 219.45 U1l -4.21 U1 0.00 U1
10.000 0.00 Ul 218.18 Ul -5.93 Ul 0.00 UL
10.250 0.00 Ul 216.49 Ul -7.64 Ul 0.00 U1
10.500 0.00 Ul 214.36 Ul -9.35 U1 0.00 Ul
10.750 0.00 U1 211.81 Ul -11.07 Ul 0.00 ULl
11.000 0.00 Ul 208.83 Ul -12.78 U1 0.00 U1
11.250 0.00 Ul 205.42 Ul -14.49 Ul 0.00 Ul
11.500 0.00 Ul 201.58 Ul -16.20 Ul 0.00 U1

50
76

.17

73
18
86
40

.00
.00
.00
.41
.41
.41
.41

-10.50
-9.76
0.17
-1.73
-0.18
-7.86
-9.40

0.00
0.00
0.00
-0.00
0.00
-1.50
-1.50
1.50
1.50

0.00
-0.00
0.00
-2.41
-2.41
2.41
2.41

Examples
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.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.250
.500
.750
.000

000
250
500
750
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000

-6.
-13.
-19.
-26.
-34.
-41.
-49.
-56.
-64.
-79.
-96.

-112.
-129.
-147.
-165.
-183.
-202.
-221.
-241.
-261.
-282.
-282.
-303.
-324.
-346.

-305.
-286.
-268.
-250.
-250.
-233.
-216.
-200.
-184.
-168.
-153.
-138.
-124.
-110.
-96.
-83.
-76.
=70.
-63.
=57.
-51.
-45.
-39.
-33.
-29.
-24.
-20.
-16.
-13.
-9.
-6.
-3.
-0.

o

cooocooooocoocooocoooO

cooco

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

197.32
192.63
187.50
181.95
175.97
170.23
164.82
159.02
152.86
146.32
139.41
132.13
124.47
116.44
108.04
99.26
90.11
80.59
70.69
60.42
49.78
38.76
27.37
15.61
3.47
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
8.92
17.60
25.90
33.84
41.40
49.06
56.71
63.99
70.90
77.43
83.59
89.37
94.79
99.83
104.49
108.79
112.71
116.25
119.43

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

-17.92
-19.63
-21.34
-23.06
-24.77
-26.48
-28.20
-29.91
-31.62
-33.34
-35.05
-36.76
-38.48
-40.19
-41.90
-43.62
-45.33
-47.04
-48.76
-50.47
-52.18
-53.90
-55.61
-57.32
-59.04
-60.75
-62.46
-64.18
-65.89
-67.60
-69.32
-71.03
=72.74
-74.46
-76.17
-77.88
-79.60
-81.31
-83.02
-83.02
-84.73
-86.45
-88.16

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

75.38
73.67
71.96
70.24
70.24
68.53
66.82
65.10
63.39
61.68
59.96
58.25
56.54
54.82
53.11
51.40
49.68
47.97
46.26
44.54
42.83
41.12
39.40
37.69
35.98
34.27
32.55
30.84
29.13
27.41
25.76
24.27
22.77
21.28
19.79
18.29
16.80
15.31

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul

Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
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.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.250
.500
.750
.000

000
250
500
750
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

-51.
=57.
-63.
=70.
-76.
-83.
-96.
-110.
-124.
-138.
-153.
-168.
-184.
-200.
-216.
-233.
-250.
-250.
-268.
-286.
-305.

-346.
-324.
-303.
-282.
-282.
-261.
-241.
-221.
-202.
-183.
-165.
-147.
-129.
-112.
-96.
=79.
-64.
-56.
-49.
-41.
-34.
-26.
-19.
-13.

-0.

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

122.23
124.65
126.71
128.39
129.69
130.63
131.19
131.37
131.19
130.63
129.69
128.39
126.71
124.65
122.23
119.43
116.25
112.71
108.79
104.49
99.83
94.79
89.37
83.59
77.43
70.90
63.99
56.71
49.06
41.40
33.84
25.90
17.60
8.92
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
3.47
15.61
27.37
38.76
49.78
60.42
70.69
80.59
90.11
99.26

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
-0.03
-0.86
-1.69
-2.53
-3.36
-4.85
-6.35
-7.84
-9.33
-10.83
-12.32
-13.81
-15.31
-16.80
-18.29
-19.79
-21.28
=22.77
-24.27
-25.76
-27.41
-29.13
-30.84
-32.55
-34.26
-35.98
-37.69
-39.40
-41.12
-42.83
-44.54
-46.26
-47.97
-49.68
-51.40
-53.11
-54.82
-56.54
-58.25
-59.96
-61.68
-63.39
-65.10
-66.82
-68.53
-70.24
-70.24
-71.96
-73.67
-75.38

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

13.81
12.32
10.83
9.33
7.84
6.35
4.85
3.36
2.53
1.69
0.86
0.03
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

88.16
86.45
84.73
83.02
83.02
81.31
79.60
77.88
76.17
74.46
72.74
71.03
69.32
67.60
65.89
64.18
62.46
60.75
59.04
57.32
55.61
53.90
52.18
50.47
48.76
47.04
45.33
43.62

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
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6.750 0.00 Ul 108.04 Ul 0.00 Ul 41.90 U1
7.000 0.00 UL 116.44 Ul 0.00 U1 40.19 Ul
7.250 0.00 Ul 124.47 Ul 0.00 U1 38.48 Ul
7.500 0.00 Ul 132.13 Ul 0.00 Ul 36.76 Ul
7.750 0.00 U1 139.41 Ul 0.00 U1 35.05 Ul
8.000 0.00 Ul 146.32 Ul 0.00 Ul 33.34 U1
8.250 0.00 UL 152.86 Ul 0.00 U1 31.62 Ul
8.500 0.00 U1 159.02 Ul 0.00 U1 29.91 Ul
8.750 0.00 Ul 164.82 Ul 0.00 Ul 28.20 Ul
9.000 0.00 UL 170.23 Ul 0.00 U1 26.48 Ul
9.250 0.00 Ul 175.97 Ul 0.00 Ul 24.77 U1
9.500 0.00 UL 181.95 Ul 0.00 Ul 23.06 Ul
9.750 0.00 U1 187.50 Ul 0.00 U1 21.34 U1
10.000 0.00 Ul 192.63 Ul 0.00 Ul 19.63 Ul
10.250 0.00 Ul 197.32 Ul 0.00 Ul 17.92 Ul
10.500 0.00 Ul 201.58 Ul 0.00 U1 16.20 U1
10.750 0.00 UL 205.42 Ul 0.00 Ul 14.49 Ul
11.000 0.00 U1 208.83 Ul 0.00 U1 12.78 Ul
11.250 0.00 Ul 211.81 Ul 0.00 Ul 11.07 Ul
11.500 0.00 U1 214.36 Ul 0.00 Ul 9.35 U1
11.750 0.00 Ul 216.49 U1 0.00 U1 7.64 UL
12.000 0.00 Ul 218.18 Ul 0.00 Ul 5.93 Ul
12.250 0.00 Ul 219.45 Ul 0.00 Ul 4.21 Ul
12.500 0.00 Ul 220.29 Ul 0.00 Ul 3.38 Ul
12.750 0.00 Ul 220.70 Ul -1.48 Ul 2.54 Ul
13.000 0.00 Ul 220.68 Ul -2.97 U1 1.71 U1
13.250 0.00 Ul 220.23 Ul -4.46 Ul 0.88 Ul
13.500 0.00 UL 219.36 Ul -5.96 Ul 0.04 Ul
13.750 0.00 Ul 218.06 Ul -7.45 U1 0.00 Ul
14.000 0.00 Ul 216.33 Ul -8.94 Ul 0.00 Ul
14.250 0.00 U1 214.17 Ul -10.44 U1 0.00 U1
14.500 0.00 Ul 211.58 Ul -11.93 Ul 0.00 Ul
14.750 0.00 UL 208.56 Ul -13.42 Ul 0.00 Ul
15.000 0.00 Ul 205.12 Ul -14.92 U1 0.00 Ul
15.250 0.00 Ul 201.25 Ul -16.41 Ul 0.00 Ul
15.500 0.00 U1 196.95 UL -18.06 Ul 0.00 Ul
15.750 0.00 Ul 192.22 Ul -19.77 Ul 0.00 Ul
16.000 0.00 UL 187.06 UL -21.49 Ul 0.00 Ul
16.250 0.00 Ul 181.47 Ul -23.20 Ul 0.00 Ul
16.500 0.00 Ul 175.46 Ul -24.91 Ul 0.00 Ul
16.750 0.00 U1 169.02 Ul -26.63 Ul 0.00 Ul
17.000 0.00 Ul 162.15 Ul -28.34 Ul 0.00 Ul
17.250 0.00 Ul 154.85 Ul -30.05 Ul 0.00 Ul
17.500 0.00 Ul 147.12 Ul -31.77 Ul 0.00 Ul
17.750 0.00 Ul 138.96 Ul -33.48 Ul 0.00 Ul
18.000 0.00 U1 130.38 Ul -35.19 Ul 0.00 Ul
18.250 0.00 Ul 121.37 Ul -36.91 Ul 0.00 Ul
18.500 0.00 U1 111.93 Ul -38.62 Ul 0.00 Ul
18.750 0.00 Ul 102.06 U1 -40.33 U1 0.00 U1
19.000 0.00 Ul 91.76 U1 -42.05 Ul 0.00 Ul
19.250 0.00 Ul 81.04 Ul -43.76 Ul 0.00 Ul
19.500 0.00 Ul 69.88 UL -45.47 Ul 0.00 Ul
19.750 0.00 Ul 58.30 Ul -47.19 Ul 0.00 Ul
20.000 0.00 Ul 46.29 U1 -48.90 Ul 0.00 U1
20.250 0.00 Ul 33.85 U1 -50.61 Ul 0.00 Ul
20.500 0.00 UL 20.98 Ul -52.33 Ul 0.00 Ul
20.750 0.00 Ul 7.69 UL -54.04 Ul 0.00 Ul
21.000 -8.76 Ul 0.56 UL -55.75 U1 0.00 Ul
21.250 -21.63 Ul 0.00 U1 -57.46 Ul 0.00 U1
21.250 -21.63 Ul 0.00 Ul -57.46 Ul 0.00 Ul
21.500 -34.88 Ul 0.00 U1 -59.18 Ul 0.00 Ul
21.750 -49.78 Ul 0.00 Ul -60.89 Ul 0.00 Ul
22.000 -65.21 Ul 0.00 Ul -62.60 Ul 0.00 Ul
[7] SEGMENTAL DEFLECTIONS
Units: x (ft), D (in)
Span x Ddead Dlive Dtotal
1 0.000 0.000 0.000 0.000
0.250 0.005 0.008 0.012
0.500 0.009 0.015 0.024
0.750 0.014 0.023 0.037
0.750 0.014 0.023 0.037
1.000 0.018 0.031 0.049
1.250 0.023 0.039 0.062
1.500 0.027 0.047 0.075
1.750 0.032 0.055 0.087
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119
120
119
119
119
118
117
116
115
114
112
111
109
107
105
102
100
097
095
092
089
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083
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076
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069
066
062
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052
048
044
041
037
034
031
027
024
021
018
015
013
010
008
006
004
004
002
001
000
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0.072
0.080
0.088
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0.104
0.112
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0.134
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0.155
0.161
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0.179
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0.194
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0.209
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0.220
0.218
0.217
0.215
0.212
0.210
0.206
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0.186
0.181
0.176
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0.165
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0.153
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0.140
0.133
0.127
0.120
0.113
0.106
0.099
0.092
0.085
0.078
0.072
0.065
0.059
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0.046
0.040
0.035
0.029
0.025
0.020
0.016
0.012
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0.006
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0.003
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0.000

OO 0000000000000 0000000000000000000000000000000000000000000000000000000000000000000
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.220
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.306
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.326
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.333
.336
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.340
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.328
.323
.319
.314
.308
.302
.295
.288
.281
.273
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.257
.248
.239
.229
.219
.209
.199
.189
.179
.168
.158
.147
.137
.126

116
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.096
.086
L077
.068
.059
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.043
.035
.028
.022
.017
.012
.008
.008
.005
.002
.000

Examples

6-111



slab|pcfBeam

000
250
500
750
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750

0000000000000 00000000000000000000000000000000000000000000000000000 0O

.000
-0.
-0.
-0.
-0.
-0.
-0.
-0.
.002
-0.
-0.
-0.
.000

001
002
002
002
002
002
002

002
001
000

001
002
003
005
006
007
0os8
010
011
012
014
015
017
018
019
021
022
023
024
025
026
027
028
029
030
030
031
031
032
032
032
032
033
032
032
032
032
031
031
030
030
029
028
027
026
025
024
023
022
021
019
018
017
015
014
012
011
010
008
007
006
005
003
002
001
000
000

.001

PLr
OCO0O0O00O0O0O0OO0O0O0O0 O

0O 0000000000000 000000000000000000000000000000000000000000000000O0

[
cooo

.000
.001
.002
.003
.003
.003
.003
.004
.003
.003
.002
.002
.001
.000
.001
.003
.004
.005
.007
.008
.010
.011
.013
.015
.016
.018
.019
.021
.023
.024
.025
.027
.028
.029
.031
.032
.033
.034
.034
.035
.036
.036
.036
.037
.037
.037
.037
.037
.036
.036
.036
.035
.034
.034
.033
.032
.031
.029
.028
.027
.025
.024
.023
.021
.019
.018
.016
.015
.013
.011
.010
.008
.007
.005
.004
.003
.001
.000
.001
.002
.002

A A
CO0OO00O0O00O0O0O0OO0 O

0O 0000000000000 0000000000000000000000000000000000000000000000000

[
cooo

.000
.002
.004
.005
.005
.006
.006
.006
.005
.005
.004
.002
.000
.001
.004
.006
.008
.011
.014
.017
.020
.022
.025
.028
.031
.034
.037
.040
.043
.046
.048
.051
.053
.056
.058
.060
.062
.063
.065
.066
.067
.068
.069
.069
.069
.069
.069
.069
.069
.068
.067
.066
.065
.063
.062
.060
.058
.056
.053
.051
.048
.046
.043
.040
.037
.034
.031
.028
.025
.022
.020
.017
.014
.011
.008
.006
.004
.001
.000
.002
.004

6-112

Examples



p Igﬁb | pcﬁﬁm

.000
.250
.500
.750
.000
.250
.250
.500
.750
.000

000
250
500
750
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250

-0.
.002
-0.
-0.
-0.
-0.
-0.
-0.
-0.
.000

0000000000000 000000000000000000000000000000000000000000000000000000000O

002

002
002
002
002
002
002
001

.000

001
002
004
004
006
008
010
013
015
018
021
024
027
031
034
037
041
044
048
052
055
059
062
066
069
073
076
079
083
086
089
092
095
097
100
102
105
107
109
111
112
114
115
116
117
118
119
119
119
120
119
119
119
118
117
1l6
115
113
111
110
108
105
103
101
098
095
092
089

.085
.082

-0.
.003
-0.
-0.
-0.
-0.
-0.
-0.
-0.
.000

o

00 0000000000000 0000000000000000000000000000000000000000000000000000000O0

003

004
003
003
003
003
002
001

.000
.001
.003
.004
.004
.006
.009
.012
.016
.020
.025
.029
.035
.040
.046
.052
.059
.065
.072
.078
.085
.092
.099
.106
.113
.120
.127
.133
.140
.146
.153
.159
.165
.170
.176
.181
.186
.191
.195
.199
.203
.206
.210
.212
.215
.217
.218
.220
.221
.221
.221
.221
.221
.220
.218
.217
.214
.212
.209
.206
.202
.198
.194
.189
.184
.179
L1173
.168
.161
.155
.148

-0.
.005
-0.
-0.
-0.
-0.
-0.
-0.
-0.
.000

o

OO0 0000000000000 00000000000000000000000000000000000000000000000000000 00O

005

006
006
006
005
005
004
002

.000
.002
.005
.008
.008
.012
.017
.022
.028
.035
.043
.050
.059
.068
.077
.086
.096
.106
.116
.126
.137
.147
.158
.168
L179
.189
.199
.209
.219
.229
.239
.248
.257
.265
.273
.281
.288
.295
.302
.308
.314
.319
.323
.328
.331
.334
.337
.339
.340
.341
.341
.341
.340
.338
.336
.333
.330
.326
.322
.317
.312
.306
.299
.292
.285
.277
.268
.259
.250
.240
.230

Examples

6-113



slab|pcfBeam

.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.250
.500
.750
.000

C0OO000000000000O0O0O0OOO

078
075
071
067
063
059
054
050
046
041
037
032
027
023
018
014
014
009
005
000

OO0 0000000000000O000O0

.141
.134
.127
.119
.112
.104
.096
.088
.080
.072
.064
.055
.047
.039
.031
.023
.023
.015
.008
.000

C0O0O0000000000O0O0O0O0OOO0

.220
.209
.198
.186
174
.162
.150
.138
.125
.113
.100
.087
.075
.062
.049
.037
.037
.024
.012
.000

6-114

Examples



slab|pcfBeam

Graphical Output
Loads

100 100 100
CASE: Live
20 20 20
[ [ [ [ [ [ [ I [ [ [ |
I I I
CASE: Dead
106 .25 106 .25 106 25
CASE: SELF
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Internal Forces
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Moment Capacity

3500
£ ! ! 1
= 1 i i i
2 4 1 : ‘
3 | i
2 1 :
5 N i
| * 1 ‘
= ] —  —
5 ! % ;
2 1 i | :
32 10 i
s 4 ! ! !
| | | :

3500

-3500
= T I | |
A | | |
% J1 4 T I
g9 i ; ;
3 ! ! ! !
g ! i i
= 4 | }
S
3 1 : : LEGEND
=y q ——Envelope Curve
3 ] ! ! ——Capacity Curve
£ 1 i i | — - —Support Centerline
5 T 1 i . ——Face of Support
b= J! | | |
3 ik ; ! !

350.0

pcaSlab w2 .00. Licensed to: peaStructurePoint. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files'PCA\pcaSlapExamples\iManualExample 4 - Design of Concrete Structures by Nilson Example 13 3 slb
Project pcaSlab/pcaBeam Manual, Example 4

Frame: Design of Concrete Structures by Nilson, Danain, and Dolan, 2004, Exarnple 1Ehgineer peaStructurePoint

Examples 6-117



slab|pcfBeam
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Deflection
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Reinforcement
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Example 5 Two-way slab system sfab

Problem description
Using the Equivalent Frame Method, determine design moments for the slab
system in the direction shown, for an intermediate floor. This example refers to
Example 20-2 from PCA Notes on ACI 318-05 Building Code Requirements for
Structural Concrete, Portland Cement Association, 2005.

! | 176
! !
R 0t "
! l 176" w E
I I i
= == | S
! l 176
I I
= _1?.’__ \kl ,_._IT.77
#——design strip——»
I 22'-0 ;— 22'-0 i
Story height = 12 ft
Edge beam dimensions = 14 x 27 in.
Interior beam dimensions = 14 x 20 in.
Column dimensions = 18 x 18 in.
Service live load = 100 psf
Dead load = self weight
f. = 4000 psi (for all members), normal weight concrete
fy = 60,000 psi
Preparing Input

1.  From the Input menu, select General Information. A dialog box appears.

e In the LABELS section, input the names of the project, frame, and
engineer.

e In the FRAME section, input 4 for NO OF SUPPORTS.
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e Inthe FLOOR SYSTEM section, click the radial button next to TWO-WAY.

e Leave all other options in the General Information tab to their default
settings of ACI 318-05 design code, ASTM A615 reinforcement, and
DESIGN run mode option.

General Information &‘
GeneralInformation | Salve Optians | Span Centrol |

Labels

PFroject.

Frame:  [PCA Nates on AC| 318-05, Example 20-2

Engineer: ‘pcaStructureFomt

Options Run mode

Design code: ACI 318-05 - * Design
Reinforcement  |ASTMAE1S =] | Investigation

Frame Floar System
Mo. of Supports: 4 * Twoway

™ Leftcantilever [ Fight cantilever | ¢ OneWay/Beam

[ Distance location as ratio of span

i3 Cancel | b |

2. Nothing needs to be changed in the Material Properties menu.

Material Properties E‘
Canerete I Reinforcing Steel]
Slabs and
Beams Columins
Unit dersity: 150 150 Ib/ft3
Comp. strength; 4 4 kesi
‘Young's modulus: |3834.3 2834.3 ksi
Fupture modulus:  |0.47434 047434 ki
Copy »

0K Cocel | Hep |

3. From the Input menu, select Spans. A dialog box appears.

e  Under the Slabs/Flanges tab, input 17 .5 for LENGTH, 6 for THICKNESS,
and 11 for WIDTH LEFT and WIDTH RIGHT. Press MODIFY.

e  Press COPY. Press the CHECK ALL button. Press OK.
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e Select the Longitudinal Beams tab. Input 14 for WIDTH and 20 for
DEPTH. Press MODIFY.

e  Press CoPY. Press the CHECK ALL button. Press OK.

e Press OK again.

Span Data b_?

Slabs/Flanges | Longitudinal Beams | Fibs |

Span I -~ Length 175 Width Left. |11 ft

Location: | Interior - Thickness: |6 in “idth Right. |11 it

Span No. ‘ Location | Length Thickness “width-L “‘width-F
1 Interior 175 B i 1
2 Inkerior 176 B il 1
3 Inkerior 17h E n 1

i3 Concel | Hep |

Span Data g

Slabs/Flanges Lung\ludmalBeamSIF\ibs |

Span - Width 14 in
20

Depth:

Span No | wiidth Depth
1 14 20
2 14 20
3 14 20
ok | cencel | Hen |

4. From the Input menu, select Supports. A dialog box appears.

e  Under the Columns tab, input 12 for the HEIGHT in both the ABOVE and
BELOW rows.
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e Input 18 for both the Cl and €2 values in both the ABOVE and BELOW
rows. Press MODIFY.

e  Press CoPY. Press the CHECK ALL button. Press OK.

e Under the Transverse Beams tab, input 14 for WIDTH and 27 for
DEPTH. Press MODIFY.

e Press CoPY. Click the check box next to SUPPORT 4. Press OK.
e  Use the drop down arrow next to SUPPORT to select SUPPORT 2.
e Input 14 for WIDTH and 20 for DEPTH. Press MODIFY.

e Press CoPY. Click the check box next to SUPPORT 3 and unclick the check
box next to SUPPORT 1. Press OK.

e  Press OK again.

X

Support Data
Columns I Drop Panels] Column Capllals] Transverse Eeams} Baoundary Eondlllons}

Height [ft) ¢ [in) &2 [in)
Support -| | Above: 12 iE] 18
Stiffress share % 100 Below: 12 18 18

[ Check punching shear around colurmn

Sup Mo [ Siifs [ Hi [ clh |24 HE clE 28 Shear
1 100 12 18 18 12 18 18 Yes
2 100 12 18 18 12 18 18 Yes
3 100 12 18 18 12 18 18 Yes
4 100 12 18 18 12 18 18 Yes

1] Cancel Help
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Support Data

Columns | Diop Paneks | Column Capitals

Suppart | | width fin)

Depth fin)

Transverse Beams | Boundary Conditions |

14 Offsetfin] 0
27

Sup. Na | width Depth Dffset
1 14 7 [
2 14 a0 i
3 14 20 i
4 14 27 i
ok | cencel | Hep |

5. Nothing needs to be changed in the Reinforcement menu.

Reinforcement Criteria

Slabs and Fibs | Beams |
Tap bars Battam bars
Cover [in)
Clear: 15
Bar size
Min: | #5 - #5 hal
Maw [0 | [w =
Spacing [in]
bdin 1 1
Max |18 18
Reint. ratio [%)
Min: |0.14 0.14
tax |5 5
There is mare than 12 in of
concrete below top bars,
ok Cancel Help
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Reinforcement Criteria rg\
Slabs and Fibs  Beams |
Top bars Battom bars Stirmups
Caver [in] Side Caver [in]
Clear: [fs Cear: [15
Bar size Bar size:
i w5 <] [#5 -] M [#3 -
Maw w8~ [ws ~] Maw (45 =
Spacing [in] Spacing [in)
we T F | Me
Mae 8 [ | M B
Reint. ratio [%) Mumber of l2gs
i Jota are i 2+
M 5 || M [ =
Clear distance between i r There iz more than 12 in of
bar layers [in): conciete below top bars,
[ Cacel | Hep |

From the Input menu, select Load Cases. A dialog box appears.

e Since we are not considering lateral forces, click on WIND in the LABEL
column on the list in the bottom half of the LOAD CASES dialog box and
press the DELETE button.

e Click on EQ in the LABEL column and press the DELETE button. Press

OK.
Load Cases El
Label Type: |DEAD ~|
add | |
Label ‘ Tvpe
SELF DEAD
Dead DEAD
Live LIVE

0K Cancel | Help ‘

From the Input menu, select Load Combinations. A dialog box appears.

e Delete all the load combinations by clicking anywhere on the list in the
bottom half of the LOAD COMBINATIONS dialog box and pressing the
DELETE button. Repeat this procedure until all the load combinations are
gone.
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8. From the Input menu, select Span Loads. A dialog box appears.

Input 1.2 in the SELF field, 1. 2 in the DEAD field, and 1. 6 in the LIVE
field. Press ADD.

Press OK.

Load Combinations El

SELF Dead Live

I =2 [T I I

sad | Mogly | Delete |

Camb [ sELF | Dead Live
n 12 12 16

ok Cancel | Help ‘

In the top left corner of the SPAN LOADS dialog box, there is a section
called CURRENT CASE. Click on LIVE.

Input 100 for MAGNITUDE. Press ADD.

Press Cory. Press the CHECK ALL button. Press OK.

Press Ok

again.
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10.

11.

12.

13.

14.

15.

Span Loads

3

Current Case:
Dead

Span: |1 =| Copy Magnitude: 100
Type: |Area Load -

Span=1751t

Ib/ft2

Case Cony. | add | Modiy | Dele |

[ Type
1 freaload 100
2 freaload 100
3 freaload 100

Span Na.

[wia [Ls [wit [ o

o]

Help

cael |

From the Solve menu, select Execute. Press CLOSE.
From the Solve menu, select Results Report.

e  Use the scroll bars to scroll through the results file.

e Use the ARROW keys or the mouse wheel to browse through different
parts of the results quickly. Press the CLOSE button to close the RESULTS
REPORT dialog box and return to pcaBeam.

To view diagrams, select Loads, Internal Forces, Moment Capacity, Shear
Capacity, Deflection, or Reinforcement from the View menu. Right click in
any of these diagrams to get new copy, printing, or display options.

You may print the results file by selecting Print Results from the File menu.
To print any of the diagrams you selected to view, use the Print Preview
command found by right clicking in the diagram’s window. After viewing the
results, you may decide to investigate the input beams under the same loads
but with a modified reinforcement configuration.

From the Input menu, select General Information. In the General
Information dialog box change the RUN MODE option to INVESTIGATION. Do
not change any of the other options. Press OK

From the Input menu, select the different commands under Reinforcement
Criteria and Reinforcing Bars to modify the reinforcement configuration
computed by the program.

Repeat steps 10 and subsequent to perform the investigation and view the
results.
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Text Output (abbreviated)

0000000 000000 00000
00000000 00000000 0000000
oo oo oo oo oo oo
oo oo oo oo 0o
00000000 oo 0000000 00000
0000000 oo oo 0000000 00000
oo oo oo oo 0o
oo 00000000 oo oo
oo 000000 oo 0o
000000 o o
00000000 oo 00000 oo
oo oo o oo oo
0000 oo o oo oo
000000 oo 000000 000000
0000 oo oo 00 oo 0o
oo oo oo oo oo oo
00000000 oo o oo oo oo oo
000000 ooo 00000 0 00000

pcaSlab v2.00 (TM)
A Computer Program for Analysis, Design, and Investigation of
Reinforced Concrete Beams, One-way and Two-way Slab Systems

Copyright © 2003-2006, Portland Cement Association
All rights reserved

Licensee stated above acknowledges that Portland Cement Association
(PCR) is not and cannot be responsible for either the accuracy or
adequacy of the material supplied as input for processing by the
pcaSlab computer program. Furthermore, PCA neither makes any warranty
expressed nor implied with respect to the correctness of the output
prepared by the pcaSlab program. Although PCA has endeavored to
produce pcaSlab error free the program is not and cannot be certified
infallible. The final and only responsibility for analysis, design and
engineering documents is the licensees. Accordingly, PCA disclaims all
responsibility in contract, negligence or other tort for any analysis,
design or engineering documents prepared in connection with the use of
the pcaSlab program.

[1] INPUT ECHO

General Information:

File name Program Files\PCA\pcaSlab\Examples\Manual\Example 5 - PCA Notes on ACI 318-05 Example 20-2.slb
Project: pcaSlab/pcaBeam Manual, Example 5

Frame: PCA Notes on ACI 318-05, Example 20-2

Engineer: pcaStructurePoint

Code: ACI 318-05

Reinforcement Database: ASTM A615

Mode: Design

Number of supports = 4

Floor System: Two-Way

Live load pattern ratio = 75%

Minimum free edge for punching shear = 10 times slab thickness

Deflections are based on cracked section properties.

In negative moment regions, Ig and Mcr DO NOT include flange/slab contribution (if available)
Long-term deflections are calculated for load duration of 60 months.

0% of live load is sustained.

Compression reinforcement calculations NOT selected.

Material Properties

Slabs|Beams Columns

we = 150 150 1b/ft3

f'c = 4 4 ksi

Ec = 3834.25 3834.25 ksi

fr = 0.474342 0.474342 ksi

fy = 60 ksi, Bars are not epoxy-coated
fyt = 60 ksi
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Es = 29000 ksi

Reinforcement Database:

Db (in), Ab (in"2), Wb (lb/ft)

Size Db Ab Wb Size Db 2b Wb
#3 0.38 0.11 0.38 #4 0.50 0.20 0.67
#5 0.63 0.31 1.04 #6 0.75 0.44 1.50
#7 0.88 0.60 2.04 #8 1.00 0.79 2.67
#9 1.13 1.00 3.40 #10 1.27 1.27 4.30
#11 1.41 1.56 5.31 #14 1.69 2.25 7.65
#18 2.26 4.00 13.60
Span Data:

wR (ft); t, Hmin (in)
L1l t

wL wR Hmin
.500 6.00 11.000 11.000 4.44
.500 6.00 11.000 11.000 4.44
.500 6.00 11.000 11.000 4.44

Ribs and Longitudinal Beams: b, h, Sp (in)

Ribs Beams
Span b h Sp
1 0.00 0.00 0.00 14.00 20.00
2 0.00 0.00 0.00 14.00 20.00
3 0.00 0.00 0.00 14.00 20.00

Columns: cla, c2a, clb, c2b (in); Ha, Hb (ft)

Supp cla c2a Ha clb c2b Hb Red$%
1 18.00 18.00 12.000 18.00 18.00 12.000 100
2 18.00 18.00 12.000 18.00 18.00 12.000 100
3 18.00 18.00 12.000 18.00 18.00 12.000 100
4 18.00 18.00 12.000 18.00 18.00 12.000 100
Transverse Beams: b, h, Ecc (in)
b h Ecc
14.00 27.00 0.00
14.00 20.00 0.00
14.00 20.00 0.00
14.00 27.00 0.00

Boundary Conditions: Kz (kip/in); Kry (kip-in/rad)

Supp Spring Kz  Spring Kry Far End A Far End B
1 0 0 Fixed Fixed
2 0 0 Fixed Fixed
3 0 0 Fixed Fixed
4 0 0 Fixed Fixed
Load Data

Load Cases and Combinations:

Case SELF Dead Live
Type DEAD DEAD LIVE
Ul 1.200 1.200 1.600

Span Loads:
Span Case Wa

Area Loads - Wa (lb/ft2):

1 Live 100
2 Live 100
3 Live 100

Support Loads - Fz (kip), My (k-ft):

Supp Case Fz My
1 SELF 0 0
2 SELF 0 0
3 SELF 0 0
4 SELF 0 0
1 Dead 0 0
2 Dead 0 0
3 Dead 0 0
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4 Dead 0 0
1 Live 0 0
2 Live 0 0
3 Live 0 0
4 Live 0 0

Support Displacements - D (in), R (rad):

Supp Case D R
1 SELF 0 0
2 SELF 0 0
3 SELF 0 0
4 SELF 0 0
1 Dead 0 0
2 Dead 0 0
3 Dead 0 0
4 Dead 0 0
1 Live 0 0
2 Live 0 0
3 Live 0 0
4 Live 0 0

Reinforcement Criteria:

Top bars___ __ Bottom bars__ Stirrups
Min Max Min Max Min Max

Slabs and Ribs:

Bar Size #5 #8 #5 #8

Bar spacing 1.00 18.00 1.00 18.00 in

Reinf ratio 0.14 5.00 0.14 5.00 %

Cover 1.50 1.50 in
Beams:

Bar Size #5 #8 #5 #8 #3 #5

Bar spacing 1.00 18.00 1.00 18.00 6.00 18.00 in

Reinf ratio 0.14 5.00 0.14 5.00 %

Cover 1.50 1.50 in

Side cover 1.50 1.50 in

Layer dist. 1.00 1.00 in

No. of legs 2 6

[2] DESIGN RESULTS*

*Unless otherwise noted, all results are in the direction of analysis only. Another analysis
in the perpendicular direction has to be carried out for two-way slab systems.

Top Reinforcement

Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in"2), Sp (in)

Span Strip Zone width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 Column Left 7.58 6.17 0.750 0.983 6.883 11.375 0.330 8-#5 *5
Middle 7.58 0.00 8.750 0.000 6.883 0.000 0.000 -
Right 7.58 14.30 16.750 0.983 6.883 11.375 0.773 8-#5 *5
Middle Left 13.25 19.20 0.750 1.717 12.026 11.357 1.033 14-45 *5
Middle 13.25 0.00 8.750 0.000 12.026 0.000 0.000 ==
Right 13.25 46.35 16.750 1.717 12.026 11.357 2.546 14-4#5 =5
Beam Left 1.17 34.97 0.750 0.577 4.599 8.722 0.434 2-#5
Middle 1.17 0.00 8.750 0.000 4.599 0.000 0.000 -
Right 1.17 81.03 16.750 0.849 4.599 2.907 1.027 4-#5
2 Column Left 7.58 12.93 0.750 0.983 6.883 11.375 0.698 8-#5 *5
Middle 7.58 0.17 6.350 0.983 6.883 11.375 0.009 8-#5 *5
Right 7.58 12.93 16.750 0.983 6.883 11.375 0.698 8-#5 *5
Middle Left 13.25 41.92 0.750 1.717 12.026 11.357 2.294 14-#5 *5
Middle 13.25 0.54 6.350 1.717 12.026 11.357 0.029 14-45 *5
Right 13.25 41.92 16.750 1.717 12.026 11.357 2.294 14-#5 *5
Beam Left 1.17 73.28 0.750 0.849 4.599 2.907 0.925 4-#5
Middle 1.17 0.94 6.350 0.356 4.599 8.722 0.012 2-#5
Right 1.17 73.28 16.750 0.849 4.599 2.907 0.925 4-#5
3 Column Left 7.58 14.30 0.750 0.983 6.883 11.375 0.773 8-#5 *5
Middle 7.58 0.00 8.750 0.000 6.883 0.000 0.000 ==
Right 7.58 6.17 16.750 0.983 6.883 11.375 0.330 8-#5 *5
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Middle Left 13.25 46.35 0.750 1.717 12.026 11.357 2.546 14-#5 *5
Middle 13.25 0.00 8.750 0.000 12.026 0.000 0.000 -—=
Right 13.25 19.20 16.750 1.717 12.026 11.357 1.033 14-45 *5
Beam  Left 1.17 81.03 0.750 0.849 4.599 2.907 1.027 4-#5
Middle 1.17 0.00 8.750 0.000 4.599 0.000 0.000 ==
Right 1.17 34.97 16.750 0.577 4.599 8.722 0.434 2-#5
NOTES:

*5 - Number of bars governed by maximum allowable spacing.

Top Bar Detail

Units: Length (ft)

Left Continuous_ Right
Span Strip Bars Length Bars Length Bars Length Bars Length Bars Length
1 Column 4-#5 3.75 4-#5 1.75 4-#5 6.75 4-#5 1.75
Middle 14-#5 3.75 - 14-#5 6.75 -
Beam 2-#5 4.27 == == 3-#5 7.27 1-#5 2.52
2 Column - 8-#5 17.50 -
Middle == 14-#5 17.50 -
Beam 3.22 1-#5 2.27 2-#5 17.50 1-#5 3.22 2.27
3 Column 4-#5 6.75 4-#5 1.75 4-#5 3.75 1.75
Middle 14-45 6.75 - 14-45 3.75
Beam 3-#5 7.27 1-#5 2.52 2-#5 4.27
Bottom Reinforcement
Units: Width (ft), Mmax (k-ft), Xmax (ft), As (in”2), Sp (in)
Span Strip Width Mmax Xmax AsMin AsMax SpReq AsReq Bars
1 Column 7.58 8.58 7.750 0.983 6.883 11.375 0.460 8-#5 *5
Middle 13.25 27.82 7.750 1.717 12.026 11.357 1.506 14-#5 *5
Beam 1.17 48.64 7.750 0.807 4.599 4.361 0.607 3-#5
2 Column 7.58 6.45 8.750 0.983 6.883 11.375 0.345 8-#5 *5
Middle 13.25 20.91 8.750 1.717 12.026 11.357 1.127 14-#5 *5
Beam 1.17 36.56 8.750 0.604 4.599 8.722 0.454 2-#5
3 Column 7.58 8.58 9.750 0.983 6.883 11.375 0.460 8-#5 *5
Middle 13.25 27.82 9.750 1.717 12.026 11.357 1.506 14-#5 *5
Beam 1.17 48.64 9.750 0.807 4.599 4.361 0.607 3-#5
NOTES:

*5 - Number of bars governed by maximum allowable spacing.

Bottom Bar Details:

Units: Start (ft), Length (ft)

Long Bars Short Bars
Span Strip Bars Start Length Bars Start Length
1 Column 8-#5 0.00 17.50 -—=
Middle T-#5 0.00 17.50 T-#5 2.63 12.25
Beam 3-#5 0.00 17.50 -—=
2 Column 8-#5 0.00 17.50 -
Middle T-#5 0.00 17.50 T-#5 2.63 12.25
Beam 2-45 0.00 17.50 -
3 Column 8-#5 0.00 17.50 -
Middle T-#5 0.00 17.50 T-#5 2.63 12.25
Beam 3-#5 0.00 17.50 -—=

Flexural Capacity:

Units: x (ft), As (in"2), PhiMn (k-ft)

Span Strip x AsTop AsBot PhiMn- PhiMn+
1 Column 0.000 2.48 2.48 -44.05 44.05
0.750 2.48 2.48 -44.05 44.05

0.751 2.48 2.48 -44.05 44.05

1.751 1.24 2.48 -22.70 44.05

2.750 1.24 2.48 -22.70 44.05

3.750 0.00 2.48 0.00 44.05

6.350 0.00 2.48 0.00 44.05

8.750 0.00 2.48 0.00 44.05

10.750 0.00 2.48 0.00 44.05

11.150 0.50 2.48 -9.24 44.05

11.750 1.24 2.48 -22.70 44.05

15.749 1.24 2.48 -22.70 44.05
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16.749 2.48 2.48 -44.05 44.05
16.750 2.48 2.48 -44.05 44.05
17.500 2.48 2.48 -44.05 44.05
Middle 0.000 4.34 2.17 -77.08 39.72
0.750 4.34 2.17 -177.08 39.72
2.625 4.34 2.17 -77.08 39.72
2.750 4.34 2.44 -77.08 44.51
3.625 0.54 4.34 -10.14 77.08
3.750 0.00 4.34 0.00 77.08
6.350 0.00 4.34 0.00 77.08
8.750 0.00 4.34 0.00 77.08
10.750 0.00 4.34 0.00 77.08
11.150 1.74 4.34 -31.95 77.08
11.750 4.34 4.34 -77.08 77.08
13.875 4.34 4.34 -177.08 77.08
14.875 4.34 2.17 =77.08 39.72
16.750 4.34 2.17 -177.08 39.72
17.500 4.34 2.17 -177.08 39.72
Beam 0.000 0.62 0.93 -49.65 73.66
0.750 0.62 0.93 -49.65 73.66
3.266 0.62 0.93 -49.65 73.66
4.266 0.00 0.93 0.00 73.66
6.350 0.00 0.93 0.00 73.66
8.750 0.00 0.93 0.00 73.66
10.234 0.00 0.93 0.00 73.66
11.150 0.81 0.93 -64.20 73.66
11.290 0.93 0.93 -73.66 73.66
14.978 0.93 0.93 -73.66 73.66
16.033 1.24 0.93 -97.13 73.66
16.750 1.24 0.93 -97.13 73.66
17.500 1.24 0.93 -97.13 73.66
2 Column 0.000 2.48 2.48 -44.05 44.05
0.750 2.48 2.48 -44.05 44.05
6.350 2.48 2.48 -44.05 44.05
8.750 2.48 2.48 -44.05 44.05
11.150 2.48 2.48 -44.05 44.05
16.750 2.48 2.48 -44.05 44.05
17.500 2.48 2.48 -44.05 44.05
Middle 0.000 4.34 2.17 -77.08 39.72
0.750 4.34 2.17 -177.08 39.72
2.625 4.34 2.17 -77.08 39.72
3.625 4.34 4.34 -177.08 77.08
6.350 4.34 4.34 -77.08 77.08
8.750 4.34 4.34 -77.08 77.08
11.150 4.34 4.34 -77.08 77.08
13.875 4.34 4.34 -77.08 77.08
14.875 4.34 2.17 -77.08 39.72
16.750 4.34 2.17 =77.08 39.72
17.500 4.34 2.17 =77.08 39.72
Beam 0.000 1.24 0.62 -97.13 49.65
0.750 1.24 0.62 -97.13 49.65
1.266 1.24 0.62 -97.13 49.65
2.222 0.94 0.62 -74.69 49.65
2.266 0.92 0.62 -72.63 49.65
3.222 0.62 0.62 -49.65 49.65
6.350 0.62 0.62 -49.65 49.65
8.750 0.62 0.62 -49.65 49.65
11.150 0.62 0.62 -49.65 49.65
14.278 0.62 0.62 -49.65 49.65
15.234 0.92 0.62 -72.63 49.65
15.278 0.94 0.62 -74.69 49.65
16.234 1.24 0.62 -97.13 49.65
16.750 1.24 0.62 -97.13 49.65
17.500 1.24 0.62 -97.13 49.65
3 Column 0.000 2.48 2.48 -44.05 44.05
0.750 2.48 2.48 -44.05 44.05
0.751 2.48 2.48 -44.05 44.05
1.751 1.24 2.48 -22.70 44.05
5.750 1.24 2.48 -22.70 44.05
6.350 0.50 2.48 -9.24 44.05
6.750 0.00 2.48 0.00 44.05
8.750 0.00 2.48 0.00 44.05
11.150 0.00 2.48 0.00 44.05
13.750 0.00 2.48 0.00 44.05
14.750 1.24 2.48 -22.70 44.05
15.749 1.24 2.48 =-22.70 44.05
16.749 2.48 2.48 -44.05 44.05
16.750 2.48 2.48 -44.05 44.05
17.500 2.48 2.48 -44.05 44.05
Middle 0.000 4.34 2.17 -77.08 39.72
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0.750 4.34 2.17 =-77.08 39.72
2.625 4.34 2.17 =77.08 39.72
3.625 4.34 4.34 =-77.08 77.08
5.750 4.34 4.34 -77.08 77.08
6.350 1.74 4.34 -31.95 77.08
6.750 0.00 4.34 0.00 77.08
8.750 0.00 4.34 0.00 77.08
11.150 0.00 4.34 0.00 77.08
13.750 0.00 4.34 0.00 77.08
13.875 0.54 4.34 -10.14 77.08
14.750 4.34 2.44 -77.08 44.51
14.875 4.34 2.17 -77.08 39.72
16.750 4.34 2.17 -77.08 39.72
17.500 4.34 2.17 -77.08 39.72
Beam 0.000 1.24 0.93 -97.13 73.66
0.750 1.24 0.93 -97.13 73.66
1.467 1.24 0.93 -97.13 73.66
2.522 0.93 0.93 -73.66 73.66
6.210 0.93 0.93 -73.66 73.66
6.350 0.81 0.93 -64.20 73.66
7.266 0.00 0.93 0.00 73.66
8.750 0.00 0.93 0.00 73.66
11.150 0.00 0.93 0.00 73.66
13.234 0.00 0.93 0.00 73.66
14.234 0.62 0.93 -49.65 73.66
16.750 0.62 0.93 -49.65 73.66
17.500 0.62 0.93 -49.65 73.66

Longitudinal Beam Shear Reinforcement Required:

Units: d (in), Start, End, Xu (ft), PhiVc, Vu (kip), Av/s (in”2/in)
Span d Phive Start End Vu Xu Av/s

1 18.19 24.16 2.266 4.118 32.17 2.266 0.0117
4.118 5.971 21.53 4.118 0.0117
5.971 7.824 11.25 5.971 0.0000
7.824 9.676 10.41 9.676 0.0000
9.676 11.529 21.05 11.529 0.0117
11.529 13.382 31.69 13.382 0.0117
13.382 15.234 42.34 15.234 0.0222
2 18.19 24.16 2.266 4.118 37.25 2.266 0.0160
4.118 5.971 26.61 4.118 0.0117
5.971 7.824 15.97 5.971 0.0117
7.824 9.676 6.79 7.824 0.0000
9.676 11.529 15.97 11.529 0.0117
11.529 13.382 26.61 13.382 0.0117
13.382 15.234 37.25 15.234 0.0160
3 18.19 24.16 2.266 4.118 42.34 2.266 0.0222
4.118 5.971 31.69 4.118 0.0117
5.971 7.824 21.05 5.971 0.0117
7.824 9.676 10.41 7.824 0.0000
9.676 11.529 11.25 11.529 0.0000
11.529 13.382 21.53 13.382 0.0117
13.382 15.234 32.17 15.234 0.0117

Longitudinal Beam Shear Reinforcement Details:

Units: spacing & distance (in).

Span Size Stirrups (2 legs each unless otherwise noted)
1 #38@ 8.5+ <-44.5 ——> + 5@ 8.9+ 6@ 7.5
2 #3111 @ 8.2 + <-- 22.2 --> + 11 @ 8.2
3 #35@ 7.5+ 6@ 8.9+ <—— 44.5 ——> + 8 @ 8.5

Beam Shear Capacit

Units: d, Sp (in), Start, End, Xu (ft), PhiVe, PhiVn, Vu (kip), Av/s (in”2/in)
Span d Phivc Start End Av/s Sp PhiVn Vu Xu
1 18.19 24.16 0.000 1.000  --mmm —mmee 45.29 49.01 0.000
1.000 5.971 0.0258 8.5 45.29 32.17 2.266
5.971 9.676  ----=  —---= 12.08 11.25 5.971
9.676 13.382 0.0247 8.9 44.40 31.69 13.382
13.382 16.500 0.0294 7.5 48.21 42.34 15.234
16.500 17.500  -=--=  ----- 48.21 57.90 17.500
2 18.19 24.16 0.000 1.000 46.15 52.82 0.000
1.000 7.824 . 46.15 37.25 2.266
7.824 9.676  ----=  —---- 12.08 6.79 7.824
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9.676 16.500 0.0269 8.2 46.15 37.25 15.234
16.500 17.500  -=--=  ---—- 46.15 52.82 17.500
3 18.19 24.16 0.000 1.000  ---——  —--—- 48.21 57.90 0.000
1.000 4.118 0.0294 7.5 48.21 42.34 2.266
4.118 7.824 0.0247 8.9 44.40 31.69 4.118
7.824 11.529 --—=—=  ————— 12.08 11.25 11.529
11.529 16.500 0.0258 8.5 45.29 32.17 15.234
16.500 17.500  ----=  -—-—- 45.29 49.01 17.500
Slab Shear Capacity:
Units: b, d (in), Xu (ft), Phive, Vu(kip)
Span b d  Vratio Phive vu Xu
1 250.00 4.19 0.000 99.32 0.00 16.40
2 250.00 4.19 0.000 99.32 0.00 1.10
3 250.00 4.19 0.000 99.32 0.00 1.10
Flexural Transfer of Negative Unbalanced Moment at Supports:
Units: Width (in), Munb (k-ft), As (in"2)
Supp Width GammaF*Munb Comb Pat AsReq AsProv Additional Bars
1 36.00 63.70 Ul aAll 4.641 0.981 12-45
2 36.00 28.33 Ul Odd 1.666 0.981 3-#5
3 36.00 28.30 Ul 0dd 1.664 0.981 3-#5
4 36.00 63.73 Ul aAll 4.645 0.981 12-#5
Punching Shear Around Columns:
Units: Vu (kip), Munb (k-ft), vu (psi), Phi*vc (psi)
Supp vu vu Munb Comb Pat GammaV vu  Phi*vc
1 48.53 72.9 65.57 Ul All 0.320 108.3 181.1
2 109.78 96.6 -17.39 Ul All 0.400 106.2 181.1
3 109.78 96.6 17.33 Ul All 0.400 106.2 181.1
4 48.53 72.9 -65.62 Ul All 0.320 108.4 181.1
Deflections:
Section properties
Units: Ig, Icr, Ie (in”4), Mcr, Mmax (k-ft) Load Level
Te,avg Dead_(d)___ Dead+Live_(d+1)__
Span Dead Dead+Live Zone Ig Tcr Mcr Mmax Te Mmax Ie
1 22896 22871 Middle 25395 2625 63.14 27.54 25395 60.04 25395
Right 9333 8548 36.89 -59.34 8736 -128.81 8566
2 20417 20348 Left 9333 8548 36.89 -53.65 8803 -116.51 8572
Middle 25395 1961 63.14 17.95 25395 39.30 25395
Right 9333 8548 36.89 -53.67 8803 -116.54 8572
3 22896 22871 Left 9333 8548 36.89 -59.31 8737 -128.78 8566
Middle 25395 2625 63.14 27.54 25395 60.04 25395
Maximum Instantaneous Deflections - Direction of Analysis
Units: D (in), Ig (in"4)
Frame Strips
Span Ddead Dlive Dtotal Strip Ig LDF Ratio Ddead Dlive Dtotal
1 0.011 0.013 0.024 Column 20040.5 0.675 0.855 0.010 0.011 0.021
Middle 2862 0.325 2.883 0.032 0.038 0.071
2 0.006 0.007 0.013 Column 20040.5 0.673 0.853 0.005 0.006 0.011
Middle 2862 0.327 2.903 0.017 0.020 0.036
3 0.011 0.013 0.024 Column 20040.5 0.675 0.855 0.010 0.011 0.021
Middle 2862 0.325 2.883 0.032 0.038 0.071
Maximum Long-term Deflections - Direction of Analysis
Time dependant factor for sustained loads = 2.000
Units: D (in)
Column Strip Middle Strip
Span Dsust Lambda Dcs Dcs+lu Dcs+1l Dtotal Dsust Lambda Dcs Dcs+lu Dcs+1l Dtotal
1 0.010 2.000 0.019 0.031 0.031 0.040 0.032 2.000 0.065 0.103 0.103 0.135
2 0.005 2.000 0.010 0.016 0.016 0.020 0.017 2.000 0.033 0.053 0.053 0.069
3 0.010 2.000 0.019 0.031 0.031 0.040 0.032 2.000 0.065 0.103 0.103 0.135

Material Takeof
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Reinforcement in the Direction

of Analysis

Top Bars: 941.5 17.93 1b/ft < 0.815 1b/ft"2
Bottom Bars: 1235.7 23.54 1b/ft < 1.070 1b/ft"2
Stirrups: 315.8 6.02 1b/ft <=> 0.273 1lb/ft"2
Total Steel: 2493.0 47.49 1b/ft <=> 2.158 1lb/ft"2
Concrete: 798.7 15.21 ft~3/ft <=> 0.691 ft"3/ft"2
[3] COLUMN AXIAL FORCES AND MOMENTS
Units: P (kip), M (k-ft)
Case/Patt Joint Far Ends
Supp Comb/Patt Plaxial] P[spring] Mb [top] Ma [bottom] M[spring] Mb [bottom] Ma[top]
1 SELF 17.75 0.00 -18.89 -11.70 0.00 9.33 9.33
Dead 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/All 17.32 0.00 -22.01 -13.63 0.00 10.87 10.87
Live/0dd 14.26 0.00 -20.15 -12.48 0.00 9.95 9.95
Live/Even -1.27 0.00 3.64 2.26 0.00 -1.80 -1.80
Live/S1 14.01 0.00 -19.43 -12.03 0.00 9.60 9.60
Live/S2 12.74 0.00 -15.79 -9.78 0.00 7.80 7.80
Live/S3 -1.02 0.00 2.92 1.81 0.00 -1.44 -1.44
Live/S4 0.25 0.00 -0.72 -0.45 0.00 0.36 0.36
Ul/All 27.71 0.00 -35.22 -21.81 0.00 17.40 17.40
Ul/0dd 22.82 0.00 -32.24 -19.97 0.00 15.93 15.93
Ul/Even -2.04 0.00 5.83 3.61 0.00 -2.88 -2.88
Ul/s1 22.41 0.00 -31.09 -19.26 0.00 15.36 15.36
uUl/s2 20.38 0.00 -25.26 -15.64 0.00 12.48 12.48
Ul/s3 -1.63 0.00 4.68 2.90 0.00 -2.31 -2.31
Ul/s4 0.40 0.00 -1.15 -0.71 0.00 0.57 0.57
2 SELF 38.36 0.00 3.27 2.39 0.00 -1.67 -1.67
Dead 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/All 40.43 0.00 3.81 2.79 0.00 -1.95 -1.95
Live/0dd 14.61 0.00 14.59 10.66 0.00 -7.46 -7.46
Live/Even 15.71 0.00 -11.73 -8.57 0.00 5.99 5.99
Live/S1 16.29 0.00 12.27 8.96 0.00 -6.27 -6.27
Live/S2 32.00 0.00 0.54 0.40 0.00 -0.28 -0.28
Live/S3 14.03 0.00 -9.41 -6.87 0.00 4.81 4.81
Live/S4 -1.68 0.00 2.32 1.69 0.00 -1.19 -1.19
Ul/All 64.69 0.00 6.10 4.46 0.00 -3.12 -3.12
Ul/0dd 23.38 0.00 23.35 17.05 0.00 -11.93 -11.93
Ul/Even 25.14 0.00 -18.77 -13.71 0.00 9.59 9.59
Ul/s1 26.07 0.00 19.63 14.34 0.00 -10.03 -10.03
Ul/s2 51.21 0.00 0.87 0.63 0.00 -0.44 -0.44
Ul/s3 22.45 0.00 -15.06 -11.00 0.00 7.69 7.69
Ul/s4 -2.69 0.00 3.71 2.71 0.00 -1.90 -1.90
3 SELF 38.36 0.00 -3.27 -2.39 0.00 1.67 1.67
Dead 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/All 40.43 0.00 -3.81 -2.79 0.00 1.95 1.95
Live/0dd 14.61 0.00 -14.59 -10.66 0.00 7.46 7.46
Live/Even 15.71 0.00 11.73 8.57 0.00 -5.99 -5.99
Live/S1 -1.68 0.00 -2.32 -1.69 0.00 1.19 1.19
Live/S2 14.03 0.00 9.41 6.87 0.00 -4.81 -4.81
Live/S3 32.00 0.00 -0.54 -0.40 0.00 0.28 0.28
Live/S4 16.29 0.00 -12.27 -8.96 0.00 6.27 6.27
Ul/All 64.69 0.00 -6.10 -4.46 0.00 3.12 3.12
Ul/0dd 23.38 0.00 -23.35 -17.05 0.00 11.93 11.93
Ul/Even 25.14 0.00 18.77 13.71 0.00 -9.59 -9.59
Ul/s1 -2.69 0.00 -3.71 -2.71 0.00 1.90 1.90
Ul/s2 22.45 0.00 15.06 11.00 0.00 -7.69 -7.69
Ul/s3 51.21 0.00 -0.87 -0.63 0.00 0.44 0.44
Ul/s4 26.07 0.00 -19.63 -14.34 0.00 10.03 10.03
4 SELF 17.75 0.00 18.89 11.70 0.00 -9.33 -9.33
Dead 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Live/All 17.32 0.00 22.01 13.63 0.00 -10.87 -10.87
Live/0dd 14.26 0.00 20.15 12.48 0.00 -9.95 -9.95
Live/Even -1.27 0.00 -3.64 -2.26 0.00 1.80 1.80
Live/S1 0.25 0.00 0.72 0.45 0.00 -0.36 -0.36
Live/S2 -1.02 0.00 -2.92 -1.81 0.00 1.44 1.44
Live/S3 12.74 0.00 15.79 9.78 0.00 -7.80 -7.80
Live/S4 14.01 0.00 19.43 12.03 0.00 -9.60 -9.60
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Ul/All 27.71 0.00 35.22 21.81 0.00 -17.
Ul/0dd 22.82 0.00 32.24 19.97 0.00 -15.
Ul/Even -2.04 0.00 -5.83 -3.61 0.00 2
Ul/s1 0.40 0.00 1.15 0.71 0.00 -0
Ul/s2 -1.63 0.00 -4.68 -2.90 0.00 2
Ul/s3 20.38 0.00 25.26 15.64 0.00 -12
Ul/s4 22.41 0.00 31.09 19.26 0.00 -15
Sum SELF 112.23 0.00 -0.00 -0.00 0.00
Dead 0.00 0.00 0.00 0.00 0.00
Live/All 115.50 0.00 -0.00 -0.00 0.00
Live/0dd 57.75 0.00 -0.00 -0.00 0.00
Live/Even 28.87 0.00 0.00 0.00 0.00 -
Live/S1 28.87 0.00 -8.76 -4.32 0.00
Live/S2 57.75 0.00 -8.76 -4.32 0.00
Live/S3 57.75 0.00 8.76 4.32 0.00 -4.
Live/S4 28.88 0.00 8.76 4.32 0.00 -4
Ul/All 184.80 0.00 -0.00 -0.00 0.00
Ul/0dd 92.40 0.00 -0.00 -0.00 0.00
Ul/Even 46.20 0.00 0.00 0.00 0.00 -0.
Ul/s1 46.20 0.00 -14.01 -6.91 0.00
Ul/s2 92.40 0.00 -14.01 -6.91 0.00
Ul/s3 92.40 0.00 14.01 6.91 0.00 -6.
Ul/s4 46.20 0.00 14.01 6.91 0.00 -6.
[6] SEGMENTAL MOMENT AND SHEAR - ENVELOPES
Span x (ft) M- (k-ft) Comb M+ (k-ft) Comb (kip) Comb V+ (kip) Comb
1 0.000 -93.73 Ul 0.00 Ul 0.00 Ul 49.01 U1
0.250 -81.86 Ul 0.00 Ul 0.00 Ul 45.94 Ul
0.500 -70.76 U1 0.00 U1 0.00 U1 42.86 Ul
0.750 -60.29 Ul 0.00 Ul 0.00 Ul 40.88 Ul
0.750 -60.34 Ul 0.00 Ul 0.00 U1 40.88 Ul
1.000 -50.30 Ul 0.00 Ul 0.00 U1 39.44 U1
1.250 -41.23 Ul 0.00 Ul 0.00 Ul 38.00 Ul
1.500 -32.83 Ul 0.00 U1 0.00 U1 36.57 Ul
1.750 -24.73 Ul 0.00 Ul 0.00 Ul 35.13 Ul
2.000 -16.94 Ul 0.29 UL 0.00 Ul 33.69 Ul
2.250 -9.45 U1 2.97 Ul 0.00 Ul 32.26 U1
2.500 -2.26 Ul 5.51 U1 0.00 Ul 30.82 Ul
2.750 0.00 U1 9.92 U1l 0.00 U1 29.39 U1
3.000 0.00 Ul 17.09 U1 0.00 Ul 27.95 U1
3.250 0.00 UL 23.90 Ul 0.00 U1 26.51 Ul
3.500 0.00 Ul 30.35 U1 0.00 U1 25.08 U1
3.750 0.00 Ul 36.44 Ul 0.00 Ul 23.64 UL
4.000 0.00 U1 42.17 Ul 0.00 Ul 22.20 Ul
4.250 0.00 Ul 47.54 U1 0.00 Ul 20.77 Ul
4.500 0.00 Ul 52.55 Ul 0.00 Ul 19.33 Ul
4.750 0.00 Ul 57.21 Ul 0.00 U1 17.90 U1
5.000 0.00 Ul 61.50 U1 0.00 Ul 16.46 Ul
5.250 0.00 Ul 65.44 Ul 0.00 U1 15.02 Ul
5.500 0.00 Ul 69.01 Ul 0.00 Ul 13.59 U1
5.750 0.00 Ul 72.23 Ul 0.00 Ul 12.32 Ul
6.000 0.00 Ul 75.09 Ul 0.00 U1 11.10 U1
6.250 0.00 Ul 77.59 U1 0.00 Ul 9.89 U1
6.500 0.00 UL 79.73 Ul 0.00 Ul 8.67 UL
6.750 0.00 Ul 81.51 U1l 0.00 Ul 7.46 UL
7.000 0.00 Ul 82.93 Ul -0.13 Ul 6.24 UL
7.250 0.00 U1 83.99 Ul -0.69 Ul 5.02 Ul
7.500 0.00 Ul 84.70 Ul -1.25 U1 3.81 Ul
7.750 0.00 UL 85.04 Ul -1.80 Ul 2.59 Ul
8.000 0.00 Ul 85.03 Ul -2.36 Ul 1.37 U1
8.250 0.00 Ul 84.65 Ul -2.92 Ul 0.16 Ul
8.500 0.00 U1 83.92 Ul -3.65 Ul 0.00 Ul
8.750 0.00 Ul 82.83 Ul -5.08 Ul 0.00 U1
9.000 0.00 Ul 81.38 Ul -6.52 Ul 0.00 Ul
9.250 0.00 Ul 79.57 U1 -7.96 Ul 0.00 Ul
9.500 0.00 Ul 77.40 Ul -9.39 Ul 0.00 Ul
9.750 0.00 U1 74.87 Ul -10.83 Ul 0.00 Ul
10.000 0.00 Ul 71.99 U1 -12.27 Ul 0.00 U1
10.250 0.00 Ul 69.66 UL -13.70 Ul 0.00 Ul
10.500 0.00 Ul 67.12 UL -15.14 U1 0.00 U1
10.750 0.00 Ul 64.27 UL -16.57 Ul 0.00 Ul
11.000 0.00 UL 61.11 Ul -18.01 Ul 0.00 Ul
11.250 0.00 Ul 57.66 ULl -19.45 U1 0.00 U1
11.500 0.00 Ul 53.90 Ul -20.88 Ul 0.00 Ul
11.750 0.00 Ul 49.83 Ul -22.32 U1 0.00 U1

40

.88
.57
.31
.48
.36

.00

.00
.00
.00
.16
.16

.16

-17.40
-15.93
2.88
-0.57
2.31
-12.48
-15.36

0.00
0.00
0.00
0.00
-0.00
4.16
4.16
-4.16
-4.16

0.00
0.00
-0.00
6.65
6.65
-6.65
-6.65

Examples

6-137



pC gﬁb | pcﬁﬁm

.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.750
.000
.250
.500

000
250
500
750
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750

-1.

-6.
-10.
-13.
-16.
-20.
-24.
-28.
-32.
-41.
-51.
-61.
-71.
-82.
-93.

-105.
-116.
-129.
-141.
-141.
-154.
-168.
-182.

-164.
-152.
-139.
-128.
-128.
-116.
-105.
-95.
-85.
-75.
-65.
-56.

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

45.46
40.79
35.81
30.53
24.94
19.05
12.86
6.36
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.50
6.16
11.52
16.57
21.32
25.77
29.91
34.13
38.24
42.04
45.54
48.73
51.62
54.20
56.48
58.46
60.13
61.50
62.56
63.32
63.78
63.93
63.78
63.32
62.56
61.50
60.13
58.46
56.48
54.20
51.62
48.73
45.54
42.04
38.24
34.13
29.91
25.77
21.32
16.57
11.52
6.16

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

-23.76
-25.19
-26.63
-28.06
-29.50
-30.94
-32.37
-33.81
-35.25
-36.68
-38.12
-39.55
-40.99
-42.43
-43.86
-45.30
-46.74
-48.17
-49.61
-51.04
-51.04
-52.84
-55.37
-57.90

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
-0.06
-0.62
-1.17
-1.73
-2.28
-3.50
-4.72
-5.93
-7.15
-8.37
-9.58
-10.80
-12.01
-13.23
-14.45
-15.80
-17.24
-18.67
-20.11
-21.54
-22.98
-24.42
-25.85
-27.29
-28.73

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

52.82
50.29
47.76
45.96
45.96
44.52
43.09
41.65
40.22
38.78
37.34
35.91
34.47
33.03
31.60
30.16
28.73
27.29
25.85
24.42
22.98
21.54
20.11
18.67
17.24
15.80
14.45
13.23
12.01
10.80
9.58
8.37
7.15
5.93
4.72
3.50
2.28
1.73
1.17
0.62
0.06
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
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.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.750
.000
.250
.500

000
250
500
750
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500
750
000
250
500

.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750
.000
.250
.500
.750

-29.
-33.
-39.
-47.
-56.
-65.
-175.
-85.
-95.
-105.
-116.
-128.
-128.
-139.
-152.
-164.

-182.
-168.
-154.
-141.
-141.
-129.
-116.
-105.
-93.
-82.
=71.
-61.
-51.
-41.
-32.
-28.
-24.
-20.
-16.
-13.
-10.
-6.
-3.

-2.
-9.
-16.
-24.

000 0000000000000 0000000000000O0 00000

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.50
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
6.36
12.86
19.05
24.94
30.53
35.81
40.79
45.46
49.83
53.90
57.66
61.11
64.27
67.12
69.66
71.99
74.87
77.40
79.57
81.38
82.83
83.92
84.65
85.03
85.04
84.70
83.99
82.93
81.51
79.73
77.59
75.09
72.23
69.01
65.44
61.50
57.21
52.55
47.54
42.17
36.44
30.35
23.90
17.09
9.92
5.51
2.97
0.29
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul

-30.16
-31.60
-33.03
-34.47
-35.91
-37.34
-38.78
-40.22
-41.65
-43.09
-44.52
-45.96
-45.96
-47.76
-50.29
-52.82

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
-0.16
-1.37
-2.59
-3.81
-5.02
-6.24
-7.46
-8.67
-9.89
-11.10
-12.32
-13.59
-15.02
-16.46
-17.90
-19.33
-20.77
-22.20
-23.64
-25.08
-26.51
-27.95
-29.39
-30.82
-32.26
-33.69
-35.13

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

57.90
55.37
52.84
51.04
51.04
49.61
48.17
46.74
45.30
43.86
42.43
40.99
39.55
38.12
36.68
35.25
33.81
32.37
30.94
29.50
28.06
26.63
25.19
23.76
22.32
20.88
19.45
18.01
16.57
15.14
13.70
12.27
10.83
9.39
7.96
6.52
5.08
3.65
2.92
2.36
1.80
1.25
0.69
0.13
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul

Ul
Ul
ul
Ul
ul
Ul
Ul
ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
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Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
Ul
Ul
Ul
ul
Ul
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16.
16.
16.
16.
16.
17.
17.
17.

000
250
500
750
750
000
250
500

-32.83
-41.23
-50.30
-60.34
-60.34
-70.81
-81.91
-93.77

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

-36.57
-38.00
-39.44
-40.88
-40.88
-42.86
-45.94
-49.01

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Ul
Ul
Ul
Ul
Ul
Ul
Ul
Ul

[7] SEGMENTAL DEFLECTIONS

Units:

Span

1

x (ft), D (in)

x Ddead Dlive Dtotal
0.000 0.000 0.000 0.000
0.250 0.000 0.000 0.001
0.500 0.001 0.001 0.002
0.750 0.001 0.001 0.003
0.750 0.001 0.001 0.003
1.000 0.002 0.002 0.004
1.250 0.002 0.002 0.005
1.500 0.003 0.003 0.006
1.750 0.003 0.004 0.007
2.000 0.003 0.004 0.008
2.250 0.004 0.005 0.009
2.500 0.004 0.005 0.010
2.750 0.005 0.006 0.011
3.000 0.005 0.006 0.012
3.250 0.006 0.007 0.013
3.500 0.006 0.008 0.014
3.750 0.007 0.008 0.015
4.000 0.007 0.009 0.016
4.250 0.008 0.009 0.017
4.500 0.008 0.010 0.018
4.750 0.009 0.010 0.019
5.000 0.009 0.011 0.019
5.250 0.009 0.011 0.020
5.500 0.010 0.011 0.021
5.750 0.010 0.012 0.022
6.000 0.010 0.012 0.022
6.250 0.010 0.012 0.023
6.500 0.011 0.013 0.023
6.750 0.011 0.013 0.024
7.000 0.011 0.013 0.024
7.250 0.011 0.013 0.024
7.500 0.011 0.013 0.024
7.750 0.011 0.013 0.024
8.000 0.011 0.013 0.024
8.250 0.011 0.013 0.024
8.500 0.011 0.013 0.024
8.750 0.011 0.013 0.024
9.000 0.011 0.013 0.024
9.250 0.011 0.013 0.024
9.500 0.011 0.013 0.023
9.750 0.010 0.012 0.023
10.000 0.010 0.012 0.022
10.250 0.010 0.012 0.022
10.500 0.010 0.011 0.021
10.750 0.009 0.011 0.020
11.000 0.009 0.011 0.020
11.250 0.009 0.010 0.019
11.500 0.008 0.010 0.018
11.750 0.008 0.009 0.017
12.000 0.007 0.009 0.016
12.250 0.007 0.008 0.015
12.500 0.007 0.008 0.014
12.750 0.006 0.007 0.013
13.000 0.006 0.007 0.012
13.250 0.005 0.006 0.011
13.500 0.005 0.006 0.010
13.750 0.004 0.005 0.009
14.000 0.004 0.005 0.008
14.250 0.003 0.004 0.007
14.500 0.003 0.003 0.006
14.750 0.003 0.003 0.006
15.000 0.002 0.003 0.005
15.250 0.002 0.002 0.004
15.500 0.001 0.002 0.003
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.
Graphical Output
Loads
100 100 100
CASE: Live
I I
CASE: Dead
5468.75 5468.75
SERMEGE SERIE3
75 75 75
204 167 204 167 204167
CASE: SELF
pcasSlab v2 00, Licensed to: peaStructurePaint. License ID: 12345-1234567-4-2D2DE-2C800
File: C:\Program Files\PCAYcaSlab\ExamplesivanualExample 5 - PCA Notes on ACI 318-05 Bxample 20-2 slb
Project pcaSlab/pcaBeam Manual, Example 5
Frame: PCA Notes on AC| 318-05, Example 20-2 Engineer: pcaStructurePoint
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Internal Forces
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pcaSlab w2.00. Licensed to: peaStructurePoint. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files\PCA\pcaSlabExamples\ivanualExample 5 - PCA Notes on ACI 318-05 Example 20-2.slb
Project pcaSlab/pcaBeam Manual, Example 5

Frame: PCA Notes on ACI 318-05, Example 20-2 Enginser pcaStructurePoint
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Moment Capacity
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Shear Capacity
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Deflection
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Beam Strip Flexural and Transverse Reinforcement
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Middle Strip Flexural Reinforcement
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Column Strip Flexural Reinforcement

i

1
1
1
1
! o
: 5
N n = N |
1S = = =) =)
H =) =) = ey I~ =y [
e 2 = ol + iaR = o
B @ @ B I
5 o F 5 el
5 g g 5 5 & g4
ey 5 [ 1+ 5
b T ‘
=

2 2 S

& =} 5

= S =

2 o 2

& % =

% © %

h3 pis

Column Strip Flexural Reinforcement

pcaSlab w2.00. Licensed to: peaStructurePoint. License ID: 12345-1234567-4-2D2DE-2C8D0

File: C\Program Files\PCA\pcaSlabExamples\ivanualExample 5 - PCA Notes on ACI 318-05 Example 20-2.slb
Project pcaSlab/pcaBeam Manual, Example 5

Frame: PCA Notes on ACI 318-05, Example 20-2 Enginser pcaStructurePoint

6-150

Examples



Appendix

Conversion Factors - English to S|

To convert from To Multiply by

in. m (1000 mm) 0.025400

ft m 0.304800

Ib N (0.001 kN) 4.448222

kip (1000 Ibs) kN 4.448222

plf (Ib/ft) N/m 14.593904

psi (Ib/in.?) kPa 6.894757
ksi (kips/in.?) MPa 6.894757
psf (Ib/ft) N/m’ (Pa) 47.88026

pef (Ib/ft) kg/m’ 16.018460
ft-kips kN «m 1.355818

Conversion Factors - Sl to English.
To convert from To Multiply by

m (1000 mm) in 39.37008
m ft 3.28084

N (0.001 kN) Ib 0.224809
kN kip (1000 Ibs) 0.224809

kN/m PIf (Ib/ft) 68.52601

MPa Psi (Ib/in%) 145.0377

MPa ksi (kips/in®) 0.145038
kN/m? (kPa) Psf (Ib/ft?) 20.88555
kg/m’ Pcf (Ib/ft%) 0.062428

kN «m ft-kips 0.737562
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Contact Information
Web Site: http://www.pcaStructurePoint.com
E-mail: info@pcaStructurePoint.com
support@pcaStructurePoint.com
Ordering: pcaStructurePoint
5420 Ol1d Orchard Road
Skokie, IL 60077
USA
Phone: (847) 966-4357
Fax: (847) 581-0644

Technical Support:

Phone:
Fax:

pcaStructurePoint

5420 Old Orchard Road

Skokie, IL 60077

USA

(847) 966-HELP / (847) 966-4357
(847) 581-0644
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